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《Cult 3D 产品三维演示时尚创作百例》是“时尚百例丛书”中的一本。

Cult 3D 是 Cycore 公司开发的一种崭新的 3D网络技术。它基于跨平台的 3D引

擎，可以把高质量图像、实时交互的物体高速送到所有因特网用户手上。其目的

是在网页上建立互动的 3D 物件。利用 Cult 3D 技术可以让网页设计师制作出 3D

立体产品，放置在网页中可以旋转、放大、缩小，实现三维互动，还可以加入多

媒体音效和操作指引。利用 Cult 3D 的跨平台 3D引擎，可以非常方便地在网页上

进行产品的互动 3D演示，使电子商务、企业新产品等实现更生动的在线推广。

Cult 3D 作为一种全新的优秀电子商务方案，用它能创造出可以随时随地在网

上可触摸、可感觉的产品，还可以和其他人一起玩令人激动的网上游戏。该技术

使用户可以非常真实的体验设计，定制和量化自己的产品，也可使网络开发者和

3D动画师们更好的完成工作。

本书用 Cult 3D 精心制作了 100 个精彩实例，有着较大的覆盖面。通过对这些

实例的学习，对于初次接触本软件的读者有着循序渐进的作用，对于熟悉本软件

的创作人员有着很好的借鉴意义。随着 3D技术的不断成熟和发展，网页的动态交

互性能是未来网页的一个发展趋势，必然会成为未来网页技术的主流。Cult 3D 强

大完善的功能也必然会吸引越来越多人的重视，快快加入到 3D大家族中来吧。

前前    言言  
CCuulltt  33DD产产品品三三维维演演示示时时尚尚创创作作百百例例
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Cult 3D 安装程序 DesignerPack.exe 可从网上下载（http://www.cult3d.com），本

书随盘提供。安装方法：双击 DesignerPack.exe，完成后执行 �开始 �→�程

序�? �Cult3D Designer�? �Cult3D Designer�即可启动Cult 3D。如果要使用 3DS MAX

4.0 建模文件，需安装 MaxPlugs.exe。如果要使用 Maya 4.0 建模文件，需安装

maya_setup.exe。

希望本书的出版能给广大网络开发者和 3D动画师们提供一些帮助和启发。由

于本人水平有限，书中可能存在着诸多不足之处，希望能得到大家的批评指正。

 � �������������网冠科技
本书光盘含配套素材（使用方法请见光盘中“光盘使用说明书”），技术支持请点击网冠

科技站点 Netking.163.com。E-mail：Netking_@yeah.net。 
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本篇介绍如何将已经制作完成的 3D 文件从

3D MAX软件中导出，使之成为 Cult 3D 软件可以

导入的.c3d 文件。

本篇详细介绍了输出过程的步骤以及其他参

数的设置，例如背景色的设置等。重点指出了在

保存过程中需要注意的问题。

本篇制作了 5 个简单且精彩的实例，使读者

初步感受到 Cult 3D 软件的功能和它完美的 3D效

果。

从 3D MAX导出篇 
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实例 1  船  模 （一） 

 

本例制作“船模（一）”的效果，

如图 1-1所示。 

本例特点是：将制作好的 3DS 

MAX文件从 3DS MAX导出，使之成

为 Cult3D可以导入的文件格式。 

本例通过 3DS MAX 群组和

ship.3DS文件导入等知识完成。 

 

图 1-1  效果图 

 

 

1．启动 3DS MAX。 

2．装载 ship.3DS。选择 File→

Import...命令，在出现的对话框中选中

ship.3DS，如图 1-2所示。单击打开后，

在弹出对话框中单击 OK按钮，按其默

认设置。 

3．生成组。单击 （Select by 

Name）按钮，弹出对话框，如图 1-3

所示，单击 All按钮，选中所有实体，

单击 Seclect 按钮，再选择 Group→

Group命令，弹出如图 1-4所示对话框，

在输入框中输入 ship，单击 OK按钮。

将所有的实体对象编辑在一个组中是

为了后续的制作，当然也可以选择需要

的实体对象编辑为一个组。 

4．导出。单击 File→Export...命令，

弹出对话框，在保存类型的下拉菜单条

中，选取 Cult3D Designer（*.C3D）命

令，在文件名中输入 ship，单击保存。 

注意：这里的保存事实上并没有真

正的保存文件。 

 

图 1-2 

 

图 1-3 

 

图 1-4 
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5．设置输出属性。完成保存后，

弹出对话框，如图 1-5所示。共有五个

属性，下面依次介绍： 

① Header。在 Object Data中是输

出对象的一些参数，不可更改。在

Object Information中，可以更改Object、

Author、Organization三项。 

② Background。选中左边空白处

的Background，单击右面的Background 

color，设置背景色，如图 1-6所示。在

弹出的对话框中，选中需要设置的白色

背景色，单击确定按钮。 

③ Materials，用来控制不同的着

色方式。可选用的四种着色方式如下：

Constant Shading，没有任何光源，无法

显示立体感；Flat Shading，有光源设置，

对象表面没有平滑处理，较为平面化；

Gouraud Shading，有光源设置，对象表

面做了平滑处理，而且根据点数计算强

光模式；Phone Shading，有光源设置，

对象表面做了较佳的平滑处理，根据像

素来计算强光模式。一般选取 Gouraud 

Shading，如图 1-7所示。 

④ Nodes。有三种模式，General，

Mesh和Camera，这些设置和3DS MAX

中动画的关系较大，在以后的学习中，

以静态实体为主，在此不做介绍。 

⑤ Textures，主要用来控制贴图

面积大小和贴图的压缩比，有 Texture 

map options和 Image compression，对

于没有贴图的实体，则没有此选项。 

6．保存。改变输出对象属性后单

击对话框右下 Apply 按钮，使设置生

效。单击 Viewer 按钮，可以预览输出

的对象，并且系统提供了六个不同的视

角，如图 1-8所示。单击 Saver按钮，

保存文件，本例制作完成。 

 

图 1-5 

 

图 1-6 

 

图 1-7 

 

图 1-8 
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实例 2  船  模 （二） 

 

本例制作“船模（二）”的效果，

如图 2-1所示。 

本例特点是：单击鼠标左键，可以

在 XY平面内旋转船模，单击鼠标右键

可以沿 Z 轴移动船模，同时单击鼠标

左、右两键可以移动船模在 XY平面内

的位置。 

本例知识点有：Arcball。 

 

图 2-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 ship.C3D。执行 File→Add 

Cult3D Designer file命令，在出现的对

话框中选中 ship.C3D，如图 2-2所示。

单击打开，弹出对话框，如图 2-3所示，

单击 Yes按钮，输入原先设置的背景色

为当前背景色；单击 No按钮，则选择

系统默认的背景色为黑色。 

3．添加 Arcball。在 Event map 1

中单击 （world start）按钮，拖动到

右面的空白处。选中 （WorldStart_1）

按钮，右击选中 Change Name 选项，

弹出对话框，如图 2-4所示，在输入框

中输入 Start，单击 OK按钮完成设置。 

在 Actions 窗口中，单击 Object 

motion按钮，选中 （arcball），拖动

到 Event map 1 中 ， 叠 加 在  
（WorldStart_1）上面，出现黑框。在

Scene Graph中，单击 rootnode，选中 
（ship），按住并拖动到 Event map 1

 

图 2-2 

 

图 2-3 
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中，叠加在 （Arcball）上，出现黑框，

形成的 Event map 1如图 2-5所示。 

4．预览。单击 View 1 窗口中的

右面的 （Preview run/Stop）按钮，可

以观察刚刚设置的效果。 

5．改变 Arcball 的参数设置。在

Event map中选中 （Arcball），右击

Details选项，弹出对话框，具体设置如

图 2-6所示。 

6．保存。单击 File→Save project

命令，保存为 ship.c3p，本例制作完成。 

 

图 2-4 

 

图 2-5 

 

图 2-6 
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实例 3  航    模 

 

本例制作“航模”的效果，如图

3-1所示。 

本例特点是：单击鼠标左键，可以

在 XY平面内旋转航模，单击鼠标右键

可以沿 Z 轴移动航模，同时按住鼠标

左右两键可以移动航模在 XY 平面内

的位置。 

本例通过群组和.C3D 文件的导出

等知识完成。  

 

图 3-1  效果图 

 

 

1．启动 3DS MAX。 

2．装载 biplane.max。选择 File→

Import...命令，在出现的对话框中选中

biplane.max，如图 3-2所示。单击打开

后，在弹出对话框中单击 OK按钮，选

择默认设置。 

3．生成组。单击 （Select by 

Name）按钮，弹出对话框，单击 All

按钮，选中除 Camera01、Camera.target、

Light01、Light02和 Light02.target以外

的所有实体，如图3-3所示。单击Seclect

按钮，选择 Group→Group命令，弹出

对话框，如图 3-4所示，在输入框中输

入 biplane，单击 OK按钮完成。 

4．导出。选择 File→Export...命令，

弹出对话框，在保存类型的下拉菜单条

中选取 Cult3D Designer（*.C3D），在

文件名中输入 biplane，单击保存。 

5．设置输出属性。单击保存后，

 

图 3-2 

 

图 3-3 
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弹出对话框。选中左边空白处的

Background，单击右面的 Background 

color 按钮，设置背景色，如图 3-5 所

示。在弹出的如图 3-6所示对话框中，

选中需要设置的白色背景色，单击确定

按钮。 

6．保存。改变输出对象属性后，

单击对话框右下的 Apply按钮，使设置

生效。单击 Viewer 按钮，可以预览输

出的对象，并且系统提供了六个不同的

视角。单击 Saver按钮，保存文件。 

7．启动Cult 3D。装载 biplane.C3D。

执行 File→Add Cult3D Designer file命

令 ， 在 出 现 的 对 话 框 中 选 中

biplane.C3D，如图 3-7所示。单击打开，

弹出对话框，单击 Yes按钮，输入原先

设置的背景色为当前背景色。 

8．添加 Arcball。在 Event map 1

中单击 （world start）按钮，拖动到

右面的空白处。选中 （WorldStart_1）

按钮，右击 Change Name 选项，弹出

对话框，在输入框中输入 Start，单击

OK按钮完成设置。 

在 Actions 窗口中，单击 Object 

motion选项，选中 （Arcball）按钮，

拖动到 Event map 1 中，叠加在  
（Start）上面，出现黑框。在 Scene 

Graph中，单击 rootnode选项，选中 
（biplane）按钮，按住并拖动到 Event 

map 1中，叠加在 （Arcball）上，出

现黑框，形成的 Event map 1如图 3-8

所示。 

9．预览。单击 View 1 窗口中的

右面的 （Preview run/Stop）按钮，可

以观察刚刚设置的效果。 

10．单击 Saver 按钮，保存为

biplane.c3p，本例制作完成。 

 

图 3-4 

 

图 3-5 

 

图 3-6 

 

图 3-7 

 

图 3-8 
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实例 4  车    模 

 

本例制作“车模”的效果，如图

4-1所示。 

本例的特点是：将制作好的 3DS 

MAX文件从 3DS MAX导出，使之成

为 Cult3D 可以导入的文件格式。单击

左键，可以在 XY平面内旋转车模，单

击右键可以沿 Z 轴移动车模，同时单

击左、右两键可以移动车模在 XY平面

内的位置。 

本例通过群组和.C3D 文件的导出

等知识来完成。  

 

 

图 4-1  效果图 

 

 

1．启动 3DS MAX。 

2．装载 Toyota.3ds。选择 File→

Import...命令，在出现的对话框中选中

Toyota.3ds，如图 4-2所示。单击打开，

弹出对话框，选择默认设置，单击 OK

按钮。 

3．生成组。单击 （Select by 

Name）按钮，弹出对话框，如图 4-3

所示，单击 All按钮，选中除 Camera01

和 Camera01.target 以外的所有实体。

单击 Select 按钮，选择 Group→Group

命令，弹出对话框，如图 4-4所示，在

输入框中输入 Toyota，单击 OK按钮。

将所有的实体对象编辑在一个组中是

为了后续的制作，当然也可以选择需要

的实体对象编辑为一个组。 

4．导出。选择 File→Export...命令，

 

 

图 4-2 

 

图 4-3 
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弹出对话框，在保存类型的下拉菜单条

中，选取 Cult3D Designer（*.C3D），

在文件名中输入 Toyota，单击保存。 

5．设置输出属性。单击保存后，

弹出对话框，如图 4-5所示。将背景色

设为白色，单击 Apply 按钮，单击

Viewer 按钮可以预览输出的对象，单

击 Saver按钮保存。 

6．启动 Cult 3D。 

7．装载 Toyota.C3D。选择 File→

Add Cult3D Designer file命令，在出现

的对话框中选中 Toyota.C3D。单击打

开，弹出对话框，如图 4-6所示。单击

Yes，输入原先设置的背景色为当前背

景色。单击 No，则选择系统默认的背

景色为黑色。这里选择 Yes。 

8．添加 Arcball。在 Event map 1

中单击 （world start）按钮，拖动到

右面的空白处。在 Actions窗口中，单

击 Object motion，选中 （arcball），

拖动到 Event map 1 中，叠加在  
（WorldStart_1）上面，出现黑框。在

Scene Graph中，单击 rootnode，选中 
（Toyota），按住并拖动到 Event map 1

中，叠加在 （Arcball）上，出现黑框，

形成的 Event map 1如图 4-7所示。 

9．保存为 Toyota.c3p，本例制作

完成。 

 

图 4-4 

 

图 4-5 

 

图 4-6 

 

图 4-7 
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实例 5  机  器  猫 

 

本例制作“机器猫”的效果，如图

5-1所示。 

本例的特点是：按住鼠标左键，可

以在 X 方向移动机器猫，按住鼠标右

键可以在 Y 方向移动机器猫，同时按

住鼠标左、右两键可在 Z 方向移动机

器猫。 

本例通过群组和.C3D 文件的导出

等知识完成。  

 

图 5-1  效果图 

 

 

1．启动 3DS MAX。 

2．装载 cat.max。执行 File→Open

命令，在出现的对话框中选中 cat.max，

如图 5-2所示。单击打开后，在弹出的

对话框中单击 OK 按钮，按其默认设

置。 

3．生成组。单击 （Select by Name）

按钮，弹出对话框，单击 All 按钮，选

中除 Camera01、Camera01.target 以外

的所有实体，如图 5-3所示，单击 Select

按钮，选择 Group→Group命令，弹出

对话框，如图 5-4所示，在输入框中输

入 cat，单击 OK按钮完成。 

4．导出。选择 File→Export...命令，

弹出对话框，在保存类型的下拉菜单条

中，选取 Cult3D Designer（*.C3D），

在文件名中输入 cat，单击保存。 

5．设置输出属性。单击保存后，

弹出对话框。选中左边空白处的

 

图 5-2 

 

图 5-3 
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Background，单击右面的 Background 

color 按钮来设置背景色。在弹出的如

图 5-5所示对话框中，选中需要设置的

白色背景色，单击确定按钮。 

6．保存。改变输出对象属性后单

击对话框右下的 Apply按钮，使设置生

效。单击 Viewer 按钮可以预览输出的

对象，系统提供了六个不同的视角。最

后单击 Saver按钮，保存文件。 

7．启动 Cult 3D。 

8．装载 cat.C3D。选择 File→Add 

Cult3D Designer File命令，在出现的对

话框中选中 cat.C3D，如图 5-6 所示。

单击打开，弹出对话框，单击 Yes，输

入原先设置的背景色为当前背景色。 

9．添加 Arcball。在 Event map 1

中单击 （world start），拖动到右面

的空白处。在 Actions 窗口中，单击

Object motion按钮，选中 （Arcball），

拖动到 Event map 1 中，叠加在  
（WorldStart_1）上面，出现黑框。 

在 Scene Graph中可以看到三个实

体 （cat）、 （头 02）和 （zuofujian），

如图 5-7所示。在此要将不需要的两个

实体 （头 02）、 （zuofujian）删

除，方法为选中实体，右击选择 Delete

命令删除。 

在 Scene Graph中，单击 rootnode，

选中 （cat），按住并拖动到 Event map 

1中，叠加在 （Arcball）上，出现黑

框，形成的 Event map 1如图 5-8所示。 

10．改变原来 Arcball的默认设置。

原来的默认设置为：按住左键，可以在

XY平面内旋转机器猫，按住右键可以

沿 Z 轴移动机器猫，同时按住左、右

两键可以移动机器猫在 XY 平面内的

位置。 

单击 Event map 1中的 （Arcball）

按钮，再右击选择 Details 命令，弹出

 

图 5-4 

 

图 5-5 

 

图 5-6 

 

图 5-7 

 

图 5-8 
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对话框，如图 5-9所示。在 LEFT button

下拉菜单中选中 Translation X；在

RIGHT button 下 拉 菜 单 中 选 中

Translation Y；在MIDDLE button下拉

菜单中选中 Translation Z，也可以改动

三个动作的 Translation Sensitivity。 

11．预览。单击 View 1窗口中的

右面的 （Preview run/Stop）按钮，可

以观察刚刚设置的效果。同时也可以和

没有改变默认设置前的效果做比较。 

12．保存为 cat.c3p，本例制作完

成。  

图 5-9 

 �



 

 

本篇介绍如何制作各种交通工具的 3D 交互

效果，例如汽车、气垫船等交通工具在实际使用

时，可能出现的一些情况。同时也制作了一些用

于产品发布等方面的实例，如汽车的展示等。

通过本篇的学习，读者可逐步熟悉 Cult 3D 软

件的基本功能，慢慢确立起事件（Event）、动作

（Action）和物体（Objection）这三个重要的概念，

理解这三者之间的联系。

交通工具篇 
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实例 6  飞    机 

 

本例制作“飞机”的效果，如图 6-1 所

示。 

本例的特点是：按“+”键，螺旋桨顺

时针旋转，按“-”键，螺旋桨逆时针旋转。

按“↑”键，飞机向前移动，释放“↑”键，

飞机停止移动；按 “↓”键，飞机向后移

动，释放“↓”键，飞机停止移动；按 “→”

键，飞机向右移动，释放“→”键，飞机停

止移动；按“←”键，飞机向左移动，释放

“←”键，飞机停止移动。 

本例通过 KeyBoard�s key press 和
KeyBoard�s key release等知识完成。 

 

 

图 6-1  效果图 

 

 

1．启动 Cult 3D。 
2．装载 bi_plane.C3D。选择 File→Add 

Cult3D Designer File命令，在出现的对话框
中选中 bi_plane.C3D，如图 6-2所示。 

3．添加 Arcball。在 Event map 1中，单
击 （World Start），拖动到右面的空白处。
在 Actions窗口中，单击 Object motion选项，
选中 （Arcball），拖动到 Event map 1中，
叠加在 （World Start_1）上面，出现黑框。
在 Scene Graph中，单击 rootnode选项→
（BI_PLANE），选中 （BI_PLANE），
拖动到 Event map 1中，叠加在 （Arcball）
上面，出现黑框。效果如图 6-3所示。 

4．制作飞机旋转的效果。在 Actions
窗口中，单击 Object motion 选项，选中 
（Rotation XYZ），按住并拖动到 Event map 

 

图 6-2 

 

图 6-3 
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（Rotation XYZ），按住并拖动到 Event map 

1中，叠加在 （WorldStart_1）上面，出现

黑 框 。 选 中 Event map 1 中 的

（BI_PLANE），按住并拖动到 （Rotation 

XYZ），出现黑框。双击 （Rotation XYZ），

弹出对话框，如图 6-4所示。在 Y轴中输入

�20（角度），Time设为 1000（毫秒），在
Z轴中输入 80（角度），Time设为 1000（毫
秒），并且选择 Repeat count 方式，执行 1
次，单击 Close 按钮完成参数设置。形成的
Event map 1如图 6-5所示。 

5．制作控制飞机前后左右移动的效果。 
前 ： 在 Event map 1 中 选 中

（Keyboard�s key Press），按住并拖动到右
面的空白处，双击 （KeyPress_1），弹出
对话框，如图 6-6 所示，在左边框中选中
“Arrow up”，单击 Add按钮，添加到右边
框，单击 OK按钮完成。 
在 Actions窗口中，单击 Object motion

选项，选中 （Translation XYZ），拖动到
Event map 1中，叠加在 （KeyPress_1）上
面，出现黑框。选中 Event map 1 中的
（BI_PLANE），拖动到  （Translation 
XYZ），出现黑框。双击  （Translation 
XYZ），弹出对话框。在 Y 轴中输入�100
（位移），Time 设为 1000（毫秒），选择
Loop方式，单击 Close按钮完成参数设置。 
在 Event map 1中，选中 （Keyboard�s 

key Release），拖动到右面的空白处，双击
（KeyRelase_1），弹出对话框，如图 6-7所
示，在左边框中选中“Arrow up”，单击 Add
按钮，添加到右边框，单击 OK按钮完成。 
在 Actions窗口中，单击 Object motion

选项，选中 （Translation XYZ），拖动到
Event map 1中，叠加在 （KeyRelase_1）
上面，出现黑框。选中 Event map 1中的
（BI_PLANE），拖动到  （Translation 
XYZ），出现黑框。双击  （Translation 
XYZ），弹出对话框。在 Y轴中输入 100（位

 

图 6-4 

 

图 6-5 

 

图 6-6 

 

图 6-7 

 

图 6-8 
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移），Time设为 1000（毫秒），选择 Loop

方式，单击 Close 按钮完成参数设置。形成

的 Event map 1如图 6-8所示。 

对于向后、向左和向右移动，和上面的

向前移动一样制作。但是必须注意移动方向

和坐标之间的关系。形成的 Event map 1如

图 6-9所示。 

6．制作飞机螺旋桨旋转的效果。在

Event map 1 中，选中 （Keyboard�s key 
Press），拖动到右面的空白处，双击
（KeyPress_5），弹出对话框，在左边框中
选中“+”，单击 Add按钮，添加到右边框，
单击 OK按钮完成。 
在 Actions窗口中，单击 Object motion

选项，选中 （Rotation XYZ），拖动到 Event 
map 1 中，叠加在 （KeyPress_5）上面，
出现黑框。选中 Scene Graph中的BI_PLANE
中的 （Object16），拖动到 （Rotation 
XYZ），出现黑框。双击 （Rotation XYZ），
弹出对话框。在 Y轴中输入 200（角度），
Time设为 1000（毫秒），并且选择 Loop方
式，单击 Close 按钮完成参数设置。形成的
Event map 1如图 6-10所示。 
在 Event map 1中选中 （Keyboard�s 

key Press），按住并拖动到右面的空白处，
双击 （KeyPress_6），弹出对话框，在左
边框中选中“-”，单击 Add 按钮，添加到
右边框，单击 OK按钮完成。 
在 Actions窗口中，单击 Object motion

选项，选中 （Rotation XYZ），拖动到 Event 
map 1 中，叠加在 （KeyPress_6）上面，
出现黑框。选中 Event map 1 中的
（Object16），拖动到 （Rotation XYZ），
出现黑框。双击 （Rotation XYZ），弹出
对话框，具体设置如图 6-11所示，并且选择
Loop方式，单击 Close按钮完成参数设置。
形成的 Event map如图 6-12所示。 

7．保存为 bi_plane.c3p，本实例制作完
成。 

 

图 6-9 

 

图 6-10 

 

图 6-11 

 

图 6-12 
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实例 7  开动的火车 

 

本例制作“开动的火车”的效果，如图

7-1所示。 

本例的特点是：按键盘上的“1”键，

火车会开动；按键盘上的“2”键火车会停

止运行；按键盘上的“3”键，火车会复位。 

本例通过 KeyBoard�s key press 和
Sequence actions等知识完成。 

 

图 7-1  

 

 

1．启动 Cult 3D。 
2．装载 train.C3D。选择 File→Add 

Cult3D Designer File命令，在出现的对话框
中选中 train.C3D，如图 7-2所示。 

3．添加 Arcball。在 Event map 1中单击
 （World start），拖动到右面的空白处。
在 Actions窗口中，单击 Object motion选项，
选中 （Arcball），拖动到 Event map 1中，
叠加在 （WorldStart_1）上面，出现黑框。
在 Scene Graph中，单击 rootnode选项，选
中 （Train），拖动到 Event map 1中，叠
加在 ）Arcball）上面，出现黑框。效果如
图 7-3所示。 

4．制作启动运行的效果。在 Event map 
1中，单击 （Keyboard�s key press），拖
动到右面的空白处，双击 （KeyPress_1），
弹出对话框，如图 7-4 所示，在左边框中选
中“1”，单击 Add 按钮，添加到右边框，
单击 OK 按钮完成。在 Actions 窗口中，单
击 Object motion 选项，选中 （Sequence 

 

图 7-2 

 

图 7-3 
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actions），按住并拖动到 Event map 1中，叠

加在 （KeyPress_1）上面，出现黑框。在

Actions窗口中，单击 Object motion选项，

选中 （Translation XYZ），拖动到 Event map 

1中，叠加在 （Sequence actions）上面，

出现黑框。选中 Event map 1中的 （Train），

拖动到 （Translation XYZ），出现黑框。

双击 （Translation XYZ），弹出对话框，

如图 7-5所示。在 X轴中输入 2（位移），

Time设为 1000（毫秒），选择 Repeat count 

1方式，单击 Close按钮完成参数设置。 

在 Actions窗口中，单击 Object motion

选项，选中 （Translation XYZ），拖动到

Event map 1中，叠加在 （Sequence actions）

上面，出现黑框。在 Scene Graph中，选中

（Track），拖动到 （Translation XYZ），

出现黑框。双击 （Translation XYZ），弹

出对话框。在 X轴中输入�2（位移），Time
设为 1000（毫秒），选择 Repeat count 1方
式，单击 Close按钮完成参数设置。双击
（Sequence actions），弹出对话框，如图 7-6
所示，选中 Loop the sequence。最后 Event 
map 1如图 7-7所示。 

5．制作火车停止的效果。在 Event map 
1中选中 （Keyboard�s key Press），拖动
到右面的空白处，双击 （KeyPress_2），
弹出对话框，在左边框中选中“2”，单击
Add按钮，添加到右边框，单击 OK按钮完
成。在 Actions窗口中，单击 Object motion
选项，选中 （Stop Sequence actions），按
住并拖动到 Event map 1 中，叠加在
（KeyPress_2）上面，出现黑框。选中 Event 
map 1中的 （Sequence actions），叠加在
（Stop Sequence actions）上面，出现黑框。 
在 Actions窗口中，单击 Object motion

选项，选中 （Stop�），拖动到 Event map 
1 中，叠加在 （KeyPress_2）上面，出现
黑框。在 Event map 1中，选中 （track），
拖动到 （Stop�），出现黑框。在 Event map 

 

图 7-4 

 

图 7-5 

 

图 7-6 

 

图 7-7 
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1中，选中 （Train），拖动到 （Stop�），
出现黑框。双击 （Stop�），弹出对话框，
如图 7-8 所示。选中左边除 WorldStart_1. 
Arcball 的所有动作，单击 按钮添加至右
边框中，单击 Close 按钮完成设置。最后形
成的 Event map 1如图 7-9所示。 

6．制作火车复位的效果。在 Event map 
1中，选中 （Keyboard�s key Press），拖
动到右面的空白处，双击 （KeyPress_3），
弹出对话框，在左边框中选中“3”，单击
Add按钮，添加到右边框，单击 OK按钮完
成。在 Actions窗口中，单击 Object motion
选项，选中 （Reset），拖动到 Event map 1
中，叠加在 （KeyPress_3）上面，出现黑
框。选中 Event map 1中 （Train），叠加
在 （Reset）上面，出现黑框。最后形成
Event map 1如图 7-10所示。 

7．保存为 train.c3p，本实例制作完成。 

 

图 7-8 

 

图 7-9 

 

图 7-10 
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实例 8  轿    车 

 

本例制作“轿车”，如图 8-1所示。 

本例的特点是：初始时，轿车顺时

针转动，按“1”键，车为灰色；按“2”

键，车为红色；按“3”键，车为蓝色；

按“4”键，车为紫色；按“5”键，车

为黄色。 

本例通过 Hide Object 和 Unhide 

Object等知识完成。 
 

图 8-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 car.C3D。选择 File→Add 

Cult3D Designer File命令，在出现的对

话框中选中 car.C3D，如图 8-2所示。 

3．添加 Arcball。在 Event map 1

中，单击 （World start），按住并拖

动到右面的空白处。在 Actions窗口中，

单击 Object motion 选项，选中  
（Arcball），按住并拖动到 Event map 1

中，叠加在原来的 （WorldStart_1）

上面，出现黑框。在 Scene Graph中，

单击 rootnode 选项，选中 （car），

按住并拖动到 Event map 1中，叠加在

 （Arcball）上面，出现黑框。形成

的 Event map 1如图 8-3所示。 

4．制作初始轿车顺时针转动的效

果。在 Actions 窗口中，单击 Object 

motion选项，选中 （Rotation XYZ），

按住并拖动到 Event map 1中，叠加在

 （WorldStart_1）上，出现黑框。选

 

图 8-2 

 

图 8-3 
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中 Event map 1中的 （car），拖动到

 （Rotation XYZ），出现黑框。双击

 （Rotation XYZ），弹出对话框。在

Z轴中输入�10（角度），Time设为 1000
（毫秒），并且选择 Loop方式，单击
Close按钮完成参数设置。 

5．制作初始时隐藏其他四种颜色
的效果。在 Actions 窗口中，单击
Render，选中 （Hide Object）。拖动
到 Event map 1 中 ， 叠 加 在  
（WorldStart_1）上面，出现黑框。在
Scene Graph 中 ， 分 别 选 中  
（Group02），  （Group03），  
（Group04）和 （Group05），叠加
到 （Hide Object）上面，出现黑框。
选中 （Hide Object），右击选择
Details...命令，弹出对话框，如图 8-5
所示，选中 Apply to child，单击 OK按
钮完成设置。形成的 Event map 1如图
8-6所示。 

6．制作显示灰色车身的效果。在
Event map 1 中，单击 （Keyboard�s 
key press），拖动到右面的空白处，双
击 （KeyPress_1），弹出对话框，如
图 8-7 所示，在左边框中选中“1”，
单击 Add 按钮，添加到右边框，单击
OK 按钮完成。在 Actions 窗口中，单
击 Render，选中 （Unhide Object）。
拖动到 Event map 1 中，叠加在
（KeyPress_1）上面，出现黑框。在
Scene Graph 中的 RootNode 中的 Car
中，选中 （Group01），叠加到
（Unhide Object）上面，出现黑框。选
中 （Unhide Object），右击选择
Details...,弹出对话框，选中 Apply to 
child，单击 OK按钮完成设置。 
在 Actions窗口中，单击 Render，

选中 （Hide Object）。拖动到 Event 
map 1中，叠加在 （KeyPress_1）上

 

图 8-4 

 

图 8-5 

 

图 8-6 

 

图 8-7 
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面，出现黑框。在 Scene Graph中，分

别选中 （Group02）， （Group03），

 （Group04）和 （Group05），叠

加到 （Hide Object）上面，出现黑框。

选中 （Hide Object），右击选择

Details...，弹出对话框，选中 Apply to 

child，单击 OK按钮完成设置。形成的

Event map 1如图 8-8所示。 

7．制作显示其他颜色车身的效果

同上面第 6步的做法。制作显示其他颜

色车身的步骤应当注意对应关系，按键

盘上的“2”键，车为红色；按键盘上

的“3”键，车为蓝色；按键盘上的“4”

键，车为紫色；按键盘上的“5”键，

车为黄色。在 （Unhide Object）当前

颜色的时候，必须注意要将其他不显示

的颜色 （Hide Object），避免引起干

涉。而且所有的 （Hide Object）和

（ Unhide Object）必须右击选择

Details...命令，在弹出的对话框中，选

中 Apply to child 选项，最终如图 8-9

所示。 

8．保存为 car.c3p，本例制作完成。 

 

图 8-8 

 

图 8-9 
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实例 9  轿车的展示 

 

本例制作“轿车的展示”的效果，

如图 9-1所示。 

本例的特点是：轿车可以在地面上

旋转，单击“1”键轿车逆时针旋转，

单击“2”键轿车停止旋转。 

本例通过 Arcball、Rotation等知识

制作完成。 

 

图 9-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 car1.c3p。选择 File→Add 

Cult3D Designer File命令，在出现的对

话框中选中 car.C3D，如图 9-2所示。 

3．添加 Arcball。在 Event map 1

中单击 （world start），拖动到右面

的空白处。在 Actions 窗口中，单击

Object motion选项，选中 （Arcball），

按住并拖动到 Event map 1中，叠加在

 （world start）上面，出现黑框。在

Scene Graph中，单击 rootnode选项 ，

单击 （car），按住并拖动到 Event map 

1中，叠加在原来的 （Arcball）上，

出现黑框，最后 Event map 1如图 9-3

所示。 

4．制作轿车逆时针旋转效果。在

Event map 1中单击 （Keyboard�s key 
Press），把它拖动到右侧的空白处，
双击 （KeyPress_1），弹出对话框，
如图 9-4所示，在左边框中选中“1”，
单击 Add按钮添加到右边框，单击 OK

 

 

 

图 9-2 

 

图 9-3 
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按钮完成。在 Actions 窗口中，单击

Object motion选项，选中 （Rotation 

XYZ），按住并拖动到 Event map 1中，

叠加在原来的 （KeyPress_1）上面，

出现黑框。在 Scene Graph中，单击

（car），拖动到 （Rotation XYZ），

出现黑框。双击 （Rotation XYZ），

弹出对话框，如图 9-5所示。在 Z轴中

输入 10（角度），Time设为 1000（毫

秒），并且选择 Loop方式，单击 Close

按钮完成参数设置。 

5．制作顺时针旋转效果。在 Event 

map 1 中单击 （Keyboard�s key 
Press），把它拖动到右侧的空白处，
双击 （KeyPress_2），弹出对话框，
在左边框中选中“2”，单击 Add按钮
添加到右边框，单击 OK按钮完成。在
Actions窗口中，单击 Object motion选
项，选中 （Rotation XYZ），按住并
拖动到 Event map 1中，叠加在原来的
（KeyPress_2）上面，出现黑框。在

Scene Graph中，单击 （car），拖动
到 （Rotation XYZ），出现黑框。双
击 （Rotation XYZ），弹出对话框，
如图 9-5所示。在 Z轴中输入�10（角
度），Time设为 1000（毫秒），并且
选择 Loop 方式，单击 Close 按钮完成
参数设置。形成的 Event map 1，如图
9-6所示。 

6．保存为 car1.c3p，本例制作完
成。 

 

图 9-4 

 

图 9-5 

 

图 9-6 

 



第二篇  交通工具篇 

 
25 

实例 10  轿车车门的打开 

 

本例制作“轿车车门的打开”的效

果，如图 10-1所示。 

本例的特点是：轿车在地面上旋转

的同时，单击鼠标左键车门打开，再次

单击，车门关上。 

本例通过 Rotation、Activate event

和 Deactivate event等知识完成。 

 

图 10-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 car1.c3p。执行 File→Load 

project 命令，在出现的对话框中选中

car1.c3p，如图 10-2所示。 

3．制作右车门打开的效果。在

Event map 1中，单击 （Left mouse 

click on Object），拖动到右面的空白

处。在 Scene Graph中，单击 rootnode

选项，选中 （AVUSDOOR），拖到

Event map 1 中 ， 叠 加 在  

（ObjectClick_1）上面，出现黑框。在

Actions窗口中，单击 Object motion选

项，选中 （Rotation XYZ），按住并

拖动到 Event map 1 中，叠加在   

（ObjectLClick_1）上，出现黑框。选

中 Event map 1中的 （AVUSDOOR），

拖动到 （Rotation XYZ），出现黑框。

双击 （Rotation XYZ），弹出对话框,

如图 10-3所示。在 Z轴中输入�60（角
度），Time设为 1000（毫秒），并且
选择 Repeat count 1方式，单击 Close

 

 

 

图 10-2 

 

 

图 10-3 
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按钮完成参数设置。形成的 Event map 

1，如图 10-4所示。 

4．制作右车门关上的效果。在

Event map 1中，单击 （Left mouse 

click on Object），拖动到右面的空白

处。在 Event map 1 中，选中  
（AVUSDOOR），拖到到 Event map 1

中，叠加在 （ObjectLClick_2）上面，

出现黑框。在 Actions 窗口中，单击

Object motion选项，选中 （Rotation 

XYZ），按住并拖动到 Event map 1中，

叠加在  （ObjectLClick_2）上。选中

Event map 1中的 （AVUSDOOR），

拖动到 （Rotation XYZ），出现黑框。

双击 （Rotation XYZ），弹出对话框。

在 Z轴中输入 60（角度），Time设为

1000（毫秒），并且选择 Repeat count 1

方式，单击 Close按钮完成参数设置。

形成的 Event map 1，如图 10-5所示。 

5．确定关门和开门的关系。在

Actions 窗口中，单击 Event，选中 
（Deactivate event，按住并拖动到

Event map 1 中 ， 叠 加 在  
（  ObjectLClick_1 ） 上 。 选 中  
（Deactivate event），单击右键选择

parameters命令，弹出对话框，如图 10-6

所示，在左边框中选中ObjectLClick_1，

单击 Add，单击 OK 按钮。在 Actions

窗口中，选中 （Activate event），拖

动到 Event map 1 中，叠加在  
（ObjectLClick_1）上面，出现黑框。

选中 （Activate event），单击右键选

择 parameters命令，弹出对话框，在左

边框中选中 ObjectLClick_2，单击 Add

按钮，单击 OK按钮。 

在 Actions窗口中，单击 Event按

钮，选中 （Deactivate event），按住

并拖动到 Event map 1 中，叠加在 
（ObjectLClick_2）上，出现黑框。选

 

 

 

图 10-4 

 

 

 

图 10-5 

 

 

 

图 10-6 
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中 （Deactivate event），单击右键选

择 parameters命令，弹出对话框，在左

边框中选中 ObjectLClick_2，单击 Add

按钮，单击 OK按钮。在 Actions窗口

中，选中 （Activate event），拖动到

Event map 1 中 ， 叠 加 在  
（ObjectLClick_2）上，出现黑框。选

中 （Activate event），单击右键选择

parameters命令，弹出对话框。在左边

框中选中 ObjectLClick_1，单击 Add按

钮，单击OK按钮。形成的 Event map 1，

如图 10-7所示。 

6．制作左车门打开的效果。在

Event map 1中，单击 （Left mouse 

click on Object），拖动到右面的空白

处。在 Scene Graph中，单击 rootnode

选项，选中 （AVUSDOOL），拖到

Event map 1 中 ， 叠 加 在  

（ObjectLClick_3），出现黑框。在

Actions窗口中，单击 Object motion选

项，选中 （Rotation XYZ），按住并

拖动到 Event map 1 中，叠加在   

（ObjectLClick_3）上，出现黑框。选

中 Event map 1中的 （AVUSDOOR），

拖动到 （Rotation XYZ），出现黑框。

双击 （Rotation XYZ），弹出对话框，

如图 10-8所示。在 Z轴中输入 60（角

度），Time设为 1000（毫秒），并且

选择 Repeat count 1方式，单击 Close

按钮完成参数设置。形成的 Event map 

1，如图 10-9所示。 

7．制作左车门关上的效果。在

Event map 1中，单击 （Left mouse 

click on Object），拖动到右面的空白

处。在 Event map 1 中，选中  
（AVUSDOOL），拖到到 Event map 1

中，叠加在 （ObjectLClick_4），出

现黑框。在 Actions窗口中，单击 Object 

motion选项，选中 （Rotation XYZ），

 

 

 

图 10-7 

 

 

 

图 10-8 

 

 

 

图 10-9 
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按住并拖动到 Event map 1中，叠加在

  （ObjectLClick_4）上，出现黑框。

选 中 Event map 1 中 的  
（AVUSDOOL），拖动到 （Rotation 

XYZ），出现黑框。双击 （Rotation 

XYZ），弹出对话框。在 Z轴中输入�60
（角度），Time设为 1000（毫秒），
并且选择 Repeat count 1 方式，单击
Close按钮完成参数设置。形成的 Event 
map 1，如图 10-10所示。 

8．确定关门和开门的关系。在
Actions 窗口中，单击 Event 按钮，选
中 （Deactivate event，按住并拖动到
Event map 1 中 ， 叠 加 在  
（ObjectLClick_3）上面，出现黑框。
选中 （Deactivate event），单击右键
选择 parameters命令，弹出对话框，如
图 10-11 所示，在左边框中选中
ObjectLClick_3，单击 Add按钮，单击
OK 按钮结束。在 Actions 窗口中，选
中 （Activate event），拖动到 Event 
map 1中，叠加在 （ObjectLClick_3）
上面，出现黑框。选中  （Activate 
event），单击右键选择 parameters命令，
弹出对话框，如图 10-12所示。在左边
框中选中 ObjectLClick_4，单击 Add按
钮，单击OK按钮。形成的 Event map 1，
如图 10-13所示。 
在 Actions窗口中，单击 Event按

钮，选中 （Deactivate event），按住
并拖动到 Event map 1 中，叠加在 
（ObjectLClick_4）上，出现黑框。选
中 （Deactivate event），单击右键选
择 parameters命令，弹出对话框，在左
边框中选中 ObjectLClick_4，单击 Add
按钮，单击 OK按钮。在 Actions窗口
中，选中 （Activate event），拖动到
Event map 1 中 ， 叠 加 在  
（ObjectLClick_4）上，出现黑框。选

 

图 10-10 

 

图 10-11 

 

图 10-12 

 

图 10-13 
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中 （Activate event），单击右键选择

parameters命令，弹出对话框。在左边

框中选中 ObjectLClick_3，单击 Add按

钮，单击 OK按钮结束。形成的 Event 

map 1，如图 10-14所示。 

9．保存为 car2.c3p，本例制作完

成。 

 

图 10-14 
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实例 11  轿车的开动 

 

本例制作“轿车开动”的效果，如

图 11-1所示。 

本例的特点是：按“Enter”，汽

车开动，按“Space”，汽车停止。 

本例通过：Rotation，Activate event

和 Deactivate event等知识完成。 

 

图 11-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 car2.c3p。单击 File→Load

project 命令，在出现的对话框中选中

car.c3p，如图 11-2所示。 

3．制作轿车开动的效果。在 Event 

map 1 中单击 （Keyboard�s key 
Press），把它拖动到右侧的空白处，
双击 （KeyPress_3），弹出对话框，
如图 11-3 所示，在左边框中选中
“Enter”，点击 Add 按钮，添加到右
边框，点击 OK按钮。在 Actions窗口
中，点击 object motion，选中
（Rotation XYZ），按住并拖动到 Event 
map 1 中 ， 叠 加 在 原 来 的
（KeyPress_3）上面，出现黑框。 
在 Scene Graph 中，单击  

（AVUSWHE1），拖动到 （Rotation 
XYZ），出现黑框。 
在 Scene Graph 中，单击  

 

图 11-2 

 

 

图 11-3 

 



第二篇  交通工具篇 

 
31 

（AVUSWHE2），拖动到 （Rotation 

XYZ），出现黑框。 

在 Scene Graph 中，单击  
（AVUSWHE3），拖动到 （Rotation 

XYZ），出现黑框。 

在 Scene Graph 中，单击  
（AVUSWHE4），拖动到 （Rotation 

XYZ），出现黑框。 

双击 （Rotation XYZ），弹出

对话框。在 X 轴中输入 60（角度），

Time设为 1000（毫秒），并且选择 Loop

方式，点击 close完成参数设置。形成

的 Event map1如图 11-4所示。 

4．制作轿车停止的效果。在 Event 

map 1 中单击 （Keyboard�s key 
Press），把它拖动到右侧的空白处，
双击 （KeyPress_4），弹出对话框，
在左边框中选中“Space”，点击 Add
按钮，添加到右边框，点击 Ok按钮。 
在 Actions 窗口中，点击 object 

motion，选中 （Rotation XYZ），按
住并拖动到 Event map 1中，叠加在原
来的 （KeyPress_4）上面，出现黑框。 
在 Event map 1 中，单击  

（AVUSWHE1），拖动到 （Rotation 
XYZ），出现黑框。 
在 Event map 1 中，单击  

（AVUSWHE2），拖动到 （Rotation 
XYZ），出现黑框。 
在 Event map 1 中，单击  

（AVUSWHE3），拖动到 （Rotation 
XYZ），出现黑框。 
在 Event map 1 中，单击  

（AVUSWHE4），拖动到 （Rotation 
XYZ），出现黑框。 
双击 （Rotation XYZ），弹出

对话框，如图 11-5所示。在 X轴中输
入-60（角度），Time设为 1000（毫秒），
并且选择 Loop 方式，点击 close 完成

 

图 11-4 

 

图 11-5 

 

图 11-6 

 

图 11-7 



Cult 3D产品三维演示时尚创作百例 

 
32 

参数设置。形成的 Event map 1 如图

11-6所示。 

5．确定开动和停止的关系。在

Actions 窗口中，单击 Event 按钮，选

中 （Deactivate event），按住并拖动

到 Event map 1 中 ， 叠 加 在

（KeyPress_3）上面，出现黑框。选中

 （Deactivate event），单击右键选择

parameters命令，弹出对话框，如图 11-7

所 示 ， 在 左 边 的 边 框 中 选 中

KeyPress_3，单击 Add按钮，单击 OK

按钮结束。在 Actions窗口中，选中 
（Activate event），拖动到 Event map 1

中，叠加在 （KeyPress_3）上面，出

现黑框。选中 （Activate event），单

击右键选择 parameters命令，弹出对话

框，如图 11-8 所示。在左边的边框中

选中 KeyPress_4，点击 Add，点击 OK

按钮结束。形成的 Event map 1，如图

11-9所示。 

在 Actions窗口中，点击 Event，

选中 （Deactivate event），按住并拖

动到 Event map 1 中，叠加在

（KeyPress_4）上，出现黑框。选中 
（Deactivate event），单击右键选择

parameters命令，弹出对话框，在左边

的边框中选中 KeyPress_4，点击 Add

按钮，点击 OK 按钮结束。在 Actions

窗口中，选中 （Activate event），拖

动到 Event map1 中，叠加在

（KeyPress_4）上，出现黑框。选中 
（Activate event），单击右键选择

parameters命令，弹出对话框。在左边

的边框中选中 KeyPress_3，点击 Add

按钮，点击 OK按钮结束。形成的 Event 

map 1，如图 11-10所示。 

6．保存为 car3.c3p，本例制作完

成。 

 

图 11-8 

 

图 11-9 

 

图 11-10 
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实例 12  轿车废气的排放 

 

本例制作“轿车废气的排放”的效

果，如图 12-1所示。 

本例的特点是：按“Enter”键，

汽车开动，并且排气管放出黑色气体，

按“Space”键，汽车停止，排气管不

再排放黑色气体。 

本例通过 Start particle emission和

Stop particle emission等知识完成。 

 

图 12-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 car3.c3p。执行 File→Load 

project 命令，在出现的对话框中选中

car3.c3p，如图 12-2所示。 

3．制作汽车开动时排放废气的效

果。为了避免黑色的地面掩盖效果，所

以将地面 （Plane01）删去，在 Scene 

Graph窗口中，单击 rootnode选项，选

中 （Plane01），右击选择 Delete 命

令，如图 12-3所示。 

在 Scene Graph 窗口中，单击

rootnode选项，选中 （AVUSEXHA），

右击选择 New→Particle System命令。

在 Scene Graph窗口中，会出现一个

（Particle），如图 12-4所示。 

单击 （Particle），拖动到 Event 

map 1 中。在 Actions 窗口中，单击

Object motion 选项，选中 （Start 

particle emission），拖动到 Event map 1

中，叠加在 （KeyPress_3）上面，出

 

 

图 12-2 

 

图 12-3 
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现黑框。选中 Event map 1 中的

（particle），叠加在 （Start particle 

emission）上面，出现黑框。选中

（particle），右击选择 Details，弹出对

话框。在 Color settings中，单击左面的

颜色方框可以选取不同的颜色，将所有

阶段的颜色都设成黑色，图 12-5所示。

设置 Particle settings 中的参数，如图

12-6 所示，在 Emit speed（m/s）中输

入 800，在 Speed range（%）中输入 3.6，

在 Brith rate（particle）中输入 250，在

Life length（ms）中输入 1.1，在 Start 

angle（deg）中输入 0，在 End angle（deg）

中输入 25，在 Particle size（m）中输

入 300，在 Gravity（m/（s*s））中输

入 1，在 Friction中输入 1，在 Speed size

中输入 70，在 wiggle（deg/s）中输入

72，在 wiggle amplitude 中输入 3,在

Opacity中输入 0，在 Time scales（s/s）

中输入 1。单击 Close按钮完成设置。 

4．制作废气排放停止的效果。在

Actions窗口中，单击 Particle systems，

选中  （Stop particle emission），按

住并拖动到 Event map 1中，并且叠加

在 （KeyPress_4）上面，出现黑框。

选中 Event map 1中的 （particle），

拖动到  （Stop particle emission）上

面，出现黑框。最后形成 Event map 1

如图 12-7所示。 

5．保存为 car4.c3p，本例制作完

成。 

 

图 12-4 

 

图 12-5 

 

图 12-6 

 

图 12-7 
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实例 13  赛车的展示 

 

本例制作“赛车的展示”的效果，

如图 13-1所示。 

本例的特点是：按“T”或“t”键，

可从上面欣赏赛车；按“F”或“f”键，

可从前面欣赏赛车；按“L”或“l”键，

可从左面欣赏赛车；按“R”或“r”键，

可从右面欣赏赛车；按“D”或“d”

键，可从底部欣赏赛车；按“B”或“b”

键，可从后面欣赏赛车；按空格键，回

到原来的视角；按“Enter”键，车轮

开始滚动。 

本例通过 Arcball和 Select camera

等知识完成。 

 

图 13-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 formula.C3D。执行 File

→Add Cult3D Designer File命令，在出

现的对话框中选中 formula.C3D，如图

13-2所示。 

3．添加 Arcball。在 Event map 1

中，单击 （world start），按住并拖

动到右面的空白处。在 Actions窗口中，

单击 Object motion 选项，选中  
（Arcball），拖动到 Event map 1中，

叠加在 （WorldStart_1）上面，出现

黑框。在 Scene Graph中，单击 rootnode

选项，选中 （FORMULA1），拖动

到 Event map 1中，叠加在 （Arcball）

上面，出现黑框。效果如图 13-3所示。 

 

图 13-2 

 

图 13-3 
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4．制作从上面俯看赛车的效果。

在 Event map 1中选中 （Keyboard�s 
key Press），拖动到右面的空白处，双
击 （KeyPress_1），弹出对话框，如
图 13-4所示，在左边框中选中“T”或
“t”，单击 Add按钮，添加到右边框，
单击 OK按钮完成。 
在 Actions窗口中，单击 Camera，
选中 （Select camera），按住并拖动
到 Event map 1 中 ， 叠 加 在
（KeyPress_1）上面，出现黑框。在
Scene Graph中，单击 rootnode选项，
选中 （Top view），拖动到 Event map 
1中，叠加在 （Select camera）上面，
出现黑框。效果如图 13-5所示。 

5．制作从前面欣赏赛车的效果。
在 Event map 1中，选中 （Keyboard�s 
key Press），按住并拖动到右面的空白
处，双击 （KeyPress_2），弹出对话
框，在左边框中选中“F”或“f”，单
击 Add按钮，添加到右边框，单击 OK
按钮完成。 
在 Actions窗口中，单击 Camera，
选中 （Select camera），拖动到 Event 
map 1中，叠加在 （KeyPress_2）上
面，出现黑框。在 Scene Graph中，单
击 rootnode选项，选中 （Front view），
拖动到 Event map 1 中，叠加在
（Select camera）上面，出现黑框。 
对于其他的视角也按照上面同样

的方法来制作。应注意的是选取的字母

和视角的对应关系。完成后形成的

Event map 1如图 13-6所示。 
6．制作恢复到原来视角的效果。

在 Event map 1中，单击 （Keyboard�s 
key Press），拖动到右面的空白处，双
击 （KeyPress_7），弹出对话框，如
图 13-7所示，在左边框中选中“Space”，
单击 Add 按钮，添加到右边框，单击

 

图 13-4 

 

图 13-5 

 

图 13-6 

 

图 13-7 
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OK按钮完成。 

在 Actions窗口中，单击 Camera，

选中 （Select camera），拖动到 Event 

map 1中，叠加在 （KeyPress_7）上

面，出现黑框。在 Scene Graph中，单

击 rootnode选项，选中 （View 4），

拖动到 Event map 1 中，叠加在

（Select camera）上面，出现黑框。最

后形成的 Event map 1，如图 13-8所示。 

7．制作车轮旋转的效果。在 Event 

map 1 中，单击 （Keyboard�s key 
Press），拖动到右面的空白处，双击
（KeyPress_8），弹出对话框，在左边
框中选中“Enter”，单击 Add 按钮，
添加到右边框，单击 OK按钮完成。 
在 Actions 窗口中，单击 Object 

motion选项，选中 （Rotation XYZ），
拖动到 Event map 1 中，叠加在
（KeyPress_8）上面，出现黑框。选中
Scene Graph中的 （WHEELRIM），
拖动到 （Rotation XYZ），出现黑框。
双击 （Rotation XYZ），弹出对话框，
如图 13-9所示。在Y轴中输入 1000（角
度），Time设为 1000（毫秒），并且
选择 Loop 方式，单击 Close 按钮完成
参数设置。 
在 Actions 窗口中，单击 Object 

motion选项，选中 （Rotation XYZ），
拖动到 Event map 1 中，叠加在
（KeyPress_8）上面，出现黑框。选中
Scene Graph中的 （WHEELRIM01），
拖动到 （Rotation XYZ），出现黑框。
双击 （Rotation XYZ），弹出对话框。
在 Y轴中输入�1000（角度，因为两者
的坐标系不同，所以符号不一样），

Time设为 1000（毫秒），并且选择 Loop
方式，单击 Close按钮完成参数设置。 
在 Scene Graph 中，选中在  

（FORMULA1）下的 （TIRE1），

 

图 13-8 

 

图 13-9 

 

图 13-10 
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拖动到 （TIRE02）下，出现黑色。

形成的 Scene Graph，如图 13-10所示。 

在 Actions 窗口中，单击 Object 

motion选项，选中 （Rotation XYZ），

按住并拖动到 Event map 1中，叠加在

（KeyPress_8），出现黑框。选中

Scene Graph中的 （TIRE02），拖动

到 （Rotation XYZ），出现黑框。双

击 （Rotation XYZ），弹出对话框。

在 X轴中输入�500（角度），Time设
为 1000（毫秒），并且选择 Loop方式，
单击 Close按钮完成参数设置。最后形
成 Event map 1，如图 13-11所示。 

8．保存为 formulac3p，本例制作
完成。 

 

图 13-11 
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实例 14  奔驰的摩托 

 

本例制作“奔驰的摩托”的效果，

如图 14-1所示。 

本例的特点是：初始时摩托是开动

的状态，按“←”键，摩托车的前轮左

拐，按“→”键，摩托车的前轮会右拐。 

本例通过 Keyboard�s key press和
Rotation XYZ等知识完成。 

 

图 14-1  效果图 

 

 

1．启动 Cult 3D。 
2．装载 train.C3D。执行 File→Add 

Cult3D Designer File命令，在出现的对
话框中选中 cycle.C3D，如图 14-2所示。 

3．添加 Arcball。在 Event Map 1
窗口中单击 （World Start），把它拖
到右侧的空白处。在 Actions窗口中，
单击 Object Motion，选中 （Arcball），
把它拖到 Event map 1中，并且叠加在
原来的 （World Start）上面，出现黑
框。在 Scene Graph 窗口中，单击
rootnode 选项，选中 （Group01），
把它拖到 Event map 1中，并且叠加在
原来的 （Arcball）上面，出现黑框。
效果如图 14-3所示。 

4．制作初始时摩托开动的效果。
在Actions窗口中，单击Object Motion，
选中 （Rotation XYZ），把它拖到
Event map 1中，并且叠加在原来的 
（World Start）上面，出现黑框。双击
（Rotation XYZ），弹出对话框，如

 

 

图 14-2 

 

图 14-3 

 

图 14-4 
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图 14-4 所示。在 X 轴中输入 200（角

度），Time设为 1000（毫秒），其他

设置不变，单击 Close 按钮完成。在

Scene Graph窗口中，单击 rootnode选

项，选中 （group1）下的 （wheel），

把它拖到 Event map 1中，并且叠加在

原来的 （Rotation XYZ）上面，出现

黑框。选中  （ group1）下的

（wheel02），把它拖到 Event map 1中，

并且分别叠加在原来的 （Rotation 

XYZ）上面，出现黑框。效果如图 14-5

所示。 

5．制作摩托前轮转动的效果。先

确定包含关系，在 Scene Graph窗口中，

单击 rootnode 选项，分别选中  
（group1）下的 （wheel）、（tire01）、

（break）、 （disc）、 （fender），

依次拖动分别叠加在 （Front Fork）

上面，出现黑色。形成的包含关系如图

14-6所示。 

6．在 Event map 1 中单击

（Keyboard�s key Press），把它拖动到
右侧的空白处，双击 （KeyPress_1），
弹出对话框，如图 14-7 所示，在左边
框中选中“Arrow Left”，单击 Add按
钮添加到右边框，单击 OK 按钮。在
Actions窗口中，单击 Object motion选
项，选中 （Rotation XYZ），拖动到
Event map 1中，并且叠加在原来的
（KeyPress_1）上面，出现黑框。在
Scene Graph中，选中 （Front Fork），
按住并拖动到 （Rotation XYZ）上面，
出现黑框。双击 （Rotation XYZ），
弹出对话框，如图 14-8所示。在 Z轴
中输入 10（角度），Time 设为 1000
（毫秒），并且选择 Repeat count  1
方式，单击 Close按钮完成参数设置。
形成的 Event map 1，如图 14-9所示。 

7．在 Event map 1 中单击

 

图 14-5 

 

图 14-6 

 

图 14-7 

 

图 14-8 
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（Keyboard�s key Press），把它拖动到
右侧的空白处，双击 （KeyPress_2），
弹出对话框，在左边框中选中“Arrow 
Right”，单击 Add按钮添加到右边框，
单击 OK按钮完成。在 Actions窗口中，
单击 Object motion 选项，选中
（Rotation XYZ），按住并拖动到 Event 
map 1 中，并且叠加在原来的
（KeyPress_2）上面，出现黑框。在
Event map 1中，选中 （Front Fork），
按住并拖动到 （Rotation XYZ），出
现黑框。双击 （Rotation XYZ），弹
出对话框，在 Z轴中输入�10（角度），
Time 设为 1000（毫秒），并且选择
Repeat count  1方式，单击 Close按钮
完成参数设置。形成的 Event map 1，
如图 14-10所示。 

8．保存为 cycle.c3p，本实例制作
完成。 

 

图 14-9 

 

图 14-10 
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实例 15  卡    车 

 

本例制作“卡车”的效果，如图

15-1所示。 

本例特点：按“1”键控制卡车移

动，按“2”键车斗打开。 

本例通过 Timer、Select camera和

Stereoscopic features等知识完成。 

 

图 15-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 dtruck.C3D。执行 File→

Add Cult3D Designer File命令，在对话

框中选中 dtruck.C3D，如图 15-2所示。 

3．制作视角旋转的效果。在 Event 

Map1窗口中单击 （World Start），

拖到右侧的空白处。在 Actions中，单

击 Camera，选中 （Select camera），

拖到 Event map 1中，叠加在 （World 

Start）上。在 Scene Graph 中单击

RootNode，选中 （Right view），拖

到 Event map 1中，叠加在 （Select 

camera）上。在 Actions 中选中  
（Rotation XYZ），拖动到 Event map 1

中，叠加在 （World Start）上。在 Scene 

Graph 中，单击 RootNode，选中  
（dtruck），拖到 Event map 1中，叠

加在 （Rotation XYZ）上。双击 
（Rotation XYZ），弹出对话框，具体

设置如图 15-3所示，选择 Loop方式，

单击 Close按钮。效果如图 15-4所示。 

4．制作卡车加速前进的效果。在

 

图 15-2 

 

图 15-3 

 

图 15-4 
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Event map 1中单击 （Keyboard�s key 
press），拖动到右面的空白处。双击
（KeyPress_1），出现对话框，在左边
选择 1，单击 Add按钮，单击 OK按钮。
单 击 Object Motion ， 选 中   
（Translation XYZ），拖到 Event map 1
中，叠加在 （KeyPress_1）上，出现
黑框。双击  （Translation XYZ），
出现对话框，单击 Y 方向上的 ，选
择 ，如图 15-5所示，单击 Set，出现
对话框如图 15-6 所示。在 Waveform 
type中选择 Swtooth up方式。在 Sustain
和 global parameters中，修改参数，具
体设置如图 15-6 所示，单击 Close 按
钮。选择 Repeat count方式，单击 Close
按钮。选中 （dtruck），叠加在 
（Translation XYZ）上。在 Actions中
选中 （Rotation XYZ），拖动到 Event 
map 1中，叠加在 （KeyPress_1）上。
选中 （dtruck），叠加在 （Rotation 
XYZ）上。双击 （Rotation XYZ），
弹出对话框，具体设置如图 15-7所示，
选择 Loop 方式，单击 Close 按钮。在
Actions 中，单击 Camera，选中
（Stereoscopic features），拖到 Event 
map 1中，叠加在 （KeyPress_1）上。
选中 （Right view），叠加在
（Stereoscopic features）上。双击
（Stereoscopic features），出现对话框
如图 15-8 所示，拖动下部的滚动条就
可以调节重影的大小。效果如图 15-9
所示。在 Actions 中，单击 Event，选
中 （Deactivate event），拖动到 Event 
map 1中，叠加在 （KeyPress_1）上。 

5．修改包含关系。在 Scene Graph
中 ， 单 击 RootNode ， 单 击  
（Group_All），找到 （dump02）、

 （sides02）和 （gate02），拖动 
（sides02）和 （gate02）到 （dump02）

 

图 15-5 

 

图 15-6 

 

图 15-7 

 

图 15-8 

 

图 15-9 
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上，形成关系图如图 15-10所示。 

6．制作车斗打开和关闭的效果。

在 Event map 1中单击 （Keyboard�s 
key press），拖动到右面的空白处。双
击 （KeyPress_2），出现对话框，在
左边选择 2，单击 Add按钮，单击 OK
按钮。在 Actions中，选中 （Rotation 
XYZ），拖动到 Event map 1中，叠加
在 （ KeyPress_2）上。选中  
（dump02），叠加在 （Rotation XYZ）
上。双击 （Rotation XYZ），弹出对
话框，具体设置如图 15-11所示，选择
Repeat count方式，单击 Close按钮。
在 Event map 1中单击 （Timer），拖
动到右面的空白处。选中 （Timer_1），
单击右，键选择不要 Initial Activation。
双击 （Timer_1），出现对话框，填
入 8000（毫秒），单击 OK 按钮。在
Actions中，选中 （Rotation XYZ），
拖动到 Event map 1 中，叠加在
（KeyPress_1）上。选中 （dtruck），
叠加在 （Timer_1）上。双击  
（Rotation XYZ），弹出对话框，具体
设置如图 15-12所示，选择Repeat count
方式，单击 Close 按钮。拖动  
（dump02）叠加在 （Rotation XYZ）
上。单击 Event，选中 （Deactivate 
event），拖动到 Event map 1中，叠加
在 （Timer_1）上。选中 （Timer_1），
叠加到 （Deactivate event）上。单击
Event，选中 （activate event），拖动
到 Event map 1 中 ， 叠 加 在
（KeyPress_2）上。将 （Timer_1）
拖动到 （activate event）上。完成效
果如图 15-13所示。 

7．保存为Motor5.c3p，本例制作
完成。 

 

图 15-10 

 

图 15-11 

 

图 15-12 

 

图 15-13 
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实例 16  自 行 车（一） 

 

本例制作“自行车（一）”的效果，

如图 16-1所示。 

本例的特点是：用鼠标左键单击自

行车，车轮车把开始转动，再次单击左

键，自行车车把回到原来的位置。 

本例通过 Arcball、Left click on 

Object和 Rotation等知识完成。 

 

图 16-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 bike.C3D。执行 File→Add 

Cult3d Design File，在出现的对话框中

选中 bike.C3D，如图 16-2所示。 

3．添加 Arcball。在 Event map 1

中，单击 （World start），按住并拖

动到右面的空白处。在 Actions窗口中，

单击 Object motion 选项，选中  
（Arcball），按住并拖动到 Event map 1

中，叠加在原来的 （World start）上

面，出现黑框。在 Scene Graph中，单

击 rootnode选项，选中 （Group），

按住并拖动到 Event map 1中，叠加在

 （Arcball）上面，出现黑框。形成

的 Event map 1如图 16-3所示。 

4．制作包含车把需要旋转的物体。

在 Scene Graph中，单击 rootnode选项，

选中 （Group），拖动到 （Line01），

出现黑色。选中 （Torus01），拖动

到 （Line01），出现黑色。选中 
（ ChamferCy101 ） ， 拖 动 到   

 

图 16-2 

 

图 16-3 
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（ChamferCy102），出现黑色。选中 
（hand），拖动到 （Line01），出现

黑色。这时的 Scene Graph如图 16-4所

示。 

5．制作车把左转的效果。在 Event 

map 1中，单击 （Left mouse click on 

Object），拖动到右面的空白处。在

Actions窗口中，单击 Object motion选

项，选中 （Rotation XYZ），按住并

拖动到 Event map 1 中，叠加在   

（ObjectLClick_1）上，出现黑框。在

Scene Graph中，单击 rootnode选项，

选中 （Line01），拖动到 （Rotation 

XYZ），出现黑框。双击 （Rotation 

XYZ），弹出对话框，如图 16-5所示。

在 Y轴中输入 45（角度），Time设为

1000（毫秒），并且选择 Repeat count 1

方式，单击 Close按钮完成参数设置。

形成的 Event map 1，如图 16-6所示。 

6．制作车把右转的效果。在 Event 

map 1中，单击 （Left mouse click on 

Object），拖动到右面的空白处。在

Actions窗口中，单击 Object motion选

项，选中 （Rotation XYZ），按住并

拖动到 Event map 1 中，叠加在   

（ObjectLClick_2）上，出现黑框。在

Event map 1，选中 （Line01），拖动

到 （Rotation XYZ），出现黑框。双

击 （Rotation XYZ），弹出对话框。

在 Y轴中输入�45（角度），Time设为
1000（毫秒），并且选择 Repeat count 1
方式，单击 Close按钮完成参数设置。
形成的 Event map 1如图 16-7所示。 

7．确定车把左转和右转的关系。
在 Actions窗口中，单击 Event，选中 
（Deactivate event），按住并拖动到
Event map 1 中 ， 叠 加 在  
（ ObjectLClick_1）上面，出现黑框。
选中 （Deactivate event），单击右键

 

图 16-4 

 

图 16-5 

 

图 16-6 

 

图 16-7 
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选择 parameters命令，弹出对话框，在

左边框中选中 ObjectLClick_1，单击

Add按钮,单击OK按钮结束。在Actions

窗口中，选中 （Activate event），拖

动到 Event map 1 中，叠加在  
（ObjectLClick_1）上面，出现黑框。

选中 （Activate event），单击右键选

择 parameters命令，弹出对话框，在左

边框中选中 ObjectLClick_2，单击 Add

按钮,单击 OK按钮结束。形成的 Event 

map 1如图 16-8所示。 

在 Actions窗口中，单击 Event，

选中 （Deactivate event），按住并拖

动到 Event map 1 中，叠加在  
（ObjectLClick_2）上，出现黑框。选

中 （Deactivate event），单击右键选

择 parameters命令，弹出对话框，在左

边框中选中 ObjectLClick_2，单击 Add

按钮，单击 OK 按钮结束。在 Actions

窗口中，选中 （Activate event），拖

动到 Event map 1 中，叠加在  
（ObjectLClick_2）上，出现黑框。选

中 （Activate event），单击右键选择

parameters命令，弹出对话框，如图 16-9

所示。在左边框中选中ObjectLClick_1，

单击 Add 按钮，单击 OK 按钮结束。

形成的 Event map 1，如图 16-10所示。 

8．保存为 bike.c3p，本例制作完

成。 

 

 

图 16-8 

 

图 16-9 

 

图 16-10 
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实例 17  自 行 车（二） 

 

本例制作“自行车（二）”的效果，

如图 17-1所示。 

本例的特点是：用鼠标左键单击自

行车，车轮车把转动的同时自行车会前

行；再次单击左键，自行车会停止前行；

按任意键，自行车复位。 

本例通过 Reset来完成。 
 

图 17-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 bike.c3p。执行 File→Load 

project，在出现的对话框中选中

bike.c3p，如图 17-2所示。 

3．制作自行车车轮滚动的效果。

在 Actions窗口中，单击 Object motion

选项，选中 （Rotation XYZ），按住

并拖动到 Event map 1 中，叠加在  

（ObjectLClick_1）上，出现黑框。在

Scene Graph中，单击 rootnode选项，

分 别 选 中  （ Group01 ） ，  

（Group02）和  （Group03），拖动

到 （Rotation XYZ），出现黑框。双

击 （Rotation XYZ），弹出对话框，

如图 17-3所示。在 X轴中输入 100（角

度），Time设为 1000（毫秒），并且

选择 Loop 方式，单击 Close 按钮完成

参数设置。形成的 Event map 1，如图

17-4所示。 

4．制作自行车车轮停止滚动的效

 

图 17-2 

 

图 17-3 
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果。在 Actions 窗口中，单击 Object 

motion选项，选中 （Rotation XYZ），

按住并拖动到 Event map 1中，叠加在

  （ObjectLClick_2）上，出现黑框。

在 Event map 1 中，分别选中  

（Group01），  （Group02）和  

（Group03），拖动到  （Rotation 

XYZ），出现黑框。双击 （Rotation 

XYZ），弹出对话框。在 X 轴中输入

�1000（角度），Time 设为 1000（毫
秒），并且选择 Loop方式，单击 Close
按钮完成参数设置。形成的 Event map 
1如图 17-5所示。 

5．制作自行车前行的效果。在
Actions窗口中，单击 Object motion选
项，选中 （Rotation XYZ），按住并
拖动到 Event map 1 中，叠加在  
（ObjectLClick_1）上，出现黑框。在
Event map 1，选中  （Group），拖
动到 （Rotation XYZ），出现黑框。
双击 （Rotation XYZ），弹出对话框。
在 Z轴中输入 30（角度），Time设为
1000（毫秒），并且选择 Loop方式，
单击 Close按钮完成参数设置。 
在 Actions 窗口中，单击 Object 

motion 选项，选中  （ Translation 
XYZ），按住并拖动到 Event map 1中，
叠加在 （ObjectLClick_1）上，出现
黑框。在 Event map 1 中，选中  
（Group），拖动到  （Translation 
XYZ），出现黑框。双击 （Translation 
XYZ），弹出对话框，如图 17-6所示。
在 X 轴中输入 100（位移），Time 设
为 1000（毫秒），在 Y 轴中输入�50
（位移），Time设为 1000（毫秒），
并且选择 Loop 方式，单击 Close 按钮
完成参数设置。形成的 Event map 1，
如图 17-7所示。 

6．制作自行车停止前行的效果。

 

图 17-4 

 

 

图 17-5 

 

 

图 17-6 
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在 Actions窗口中，单击 Object motion

选项，选中 （Rotation XYZ），按住

并拖动到 Event map 1 中，叠加在  

（ObjectLClick_2）上，出现黑框。在

Event map 1，选中 （Group），拖动

到 （Rotation XYZ），出现黑框。双

击 （Rotation XYZ），弹出对话框，

如图 17-8所示。在 Z轴中输入�30（角
度），Time设为 1000（毫秒），并且
选择 Loop 方式，单击 Close 按钮完成
参数设置。 
在 Actions 窗口中，单击 Object 

motion 选项，选中  （ Translation 
XYZ），按住并拖动到 Event map 1中，
叠加在 （ObjectLClick_2）上，出现
黑框。在 Event map 1，选中  
（Group），拖动到  （Translation 
XYZ），出现黑框。双击 （Translation 
XYZ），弹出对话框。在X轴中输入�100
（位移），Time设为 1000（毫秒），
在 Y轴中输入 50（位移），Time设为
1000（毫秒），并且选择 Loop方式，
单击 Close按钮完成参数设置。形成的
Event map 1，如图 17-9所示。 

7．制作自行车复位的效果。在
Event map 1 中，单击 （Keyboard�s 
key Press），拖动到右面的空白处。在
Actions窗口中，单击 Object motion选
项，选中 （Reset），按住并拖动到
Event map 1 中，叠加在 （Key 
Press-1）上，出现黑框。在 Event map 1
中，选中  （Group），拖动到
（Reset），出现黑框。形成 Event map 
1如图 17-10所示。 

8．保存为 bike1.c3p，本例制作完
成。 

 

图 17-7 

 

图 17-8 

 

图 17-9 

 

图 17-10 
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实例 18  气 垫 船（一） 

 

本例制作“气垫船（一）”的效果，

如图 18-1所示。 

本例的特点是：按鼠标左键，车上

司机的左手会举起，按鼠标右键，司机

的左手会放下。 

本例通过 Active event、Deactive 

event等知识完成。 

 

图 18-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 hover.C3D。执行 File→

Add Cult3D Designer File命令，在出现

的对话框中选中 hover.C3D，如图 18-2

所示。 

3．添加 Arcball。在 Event Map1

窗口中单击 （World Start），拖到右

侧的空白处。在 Actions窗口中，单击

Object Motion，选中 （Arcball），拖

到 Event map 1 中，叠加在原来的 
（World Start）上面，出现黑框。在

Scene Graph窗口中，单击 rootnode选

项，选中 （hover），拖到 Event map 

1中，叠加在原来的 （Arcball）上面，

出现黑框。效果如图 18-3所示。 

4．确定手和手臂的相互关系。在

Scene Graph中，单击 rootnode选项，

选中 （lhand），拖动到 （larm）

上面，出现黑色，如图 18-4 所示，最

后形成的包含关系如图 18-5所示。 

5．制作左臂上举的效果。在 Event 

 

 

图 18-2 

 

图 18-3 
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map 1中单击 （Left mouse click on 

Object），拖动到右面的空白处。在

Actions窗口中，单击 Object motion选

项，选中 （Translation XYZ），按住

并拖动到 Event map 1 中，叠加在  

（ObjectLClick_1）上面，出现黑框。

选中 Scene Graph中的 （larm），拖

动到 （Translation XYZ），出现黑框。

双击  Translation XYZ，弹出对话框，

如图 18-6所示。在 Y轴中输入�800（位
移），Time设为 1000（毫秒），在 Z
轴中输入 800（位移），Time设为 1000
（毫秒），选择 Repeat count方式，单
击 Close按钮完成。在 Actions窗口中，
选中 （Rotation XYZ），按住并拖动
到 Event map 1 中 ， 叠 加 在  
（ObjectLClick_1）上面，出现黑框。
选中 Event map 1中的 （larm），拖
动到 （Rotation XYZ），出现黑框。
双击 （Rotation XYZ），弹出对话框，
如图 18-7所示。在 X轴中输入�60（角
度），Time设为 1000（毫秒），选择
Repeat count方式，单击 Close按钮完
成。形成的 Event map 1关系如图 18-8
所示。 

6．制作左臂放下的效果。在 Event 
map 1中单击 （Right mouse click on 
Object），拖动到右面的空白处。在
Actions窗口中，单击 Object motion选
项，选中 （Translation XYZ），按住
并拖动到 Event map 1 中，叠加在  
（ObjectRClick_1）上面，出现黑框。
选中 Event map 1中的 （larm），拖
动到 （Translation XYZ）上面，出现
黑框。双击  Translation XYZ，弹出
对话框。在 Y轴中输入 800（位移），
Time设为 1000（毫秒），在 Z轴中输
入�800（位移），Time设为 1000（毫
秒），选择 Repeat count 方式，单击

 

图 18-4 

 

图 18-5 

 

图 18-6 

 

图 18-7 

 

图 18-8 
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Close 按钮完成。在 Actions 窗口中，

选中 （Rotation XYZ），按住并拖动

到 Event map 1 中 ， 叠 加 在  
（ObjectRClick_1）上面，出现黑框。

选中 Event map 1中的 （larm），拖

动到 （Rotation XYZ）上面，出现黑

框。双击 （Rotation XYZ），弹出对

话框。在 X轴中输入 60（角度），Time

设为 1000（毫秒），选择 Repeat count

方式，单击 Close 按钮完成。形成的

Event map 1如图 18-9所示。 

7．制作手臂举起和放下的联系。

在 Actions窗口中，单击 Event，选中 
（Deactivate event），按住并拖动到

Event map 1 中，叠加在原来的   

（ObjectLClick_1）上面，出现黑框。

选中 （Deactivate event），右击选择

parameters 选项，弹出对话框，如图

18-10 所 示 ， 在 左 边 框 中 选 中

ObjectLClick_1，单击 Add按钮，单击

OK 按钮结束。在 Actions 窗口中，选

中 （activate event），按住并拖动到

Event map 1中，并且叠加在原来的  

（ObjectLClick_1）上面，出现黑框。

选中 （activate event），右击选择

parameters 命令，弹出对话框，如图

18-11 所 示 ， 在 左 边 框 中 选 中

ObjectRClick_1，单击 Add按钮。单击

OK按钮结束。 

在 Actions窗口中，单击 Event按

钮，选中 （Deactivate event），按住

并拖动到 Event map 1中，叠加在原来

的  （ObjectLRlick_1）上面，出现黑

框。选中 （Deactivate event），右击

选择 parameters命令，弹出对话框，在

左边框中选中 ObjectRClick_1，单击

Add，单击 OK 按钮结束。在 Actions

窗口中，选中 （activate event），按

住并拖动到 Event map 1中，并且叠加

 

 

  

图 18-9 

 

 

 

图 18-10 

 

 

 

图 18-11 



Cult 3D产品三维演示时尚创作百例 

 
54 

在原来的  （ObjectRClick_1）上面，

出现黑框。选中 （activate event），

右击 parameters选项，弹出对话框，在

左边框中选中 ObjectLClick_1，单击

Add 按钮，单击 OK 按钮结束，形成

Event map 1中关系如图 18-12所示。 

8．保存为 hover.c3p，按动鼠标左

键，车上司机的左手会举起，按动鼠标

右键，车上司机的左手会放下。 
 

图 18-12 
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实例 19  气 垫 船（二） 

 

本例制作“气垫船（二）”的效果，

如图 19-1所示。 

本例的特点是：按“Enter”键，

气垫船的前螺旋桨转动，按“空格”键

气垫船会开动，而且只有当螺旋桨转动

的时候才能开动。 

本例通过 Trigger event activatio和

Toggle event activatio等知识完成。 

 

 

 

图 19-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 hover.c3p。执行 File→Load 

project 命令，在出现的对话框中选中

hover（源文件）.c3p，如图 19-2所示。 

3．制作当放下手臂的时候触发螺

旋桨旋转的效果。在 Event map 1中单

击 （Keyboard�s key Press），拖动到
右面的空白处，双击 （KeyPress_1），
弹出对话框，如图 19-3 所示，在左边
框中选中“Enter”，单击 Add 按钮添
加到右边框，单击 OK 按钮完成。在
Actions 窗口中，单击 Event，选中
（Trigger event activatio），按住并拖动
到 Event map 1 中，叠加在原来的  
（ObjectRClick_1）上面，出现黑框。
选中 （Trigger event activatio），右
击选择 parameters命令，弹出对话框，
如图 19-4 所示，在左边框中选中
KeyPress_1，单击 Add按钮，单击 OK
按钮结束。在 Actions窗口中，选中 

 

图 19-2 

 

图 19-3 

 

图 19-4 
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（Rotation XYZ），按住并拖动到 Event 

map 1中，叠加在 （KeyPress_1）上

面，出现黑框。选中 Scene Graph中的

（Frotor），拖动到 （Rotation XYZ），

出现黑框。双击 （Rotation XYZ），

弹出对话框，。在 Z轴中输入 300（角

度），Time设为 1000（毫秒），选择

Loop 方式，单击 Close 按钮。形成的

Event map 1中的关系如图 19-5所示。 

4．制作当举起手臂的时候不响应

Enter 键不能旋转螺旋桨的效果。在

Actions 窗口中，单击 Event，选中

（Toggle event activatio），按住并拖动

到 Event map 1 中，叠加在原来的  

（ObjectLClick_1）上面，出现黑框。

选中 （Toggle event activatio），右击

选择 parameters选项，弹出对话框，在

左边框中选中 KeyPress_1，单击 Add

按钮，单击 OK按钮。 

5．制作当螺旋桨旋转的时候手部

不能上举也不能放下的效果。在

Actions 窗口中，单击 Event，选中

（Toggle event activatio），按住并拖动

到 Event map 1 中，叠加在原来的

（KeyPress_1）上面，出现黑框。选中

（Toggle event activatio），单击右键

选择 parameters命令，弹出对话框，在

左 边 框中 选中 ObjectLClick_1 和

ObjectRClick_1，单击 Add按钮，单击

OK按钮。形成 Event map 1如图 19-6

所示。 

6．当螺旋桨旋转的时候可以响应

空格键启动开动气垫船的效果。在

Event map 1中单击 （Keyboard�s key 
Press），拖动到右面的空白处，双击
（KeyPress_2），弹出对话框，在左边
框中选中“Space”，单击 Add按钮添
加到右边框，单击 OK按钮。在 Actions
窗口中，单击 Event，选中 （activate 

 

图 19-5 

 

 

图 19-6 

 

 

图 19-7 
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event），拖动到 Event map 1中，叠加

在原来的 （KeyPress_1）上面，出现

黑框。选中 （activate event），右击

选择 parameters命令，弹出对话框，如

图 19-7 所示，选中 KeyPress_2，单击

Add 按钮，单击 OK 按钮结束。在

Actions 窗口中，选中  （Rotation 

XYZ），按住并拖动到 Event map 1中，

叠加在 （KeyPress_2）上面，出现黑

框。选中 Event map 1中的 （hover），

拖动到 （Rotation XYZ），出现黑框。

双击 （Rotation XYZ），弹出对话框，

具体设置如图 19-8所示，选择 Loop方

式，单击 Close 按钮完成。在 Actions

窗口中，单击 Object motion 选项，选

中 （Translation XYZ），按住并拖动

到 Event map 1 中 ， 叠 加 在

（KeyPress_2）上面，出现黑框。选中

Event map 1中的 （hover），拖动到

 （Translation XYZ），出现黑框。双

击  Translation XYZ，弹出对话框。

在 X轴中输入 2000（位移），Time设

为 1000（毫秒），选择 Loop方式，单

击 Close按钮完成。形成 Event map 1

如图 19-9所示。 

7．制作开始时屏蔽 Space键的效

果。在 Actions窗口中，单击 Event按

钮，选中 （Deactivate event），按住

并拖动到 Event map 1中，叠加在原来

的 （KeyPress_2）上面，出现黑框。

选中 （Deactivate event），右击选择

parameters 命令，弹出对话框，如图

19-10 所 示 ， 在 左 边 框 中 选 中

ObjectRClick_1，单击 Add按钮，单击

OK 按钮结束。在 Actions 窗口中，选

中 （activate event），按住并拖动到

Event map 1中，并且叠加在原来的  

（ObjectLClick_1）上面，出现黑框。

选中 （activate event），右击选择

 

图 19-8 

  

图 19-9 

 

图 19-10 

 

图 19-11 
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parameters 命令，弹出对话框，如图

19-11 所 示 ， 在 左 边 框 中 选 中

WorldStart_1，单击 Add 按钮，单击

OK按钮结束。最终效果如图 19-12所

示。 

8．保存为 hover.c3p，本例制作完

成。 

 

图 19-12 
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实例 20  深水打捞舰（一） 

 

本例制作“深水打捞舰（一）”的

效果，如图 20-1所示。 

本例的特点是：用鼠标左键单击深

水打捞舰，夹子开始转动，再次单击左

键，夹子回到原来的地方。  

本例通过 Left click on Object、

Rotation等知识完成。 
 

图 20-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 deepfight.C3D。执行 File

→Add Cult3d Design File命令，在出现

的对话框中选中 deepfight.C3D，如图

20-2所示。 

3．添加 Arcball。在 Event map 1

中，单击 （World start），按住并拖

动到右面的空白处。在 Actions窗口中，

单击 Object motion 选项，选中  
（Arcball），按住并拖动到 Event map 1

中，叠加在原来的 （World start）上

面，出现黑框。在 Scene Graph中，单

击 rootnode选项，选中 （deepfight），

按住并拖动到 Event map 1中，叠加在

 （Arcball）上面，出现黑框。形成

的 Event map 1如图 20-3所示。 

4．制作夹子向上转的效果。在

Event map 1中，单击 （Left mouse 

click on Object），拖动到右面的空白

处。在 Actions 窗口中，单击 Object 

 

图 20-2 

 

图 20-3 
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motion选项，选中 （Rotation XYZ），

按住并拖动到 Event map 1中，叠加在

  （ObjectLClick_1）上，出现黑框。

在 Scene Graph中，单击 rootnode选项，

选中 （Mounting Left），拖动到 

（Rotation XYZ）上面，出现黑框。选

中 （Mounting Right），拖动到 

（Rotation XYZ）上面，出现黑框。双

击 （Rotation XYZ），弹出对话框，

如图 20-4所示。在 Z轴中输入�30（角
度），Time设为 1000（毫秒），并且
选择 Repeat count 1方式，单击 Close
按钮完成参数设置。形成的 Event map 
1，如图 20-5所示。 

5．制作夹子向下转的效果。在
Event map 1中，单击 （Left mouse 
click on Object），拖动到右面的空白
处。在 Actions 窗口中，单击 Object 
motion选项，选中 （Rotation XYZ），
按住并拖动到 Event map 1中，叠加在
  （ObjectLClick_2）上，出现黑框。
在 Event map 1，选中 （Mounting 
Left），拖动到 （Rotation XYZ）上
面，出现黑框。选中  （Mounting 
Right），拖动到 （Rotation XYZ）上
面，出现黑框。双击 （Rotation XYZ），
弹出对话框。在 Z轴中输入 30（角度），
Time 设为 1000（毫秒），并且选择
Repeat count 1方式，单击 Close按钮完
成参数设置。形成的 Event map 1如图
20-6所示。 

6．确定夹子上转和下转的关系。
在 Actions窗口中，单击 Event按钮，
选中 （Deactivate event），按住并拖
动到 Event map 1 中，叠加在  
（ObjectLClick_1）上，出现黑框。选
中 （Deactivate event），单击右键选
择 parameters命令，弹出对话框，如图
20-7 所 示 ， 在 左 边 框 中 选 中

 

图 20-4 

 

图 20-5 

 

图 20-6 

 

图 20-7 
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ObjectLClick_1，单击 Add按钮，单击

OK 按钮结束。在 Actions 窗口中，选

中 （Activate event），拖动到 Event 

map 1中，叠加在 （ObjectLClick_1）

上，出现黑框。选中 （Activate event），

单击右键选择 parameters命令，弹出对

话框，在左边框中选中ObjectLClick_2，

单击 Add 按钮，单击 OK 按钮。形成

的 Event map 1，如图 20-8所示。 

在 Actions窗口中，单击 Event按

钮，选中 （Deactivate event），按住

并拖动到 Event map 1 中，叠加在 
（ObjectLClick_2）上，出现黑框。选

中 （Deactivate event），单击右键选

择 parameters命令，弹出对话框，在左

边框中选中 ObjectLClick_2，单击 Add

按钮，单击 OK 按钮结束。在 Actions

窗口中，选中 （Activate event），拖

动到 Event map 1 中，叠加在  
（ObjectLClick_2）上，出现黑框。选

中 （Activate event），单击右键选择

parameters命令，弹出对话框，如图 20-9

所示。在左边框中选中ObjectLClick_1，

单击 Add 按钮，单击 OK 按钮。形成

的 Event map 1，如图 20-10所示。 

7．保存为 deepfight.c3p，本例制

作完成。 

 

图 20-8 

 

图 20-9 

 

图 20-10 
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实例 21  深水打捞舰（二） 

 

本例制作“深水打捞舰（二）”的

效果，如图 21-2所示。 

本例的特点是：按“Enter”键，

深水打捞舰开始起动，发动机引擎旋

转。按“Space”键，深水打捞舰停止，

回到原来的地方。 

本例通过 Deactive event和 Active 

event等知识完成。 

 

图 21-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 deepfight.c3p。执行 File

→Load project（源文件）命令，在出现

的对话框中选中 deepfight.c3p，如图

21-2所示。 

3．制作发动机引擎旋转的效果。

在 Event map 1中单击 （Keyboard�s 
key Press），拖动到右面的空白处，双
击 （KeyPress_1），弹出对话框，如
图 21-3所示，在左边框中选中“Enter”，
单击 Add 按钮，添加到右边框，单击
OK 按钮完成。在 Actions 窗口中，选
中 （Rotation XYZ），按住并拖动到
Event map 1中，叠加在 （KeyPress_1）
上面，出现黑框。选中 Scene Graph中
的 （Engine Prop 1）， （Engine Prop 
2）， （Engine Prop 3）， （Engine 
Prop 4），依次分别拖动到 （Rotation 
XYZ）上面，出现黑框。双击 （Rotation 
XYZ），弹出对话框，在 Z 轴中输入

 

 

图 21-2 

 

 

 

图 21-3 
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180（角度），Time设为 1000（毫秒），

选择 Loop方式，单击 Close按钮完成。

形成的 Event map 1中的关系如图 21-4

所示。 

4．制作发动机引擎停止旋转的效

果 。 在 Event map 1 中 单 击

（Keyboard�s key Press），拖动到右面
的空白处，双击 （KeyPress_2），弹
出对话框，在左边框中选中“Space”，
单击 Add 按钮，添加到右边框，单击
OK 按钮完成。在 Actions 窗口中，选
中 （Rotation XYZ），按住并拖动到
Event map 1中，叠加在 （KeyPress_2）
上面，出现黑框。选中 Event map 1中
的 （Engine Prop 1）， （Engine Prop 
2）， （Engine Prop 3）， （Engine 
Prop 4），依次分别拖动到 （Rotation 
XYZ）上面，出现黑框。双击 （Rotation 
XYZ），弹出对话框。在 Z轴中输入�180
（角度），Time设为 1000（毫秒），
选择 Loop方式，单击 Close按钮完成。
形成的 Event map 1中的关系如图 21-5
所示。 

5．发动机引擎起动和停止的关
系。在 Actions 窗口中，单击 Event，
选中 （Deactivate event，按住并拖动
到 Event map 1 中 ， 叠 加 在
（KeyPress_1）上面，出现黑框。选中
 （Deactivate event），单击右键选择
parameters命令，弹出对话框，如图 21-6
所示，在左边框中选中 KeyPress_1，单
击 Add 按钮,单击 OK 按钮结束。在
Actions 窗口中，选中  （Activate 
event），拖动到 Event map 1中，叠加
在 （KeyPress_1）上面，出现黑框。
选中 （Activate event），单击右键选
择 parameters命令，弹出对话框，在左
边框中选中 KeyPress_2，单击 Add 按
钮，单击 OK按钮结束。形成的 Event 

 

图 21-4 

 

图 21-5 

 

图 21-6 

 

图 21-7 
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map 1，如图 21-7所示。 

在 Actions窗口中，单击 Event按

钮，选中 （Deactivate event），按住

并拖动到 Event map 1 中，叠加在

（KeyPress_2）上，出现黑框。选中 
（Deactivate event），单击右键选择

parameters命令，弹出对话框，在左边

框中选中 KeyPress_2，单击 Add按钮，

单击 OK按钮结束。在 Actions窗口中，

选中 （Activate event），拖动到 Event 

map 1中，叠加在 （KeyPress_2）上，

出现黑框。选中 （Activate event），

单击右键选择 parameters命令，弹出对

话框，如图 21-8 所示。在左边框中选

中 KeyPress_1，单击 Add 按钮，单击

OK按钮结束。形成的 Event map 1如

图 21-9所示。 

6．深水打捞的开启效果。在

Actions 窗口中，选中 （Translation 

XYZ），按住并拖动到 Event map 1中，

叠加在 （KeyPress_1）上，出现黑框。

在 Event map 1中，选中 （deepfight），

拖动到 （Translation XYZ）上，出现

黑框。双击 （Translation XYZ），弹

出对话框。在 Y轴中输入 1500（位移），

Time设为 3000（毫秒），选择 Repeat 

count 1方式，单击 Close按钮。形成的

Event map 1如图 21-10所示。 

7．深水打捞键的复位效果。在

Actions窗口中，选中 （Reset），按

住并拖动到 Event map 1中，叠加在

（KeyPress_2）上面，出现黑框。在

Event map 1中，选中 （deepfight），

拖动到 （Reset）上面，出现黑框。

形成的 Event map 1 中的关系如图

21-11所示。 

8．保存为 deepfight1.c3p，本例制

作完成。 

 

图 21-8 

 

图 21-9 

 

图 21-10 

 

图 21-11 
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实例 22  深水打捞舰（三） 

 

本例制作“深水打捞舰（三）”的

效果，如图 22-1所示。 

本例的特点是：按“Enter”键，

深水打捞舰开始起动，发动机引擎旋

转，深水打捞键发动机底部喷射火焰的

情景。按“Space”键，深水打捞舰停

止，回到原来的地方。 

本例通过 Start particle emissioin和

Stop particle emission等知识完成。 

 

图 22-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 deepfight1.c3p。执行 File

→Load project命令，在出现的对话框

中选中 deepfight1.c3p，如图 22-2所示。 

3．制作深水打捞键起动效果。在

Scene Graph窗口中，单击 rootnode选

项，选中 （Engine 2），右击选择

New→Particle System 命令。在 Scene 

Graph 窗 口 中 ， 单 击 出 现 的  

（Particle），如图 22-3 所示，将其拖

动到 Event map 1中。在 Actions窗口

中，单击 Object motion选项，选中

（Start particle emission），拖动到 Event 

map 1中，叠加在 （KeyPress_1）上，

出现黑框。选中 Event map 1 中的

（Particle），叠加在 （Start particle 

emission）上，出现黑框。选中

（Particle），右击选择 Details 命令，

弹出对话框。在 Color settings中，单击

 

图 22-2 

 

图 22-3 
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左面的颜色方框可以选取不同的颜色，

将第一段颜色设为红色，第二段颜色设

为黄色，第三段颜色设为黄色，第四段

颜色设为红色，最后一段的颜色设为黄

色，如图 22-4所示。 

说明：拖动颜色框下的三角形按

钮，可以控制每一段不同颜色持续的时

间长短。 

设置 Particle settings中的参数，如

图 22-5 所示，单击 Close 按钮完成设

置。形成的Event map 1如图 22-6所示。 

4．制作深水打捞舰复位效果。在

Actions窗口中，单击 Particle systems，

选中  （Stop particle emission），按

住并拖动到 Event map 1中，并且叠加

在 （KeyPress_1）上面，出现黑框。

选中 Event map 1中的 （particle），

拖动到  （Stop particle emission）上

面，出现黑框。 

依次选中  （Engine 1）、  
（Engine 3）和 （Engine 4），重复

步骤 3的过程，制作四个发动机喷射火

焰的效果。最后形成 Event map 1如图

22-7所示。 

5．保存为 deepfight2.c3p，本例制

作完成。 

 

图 22-4 

 

图 22-5 

 

图 22-6 

 

图 22-7 

 



 

 

本篇介绍如何制作各种玩具和一些小游戏，

例如机器猫唱歌、打台球、飞镖游戏等，体验各

种玩具和游戏类的 3D实体和场景。

在本篇中，开始逐步加入声音等多媒体效果，

使 3D实体和场景更加逼真和富有吸引力。通过本

篇的学习，读者将体会到使用Cult 3D软件的乐趣，

并且还可移植或改造其中的某些游戏放到网络

上，使之成为网络互动的 3D小游戏，给呆板的静

态网页增加无限乐趣。

娱  乐  篇 
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实例 23  旋转的汽球 

 

本例制作“旋转的汽球”的效果，如图

23-1所示。 

本例特点是：汽球可以在空中移动和旋

转，单击左键汽球逆时针旋转，单击右键汽

球顺时针旋转。 

本例通过 Arcball、Rotation等知识完成。 

 

图 23-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 balloon.C3D。选择 File→Add 

Cult3D Designer File命令，在出现的对话框

中选中 balloon.C3D，如图 23-2所示。 

3．添加 Arcball。在 Event map 1中单击

 （world start），拖动到右面的空白处。在

Actions窗口中，单击 Object motion选项，

选中 （Arcball），按住并拖动到 Event map 

1中，叠加在 （WorldStart_1）上面，出现

黑框。在 Scene Graph中，单击 rootnode选

项，选中 （BALLOON），拖动到 Event map 

1中，叠加在的 （Arcball）上，出现黑框，

形成的 Event map 1如图 23-3所示。 

4．制作逆时针旋转效果。在 Event map 

1中，单击 （Left mouse click on Object）

按钮，拖动到右面的空白处。在 Actions 窗

口中，单击 Object motion 选项，选中 

（Rotation XYZ），拖动到 Event map 1中，

叠加在 （ObjectLClick_1）上面，出现黑

框。选中 Scene Graph中的 （balloon1），

拖动到 （Rotation XYZ）上面，出现黑框。

双击 （Rotation XYZ），弹出对话框，如

 

 

图 23-2 

 

图 23-3 
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图 23-4所示。在 Y轴中输入 30（角度），

Time设为 1000（毫秒），选择 Loop方式，

单击 Close按钮完成参数设置。 

在 Actions窗口中，单击 Object motion

选项，选中 （Translation XYZ），拖动到

Event map中，叠加在  （ObjectLClick_1）

上面，出现黑框。选中 Event map 1中的

（balloon1），拖动到 （Translation XYZ）

上面，出现黑框。双击 （Translation XYZ），

弹出对话框。在 X轴中输入 30（坐标点），

Time设为 1000（毫秒），在 Z轴中输入 50

（坐标点），Time 设为 1000（毫秒），选

择Loop方式，单击Close按钮完成参数设置。

形成的 Event map 1如图 23-5所示。 

5．制作顺时针旋转效果。在 Event map 

1中，单击 （Right mouse click on Object），

拖动到右面的空白处。在 Actions 窗口中，

单击 Object motion选项，选中 （Rotation 

XYZ），拖动到 Event map 中，叠加在 

（ObjectRclick_1）上面，出现黑框。选中

Event map 1中的 （balloon1），拖动到 
（Rotation XYZ），出现黑框。双击 （Rotation 

XYZ），弹出对话框。在Y轴中输入�30（角
度），Time设为 1000（毫秒），并且选择 Loop
方式，单击Close按钮完成参数设置。 
在 Actions窗口中，单击 Object motion

选项，选中 （Translation XYZ），拖动到
Event map 1中，叠加在 （ObjectRclick_1）
上面，出现黑框。选中 Event map 1中的
（balloon1），拖动到 （Translation XYZ）
上面，出现黑框。双击 （Translation XYZ），
弹出对话框，如图 23-6 所示。在 X 轴中输
入�30（角度），Time设为 1000（毫秒），
在 Z轴中输入�50（角度），Time设为 1000
（毫秒），并且选择 Loop方式，单击 Close
按钮完成参数设置，形成的 Event map 1如
图 23-7所示。 

6．保存为 balloon.c3p，本实例制作完
成。 

 

图 23-4 

 

图 23-5 

 

图 23-6 

 

图 23-7 
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实例 24  亭    子 

 

本例制作“亭子”的效果，如图

24-1所示。 

本例的特点是：当载入文件的时

候，会自动演示搭建亭子模型的过程，

一步步展现亭子的结构。 

本例通过 Hide Object和 Timer等

知识完成。 

 

图 24-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 tingzi.C3D。选择 File→

Add Cult3D Designer File命令，在出现

的对话框中选中 tingzi.C3D，如图 24-2

所示。 

3．添加 Arcball。在 Event map 1

中，单击 （World start），拖动到右

面的空白处。在 Actions窗口中，单击

Object motion选项，选中 （Arcball），

拖动到 Event map 1 中，叠加在  
（World Start_1）上，出现黑框。在

Scene Graph中，单击 RootNode选项，

选中 （gazebo），拖动到 Event map 1

中，叠加在 （Arcball）上，出现黑

框。效果如图 24-3所示。 

4．制作初始效果。在 Actions 窗

口中，单击 Render选项，选中 （Hide 

Object），拖动到 Event map 1中，叠

加在 （WorldStart_1）上，出现黑框。

选中 （gazebo），叠加到 （Hide 

Object）上，出现黑框。选中 （Hide 

 

 

图 24-2 

 

 

图 24-3 
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Object），右击选择 Details...命令，弹

出对话框，选中 Apply to child，单击

OK按钮完成设置。形成的 Event map 1

如图 24-4所示。 

5．制作逐步展现亭子结构的效

果。在 Event map 1中选中 （Timer），

拖动到右面的空白处。在 Actions窗口

中，单击 Render选项，选中 （Unhide 

Object），如图 24-5所示，叠加在 Event 

map 1 中的 （Timer_1）上面，出现

黑框。在 Scene Graph 中，单击  
（gazebo），选中 （g-pad），叠加

到 （Unhide Object）上，出现黑框。

双击  （Timer_1），弹出对话框，如

图 24-6所示，在 Time（毫秒）中输入

1000，单击 OK按钮完成设置。形成的

Event map 1如图 24-7所示。 

在 Event map 1 中 选 中

（Timer），拖动到右面的空白处。在

Actions窗口中，单击 Render选项，选

中 （Unhide Object），叠加在 Event 

map1中的 （Timer_2）上，出现黑框。

在 Scene Graph中，单击 （gazebo），

选中 （g-col），叠加到 （Unhide 

Object），出现黑框。双击 （Timer_2），

弹出对话框，在 Time（毫秒）中输入

2000。 

在 Event map 1 中 选 中

（Timer），拖动到右面的空白处。在

Actions窗口中，单击 Render选项，选

中 （Unhide Object），叠加在 Event 

map1中的 （Timer_3）上，出现黑框。

在 Scene Graph中，单击 （gazebo），

选中 （g-bench），叠加到 （Unhide 

Object），出现黑框。双击 （Timer_3），

弹出对话框，在 Time（毫秒）中输入

3000，单击 OK按钮完成设置。 

余下的 （g-table） （g-trim）

（g-trim2） （g-roof），均按以上

 

图 24-4 

 

图 24-5 

 

 

图 24-6 

 

 

图 24-7 
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的步骤制作。 

注意：每次双击 Time，设定时间

的时候都递增 1000 毫秒。最后形成的

Event map 1，如图 24-8所示。 

6．制作展示旋转效果。在 Actions

窗口中，单击 Object motion 选项，选

中 （Rotation XYZ），拖动到 Event 

map 1 中，叠加在 （WorldStart_1）

上面，出现黑框。选中 Event map 1中

的 （gazebo），拖动到 （Rotation 

XYZ）上面，出现黑框。双击 （Rotation 

XYZ），弹出对话框，如图 24-9所示。

在 Z 轴中输入 5（角度），Time 设为

1000（毫秒），并且选择 Loop方式，

单击 Close按钮完成参数设置。最后形

成的 Event map 1如图 24-10所示。 

7．保存为 tingzi.c3p，本例制作完

成。 

 

图 24-8 

 

图 24-9 

 

图 24-10 
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实例 25  八  音  盒 

 

本例制作“八音盒”的效果，如图

25-1所示。 

本例的特点是：初始时机器猫的头

部就会转动，单击鼠标左键，机器猫的

头会再次转动，并发出音乐。 

本例通过 Delete、Trigger event和

Play sound等知识完成。 

 

图 25-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 cat.C3D。执行 File→Add 

Cult3d Design File命令，在出现的对话

框中选中 cat.C3D，如图 25-2所示。 

3．删除多余的实体。由于在 3D

建模的时候留下的问题，这里要删除一

些不必要的实体，以免影响下面的制

作。在 Scene Graph中，单击 RootNode，

选中 （头 02），右击选择 Delete 命

令，如图 25-3 所示。操作同上，删除

所有不在 （cat）目录下的实体。 

4．添加 Arcball。在 Event map 1

中，单击 （World start），拖动到右

面的空白处。在 Actions窗口中，单击

Object motion选项，选中 （Arcball），

拖动到 Event map 1中，叠加在原来的

 （World start）上面，出现黑框。在

Scene Graph中，单击 RootNode选项，

选中 （cat），拖动到 Event map 1中，

叠加到 （Arcball）上，出现黑框。

形成的 Event map 1如图 25-4所示。 

 

图 25-2 

 

图 25-3 
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5．制作头部转动效果。在 Actions

窗口中，单击 Object motion 选项，选

中 （Rotation XYZ），拖动到 Event 

map 1 中，叠加到 （WorldStart_1）

上，出现黑框。在 Scene Graph中，单

击 RootNode选项，选中 （头），拖

动到 （Rotation XYZ），出现黑框。

双击 （Rotation XYZ），弹出对话框。

在 Z轴中输入 30（角度），Time设为

1500（毫秒），并且选择 Repeat count 1

方式，单击 Close按钮完成参数设置。 

在 Actions 窗口中，单击 Object 

motion选项，选中 （Rotation XYZ），

拖动到 Event map 1 中，叠加在  
（WorldStart_1）上，出现黑框。在 Event 

map 1 中，选中 （头），拖动到 

（Rotation XYZ）上面，出现黑框。双

击 （Rotation XYZ），弹出对话框，

如图 25-5所示。在 Z轴中输入�60（角
度），Time设为 3000（毫秒），并且
选择 Repeat count 1方式，单击 Close
按钮完成参数设置。 
在 Actions 窗口中，单击 Object 

motion选项，选中 （Rotation XYZ），
拖动到 Event map 1 中，叠加在  
（WorldStart_1）上，出现黑框。在 Event 
map 1 中，选中 （头），拖动到 

（Rotation XYZ）上面，出现黑框。双
击 （Rotation XYZ），弹出对话框。
在 Z轴中输入 30（角度），Time设为
1500（毫秒），并且选择 Repeat count 1
方式，单击 Close按钮完成参数设置。
形成的 Event map 1如图 25-6所示。 

6．制作以上三个旋转发生的先后
顺序。各个动作的先后顺序为：先是向

左转 30°，再向右转 60°，最后向左
转 30°，回到原来的位置。 
在 Event map 1中，选中 （World 

Start_1），单击右键选择 Edit with Time 

 

图 25-4 

 

 

 

图 25-5 

 

 

 

图 25-6 
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Line View命令，在弹出的对话框中，

调整各个动作发生的先后时间顺序。将

第二个 Rotation XYZ（头），调整为第

1.5秒的时间点开始。将第三个 Rotation 

XYZ（头），调整为第 4.5秒的时间点

开始。这里有三个 Rotation XYZ（头），

按照步骤6中将三个 （Rotation XYZ）

拖动到 Event Map 1中的顺序从上到下

依次排列。单击右上角的 ，关闭窗口。

调整后的 Time Line View for event 

“WorldStart_1”如图 25-7所示。 

7．将音乐文件导入。在 Scene 

Graph中，单击 （Sounds），右击选

择 New→Sound命令，弹出对话框，如

图 25-8 所示，在对话框中选中音乐文

件 merry.mid（必须为.avi 或者.mid 格

式）。 

8．在 Event map 1 中单击（Left 

mouse click on object），拖动到右面空

白处，制作播放音乐的效果。在 Action

窗口中，单击 Sound选项，选中 （Play 

sound），拖动到 Event map 1中，叠加

在 （ObjectLClick_1）上，出现黑框。

在 Scene Graph中，单击 Sounds选项，

单击刚才添加的音乐 （merry），如

图 25-9所示，拖动到 Event map 1，叠

加在 （Play sound）上，出现黑框。 

9．制作播放音乐的同时触发头转

的效果。在 Action窗口中，单击 Event

按钮选项，选中 （Trigger event），

拖动到 Event map 1 中，叠加在  
（ObjectLClick_1）上，出现黑框。在

Event map 1 中，选中  （World 

Start_1），拖到叠加在 （Trigger event）

上面出现黑框。最后形成的 Event map 

1如图 25-10所示。 

10．保存为 cat.c3p，本例制作完

成。 

 

图 25-7 

 

图 25-8 

 

图 25-9 

 

图 25-10 
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实例 26  滑 板 车（一） 

 

本例制作“滑板车（一）”的效果，

如图 26-1所示。 

本例的特点是：单击鼠标左键，滑

板车会开动。 

本例通过 Rotation、Translation 等

知识完成。 

 

图 26-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 huabanche.C3D。选择 File

→Add Cult3D Designer File命令，在出

现的对话框中选中 huabanche.C3D，如

图 26-2所示。 

3．添加 Arcball。在 Event map 1

中，单击 （World start），拖动到右

面的空白处。在 Actions窗口中，单击

Object motion选项，选中 （Arcball），

拖动到 Event map 1中，叠加在原来的

 （WorldStart_1）上面，出现黑框。

在 Scene Graph中，单击 RootNode，选

中 （Group），拖动到 Event map 1

中，叠加在 （Arcball）上面，出现

黑框。形成的 Event map 1如图 26-3所

示。 

4．制作初始时滑板都是直立的效

果。在 Actions 窗口中，单击 Object 

motion 选项，选中  （ Translation 

XYZ），拖动到 Event map 1中，叠加

在 （WorldStart_1）上，出现黑框。

在 Scene Graph中，单击 RootNode，选

 

 

 

图 26-2 

 

图 26-3 
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中 （Group03），拖动到 Event map 1

中，叠加在 （Translation XYZ）上面，

出现黑框。双击 （Translation XYZ），

弹出对话框，如图 26-4所示。在 X轴

中输入 80（位移），Time 设为 0（毫

秒），选择 Repeat count 1方式，单击

Close按钮完成参数设置。 

在 Actions 窗口中，单击 Object 

motion选项，选中 （Rotation XYZ），

拖动到 Event map 1 中，叠加在  
（WorldStart_1）上，出现黑框。选中

Event map 1中的 （Group03），拖动

到 （Rotation XYZ）上，出现黑框。

双击 （Rotation XYZ），弹出对话框。

在 Y轴中输入�90（角度），Time设为
0（毫秒），并且选择 Repeat count 1
方式，单击 Close按钮完成参数设置。
形成的 Event map 1，如图 26-5所示。 

5．制作滑板车转动的效果。在
Event map 1中，单击 （Left mouse 
click on Object），拖动到右面的空白
处。在 Actions 窗口中，单击 Object 
motion 选项，选中  （ Translation 
XYZ），拖动到 Event map 1中，叠加
在  （ObjectLClick_1）上，出现黑框。
在 Scene Graph中，单击 RootNode选
项，选中 （Group03），拖动到 Event 
map 1中，叠加在 （Translation XYZ）
上，出现黑框。双击  （Translation 
XYZ），弹出对话框，如图 26-6所示。
在 Y 轴中输入 100（位移），Time 设
为 2000（毫秒），在 Z轴中输入 50（位
移），Time设为 2000（毫秒），并且
选择 Repeat count 1方式，单击 Close
按钮完成参数设置。 
在 Actions 窗口中，单击 Object 

motion选项，选中 （Rotation XYZ），
拖动到 Event map 1 中，叠加在   
（ObjectLClick_1）上，出现黑框。选

 

图 26-4 

 

 

图 26-5 

 

 

图 26-6 

 

 

图 26-7 
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中 Event map 1中的 （Group03），

拖动到 （Rotation XYZ）上，出现黑

框。双击 （Rotation XYZ），弹出对

话框，如图 26-7所示。在 X轴中输入

60（角度），Time设为 2000（毫秒），

并且选择 Repeat count 1 方式，单击

Close按钮完成参数设置。形成的 Event 

map 1，如图 26-8所示。 

6．保存为 huabanche.c3p，本例制

作完成。  

图 26-8 
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实例 27  滑 板 车（二） 

 

本例制作“滑板车（二）”的效果，

如图 27-1所示。 

本例的特点是：单击鼠标左键，滑

板车会开动撞倒另一辆车，单击鼠标右

键，复位。 

本例通过 Edit with Time Line 

View和 Trigger event等知识完成。 

 

图 27-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 huabanche.c3p。执行 File

→Load project命令，在出现的对话框

中选中 huabanche.c3p，如图 27-2所示。 

3．制作滑板车翻倒的效果。在

Actions窗口中，单击 Object motion选

项，选中 （Translation XYZ），拖动

到 Event map 1 中 ， 叠 加 在   

（ObjectLClick_1）上，出现黑框。在

Scene Graph中，单击 RootNode选项，

选中 （Group02），拖到 Event map 1

中，叠加在 （Translation XYZ），出

现黑框。双击 （Translation XYZ），

弹出对话框，如图 27-3所示。在 X轴

中输入�150（位移），Time设为 3000
（毫秒），选择 Repeat count 1方式，
单击 Close按钮完成参数设置。 
在 Actions 窗口中，单击 Object 

motion选项，选中 （Rotation XYZ），
拖动到 Event map 1 中，叠加在   
（ObjectLClick_1）上，出现黑框。选

 

 

 

图 27-2 

 

图 27-3 
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中 Event map 1中的 （Group02），

拖动到 （Rotation XYZ）上，出现黑

框。双击 （Rotation XYZ），弹出对

话框，在 Y轴中输入�90（角度），Time
设为 3000（毫秒），选择 Repeat count 
1方式，单击 Close按钮完成参数设置。
形成的 Event map 1，如图 27-4所示。 

4．制作滑板车转动和翻转的顺序。
这里先要明确一下各个动作的先后顺

序，先是滑板车转动，碰到另一辆滑板

车，然后那辆滑板车倒地。 
在 Event map 1 中，选中   
（ObjectLClick_1），右击选择 Edit with 
Time Line View命令。在弹出的对话框
中，调整各个动作发生的先后时间顺

序。将第二个 Rotation XYZ（Group 
02），调整为第 2秒的时间点开始。将
第三个 Traslation XYZ（Group 02），
调整为第 2秒的时间点开始。单击右上
角的 ，关闭窗口。调整前的 Time Line 
View for event “WorldStart_1”如图
27-5所示。调整后的，如图 27-6所示。 

5．制作滑板车复位的效果。在
Event map 1中，选中  （Right mouse 
click on Object），拖动到右面的空白
处，在 Actions 窗口中，单击 Object 
motion 选项，选中 （Reset），拖动
到 Event map 1 中 ， 叠 加 在   
（ObjectRClick_1）上，出现黑框。选
中 Event map 1中 （Group），叠加
在 （Reset）上面，出现黑框。在Actions
窗口中，单击 Event 按钮，选中
（trigger event），拖动到 Event map 1
中，叠加在  （ObjectRClick_1）上面，
出现黑框。选中 Event map 1 中
（WorldStart_1），叠加在 （trigger 
event）上，出现黑框。最后形成 Event 
map 1如图 27-7所示。 

6．确定两个事件之间的关系。在

 

图 27-4 

 

图 27-5 

 

图 27-6 

 

图 27-7 
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Actions 窗口中，单击 Event 按钮，选

中 （Deactivate event），拖动到 Event 

map 1中，叠加在 （ObjectLClick_1）

上，出现黑框。选中  （Deactivate 

event），右击选择 parameters命令，弹

出对话框，如图 27-8 所示，在左边的

边框中选中 ObjectLClick_1，单击 Add

按钮，单击 OK按钮。在 Actions窗口

中，选中 （Activate event），拖动到

Event map 1 中 ， 叠 加 在  
（ObjectLClick_1）上面，出现黑框。

选中 （Activate event），右击选择

parameters命令，弹出对话框，在左边

的边框中选中 ObjectRClick_1，单击

Add按钮，单击 OK按钮。形成的 Event 

map 1，如图 27-9所示。 

在 Actions窗口中，单击 Event按

钮，选中 （Deactivate event），拖动

到 Event map 1 中 ， 叠 加 在  
（ObjectRClick_1）上，出现黑框。选

中 （Deactivate event），右击选择

parameters命令，弹出对话框，在左边

的边框中选中 ObjectRClick_1，单击

Add 按钮，单击 OK 按钮。在 Actions

窗口中，选中 （Activate event），拖

动到 Event map 1 中，叠加在  
（ObjectRClick_1）上，出现黑框。选

中  （Activate event），右击选择

parameters 命令，弹出对话框，如图

27-10 所示。在左边的边框中选中

ObjectLClick_1，单击 Add按钮，单击

OK按钮。形成的 Event map 1，如图

27-11所示。 

7．保存为 huabanche1.c3p，本例

制作完成。 

 

 

图 27-8 

 

图 27-9 

 

图 27-10 

 

图 27-11 
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实例 28  游 戏 手 柄 

 

本例制作“游戏手柄”的效果，如

图 28-1所示。 

本例的特点是：按“↑”键，游戏

手柄向前移动，释放“↑”键，游戏手

柄停止移动；按“↓”键，游戏手柄向

后移动，释放“↓”键，游戏手柄停止

移动；按“→”键，游戏手柄向右移动，

释放“→”键，游戏手柄停止移动；按 

“←”键，游戏手柄向左移动，释放“←”

键，游戏手柄停止移动。 

本例通过 KeyBoard�s key press和
KeyBoard�s key release等知识完成。 

 

 

图 28-1  效果图 

 

 

1．启动 Cult 3D。 
2．装载 joystick.C3D。执行 File
→Add Cult3D Designer File命令，在出
现的对话框中选中 joystick.C3D，如图
28-2所示。 

3．添加 Arcball。在 Event map 1
中，单击 （World Start），拖动到右
面的空白处。在 Actions窗口中，单击
Object motion选项，选中 （Arcball），
拖动到 Event map 1 中，叠加在  
（World Start_1）上面，出现黑框。在
Scene Graph中，单击 RootNode选项，
选中 （joystick）拖动到 Event map 1
中，叠加在 （Arcball）上面，出现
黑框。效果如图 28-3所示。 

4．制作游戏手柄向前移动效果。

 

图 28-2 

 

图 28-3 
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在 Event map 1中选中 （Keyboard�s 
key Press），拖动到右面的空白处，双
击 （KeyPress_1），弹出对话框，如
图 28-4 所示，选中“Arrow up”，单
击 Add按钮，添加到右边框，单击 OK
按钮完成。 
在 Actions 窗口中，单击 Object 

motion 选项，选中  （ Translation 
XYZ），拖动到 Event map 1中，叠加
在 （KeyPress_1）上面，出现黑框。
选中 Event map 1中的 （Joy Stick），
拖动到 （Translation XYZ），出现黑
框。双击 （Translation XYZ），弹出
对话框，如图 28-5所示。在 Y轴中输
入�4（位移），Time设为 1000（毫秒），
选择 Loop 方式，单击 Close 按钮完成
参数设置。 
在 Actions 窗口中，单击 Object 

motion选项，选中 （Rotation XYZ），
拖动到 Event map 1 中，叠加在
（KeyPress_1）上面，出现黑框。选中
Event map 1中的 （Joy Stick），拖动
到 （Rotation XYZ），出现黑框。双
击 （Rotation XYZ），弹出对话框。
在 X 轴中输入 6（位移），Time 设为
1000（毫秒），选择 Loop方式，单击
Close按钮完成参数设置。形成的 Event 
map 1如图 28-6所示。 
在 Event map 1 中，选中

（Keyboard�s key Release），拖动到右
面的空白处，双击 （KeyRelase_1），
弹出对话框，选中“Arrow up”，单击
Add按钮，添加到右边框，单击 OK按
钮完成。 
在 Actions 窗口中，单击 Object 

motion 选项，选中  （ Translation 
XYZ），拖动到 Event map 1中，叠加
在 （KeyRelase_1）上面，出现黑框。
选中 Event map 1中的 （Joy Stick），

 

 

图 28-4 

 

 

 

图 28-5 

 

 

 

图 28-6 
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拖动到 （Translation XYZ），出现黑

框。双击 （Translation XYZ），弹出

对话框。在 Y轴中输入 4（位移），Time

设为 1000（毫秒），选择 Loop方式，

单击 Close按钮完成参数设置。 

在 Actions 窗口中，单击 Object 

motion选项，选中 （Rotation XYZ），

拖动到 Event map 中，叠加在

（KeyRelase_1）上面，出现黑框。选

中 Event map 1中的 （Joy Stick），

拖动到 （Rotation XYZ），出现黑框。

双击 （Rotation XYZ），弹出对话框。

在 X轴中输入�6（位移），Time设为
1000（毫秒），选择 Loop方式，单击
Close按钮完成参数设置。形成的 Event 
map 1如图 28-7所示。 
制作向后、向左和向右移动效果

的方法，与上面制作向前移动效果的方

法一样。要注意的是，移动方向和坐标

之间的关系。形成的 Event map 1如图
28-8所示。 

5．保存为 joystick.c3p，本例制作
完成。 

 

图 28-7 

 

图 28-8 
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实例 29  撞球游戏（一） 

 

本例制作“撞球游戏（一）”的效

果，如图 29-1所示。 

本例的特点是：按“Enter”键，

球会先下降再上升，并且按照预定的路

线移动。 

本例通过 Rotation，Translation 和

Edit with Time Line View等知识完成。 

 

图 29-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 pinball.C3D。选择 File→

Add Cult3D Designer File命令，在出现

的对话框中选中 pinball.C3D，如图 29-2

所示。 

3．添加 Arcball。在 Event map 1

中，单击 （World start），拖动到右

面的空白处。在 Actions窗口中，单击

Object motion选项，选中 （Arcball），

拖动到 Event map 1中，叠加在原来的

 （WorldStart_1）上面，出现黑框。

在 Scene Graph中，单击 RootNode，选

中 （pinball），拖动到 Event map 1

中，叠加在 （Arcball）上面，出现

黑框。形成的 Event map 1如图 29-3所

示。 

4．制作初始球箱直立的效果。在

Actions窗口中，单击 Object motion选

项，选中 （Translation XYZ），拖动

到 Event map 1 中 ， 叠 加 在  
（WorldStart_1）上，出现黑框。在 Event 

 

图 29-2 

 

图 29-3 
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map 1中，选中 （pinball），叠加在 
（Translation XYZ）上，出现黑框。双

击 （Translation XYZ），弹出对话框，

如图 29-4所示。在 Y轴中输入�60（位
移），Time设为 1000（毫秒），选择
Repeat count 1方式，单击 Close按钮完
成参数设置。 
在 Actions 窗口中，单击 Object 

motion选项，选中 （Rotation XYZ），
拖动到 Event map 1 中，叠加在  
（WorldStart_1）上，出现黑框。选中
Event map 1中的 （pinball），拖动
到 （Rotation XYZ），出现黑框。双
击 （Rotation XYZ），弹出对话框。
在 X轴中输入 90（角度），Time设为
1000（毫秒），并且选择 Repeat count 1
方式，单击 Close按钮完成参数设置。
形成的 Event map 1，如图 29-5所示。 

5．制作球下落的效果。在 Event 
map 1 中，单击 （Keyboard�s key 
press），拖动到右面的空白处。双击
（KeyPress_1），弹出对话框，在左边
框中选中“Enter”，单击 Add 按钮，
添加到右边框，单击 OK按钮完成。 
在 Actions 窗口中，单击 Object 

motion 选项，选中  （ Translation 
XYZ），拖动到 Event map 1中，叠加
在 （KeyPress_1）上，出现黑框。在
Scene Graph中，单击 RootNode选项，
选中 （Ball），拖动到 Event map 1
中，叠加在 （Translation XYZ）上，
出现黑框。双击 （Translation XYZ），
弹出对话框，如图 29-6所示。在 Z轴
中输入�30（位移），Time 设为 1000
（毫秒），选择 Repeat count 1方式，
单击 Close按钮完成参数设置。形成的
Event map 1如图 29-7所示。 

6．制作球上升的效果。在 Actions
窗口中，单击 Object motion 选项，选

 

图 29-4 

 

图 29-5 

 

图 29-6 

 

图 29-7 
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中 （Translation XYZ），拖动到 Event 

map 1中，叠加在 （KeyPress_1）上，

出现黑框。选中 （KeyPress_1），右

击选择 Edit with Time Line View命令。

弹出对话框，如图 29-8 所示。调整刚

才添加的 （Translation XYZ）的开始

时间，调整到从第 1秒开始执行。 

在 Event map 1中，选中 （Ball），

拖动到 Event map 1 中，叠加在  
（Translation XYZ），出现黑框。双击

 （Translation XYZ），弹出对话框。

在 Z 轴中输入 180（位移），Time 设

为 1000（毫秒），选择 Repeat count 1

方式，单击 Close按钮完成参数设置。

形成的 Event map 1如图 29-9所示。 

7．制作球撞壁拐弯的效果。在

Actions窗口中，单击 Object motion选

项，选中 （Translation XYZ），拖动

到 Event map 1 中 ， 叠 加 在

（KeyPress_1）上，出现黑框。在Actions

窗口中，单击 Object motion 选项，选

中 （Rotation XYZ），拖动到 Event 

map 1中，叠加在 （KeyPress_1）上，

出现黑框。选中 （KeyPress_1），右

击选择 Edit with Time Line View命令，

弹出对话框，如图 29-10所示。调整刚

才添加的 （Translation XYZ）和 

（Rotation XYZ）的开始时间，调整到

从第 2秒开始执行。 

在 Event map 1中，选中 （Ball），

拖动到 Event map 1 中，叠加在  
（Translation XYZ），出现黑框。双击

 （Translation XYZ），弹出对话框，

如图 29-11 所示。在 X 轴中输入�110
（位移），Time设为 1000（毫秒），
在 Z 轴中输入 120（位移），Time 设
为 1000（毫秒），选择 Repeat count 1
方式，单击 Close按钮完成参数设置。 
选中 Event map 1中的 （Ball），

 

图 29-8 

 

图 29-9 

 

图 29-10 

 

图 29-11 
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拖动到 （Rotation XYZ），出现黑框。

双击 （Rotation XYZ），弹出对话框。

在 Y轴中输入�180（角度），Time设
为 1000（毫秒），并且选择 Repeat count 
1方式，单击 Close按钮完成参数设置。
形成的 Event map 1，如图 29-12所示。 

8．制作球撞柱拐弯的效果。在
Actions窗口中，单击 Object motion选
项，选中 （Translation XYZ），拖动
到 Event map 1 中 ， 叠 加 在
（KeyPress_1）上，出现黑框。选中
（KeyPress_1），右击选择 Edit with 
Time Line View命令。弹出对话框，如
图 29-13 所示。调整刚才添加的  
（Translation XYZ）的开始时间，调整
到从第 3秒开始执行。 
在 Event map 1中，选中 （Ball），

拖动到 Event map 1 中，叠加在  
（Translation XYZ），出现黑框。双击

 （Translation XYZ），弹出对话框。
在 X轴中输入�55（位移），Time设为
500（毫秒），在 Z 轴中输入�35（位
移），Time 设为 500（毫秒），选择
Repeat count 1方式，单击 Close按钮完
成参数设置。形成的 Event map 1如图
29-14所示。 

9．制作球再次撞壁拐弯的效果。
在 Actions窗口中，单击 Object motion
选项，选中 （Translation XYZ），拖
动到 Event map 1 中，叠加在
（KeyPress_1）上，出现黑框。选中
（KeyPress_1），右击选择 Edit with 
Time Line View命令。弹出对话框，如
图 29-15 所示。调整刚才添加的  
（Translation XYZ）的开始时间，调整
到从第 3.5秒开始执行。 
在 Event map 1中，选中 （Ball），

拖动到 Event map 1 中，叠加在  
（Translation XYZ），出现黑框。双击

 

图 29-12 

 

图 29-13 

 

图 29-14 

 

图 29-15 
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 （Translation XYZ），弹出对话框。

在 X 轴中输入 100（位移），Time 设

为 1000（毫秒），在 Z轴中输入 90（位

移），Time设为 1000（毫秒），选择

Repeat count 1方式，单击 Close按钮完

成参数设置。形成的 Event map 1如图

29-16所示。 

10．保存为 pinball.c3p，本例制作

完成。  

图 29-16 
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实例 30  撞球游戏（二） 

 

本例制作“撞球游戏（二）”的效

果，是在前一实例的基础上添加其他功

能，如图 30-1所示。 

本例的特点：按“Enter”键，球

下降，推杆推动球向上运动，球撞壁后，

改变运动路线，最后掉入底部。其中左

右挡板可动作，同时在撞击球的时候会

有声音发出。按“Space”键，复原。 

本例通过 Edit with Time Line 

View和 Trigger event制作完成。 

 

 

图 30-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 pinball.c3p。执行 File→

Load project命令，在出现的对话框中

选中 pinball.c3p，如图 30-2所示。 

3．制作推杆推球的效果。在

Actions窗口中，单击 Object motion选

项，选中 （Translation XYZ），拖动

到 Event map 1 中 ， 叠 加 在

（KeyPress_1）上，出现黑框。选中

（KeyPress_1），右击选择 Edit with 

Time Line View命令。弹出对话框，如

图 30-3 所示。调整刚才添加的  
（Translation XYZ）的开始时间，调整

到从第 1秒开始执行。 

在 Scene Graph 中，选中

（Pusher），拖动到 Event map 1中，

叠加在 （Translation XYZ）上，出现

黑框。双击 （Translation XYZ），弹

 

 

图 30-2 

 

图 30-3 
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出对话框，如图 30-4所示。在 Z轴中

输入 10（位移），Time设为 50（毫秒），

选择 Repeat count 1方式，单击 Close

按钮完成参数设置。形成的 Event map 

1如图 30-5所示。 

4．制作左边挡板上举的效果。在

Actions窗口中，单击 Object motion选

项，选中 （Rotation XYZ），拖动到

Event map 1中，叠加在 （KeyPress_1）

上，出现黑框。选中 （KeyPress_1），

右击选择 Edit with Time Line View命

令。弹出对话框，如图 30-6 所示。调

整刚才添加的 （Rotation XYZ）的开

始时间，调整到从第 1.5秒开始执行。 

选 中 Scene Graph 中 的

（Flipper-l），拖动到 （Rotation XYZ）

上，出现黑框。双击 （Rotation XYZ），

弹出对话框。在Y轴中输入�60（角度），
Time设为 500（毫秒），并且选择 Repeat 
count 1方式，单击 Close按钮完成参数
设置。 

5．制作左边挡板放下的效果。在
Actions窗口中，单击 Object motion选
项，选中 （Rotation XYZ），拖动到
Event map 1中，叠加在 （KeyPress_1）
上，出现黑框。选中 （KeyPress_1），
右击选择 Edit with Time Line View。弹
出对话框。调整刚才添加的 （Rotation 
XYZ）的开始时间，调整到从第 2秒开
始执行。 
选 中 Scene Graph 中 的

（Flipper-l），拖动到 （Rotation XYZ）
上，出现黑框。双击 （Rotation XYZ），
弹出对话框。在Y轴中输入�60（角度），
Time设为 500（毫秒），并且选择 Repeat 
count 1方式，单击 Close按钮完成参数
设置。形成的 Event map 1，如图 30-7
所示。 

6．对于右挡板 （Flipper-r）按照

 

图 30-4 

 

图 30-5 

 

图 30-6 

 

图 30-7 
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上面制作左挡板的方法，同样制作，但

是需要注意，上举的起始时间设为第 3

秒，放下的起始时间设为第 3.5 秒。效

果如图 30-8所示。 

7．制作复位的效果。在 Event map 

1中，选中 （Keyboard�s key press），
拖动到右面的空白处，双击

（KeyPress_2），弹出对话框，在左边
的空白处选中“Space”，单击 Add按
钮，单击 Close按钮。 
在 Actions 窗口中，单击 Object 

motion 选项，选中 （Reset），拖动
到 Event map 1 中 ， 叠 加 在
（KeyPress_2）上面，出现黑框。选中
Event map 1中 （pinball），叠加在
（Reset）上面，出现黑框。 
在 Actions窗口中，单击 Event按

钮，选中 （trigger event），拖动到
Event map 1中，叠加在 （KeyPress_2）
上面，出现黑框。选中 Event map 1中
（WorldStart_1），叠加在 （trigger 
event）上面，出现黑框。最后形成 Event 
map 1如图 30-9所示。 

8．将音乐文件导入。在 Scene 
Graph中，单击 （Sounds），右击选
择 New→Sound命令，弹出对话框，在
对话框中选中音乐文件 SOUND.AVI
（必须为.avi或者.mid格式）。 

9．制作播放音乐的效果。在
Action窗口中，单击 Sound选项，选中
（Play sound），拖动到 Event map 1
中，叠加在 （KeyPress_1）上，出现
黑框。在 Scene Graph中，单击 Sounds
选项，选中添加的音乐 （SOUND），
如图 30-10所示，拖动到 Event map 1
中，叠加在 （Play sound）上，出现
黑框。 
依次重复上面的步骤，加入五次

（Play sound），如图 30-11所示。

 

图 30-8 

 

图 30-9 

 

图 30-10 

 

图 30-11 
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选中 （KeyPress_1），右击选择 Edit 

with Time Line View。弹出对话框。调

整添加的五个 （Play sound）的开始

时间。依次将每个 （Play sound）的

起始时间设置为球撞壁或者球被击的

时间点，如图 30-12所示。 

10．保存为 pinball 1.c3p，本例制

作完成。 

 

图 30-12 
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实例 31  台  球 （一） 

 

本例制作“台球（一）”的效果，

如图 31-1所示。 

本例的特点是：初始时视角会采用

Top View，按“Enter”键，推球杆会

移动到准备位置。 

本例通过 Rotation，Translation 和

Select camera等知识完成。 

 

图 31-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 snooker.C3D。选择 File

→Add Cult3D Designer File命令，在出

现的对话框中选中 snooker.C3D，如图

31-2所示。 

3．添加 Arcball。在 Event map 1

中，单击 （World start），拖动到右

面的空白处。在 Actions窗口中，单击

Object motion选项，选中 （Arcball），

拖动到 Event map 1 中，叠加在  
（WorldStart_1）上面，出现黑框。在

Scene Graph中，单击 RootNode选项，

选中 （snooker），拖动到 Event map 

1中，叠加在 （Arcball）上面，出现

黑框。形成的 Event map 1如图 31-3所

示。 

4．制作初始时俯视的效果。在

Actions窗口中，单击 Camera选项，选

中 （Select camera），拖动到Event map 

1中，叠加在 （WorldStart_1）上面，

出现黑框。在 Scene Graph 中，单击

 

图 31-2 

 

图 31-3 

 

图 31-4 
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rootnode选项，选中 （Top view），

如图 31-4所示，拖动到Event map 1中，

叠加在 （Select camera）上面，出现

黑框。形成的 Event map 1如图 31-5所

示。 

5．制作击球杆运动到准备位置的

效果。在 Event map 1 中选中

（Keyboard�s key Press），拖动到右面
的空白处，双击 （KeyPress_1），弹
出对话框，如图 31-6 所示，在左边框
中选中“Enter”，单击 Add 按钮，添
加到右边框，单击 OK按钮完成。 
在 Actions 窗口中，单击 Object 

motion 选项，选中  （ Translation 
XYZ），拖动到 Event map 1中，叠加
在  （KeyPress_1）上，出现黑框。
在 Scene Graph中，单击 RootNode，选
中 （Cue），叠加在 （Translation 
XYZ）上面，出现黑框。双击  
（Translation XYZ），弹出对话框，设
置如图 31-7 所示，单击 Close 按钮完
成参数设置。 
在 Actions 窗口中，单击 Object 

motion选项，选中 （Rotation XYZ），
拖动到 Event map 1 中，叠加在
KeyPress_1上，出现黑框。选中 Event 
map 1 中的 （Cue），拖动到  

（Rotation XYZ），出现黑框。双击 

（Rotation XYZ），弹出对话框。在 Z
轴中输入 55（角度），Time设为 1000
（毫秒），并且选择 Repeat count 1方
式，单击 Close按钮完成参数设置。形
成的 Event map 1，如图 31-8所示。 

6．保存为 snooker.c3p，本例制作
完成。 

 

图 31-5 

 

图 31-6 

 

图 31-7 

 

图 31-8 
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实例 32  台  球 （二） 

 

本例制作“台球（二）”的效果，

如图 32-1所示。 

本例的特点：按“Enter”键，击

球杆回到准备位置、击球、球反弹、再

反弹、然后入洞；按空格键，复位。 

本例通过：Edit with Time Line 

View等知识完成。 

 

图 32-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 snooker.c3p。执行 File→

Load project命令，在出现的对话框中

选中 snooker.c3p，如图 32-2所示。 

3．制作推球杆推球的效果。在

Actions窗口中，单击 Object motion选

项，选中 （Translation XYZ），拖动

到 Event map 1 中 ， 叠 加 在

（KeyPress_1）上，出现黑框。选中

（KeyPress_1），右击选择 Edit with 

Time Line View。弹出对话框，如图 32-3

所示。调整刚才添加的 （Translation 

XYZ）的开始时间，调整到从第 2秒开

始执行。 

在 Event map 1中，选中 （Cue），

拖动到 Event map 1 中，叠加在  
（Translation XYZ）上面，出现黑框。

双击 （Translation XYZ），弹出对话

框，如图 32-4所示。在 Y轴中输入 400

（位移），Time 设为 500（毫秒），

选择 Repeat count 1方式，单击 Close

 

 

图 32-2 

 

图 32-3 
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按钮完成参数设置。形成的 Event map 

1如图 32-5所示。 

4．制作球被击的效果。在 Actions

窗口中，单击 Object motion 选项，选

中 （Translation XYZ），拖动到 Event 

map 1中，叠加在 （KeyPress_1）上，

出现黑框。选中 （KeyPress_1），右

击选择 Edit with Time Line View命令。

弹出对话框，如图 32-6 所示。调整刚

才添加的 （Translation XYZ）的开始

时间，调整到从第 2.4秒开始执行。 

在 Event map 1 中，选中

（cue-ball），拖动到 Event map 1中，

叠加在 （Translation XYZ），出现黑

框。双击 （Translation XYZ），弹出

对话框。在 X轴中输入 2000（位移），

Time设为 1000（毫秒），在 Z轴中输

入�4000（位移），Time设为 1000（毫
秒），选择 Repeat count 1方式，单击
Close按钮完成参数设置。 

5．制作球撞壁反弹的效果。在
Actions窗口中，单击 Object motion选
项，选中 （Translation XYZ），拖动
到 Event map 1 中 ， 叠 加 在
（KeyPress_1）上，出现黑框。选中
（KeyPress_1），右击选择 Edit with 
Time Line View命令。弹出对话框。调
整刚才添加的 （Translation XYZ）的
开始时间，调整到从第 3.4秒开始执行。 
在 Event map 1 中，选中

（cue-ball），拖动到 Event map 1中，
叠加在 （Translation XYZ），出现黑
框。双击 （Translation XYZ），弹出
对话框。在 X轴中输入�400（位移），
Time 设为 500（毫秒），在 X 轴中输
入�2000（位移），Time设为 500（毫
秒），选择 Repeat count 1方式，单击
Close按钮完成参数设置。形成的 Event 
map 1如图 32-7所示。 

 

图 32-4 

 

图 32-5 

 

图 32-6 

 

图 32-7 
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6．制作球再次撞壁反弹的效果。

在 Actions窗口中，单击 Object motion

选项，选中 （Translation XYZ），拖

动到 Event map 1 中，叠加在

（KeyPress_1）上，出现黑框。选中

（KeyPress_1），右击选择 Edit with 

Time Line View命令。弹出对话框，如

图 32-8 所示。调整刚才添加的  
（Translation XYZ），调整到从第 3.9

秒开始执行。 

在 Event map 1 中，选中

（cue-ball），拖动到 Event map 1中，

叠加在 （Translation XYZ），出现黑

框。双击 （Translation XYZ），弹出

对话框，如图 32-10所示。在 X轴中输

入�3000（位移），Time设为 2000（毫
秒），在 Z 轴中输入 7300（位移），
Time设为 2000（毫秒），选择 Repeat 
count 1方式，单击 Close按钮完成参数
设置。形成的 Event map 1如图 32-9所
示。 

7．制作复位的效果。在 Event map 
1中，选中 （Keyboard�s key press），
拖动到右面的空白处，双击

（KeyPress_2），弹出对话框，在左边
的空白处选中“Space”，单击 Add按
钮，单击 Close按钮完成设置。 
在 Actions 窗口中，单击 Object 

motion 选项，选中 （Reset），拖动
到 Event map 1 中 ， 叠 加 在
（KeyPress_2）上面，出现黑框。选中
Event map 1中 （pinball），叠加在
（Reset）上面，出现黑框。最后形成
的 Event map 1如图 32-11所示。 

8．保存为 snooker.c3p，本例制作
完成。 

 

图 32-8 

 

图 32-9 

 

图 32-10 

 

图 32-11 
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实例 33  飞  镖 （一） 

 

本例制作“飞镖”的效果，如图

33-1所示。 

本例的特点：按“↑”键，飞机向

前移动，释放“↑”键，飞机停止移动；

按“↓”键，飞机向后移动，释放“↓”

键，飞机停止移动；按“→”键，飞机

向右移动，释放“→”键，飞机停止移

动；按“←”键，飞机向左移动，释放

“←”键，飞机停止移动；按“Enter”

键，飞镖掷出。 

本例通过 KeyBoard�s key press和
KeyBoard�s key release等知识完成。 

 

 

图 33-1  效果图 

 

 

1．启动 Cult 3D。 
2．装载 dart.C3D。选择 File→Add 

Cult3D Designer File命令，在出现的对
话框中选中 dart.C3D，如图 33-2所示。 

3．添加 Arcball。在 Event map 1
中，单击 （World Start），拖动到右
面的空白处。在 Actions窗口中，单击
Object motion选项，选中 （Arcball），
拖动到 Event map 1 中，叠加在  
（World Start_1）上面，出现黑框。在
Scene Graph中，单击 RootNode选项，
选中 （dart），拖动到 Event map 1
中，叠加在 （Arcball）上面，出现
黑框。效果如图 33-3所示。 

4．制作初始时飞镖定位的效果。
在 Actions窗口中，单击 Object motion

 

图 33-2 

 

图 33-3 
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选项，选中 （Translation XYZ），拖

动到 Event map 1 中，叠加在  
（WorldStart_1）上，出现黑框。选中

Scene Graph中的 （dart01），拖动到

 （Translation XYZ）上面，出现黑框。

双击 （Translation XYZ），弹出对话

框，如图 33-4所示。在 Y轴中输入-600

（角度），Time 设为 0（毫秒），选

择 Repeat count 1方式，单击 Close按

钮完成参数设置。形成的 Event map 1

如图 33-5所示。 

5．制作控制飞镖上下左右移动的

效果。下面以上为例进行说明。 

在 Event map 1 中 选 中

（Keyboard�s key Press），拖动到右面
的空白处，双击 （KeyPress_1），弹
出对话框，如图 33-6 所示，在左边框
中选中“Arrow up”，单击 Add按钮，
添加到右边框，单击 OK按钮完成。 
在 Actions 窗口中，单击 Object 

motion 选项，选中  （ Translation 
XYZ），拖动到 Event map中，叠加在
（KeyPress_1）上面，出现黑框。选
中 Event map 1中的 （dart01），拖
动到 （Translation XYZ），出现黑框。
双击 （Translation XYZ），弹出对话
框。在 Z轴中输入 20（位移），Time
设为 1000（毫秒），选择 Loop方式，
单击 Close按钮完成参数设置。形成的
Event map 1如图 33-7所示。 
在 Event map 1 中，选中

（Keyboard�s key Release），拖动到右
面的空白处，双击 （KeyRelase_1），
弹出对话框，选中“Arrow up”，单击
Add按钮，添加到右边框，单击 OK按
钮完成。 
在 Actions 窗口中，单击 Object 

motion 选项，选中  （ Translation 
XYZ），拖动到 Event map 1中，叠加

 

图 33-4 

 

图 33-5 

 

图 33-6 

 

图 33-7 
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在 （KeyRelase_1）上面，出现黑框。

选中 Event map 1中的 （dart01），

拖动到 （Translation XYZ），出现黑

框。双击 （Translation XYZ），弹出

对话框。在 Z 轴中输入 20（位移），

Time 设为 1000（毫秒），选择 Loop

方式，单击 Close按钮完成参数设置。

形成的 Event map 1如图 33-8所示。 

对于向下、向左、向右的移动，

制作方法同上，必须注意的是，移动方

向和坐标之间的关系。形成的 Event 

map 1如图 33-9所示。 

6．制作投掷飞镖的效果。在 Event 

map 1 中，选中 （Keyboard�s key 
Press），拖动到右面的空白处，双击
（KeyPress_5），弹出对话框，在左边
框中选中“Enter”，单击 Add 按钮，
添加到右边框，单击 OK按钮完成。 
在 Actions 窗口中，单击 Object 

motion 选项，选中  （ Translation 
XYZ），拖动到 Event map 1中，叠加
在 （KeyPress_5）上面，出现黑框。
选中 Event map 1中的 （dart01），
拖动到 （Translation XYZ）上面，出
现黑框。双击 （Translation XYZ），
弹出对话框。在Y轴中输入600（角度），
Time 设为 1000（毫秒），并且选择
Repeat count 1方式，单击 Close按钮完
成参数设置。形成的 Event map 1如图
33-10所示。 

7．保存为 dart.c3p，本例制作完
成。 

 

图 33-8 

 

图 33-9 

 

图 33-10 
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实例 34  飞  镖 （二） 

 

本例制作“飞镖（二）”的效果，

是在前一实例的基础上添加其他功能，

如图 34-1所示。 

本例的特点是：按“↑”键，飞镖

向前移动，释放“↑”键，飞镖停止移

动；按“↓”键，飞镖向后移动，释放

“↓”键，飞镖停止移动；按“→”键，

飞镖向右移动，释放“→”键，飞镖停

止移动；按“←”键，飞镖向左移动，

释放“←”键，飞镖停止移动；按“Enter”

键，飞镖掷出；按“Space”键，复位。 

本例通过 Edit with Time Line 

View和 Trigger event等知识完成。 

 

 

图 34-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 pinball.c3p。执行 File→

Load project命令，在出现的对话框中

选中 pinball.c3p，如图 34-2所示。 

3．制作复位的效果。在 Event map 

1中，选中 （Keyboard�s key press），
拖动到右面的空白处，双击

（KeyPress_6），弹出对话框，在左边
的空白处选中“Space”，单击 Add按
钮，单击 Close按钮完成设置。 
在 Actions 窗口中，单击 Object 

motion 选项，选中 （Reset），拖动
到 Event map 1 中 ， 叠 加 在
（KeyPress_6）上面，出现黑框。选中
Event map 1 中 （dart），叠加在

 

 

 

图 34-2 
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（Reset）上面，出现黑框。形成 Event 

map 1如图 34-3所示。 

在 Actions窗口中，单击 Event按

钮，选中 （trigger event），拖动到

Event map 1中，叠加在 （KeyPress_6）

上，出现黑框。选中 Event map 1中

（WorldStart_1），叠加在 （trigger 

event）上面，出现黑框。形成的 Event 

map 1如图 34-3所示。 

4．确定各个动作之间的关系。在

Actions 窗口中，单击 Event 按钮，选

中 （Deactivate event），拖动到 Event 

map 1中，叠加在 （KeyPress_5）上

面，出现黑框。选中  （Deactivate 

event），右击选择 parameters命令，弹

出对话框，如图 34-4 所示，在左边的

边 框 中 选 中 除 KeyPress_6 和

WorldStart_1 以外的所有动作，单击

Add按钮，单击 OK按钮。 

在 Actions 窗口中，选中  
（Activate event），拖动到 Event map 1

中，叠加在 （KeyPress_5）上面，出

现黑框。选中 （Activate event），右

击选择 parameters命令，弹出对话框，

在左边的边框中选中 KeyPress_6，单击

Add按钮，单击 OK按钮。形成的 Event 

map 1，如图 34-5所示。 

在 Actions窗口中，单击 Event按

钮，选中 （Deactivate event），拖动

到 Event map 1 中 ， 叠 加 在

（KeyPress_6）上，出现黑框。选中 
（ Deactivate event ） ， 右 击 选 择

parameters命令，弹出对话框，在左边

的边框中选中 KeyPress_6，单击 Add

按钮，单击 OK按钮。 

在 Actions 窗口中，选中  
（Activate event），拖动到 Event map 1

中，叠加在 （KeyPress_6）上，出现

黑框。选中 （Activate event），右击

 

图 34-3 

 

图 34-4 

 

图 34-5 

 

图 34-6 
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选择 parameters命令，弹出对话框。在

左 边 框 中 选 中 除 KeyPress_6 和

WorldStart_1 以外的所有动作，单击

Add按钮，单击 OK按钮。形成的 Event 

map 1，如图 34-6所示。 

选 中 Event map 1 中 的

（ KeyPress_6），右击选择 Initial 

Activation,去掉前面的勾号，如图 34-7

所示。 

5．保为 dart1.c3p，本例制作完成。 

 

 

图 34-7 

 



 

 

本篇介绍如何制作各种日常用品，小到打火

机、起盖器，大到计算机、厨房设备等方面的各

种实例。

本篇介绍的各种用品与人们的日常生活息息

相关，使读者在熟悉的场景中制作熟悉的物体，

在不知不觉中得到提高。通过本篇的学习，读者

可以进一步强化了对于各项功能的理解和使用。

日常用品篇 
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实例 35  起  盖  器 

 

本例制作“起盖器”的效果，如图

35-1所示。 

本例的特点是：用鼠标左键单击起

盖器加紧瓶盖；再单击鼠标右键松开瓶

盖。 

本例通过 Arcball、Rotation等知识

完成。 

 

图 35-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 corkscrew.C3D。选择 File

→Add Cult3D Designer File命令，在对

话框中选中 corkscrew.C3D，如图 35-2

所示。 

3．添加 Arcball。在 Event map 1

中单击 （world start），拖动到右面

的空白处。在 Actions 中单击 Object 

motion 选项，选中 （Arcball），拖

动到 Event map 1 中，叠加在  
（WorldStart_1）上，出现黑框。在 Scene 

Graph 中单击 rootnode 选项，选中

（corkscrew），拖动到 Event map 1中，

叠加在的 （Arcball）上，出现黑框，

形成的 Event map 1如图 35-3所示。 

4．制作夹紧瓶盖效果。在 Event 

map 1中，单击 （Left mouse click on 

Object），拖动到右面的空白处。在

Actions中单击 Object motion选项，选

中 （Rotation XYZ），拖动到 Event 

map 1中，叠加在 （ObjectLClick_1）

 

 

 

图 35-2 

 

图 35-3 
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上，出现黑框。选中 Scene Graph中的

（pomo），拖动到 （Rotation XYZ）

上，出现黑框。双击 （Rotation XYZ），

弹出对话框，数值设置如图 35-4所示，

选择 Repeat count 1方式，单击 Close

按钮完成参数设置。形成的 Event map 

1如图 35-5所示。 

在 Actions中，单击 Object motion

选项，选中 （Rotation XYZ），拖动

到 Event map 1 中 ， 叠 加 在  

（ObjectLClick_1）上面，出现黑框。

选中 Scene Graph 中的 （qua02），

拖动到 （Rotation XYZ），出现黑框。

双击 （Rotation XYZ），弹出对话框。

在 Y 轴中输入 3（角度），Time 设为

4000（毫秒），选择 Repeat count 1方

式，单击 Close按钮完成参数设置。 

在 Actions中，单击 Object motion

选项，选中 （Rotation XYZ），拖动

到 Event map 1 中 ， 叠 加 在  

（ObjectLClick_1）上面，出现黑框。

选中 Scene Graph 中的 （qua01），

拖动到 （Rotation XYZ），出现黑框。

双击 （Rotation XYZ），弹出对话框。

在 Y轴中输入�3（角度），Time设为
4000（毫秒），选择 Repeat count 1方
式，单击 Close按钮完成参数设置。形
成的 Event map 1如图 35-6所示。 

5．制作松开瓶盖的效果。在 Event 
map 1中，单击 （Right mouse click on 
Object），拖动到右面的空白处。在
Actions中，单击 Object motion选项，
选中 （Rotation XYZ），拖动到 Event 
map 1中，叠加在 （ObjectRClick_1）
上面，出现黑框。选中 Event map 1中
的 （pomo），拖动到 （Rotation 
XYZ）上，出现黑框。双击 （Rotation 
XYZ），弹出对话框。在 Z 轴中输入
120（角度），Time设为 4000（毫秒），

 

图 35-4 

 

图 35-5 

 

图 35-6 

 

图 35-7 
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选择 Repeat count 1方式，单击 Close

按钮完成参数设置。形成的 Event map 

1如图 35-7所示。 

在 Actions中，单击 Object motion

选项，选中 （Rotation XYZ），拖动

到 Event map 1 中 ， 叠 加 在  

（ObjectRClick_1）上面，出现黑框。

选中 Scene Graph 中的 （qua02），

拖动到 （Rotation XYZ），出现黑框。

双击 （Rotation XYZ），弹出对话框，

设置如图 35-8所示，选择 Repeat count 

1方式，单击 Close按钮完成参数设置。

形成的 Event map 1如图 35-9所示。 

在 Actions中，单击 Object motion

选项，选中 （Rotation XYZ），拖动

到 Event map 1 中 ， 叠 加 在  

（ObjectRClick_1）上面，出现黑框。

选中 Scene Graph 中的 （qua01），

拖动到 （Rotation XYZ），出现黑框。

双击 （Rotation XYZ），弹出对话框。

在 Y 轴中输入 3（角度），Time 设为

4000（毫秒），选择 Repeat count 1方

式，单击 Close按钮完成参数设置。形

成的 Event map 1如图 35-10所示。 

6．保存为 corkscrew.c3p，本例制

作完成。 

 

图 35-8 

 

图 35-9 

 

图 35-10 
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实例 36  手 提 箱（一） 

 

本例制作“手提箱”的效果，如图

36-1所示。 

本例的特点：用鼠标左键单击手提

箱，箱子转动 90°，平放于地面；单

击鼠标右键，打开锁并开启箱子盖。 

本例通过相互包含关系和 Edit 

with Time Line View。 

 

图 36-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 suitcase.C3D。执行 File

→Add Cult3d Design File命令，在对话

框中选中 suitcase.C3D，如图 36-2所示。 

3．添加 Arcball。在 Event map 1

中，单击 （World start），拖动到右

面的空白处。在 Actions中，单击 Object 

motion 选项，选中 （Arcball），拖

动到 Event map 1 中，叠加在  
（WorldStart_1）上面，出现黑框。在

Scene Graph中，单击 RootNode，选中

 （suitcase），拖动到 Event map 1中，

叠加在 （Arcball）上面，出现黑框。

形成的 Event map 1如图 36-3所示。 

4．制作发下手提箱的效果。在

Event map 1中，单击 （Left mouse 

click on Object），拖动到右面的空白

处。在 Actions中，单击 Object motion

选项，选中 （Rotation XYZ），拖动

到 Event map 1 中 ， 叠 加 在   

（ObjectLClick_1）上，出现黑框。在

 

 

图 36-2 

 

图 36-3 
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Event map 1中，选中 （suitcase），

拖动到 （Rotation XYZ），出现黑框。

双击 （Rotation XYZ），弹出对话框，

如图 36-4所示。在 X轴中输入 90（角

度），Time设为 1000（毫秒），并且

选择 Repeat count 1方式，单击 Close

按钮完成参数设置。形成的 Event map 

1，如图 36-5所示。 

5．确定开启箱子是箱盖的包含关

系。激活 View1 左上角的两个小窗口

Show axes和 Show bounding box，这样

可以显示所选中物体的坐标轴和边缘

框。 

单击 （_81），右击选择 New→

Dummy 命令，单击新建立的  
（Dummy），右击选择 Change name

命令，在出现的对话框中输入 cover，

单击 OK 按钮完成设置，如图 36-6 所

示。 

将  （ _81 ） 目 录 下 的

（_SCHNALL）、 （_OB21）、

（ _SCHAR）、 （ _OB18）、

（SCHNALLE）、 （OB21）、

（_SCHAR）、 （SCHAR）、

（OB18）、（NIETE）和 （DECKEL）

拖动到 （cover）下，如图 36-7所示。. 

6．制作锁开启的效果。在 Event 

map 1中，单击 （Right mouse click on 

Object），拖动到右面的空白处。在

Actions中，单击 Object motion选项，

选中 （Rotation XYZ），拖动到 Event 

map 1中，叠加在  （ObjectRClick_1）

上，出现黑框。在 Actions 中，单击

Object motion选项，选中 （Translation 

XYZ），拖动到 Event map 1中，叠加

在  （ObjectRClick_1）上，出现黑框。 

双击 （Rotation XYZ），弹出对

话框。在 X轴中输入�90（角度），Time
设为 1000（毫秒），并且选择 Repeat 

 

图 36-4 

 

图 36-5 

 

图 36-6 

 

图 36-7 



第四篇  日常用品篇 

 
111 

count 1方式，单击 Close按钮完成参数

设置。双击 （Translation XYZ），弹

出对话框。在 Z轴中输入 150（位移），

Time 设为 1000（毫秒），并且选择

Repeat count 1方式，单击 Close按钮完

成参数设置。 

在 Scene Graph 窗口中选中

（SCHNALL）和 （_SCHNALL）,

分别叠加到 （Rotation XYZ）和 
（Translation XYZ）上面，形成交错的

关系。形成的 Event map 1如图 36-8所

示。 

7．制作锁开启后箱盖打开的效果。

在Actions中，单击Object motion选项，

选中 （Rotation XYZ），拖动到 Event 

map 1中，叠加在  （ObjectRClick_1）

上，出现黑框。在 Actions 中，单击

Object motion选项，选中 （Translation 

XYZ），拖动到 Event map 1中，叠加

在  （ObjectRClick_1）上，出现黑框。 

在 Event map 1 中，选中  

（ObjectRClick_1），右击选择 Edit with 

Time Line View，如图 36-9所示。在弹

出的对话框如图 36-10中，调整各个动

作发生的先后时间顺序。将 Rotation和

Translation 调整为第二秒的时间点开

始。单击右上角的 ，关闭窗口。 

双击 （Rotation XYZ），弹出对

话框。在 X轴中输入�70（角度），Time
设为 3000（毫秒），并且选择 Repeat 
count 1方式，单击 Close按钮完成参数
设置。双击 （Translation XYZ），弹
出对话框。在 Y轴中输入 2500（位移），
Time设为 3000（毫秒），在 Z轴中输
入 500（位移），Time 设为 3000（毫
秒），并且选择 Repeat count 1方式，
单击 Close按钮完成参数设置。 
在 Scene Graph 窗口中选中  

（ cover） ,分别叠加到  （Rotation 

 

 

 

图 36-8 

 

 

 

图 36-9 

 

 

 

图 36-10 
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XYZ）和 （Translation XYZ）上面。

形成的 Event map 1如图 36-11所示。 

8．保存为 suitcase.c3p，本例制作

完成。 

 

图 36-11 
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实例 37  手 提 箱（二） 

 

本例制作“手提箱（二）”的效果，

如图 37-1所示。 

本例的特点：用鼠标左键单击手提

箱，箱子转动 90°，平放于地面；单

击鼠标右键，打开锁，打开箱子盖；再

次单击右键时关上箱盖，并且上锁。  

本例通过 Activate、Deactivate、Edit 

with Time Line View等知识完成。 

 

 

图 37-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 suitcase.c3p。执行 File→

Load project 命令，在对话框中选中

suitcase.c3p，如图 37-2所示。 

3．制作箱盖合上的效果。在 Event 

map 1中，单击 （Right mouse click on 

Object），拖动到右面的空白处。 

在 Actions 中单击 Object motion

选项，选中 （Rotation XYZ），拖动

到 Event map 1 中 ， 叠 加 在  

（ObjectRClick_2）上，出现黑框。在
Actions中单击 Object motion选项，选

中 （Translation XYZ），拖动到 Event 

map 1中，叠加在 （ObjectRClick_2）

上，出现黑框。 

双击 （Rotation XYZ），弹出对

话框。在 X轴中输入 70（角度），Time

设为 3000（毫秒），选择 Repeat count 

1方式，单击 Close按钮完成参数设置。

双击 （Translation XYZ），弹出对话

框，具体设置如图 37-3 所示，选择

 

 

图 37-2 

 

 

 

图 37-3 
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Repeat count 1方式，单击 Close按钮完

成参数设置。 

在 Event map 1 窗口中选中  
（cover），分别叠加到 （Rotation 

XYZ）和 （Translation XYZ）上。形

成的 Event map 1如图 37-4所示。 

4．制作箱盖合上后上锁的效果。

在 Actions中单击 Object motion选项，

选中 （Rotation XYZ），拖动到 Event 

map 1中，叠加在  （ObjectRClick_2）

上，出现黑框。在 Actions 中，单击

Object motion选项，选中 （Translation 

XYZ），拖动到 Event map 1中，叠加

在  （ObjectRClick_2）上，出现黑框。 

在 Event map 1 中，选中  

（ObjectRClick_2），右击选择 Edit with 

Time Line View命令。在弹出的对话框

37-5中，调整各个动作发生的先后时间

顺序。将 Rotation和 Translation，调整

为第四秒的时间点开始。单击右上角的

，关闭窗口。 

双击 （Rotation XYZ），弹出对

话框。在 X轴中输入 90（角度），Time

设为 1000（毫秒），并且选择 Repeat 

count 1方式，单击 Close按钮完成参数

设置。双击 （Translation XYZ），弹

出对话框。在 Z轴中输入�150（位移），
Time 设为 1000（毫秒），并且选择
Repeat count 1方式，单击 Close按钮完
成参数设置。 
在 Event map 1 窗口中选中

（SCHNALL）和 （_SCHNALL）,
分别叠加到 （Rotation XYZ）和 
（Translation XYZ）上面，形成交错的
关系。形成的 Event map 1如图 37-6所
示。 

5．确定打开和合上箱盖的关系。
在 Actions 中，单击 Event，选中 
（Deactivate event），拖动到 Event map 

 

图 37-4 

 

图 37-5 

 

图 37-6 

 

图 37-7 
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1中，叠加在  （ObjectRClick_1）上

面，出现黑框。选中  （Deactivate 

event），右击选择 parameters命令，弹

出对话框，如图 37-7 所示，在左边框

中选中ObjectRClick_1，单击Add按钮，

单击 OK按钮。 

在 Actions 中，选中 （Activate 

event），拖动到 Event map 1中，叠加

在  （ObjectRClick_1）上，出现黑框。

选中 （Activate event），右击选择

parameters命令，弹出对话框，在左边

框中选中 ObjectRClick_2，单击 Add按

钮，单击OK按钮。形成的 Event map 1，

如图 37-8所示。 

在 Actions中，单击 Event，选中 
（Deactivate event），拖动到 Event map 

1中，叠加在 （ObjectRClick_2）上，

出现黑框。选中 （Deactivate event），

右击选择 parameters 命令，弹出对话

框，在左边框中选中 ObjectRClick_2，

单击 Add按钮，单击 OK按钮。 

在 Actions 中，选中 （Activate 

event），拖动到 Event map 1中，叠加

在 （ObjectRClick_2）上，出现黑框。

选中 （Activate event），右击选择

parameters命令，弹出对话框。在左边

框中选中 ObjectRClick_1，单击 Add按

钮，单击OK按钮。形成的 Event map 1，

如图 37-9所示。 

选 中 Event map 1 中 的

（ObjectRClick_2），右击选择 Initial 

Activation，如图 37-10所示，去掉前面

的勾号，这时 （ObjectRClick_2）变

成灰色。 

6．保存为 suitcase1.c3p，本例制

作完成。 

 

图 37-8 

 

图 37-9 

 

图 37-10 
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实例 38  打 火 机（一） 

 

本例制作“打火机（一）”的效果，

如图 38-1所示。 

本例特点：单击鼠标左键，打火石

滚动，按下鼠标左键，产生火焰效果。 

本例通过 Start particle emissioin和

Stop particle emission等知识完成。 

 

 

图 38-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 lighter.C3D。执行 File→

Add Cult3d Design File命令，在对话框

中选中 lighter.C3D，如图 38-2所示。 

3．添加 Arcball。在 Event map 1

中，单击 （World start），拖动到右

面的空白处。在 Actions中，单击 Object 

motion 选项，选中 （Arcball），拖

动到 Event map 1 中，叠加在  
（WorldStart_1）上，出现黑框。在 Scene 

Graph 中，单击 RootNode，选中  
（suitcase），拖动到 Event map 1中，

叠加在 （Arcball）上，出现黑框。

形成的 Event map 1如图 38-3所示。 

4．制作打火石转动的效果。在

Event map 1中，单击 （Left mouse 

click on Object），拖动到右面的空白

处。在 Actions中，单击 Object motion

选项，选中 （Rotation XYZ），拖动

到 Event map 1 中 ， 叠 加 在   

（ObjectLClick_1）上，出现黑框。 

在 Event map 1 中，选中  

 

图 38-2 

 

图 38-3 

 

图 38-4 
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（Start01）， （Start03）和 （Start04），

拖动到 （Rotation XYZ），出现黑框。

双击 （Rotation XYZ），弹出对话框，

具体设置如图 38-4 所示，并且选择

Repeat count 1方式，单击 Close按钮完

成参数设置。形成的 Event map 1，如

图 38-5所示。 

5．制作按下鼠标键的效果。在

Actions中，单击 Object motion选项，

选中 （Translation XYZ），拖动到

Event map 1 中 ， 叠 加 在  
（ObjectLClick_1）上，出现黑框。双

击 （Translation XYZ），弹出对话框。

在 Z轴中输入�15（位移），Time设为
100（毫秒），并且选择 Repeat count 1
方式，单击 Close按钮完成参数设置。 
在 Event map 1 中，选中  
（ObjectLClick_1）），右击选择 Edit 
with Time Line View命令。在弹出的对
话框中，调整各个动作发生的先后时间

顺序。将 Translation调整为第 0.2秒的
时间点开始。单击右上角的 ，关闭窗

口。调整后的 Time Line View for event 
�ObjectLClick_1�如图 38-6所示。 
在 Scene Graph 中 选 中

（Circle01），叠加到 （Translation 
XYZ）上。形成的 Event map 1如图 38-7
所示。 

6．制作火焰产生的效果。在 Scene 
Graph 中，单击 Rootnode，选中  
（Circle02），右击选择 New→Particle 
System命令。在 Scene Graph中，选中
（Particle），如图 38-8 所示，拖动
到 Event map 1中。 
在 Actions中，单击 Object motion

选项，选中 （Start particle emission），
拖动到 Event map 1 中，叠加在  
（ObjectLClick_1）上，出现黑框。选
中 Event map 1中的 （Particle），叠

 

图 38-5 

 

图 38-6 

 

图 38-7 

 

图 38-8 
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加在 （Start particle emission）上，出

现黑框。 

在 Event map 1 中，选中  
（ObjectLClick_1），右击选择 Edit with 

Time Line View命令。在弹出的对话框

中，调整各个动作发生的先后时间顺

序。将 Start particle emission调整为第

0.4秒的时间点开始。单击右上角的 ，

关闭窗口。 

选中 （Particle），右击选择

Details，弹出对话框。在 Color settings

中，单击左面的颜色方框可以选取不同

的颜色，将第一段颜色设为黄色，第二

段颜色设为红色，第三段颜色设为绿

色，第四段颜色设为红色，最后一段的

颜色设为黄色，如图 38-9 所示，拖到

颜色框下的三角形按钮，可以控制每一

段不同颜色持续的时间长短。 

设置 Particle settings 中的参数，

具体设置如图 38-10 所示，单击 Close

按钮完成设置。形成的 Event map 1如

图 38-11所示。 

7．保存为 lighter.c3p，本例制作

完成。 

 

图 38-9 

 

图 38-10 

 

图 38-11 
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实例 39  打 火 机（二） 

 

本例制作“打火机（二）”的效果，

如图 39-1所示。 

本例特点：单击鼠标左键，打火石

滚动，按下鼠标左键，产生火焰效果；

再次单击左键，松开键，火焰消失。 

本例通过 Activate，Deactivate 和

Stop particle知识完成。 

 

图 39-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 lighter.c3p。执行 File→

Load project 命令，在对话框中选中

lighter.c3p，如图 39-2所示。 

3．制作松开键的效果。在 Event 

map 1中，单击 （Left mouse click on 

Object），拖动到右面的空白处。在

Actions中，单击 Object motion选项，

选中 （Translation XYZ），拖动到

Event map 1 中 ， 叠 加 在  
（ObjectLClick_2）上，出现黑框。双

击 （Translation XYZ），弹出对话框，

具体设置如图 39-3 所示，选择 Repeat 

count 1方式，单击 Close按钮完成参数

设置。 

在 Event map 1 中 选 中

（Circle01），叠加到 （Translation 

XYZ）上。形成的 Event map 1如图 39-4

所示。 

4．制作松开键后火焰消失的效

果。在Actions中，单击Particle systems，

 

 

 

图 39-2 

 

图 39-3 
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选中  （Stop particle emission），拖

动到 Event map 1 中，并且叠加在 
（ObjectLClick_2）上，出现黑框。选

中 Event map 1中的 （particle），拖

动到  （Stop particle emission）上，

出现黑框。 

在 Event map 1 中，选中  
（ObjectLClick_2），右击选择 Edit with 

Time Line View命令。在弹出的对话框

中，调整各个动作发生的先后时间顺

序。将 Stop particle emission调整为第

0.1秒的时间点开始。单击右上角的 ，

关闭窗口。调整后的 Time Line View 

for event �ObjectLClick_1�如图 39-5所
示。 

5．确定火焰产生和消失的关系。
在 Actions 中单击 Event，选中  
（Deactivate event），拖动到 Event map 
1中，叠加在 （ObjectLClick_1）上，
出现黑框。选中 （Deactivate event），
右击选择 parameters 命令，弹出对话
框，在左边框中选中 ObjectLClick_1，
单击 Add按钮，单击 OK按钮。 
在 Actions 中，选中 （Activate 

event），拖动到 Event map 1中，叠加
在  （ObjectLClick_1）上，出现黑框。
选中 （Activate event），右击选择
parameters命令，弹出对话框，在左边
框中选中 ObjectLClick_2，单击 Add按
钮，单击OK按钮。形成的 Event map 1，
如图 39-6所示。 
在 Actions中，单击 Event，选中 

（Deactivate event），拖动到 Event map 
1中，叠加在 （ObjectLClick_2）上，
出现黑框。选中 （Deactivate event），
右击选择 parameters 命令，弹出对话
框，如图 39-7 所示，在左边框中选中
ObjectLClick_2，单击 Add按钮，单击
OK按钮。 

 

图 39-4 

 

图 39-5 

 

图 39-6 

 

图 39-7 
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在 Actions 中，选中 （Activate 

event），拖动到 Event map 1中，叠加

在 （ObjectLClick_2）上，出现黑框。

选中 （Activate event），右击选择

parameters命令，弹出对话框。在左边

框中选中 ObjectRClick_1，单击 Add按

钮，单击 OK按钮。 

选 中 Event map 1 中 的  

（ObjectLClick_2），右击选择 Initial 

Activation，如图 39-8所示，去掉之前

的勾号。这时 （ObjectLClick_2）变

成灰色。最后形成的 Event map 1，如

图 39-9所示。 

6．保存为 lighter1.c3p，本例制作

完成。 

 

图 39-8 

 

图 39-9 
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实例 40  马    桶 

 

本例制作“马桶”的效果，如图

40-1所示。 

本例特点：单击左键，盖子打开，

再单击左键盖上盖子。 

本例通过 Activate和 Deactivate等

知识完成。 

 

图 40-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 wc.C3D。选择 File→Add 

Cult3D Designer File命令，在对话框中

选中 wc.C3D，如图 40-2所示。 

3．添加 Arcball。在 Event map 1

中单击 （world start），拖动到右面

的空白处。在 Actions中，单击 Object 

motion 选项，选中 （Arcball），拖

动到 Event map 1 中，叠加在  
（WorldStart_1）上，出现黑框。在 Scene 

Graph中，单击 rootnode，选中 （wc），

拖动到 Event map 1 中，叠加在的 
（Arcball）上，出现黑框，形成的 Event 

map 1如图 40-3所示。 

4．制作盖子打开的效果。在 Event 

map 1中，单击 （Left mouse click on 

Object），拖动到右面的空白处。在
Actions中，单击 Object motion选项，

选中 （Rotation XYZ），拖动到 Event 

map 1中，叠加在 （ObjectLClick_1）

上，出现黑框。 

选中 Scene Graph中的 （Tape01）

和 （Tape03），分别拖动到 （Rotation 

 

图 40-2 

 

图 40-3 

 

图 40-4 
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XYZ），出现黑框。双击 （Rotation 

XYZ），弹出对话框，具体设置如图
40-4所示，选择 Repeat count 1方式，

单击 Close按钮完成参数设置。形成的
Event map 1如图 40-5所示。 

在 Actions中，单击 Object motion

选项，选中 （Translation XYZ），拖

动到 Event map 1 中，叠加在   

（ObjectLClick_1）上，出现黑框。选

中 Event map 1中的 （Tape01）和

（Tape03），拖动到  （Translation 

XYZ ） 上 ， 出 现 黑 框 。 双 击  
（Translation XYZ），弹出对话框。在

Y轴中输入 80（位移），Time设为 1000

（毫秒），选择 Loop方式，单击 Close

按钮完成参数设置。形成 Event map 1

如图 40-6所示。 

5．制作盖子盖上的效果。在 Event 

map 1中，单击 （Left mouse click on 

Object），拖动到右面的空白处。在
Actions中，单击 Object motion选项，

选中 （Rotation XYZ），拖动到 Event 

map 1中，叠加在 （ObjectLClick_2）

上，出现黑框。 

选中 Event map 1中的 （Tape01）

和 （Tape03），分别拖动到 （Rotation 

XYZ），出现黑框。双击 （Rotation 

XYZ），弹出对话框。在 X 轴中输入
-80（角度），Time设为 2000（毫秒），

选择 Repeat count 1方式，单击 Close

按钮完成参数设置。形成的 Event map 

1如图 40-7所示。 

在 Actions中，单击 Object motion

选项，选中 （Translation XYZ），拖

动到 Event map 1 中，叠加在   

（ObjectLClick_2）上面，出现黑框。

选中 Event map 1中的 （Tape01）和

（Tape03），拖动到 （Translation 

XYZ），出现黑框。双击 （Translation 

XYZ），弹出对话框，具体设置如图

 

图 40-5 

 

图 40-6 

 

图 40-7 

 

图 40-8 
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40-8所示，选择 Loop方式，单击 Close

按钮完成参数设置。形成 Event map 1

如图 40-9所示。 

6．确定打开和合上盖子的关系。

在 Actions 中，单击 Event，选中 
（Deactivate event），拖动到 Event map 

1中，叠加在  （ObjectLClick_1）上，

出现黑框。选中 （Deactivate event），

右击选择 parameters命令，弹出对话框，

如图 40-10所示，选中ObjectLClick_1，

单击Add按钮，单击OK按钮。 

在 Actions 中，选中 （Activate 

event），拖动到 Event map 1中，叠加

在  （ObjectLClick_1）上，出现黑框。

选中 （Activate event），右击选择
parameters 命令，弹出对话框，选中
ObjectLClick_2，单击 Add按钮，单击
OK 按钮。形成的 Event map 1 如图
40-11所示。 

在 Actions中，单击 Event，选中 
（Deactivate event），拖动到 Event map 

1中，叠加在  （ObjectLClick_2）上，

出现黑框。选中 （Deactivate event），

右击选择 parameters 命令，弹出对话

框，在左边框中选中 ObjectLClick_2，

单击 Add按钮，单击 OK按钮。 

在 Actions 中，选中 （Activate 

event），拖动到 Event map 1中，叠加

在  （ObjectLClick_2）上，出现黑框。

选中 （Activate event），右击选择
parameters命令，弹出对话框。在左边

框中选中 ObjectLClick_1，单击 Add按

钮，单击OK按钮。形成的 Event map 1，

如图 40-12所示。 

选 中 Event map 1 中 的   

（ObjectLClick_1），右击选择 Initial 

Activation，去掉之前的勾号。这时  

（ObjectLClick_1）变成灰色。 

7．保存为 wc.c3p，本例制作完成。 

 

图 40-9 

 

图 40-10 

 

图 40-11 

 

图 40-12 
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实例 41  厨  柜 （一） 

 

本例制作“厨柜（一）”的效果，

如图 41-1所示。 

本例特点：用鼠标左键单击抽屉，

抽屉打开，再次单击左键，抽屉关上。 

本例通过 Translation、Active event

和 Deactive event等知识完成。 

 

图 41-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 kitchen.C3D。选择 File→

Add Cult3D Designer File命令，在对话

框中选中 kitchen.C3D，如图 41-2所示。 

3．添加 Arcball。在 Event map 1

中，单击 （World start），拖动到右

面的空白处。在 Actions中，单击 Object 

motion 选项，选中 （Arcball），拖

动到 Event map 1中，叠加在原来的 
（World start）上面，出现黑框。在 Scene 

Graph 中，单击 RootNode，选中  
（kitchen），拖动到 Event map 1中，

叠加在 （Arcball）上面，出现黑框。

形成的 Event map 1如图 41-3所示。 

4．制作打开抽屉的效果。在 Event 

map 1中，单击 （Left mouse click on 

Object），拖动到右面的空白处。在

Actions中，单击 Object motion选项，

选中 （Translation XYZ），拖动到

Event map 1 中 ， 叠 加 在  

（ObjectLClick_1）上，出现黑框。在

Scene Graph中，单击 RootNode，单击

 

图 41-2 

 

图 41-3 
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 （ ChamferBox05 ） ， 拖 动 到  
（Translation XYZ）上面，出现黑框。单

击  （ChamferBox20），拖动到   
（Translation XYZ），出现黑框。双击 
（Translation XYZ），弹出对话框，具

体设置如图 41-4所示，并且选择Repeat 

count 1方式，单击 Close按钮完成参数

设置。 

在 Event map 1 中，分别单击 
（ChamferBox05）和 （ChamferBox20），

拖动到 （ObjectLClick_1），出现黑

框。只有单击在抽屉上的时候才会起作

用。形成的 Event map 1，如图 41-5所

示。 

5．制作关上抽屉的效果。在 Event 

map 1中，单击 （Left mouse click on 

Object），拖动到右面的空白处。在

Actions中，单击 Object motion选项，

选中 （Translation XYZ），拖动到

Event map 1 中 ， 叠 加 在  

（ObjectLClick_2）上，出现黑框。选

中 Event map 1中的 （Chamfer05），

拖动到 （Translation XYZ），出现黑

框 。 选 中 Event map 1 中 的  
（Chamfer20），拖动到 （Translation 

XYZ），出现黑框。双击  Translation 

XYZ，弹出对话框。在 Z轴中输入�300
（位移），Time设为 1000（毫秒），
并且选择 Repeat count 1 方式，单击
Close按钮完成参数设置。 
在 Event map 1 中，分别单击 

（ChamferBox05）和 （ChamferBox20），
拖动到 （ObjectLClick_2），出现黑
框。形成的 Event map 1，如图 41-6所
示。 

6．确定打开和关上抽屉的关系。
在 Actions 中，单击 Event，选中 
（Deactivate event），拖动到 Event map 
1中，叠加在 （ ObjectLClick_1）上

 

图 41-4 

 

图 41-5 

 

图 41-6 

 

图 41-7 
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面，出现黑框。选中  （Deactivate 

event），右击选择 parameters命令，弹

出对话框，如图 41-7 所示，在左边框

中选中ObjectLClick_1，单击Add按钮，

单击 OK按钮。 

在 Actions 中，选中 （activate 

event），拖动到 Event map 1中，叠加

在 （ObjectLClick_1）上面，出现黑

框。选中 （activate event），右击选

择 parameters命令，弹出对话框，在左

边框中选中 ObjectLClick_2，单击 Add

按钮，单击 OK按钮。形成的 Event map 

1，如图 41-8所示。 

在 Actions中，单击 Event，选中 
（Deactivate event），拖动到 Event map 

1中，叠加在 （ObjectLClick_2）上，

出现黑框。选中 （Deactivate event），

右击选择 parameters 命令，弹出对话

框，在左边框中选中 ObjectLClick_2，

单击 Add按钮，单击 OK按钮。 

在 Actions 中，选中 （activate 

event），拖动到 Event map 1中，叠加

在 （ObjectLClick_2）上，出现黑框。

选中 （activate event），右击选择

parameters命令，弹出对话框，在左边

框中选中 ObjectLClick_1，单击 Add按

钮，单击 OK按钮。 

在 Event map 1 中 单 击  
（ObjectLClick_2），右击选择 Initial 

Activation，如图 41-9所示，去掉前面

的勾号。形成的 Event map 1，如图

41-10所示。 

7．保存为 kitchen.c3p，本例制作

完成。 

 

图 41-8 

 

图 41-9 

 

图 41-10 



Cult 3D产品三维演示时尚创作百例 

 
128 

实例 42  厨  柜 （二） 

 

本例制作“厨柜（二）”的效果，

如图 42-1所示。 

本例特点：单击鼠标右键，点燃火

苗，再次单击右键，火苗熄灭。 

本例通过 Start particle 和 Stop 

particle等知识完成。 

 

图 42-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 kitchen.c3p。执行 File→

Load project 命令，在对话框中选中

kitchen.c3p，如图 42-2所示。 

3．制作火焰点燃的效果。在 Scene 

Graph 中单击 Rootnode，选中  
（Cylinder20），右击选择New→Particle 

System命令。在 Scene Graph中，选择

 （Particle），如图 42-3所示，拖动

到 Event map 1中。 

在 Event map 1中单击 （Right 

mouse click on Object），拖动到右面的

空白处。单击 Actions，单击 Object 

motion 选项，选中 （Start particle 

emission），拖动到 Event map 1中，

叠加在 （ObjectRClick_1）上，出现

黑框。选中 Event map 1 中的

（Particle），叠加在 （Start particle 

emission）上，出现黑框。 

选中 （Particle），右击选择

Details 命令，弹出对话框。在 Color 

settings 中，单击左面的颜色方框可以

 

 

图 42-2 

 

图 42-3 
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选取不同的颜色，将第一段颜色设为红

色，第二段颜色设为黄色，第三段颜色

设为黄色，第四段颜色设为黄色，最后

一段的颜色设为红色，如图 42-4所示，

拖到颜色框下的三角形按钮，可以控制

每一段不同颜色持续的时间长短。 

设置 Particle settings 中的参数，

具体设置如图 42-5 所示，单击 Close

按钮完成设置。形成的 Event map 1如

图 42-6所示。 

4．制作火焰熄灭的效果。在 Event 

map 1中单击 （Right mouse click on 

Object），拖动到右面的空白处。在

Actions中，单击 Particle systems，选中

 （Stop particle emission），拖动到

Event map 1 中，并且叠加在  
（ObjectRClick_2）上，出现黑框。选

中 Event map 1中的 （particle），拖

动到  （Stop particle emission）上，

出现黑框。最后形成 Event map 1如图

42-7所示。 

5．确定点燃火焰和熄灭火焰的关

系。在 Actions中，单击 Event，选中 
（Deactivate event），拖动到 Event map 

1 中，叠加在 （ObjectRClick_1）上

面，出现黑框。选中  （Deactivate 

event），右击选择 parameters命令，弹

出对话框，如图 42-8 所示，在右边框

中选中ObjectRClick_1，单击Add按钮，

单击 OK按钮。 

在 Actions 中，选中 （activate 

event），拖动到 Event map 1中，叠加

在 （ObjectRClick_1）上，出现黑框。

选中 （activate event），右击选择

parameters命令，弹出对话框，在左边

框中选中 ObjectRClick_2，单击 Add按

钮，单击OK按钮。形成的 Event map 1，

如图 42-9所示。 

在 Actions中，单击 Event，选中 

 

图 42-4 

 

图 42-5 

 

图 42-6 

 

图 42-7 
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（Deactivate event），拖动到 Event map 

1中，叠加在 （ObjectRClick_2）上，

出现黑框。选中 （Deactivate event），

右击选择 parameters 命令，弹出对话

框，在左边框中选中 ObjectRClick_2，

单击 Add按钮，单击 OK按钮。 

在 Actions 中，选中 （activate 

event），拖动到 Event map 1中，叠加

在 （ObjectRClick_2）上，出现黑框。

选中 （activate event），右击选择

parameters命令，弹出对话框，在左边

框中选中 ObjectRClick_1，单击 Add按

钮，单击 OK按钮。 

在 Event map 1 中 选 中  
（ObjectRClick_2），右击选择 Initial 

Activation，去掉前面的勾号。形成的

Event map 1，如图 42-10所示。 

6．保存为 kitchen1.c3p，本例制

作完成。 

 

图 42-8 

 

图 42-9 

 

图 42-10 
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实例 43  电  话  机 

 

本例制作“电话机”的效果，如图

43-1所示。 

本例特点：单击鼠标左键，可以将

话筒提起；单击鼠标右键，话筒放下；

用鼠标左击电话机上的按键时，会发出

PC喇叭声。 

本例通过 System beep 等知识完

成。 

 

图 43-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 phone.C3D。选择 File→

Add Cult3D Designer File命令，在对话

框中选中 phone.C3D，如图 43-2所示。 

3．添加 Arcball。在 Event map 1

中单击 （World start），拖动到右面

的空白处。在 Actions中，单击 Object 

motion 选项，选中 （Arcball），拖

动到 Event map 1 中，叠加在  
（WorldStart_1）上，出现黑框。在 Scene 

Graph 中，单击 rootnode ，单击

（PHONE），拖动到 Event map 1中，

叠加在原来的 （Arcball）上，出现

黑框，完成的 Event map 1如图 43-3所

示。 

4．制作提起话筒的效果。在 Event 

map 1中单击 （Left mouse click on 

Object），拖动到右面的空白处。在

Actions中，单击 Object motion选项，

选中 （Rotation XYZ），拖动到 Event 

 

图 43-2 

 

图 43-3 
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map 1中，叠加在 （ObjectLClick_1）

上，出现黑框。在 Scene Graph中，单

击 RootNode，选中 （handset），拖

动到 （Rotation XYZ），出现黑框。

双击 （Rotation XYZ），弹出对话框，

具体设置如图 43-4 所示，选择 Repeat 

count 1方式，单击 Close按钮完成参数

设置。 

在 Actions中，单击 Object motion

选项，选中 （Translation XYZ），拖

动到 Event map 1 中，叠加在  
（ObjectLClick_1）上，出现黑框。选

中 Event map 1中的 （handset），拖

动到 （Translation XYZ），出现黑框。

双击 （Translation XYZ），弹出对话

框，具体设置如图 43-5 所示，选择

Repeat count 1方式，单击 Close按钮。

完成的 Event map 1如图 43-6所示。 

5．制作话筒复位的效果。在 Event 

map 1中选中 （Right mouse click on 

Object），拖动到右面的空白处。在

Actions中，单击 Object motion选项，

选中 （Reset），拖动到 Event map 1

中，叠加在 （ObjectRclick_1）上，

出现黑框。选中 Event map 1 中的

（handset），拖动到  （Reset），出

现黑框。选中 （handset），拖动到 
（ObjectRclick_1），出现黑框。最后

Event map如图 43-7所示。 

6．确定提起话筒和复位的关系。

在 Actions 中，单击 Event，选中 
（Deactivate event），拖动到 Event map 

1中，叠加在 （ObjectLClick_1）上，

出现黑框。选中 （Deactivate event），

右击选择 parameters 命令，弹出对话

框，如图 43-8 所示，在左边框中选中

ObjectLClick_1，单击 Add按钮，单击

OK 按钮。在 Actions 中，选中  
（Activate event），拖动到 Event map 1

 

图 43-4 

 

图 43-5 

 

图 43-6 

 

图 43-7 
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中，叠加在 （ObjectLClick_1）上，

出现黑框。选中 （Activate event），

右击选择 parameters 命令，弹出对话

框，在左边框中选中 ObjectRClick_1，

单击 Add按钮，单击 OK按钮。 

在 Actions中，单击 Event，选中 
（Deactivate event），拖动到 Event map 

1中，叠加在 （ObjectRClick_1）上，

出现黑框。选中 （Deactivate event），

右击选择 parameters 命令，弹出对话

框，如图 43-9 所示，在左边框中选中

ObjectRClick_1，单击 Add按钮，单击

OK 按钮。在 Actions 中，选中  
（Activate event），拖动到 Event map 1

中，叠加在 （ObjectRClick_1）上，

出现黑框。选中 （Activate event），

右击选择 parameters 命令，弹出对话

框，在左边框中选中 ObjectLClick_1，

单击 Add 按钮，单击 OK 按钮。最后

形成的 Event map，如图 43-10所示。 

7．制作 PC喇叭发声的效果来模

拟电话拨号声。在 Event map 1中选中

 （Left mouse click on Object），拖动

到右面的空白处。在 Actions中，单击

Sound，选中 （System beep），拖动

到 Event map 1 中 ， 叠 加 在  
（ObjectLclick_2）上，出现黑框。分

别 选 中 Event map 1 中 的 从

（button01）至 （button06），依次

拖动到 （ObjectLclick_2）上，出现

黑框。选中 （handset），拖动到 
（ObjectRclick_2）上，出现黑框。完

成的 Event map 1如图 43-11所示。 

8．保存为 phone.c3p，本例制作

完成。 

 

图 43-8 

 

图 43-9 

 

图 43-10 

 

图 43-11 
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实例 44  台    灯 

 

本例制作“台灯”的效果，如图

44-1所示。 

本例特点：单击鼠标左键，台灯点

亮，照亮周围的环境；再次单击，台灯

熄灭。 

本例通过 Set background等知识完

成。 

 

图 44-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 lamp.C3D。选择 File→Add 

Cult3D Designer File命令，在对话框中

选中 lamp.C3D，如图 44-2所示。 

3．添加 Arcball。在 Event map 1

中选中单击 （World start），拖动到

右面的空白处。在 Actions 中，单击

Object motion选项，选中 （Arcball），

拖动到 Event map 1 中，叠加在  
（World start）上，出现黑框。在 Scene 

Graph 中，单击 rootnode，选中  
（LAMP 3），拖动到 Event map 1中，

叠加在 （Arcball）上，出现黑框，

如图 44-3所示。 

4．制作开灯的效果。在 Event map 

1 中，选中 （Left mouse click on 

Object），拖动到右面的空白处。在

Actions中，单击 Render，选中 （Set 

background），拖动到 Event map 1中，

叠加在 （ObjectLClick_1）上，出现

黑框。双击 （Set background），弹

 

 

 

图 44-2 

 

图 44-3 
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出对话框，如图 44-4所示，选择 Type

→Linear Gradient 命令。用鼠标单击

Start Color，弹出对话框，如图 44-5所

示，选中黑色，单击 OK按钮完成设置。

选中Middle，单击Middle Color，出现

与上次一样的对话框，选中桔黄色，单

击 OK按钮完成设置。单击 End Color，

弹出与上一次一样的对话框，选中红

色，单击 OK按钮完成设置。最后形成

的效果如图 44-6所示，单击 Test按钮，

可以预览。最后单击 OK按钮，完成了

开灯的制作。 

5．制作关灯的效果。在 Event map 

1 中，选中 （Left mouse click on 

Object），拖动到右面的空白处。在

Actions中，单击 Render，选中 （Set 

background）。拖动到 Event map 1中，

叠加在 （ObjectLClick_2）上，出现

黑框。双击 （Set background），弹

出对话框，不改变 Type的类型，仍然

设置为 Solid Color，单击中间的 Color，

弹出对话框，选中黑色，单击确定按钮。

最后单击 OK 按钮，完成了关灯的制

作。 

6．制作开灯与关灯之间的关系。

在 Actions 中，单击 Event，选中 
（Deactivate event），拖动到 Event map 

1中，叠加在 （ObjectLClick_1）上，

出现黑框。选中 （Deactivate event），

右击选择 parameters 命令，弹出对话

框，如图 44-7 所示，在左边框中选中

ObjectLClick_1，单击 Add按钮，单击

OK 按钮。在 Actions 中，选中  
（Activate event），拖动到 Event map 1

中，叠加在 （ObjectLClick_1）上，

出现黑框。选中 （Activate event），

右击选择 parameters 命令，弹出对话

框，在左边框中选中 ObjectLClick_2，

单击 Add按钮，单击 OK按钮。 

 

图 44-4 

 

图 44-5 

 

图 44-6 

 

图 44-7 
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在 Actions中，单击 Event，选中 
（Deactivate event），拖动到 Event map 

1中，叠加在 （ObjectLClick_2）上，

出现黑框。选中 （Deactivate event），

右击选择 parameters 命令，弹出对话

框，在左边框中选中 ObjectLClick_2，

单击 Add 按钮，单击 OK 按钮。在

Actions中，选中 （Activate event），

拖动到 Event map 1 中，叠加在  
（ObjectLClick_2）上，出现黑框。选

中  （Activate event），右击选择

parameters命令，弹出对话框，如图 44-8

所示，在左边框中选中ObjectLClick_1，

单击 Add 按钮，单击 OK 按钮。最后

形成的 Event map 1，如图 44-9所示。 

7．保存为 lamp.c3p，本例制作完

成。 

 

图 44-8 

 

图 44-9 
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实例 45  锁 

 

本例制作“锁”的效果，如图 45-1

所示。 

本例特点：单击鼠标左键，锁会自

动锁上，单击鼠标右键，锁会自动打开。 

本例通过 Edit with Time Line 

View等知识完成。 

 

图 45-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 lock.C3D。执行 File→Add 

Cult3d Design File命令，在对话框中选

中 lock.C3D，如图 45-2所示。 

3．添加 Arcball。在 Event map 1

中，单击 （World start），拖动到右

面的空白处。在 Actions中，单击 Object 

motion 选项，选中 （Arcball），拖

动到 Event map 1中，叠加在原来的 
（World start）上，出现黑框。在 Scene 

Graph 中，单击 rootnode，选中  
（GROUP），拖动到 Event map 1中，

叠加在 （Arcball）上，出现黑框。

形成的 Event map 1如图 45-3所示。 

4．制作退出钥匙的效果。在 Event 

map 1中，单击 （Left mouse click on 

Object），拖动到右面的空白处。在

Scene Graph中，单击 rootnode，选中 
（GROUP01），拖动到 Event map 1中，

叠加在 （ObjectLClick_1）上，出现

黑框。在 Actions中，单击 Object motion

选项，选中 （Translation XYZ），拖

 

 

 

图 45-2 

 

图 45-3 
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动到 Event map 1 中，叠加在   

（ObjectLClick_1）上，出现黑框。选

中 Event map 1中的 （GROUP01），

拖动到  （Translation XYZ），出现

黑框。双击 （Translation XYZ），弹

出对话框，具体设置如图 45-4 所示，

选择 Repeat count 1方式，单击 Close

按钮完成参数设置。形成的 Event map 

1如图 45-5所示。 

5．制作插上钥匙的效果。在 Event 

map 1中，单击 （Right mouse click on 

Object），拖动到右面的空白处。在

Event map 1中，选中 （GROUP01），

拖动到 Event map 1 中，叠加在  
（ObjectRClick_1）上面，出现黑框。

在Actions中，单击Object motion选项，

选中 （Translation XYZ），拖动到

Event map 1 中 ， 叠 加 在   

（ObjectRClick_1）上，出现黑框。选

中 Event map 1中的 （GROUP01），

拖动到 （Translation XYZ），出现黑

框。双击 （Translation XYZ），弹出

对话框。在 X轴中输入�100（位移），
Time 设为 2000（毫秒），并且选择
Repeat count 1方式，单击 Close按钮完
成参数设置。形成的 Event map 1，如
图 45-6所示。 

6．制作锁柄左旋的效果。在
Actions中，单击Object motion选项，选
中 （Translation XYZ），拖动到 Event 
map 1中，叠加在  （ObjectLClick_1）
上，出现黑框。选中 Scene Graph中的 
（Loft01），拖动到 （Translation XYZ），
出现黑框。双击 （Translation XYZ），
弹出对话框。在 Z轴中输入 8（位移），
Time设为 1000（毫秒），并且选择Repeat 
count 1方式，单击 Close按钮完成参数
设置。 
在 Actions中，单击 Object motion

 

图 45-4 

 

图 45-5 

 

图 45-6 

 

图 45-7 
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选项，选中 （Rotation XYZ），拖动

到 Event map 1 中 ， 叠 加 在   

（ObjectLClick_1）上，出现黑框。选中

Event map 1中的 （Loft01），拖动到 

（Rotation XYZ），出现黑框。双击 

（Rotation XYZ），弹出对话框，具体设

置如图 45-7所示，选择 Repeat count 1

方式，单击 Close 按钮完成参数设置。

形成的 Event map 1如图 45-8所示。 

7．制作锁柄右旋的效果。在

Actions中，单击 Object motion选项，

选中 （Translation XYZ），拖动到

Event map 1 中 ， 叠 加 在   

（ObjectRClick_1）上，出现黑框。选

中 Event map 1中的 （Loft01），拖

动到 Rotation XYZ，出现黑框。双击  

Rotation XYZ，弹出对话框，具体设置

如图 45-9所示，选择 Repeat count 1方

式，单击 Close按钮完成参数设置。 

在 Actions中，单击 Object motion

选项，选中 （Rotation XYZ），拖动

到 Event map 1 中 ， 叠 加 在   

（ObjectRClick_1）上，出现黑框。选

中 Event map 1中的 （Loft01），拖

动到 （Rotation XYZ），出现黑框。

双击 （Rotation XYZ），弹出对话框，

如图 45-7所示。在 Y轴中输入 24（角

度），Time设为 1000（毫秒），并且

选择 Repeat count 1方式，单击 Close

按钮完成参数设置。形成的 Event map 

1如图 45-10所示。 

8．制作上锁柄的效果。在 Actions

中，单击 Object motion选项，选中 
（Translation XYZ），拖动到 Event map 

1中，叠加在 （ObjectLClick_1）上，

出现黑框。选中 Event map 1 中的 
（Loft01），拖动到  （Translation 

XYZ），出现黑框。双击 （Translation 

 

图 45-8 

 

图 45-9 

 

图 45-10 

 

图 45-11 
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XYZ），出现黑框。双击 （Translation 

XYZ），弹出对话框，具体设置如图

45-11所示，选择 Repeat count 1方式，

单击 Close按钮完成参数设置。形成的

Event map 1如图 45-12所示。 

9．制作开锁柄的效果。在 Actions

中，单击 Object motion选项，选中 
（Translation XYZ），拖动到 Event map 

1中，叠加在  （ObjectRClick_1）上，

出现黑框。选中 Event map 1 中的 
（Loft01），拖动到  （Translation 

XYZ），出现黑框。双击 （Translation 

XYZ），弹出对话框。在 Y 轴中输入

15（位移），Time设为 1000（毫秒），

并且选择 Repeat count 1 方式，单击

Close按钮完成参数设置。形成的 Event 

map 1如图 45-13所示。 

10．确定鼠标左键单击和右键单

击的关系。在 Actions中，单击 Event，

选中 （Deactivate event），拖动到

Event map 1 中 ， 叠 加 在  
（ ObjectLClick_1）上，出现黑框。选

中 （Deactivate event），右击选择

parameters 命令，弹出对话框，如图

45-14 所 示 ， 在 左 边 框 中 选 中

ObjectLClick_1，单击 Add按钮，单击

OK按钮。 

在 Actions 中，选中 （Activate 

event），拖动到 Event map 1中，叠加

在 （ObjectLClick_1）上，出现黑框。

选中 （Activate event），右击选择

parameters命令，弹出对话框，在左边

框中选中 ObjectRClick_1，单击 Add按

钮，单击OK按钮。形成的 Event map 1，

如图 45-15所示。 

在 Actions中，单击 Event，选中 
（Deactivate event），拖动到 Event map 

1中，叠加在 （ObjectRClick_1）上，

出现黑框。选中 （Deactivate event），

 

图 45-12 

 

图 45-13 

 

图 45-14 

 

图 45-15 
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右击选择 parameters 命令，弹出对话

框，在左边框中选中 ObjectRClick_1，

单击 Add按钮，单击 OK按钮。 

在 Actions 中，选中 （Activate 

event），拖动到 Event map 1中，叠加

在 （ObjectRClick_1）上，出现黑框。

选中 （Activate event），右击选择

parameters命令，弹出对话框。在右边

框中选中 ObjectLClick_1，单击 Add按

钮，单击OK按钮。形成的 Event map 1，

如图 45-16所示。 

11．确定各个事件发生的先后顺

序和间隔时间。动作的选后顺序为：上

锁时，锁柄左旋，上锁，退出钥匙。开

锁时，插上钥匙，开锁，锁柄右旋。 

在 Event map 1 中，选中  
（ObjectLClick_1），右击选择 Edit with 

Time Line View命令。弹出对话框，调

整各个动作发生的先后时间顺序。将

Translation XYZ（GROUP01），调整

为第 2秒的时间点开始。将 Translation 

XYZ（Loft01），调整为从第 1秒的时

间点开始。注意这里有两个 Translation 

XYZ（Loft01），按照制作的先后顺序

放置。单击右上角的 ，关闭窗口。调

整后的 Time Line View for event 

“ObjectLClick_1”如图 45-17所示。  

在 Event map 1 中，选中

（ObjectRClick_1），右击选择 Edit with 

Time Line View命令。弹出对话框，调

整各个动作发生的先后时间顺序。将

Rotation XYZ（Loft01），调整为第 3

秒的时间点开始。将 Translation XYZ

（Loft01），调整为从第。秒的时间点

开始。将下一个 Translation XYZ

（Loft01），调整为从第。秒的时间点

开始。单击右上角的 ，关闭窗口。调

整后的 Time Line View for event 

“ObjectRClick_1”如图 45-18所示。 

12．保存为 lock.c3p，本例制作完成。 

 

图 45-16 

 

 

图 45-17 

 

 

图 45-18 
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实例 46  时  钟 （一） 

 

本例制作“时钟（一）”的效果，

如图 46-1所示。 

本例特点：单击鼠标左键，时钟开

始走动，再次单击左键，时钟停止走动。 

本例通过物体间的包含关系和

Left mouse click on Object等知识完成。 
 

图 46-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 Timer.C3D。执行 File→

Add Cult3d Design File命令，在对话框

中选中 Timer.C3D，如图 46-2所示。 

3．添加 Arcball。在 Event map 1

中，单击 （World start），拖动到右

面的空白处。在 Actions中，单击 Object 

motion 选项，选中 （Arcball），拖

动到 Event map 1中，叠加在原来的 
（World start）上，出现黑框。在 Scene 

Graph 中，单击 rootnode，选中  
（Group），拖动到 Event map 1中，

叠加在 （Arcball）上，出现黑框。

形成的 Event map 1如图 46-3所示。 

4．制作时针和分针的包含关系。

由于 （Sphere01）和 （Sphere02）

的坐标不是设在想要的点上，所以要将

时针和分针分别包含在中间的  
（Sphere01）和 （Sphere03）中，这

里 （Sphere01）和 （Sphere03）是

同一物体，是在 3DS MAX中 copy的。

 

 

 

图 46-2 

 

图 46-3 
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在 Scene Graph中，单击 rootnode，选

中 （Line01），拖动到 （Sphere01）

上，出现黑色。选中 （Line02），拖

动到 （Sphere03），出现黑色。这时

的 Scene Graph如图 46-4所示。 

5．制作分针走动的效果。在 Event 

map 1中，单击 （Left mouse click on 

Object），拖动到右面的空白处。在

Actions中，单击 Object motion选项，

选中 （Rotation XYZ），拖动到 Event 

map 1中，叠加在  （ObjectLClick_1）

上，出现黑框。在 Scene Graph中，单

击 rootnode，选中 （Sphere01），拖

动到 （Rotation XYZ），出现黑框。

双击 （Rotation XYZ），弹出对话框，

具体设置如图 46-5所示，选择 Loop方

式，单击 Close按钮完成参数设置。 

6．制作时针走动的效果。在

Actions中，单击 Object motion选项，

选中 （Rotation XYZ），拖动到 Event 

map 1中，叠加在  （ObjectLClick_1）

上，出现黑框。在 Scene Graph中，单

击 rootnode，选中 （Sphere03），拖

动到 （Rotation XYZ）上，出现黑框。

双击 （Rotation XYZ），弹出对话框。

在 Z轴中输入�1（角度），Time设为
1000（毫秒），并且选择 Loop方式，
单击 Close按钮完成参数设置。形成的
Event map 1如图 46-6所示。 

7．制作分针停止的效果。在 Event 
map 1中，单击 （Left mouse click on 
Object），拖动到右面的空白处。在
Actions中，单击 Object motion选项，
选中 （Rotation XYZ），拖动到 Event 
map 1中，叠加在 （ObjectLClick_2）
上，出现黑框。在 Event map 1中，选
中 （Sphere01），拖动到 （Rotation 
XYZ），出现黑框。双击 （Rotation 
XYZ），弹出对话框，具体设置如图

 

图 46-4 

 

图 46-5 

 

图 46-6 
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46-7所示，并且选择 Loop方式，单击

Close按钮完成参数设置。 

8．制作时针停止的效果。在

Actions中，单击 Object motion选项，

选中 （Rotation XYZ），拖动到 Event 

map 1中，叠加在  （ObjectLClick_2）

上，出现黑框。在 Scene Graph中，单

击 rootnode，选中 （Sphere03），拖

动到 （Rotation XYZ），出现黑框。

双击 （Rotation XYZ），弹出对话框。

在 Z 轴中输入 1（角度），Time 设为

1000（毫秒），并且选择 Loop方式，

单击 Close按钮完成参数设置。形成的

Event map 1如图 46-8所示。  

9．确定时钟走动和停止的关系。

在 Actions 中，单击 Event，选中 
（Deactivate event），拖动到 Event map 

1中，叠加在 （ ObjectLClick_1）上，

出现黑框。选中 （Deactivate event），

右击选择 parameters 命令，弹出对话

框，如图 46-9 所示，在左边框中选中

ObjectLClick_1，单击 Add按钮，单击

OK 按钮。在 Actions 中，选中  
（Activate event），拖动到 Event map 1

中，叠加在 （ObjectLClick_1）上，

出现黑框。选中 （Activate event），

右击选择 parameters 命令，弹出对话

框，在左边框中选中 ObjectLClick_2，

单击 Add 按钮，单击 OK 按钮。形成

的 Event map 1如图 46-10所示。 

在 Actions中，单击 Event，选中 
（Deactivate event），拖动到 Event map 

1中，叠加在 （ObjectLClick_2）上，

出现黑框。选中 （Deactivate event），

右击选择 parameters 命令，弹出对话

框，在左边框中选中 ObjectLClick_2，

单击 Add 按钮，单击 OK 按钮。在

Actions中，选中 （Activate event），

拖动到 Event map 1 中，叠加在  

 

图 46-7 

 

图 46-8 

 

图 46-9 

 

图 46-10 
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（ObjectLClick_2）上，出现黑框。选

中  （Activate event），右击选择

parameters 命令，弹出对话框，如图

46-11 所 示 ， 在 左 边 框 中 选 中

ObjectLClick_1，单击 Add按钮，单击

OK 按钮。形成的 Event map 1 如图

46-12所示。 

10．保存为 Timer.c3p，本例制作

完成。 

 

图 46-11 

 

图 46-12 
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实例 47  时  钟 （二） 

 

本例制作“时钟（二）”的效果，

如图 47-1所示。 

本例特点：按“Enter”键可以调

整时间，释放“Enter”键可以停止调

整时间。 

本例通过 KeyBoard�s key press和
KeyBoard�s key release等知识完成。 

 

图 47-1  效果图 

 

 

1．启动 Cult 3D。 
2．装载 timer.c3p。执行 File→Load 

project 命 令 ， 在 对 话 框 中 选 中
timer.c3p，如图 47-2所示。 

3．制作调整时钟的效果。在 Event 
map 1 中，单击 （KeyBoard�s key 
press），拖动到右面的空白处。在
Actions中，单击 Object motion选项，
选中 （Rotation XYZ），拖动到 Event 
map 1中，叠加在 （KeyPress_1）上，
出现黑框。选中 Event map 1 中的 
（Sphere01），拖动到  （Rotation 
XYZ），出现黑框。双击 （Rotation 
XYZ），弹出对话框，具体设置如图
47-3所示，选择 Loop方式，单击 Close
按钮完成参数设置。 
在 Actions中，单击 Object motion

选项，选中 （Rotation XYZ），拖动
到 Event map 1 中 ， 叠 加 在
（KeyPress_1）上，出现黑框。选中
Event map 1中的 （Sphere03），拖

 

 

 

图 47-2 

 

 

图 47-3 
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动到 （Rotation XYZ），出现黑框。

双击 （Rotation XYZ），弹出对话框。

在 Z轴中输入�3（角度），Time设为
1000（毫秒），并且选择 Loop方式，
单击 Close按钮完成参数设置。形成的
Event map 1如图 47-4所示。 

4．制作停止调整时钟的效果。在
Event map 1中，单击 （KeyBoard�s 
key release），拖动到右面的空白处。
在Actions中，单击Object motion选项，
选中 （Rotation XYZ），拖动到 Event 
map 1中，叠加在 （KeyRelease_1）
上，出现黑框。选中 Event map 1中的 
（Sphere01），拖动到  （Rotation 
XYZ），出现黑框。双击 （Rotation 
XYZ），弹出对话框，具体设置如图
47-5所示，选择 Loop方式，单击 Close
按钮完成参数设置。 
在 Actions中，单击 Object motion

选项，选中 （Rotation XYZ），拖动
到 Event map 1 中 ， 叠 加 在
（KeyRelease _1）上，出现黑框。选中
Event map 1中的 （Sphere03），拖
动到 （Rotation XYZ）上，出现黑框。
双击 （Rotation XYZ），弹出对话框。
在 Z 轴中输入 3（角度），Time 设为
1000（毫秒），并且选择 Loop方式，
单击 Close按钮完成参数设置。形成的
Event map 1，如图 47-6所示。 

5．保存为 Timer2.c3p，本例制作
完成。 

 

图 47-4 

 

图 47-5 

 

图 47-6 
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实例 48  座    钟 

 

本例制作“座钟”的效果，如图 48-1

所示。 

本例特点：单击键盘的 Arrow Left

和 Arrow Right改变视角。 

本例通过 Select camera和 Stop�等
知识完成。 

 

图 48-1  效果图 

 

 

1．启动 Cult 3D。 
2．装载 Clock.C3D。执行 File→Add 

Cult3D Designer File命令，在对话框中
选中 Clock.C3D，如图 48-2所示。 

3．设定视角的效果。在 Event Map1
窗口中单击 （World Start），拖到右
侧的空白处。在 Actions中选中 （Select 
camera），拖到 （World Start_1）上，
出现黑框。在 Scene Graph 中选中
（Right view），拖到 （Select camera）
上，出现黑框。效果如图 48-3所示。 

4．制作旋转视角的效果。在 Event 
map中单击 （Keyboard�s key press），
拖动两次到右面的空白处。双击

（KeyPress_1），弹出对话框，在左边
的边框中选中 Arrow Left，单击 Add按
钮，单击OK按钮。双击 （KeyPress_2），
弹出对话框，在左边的边框中选中

Arrow Right，单击 Add按钮，单击 OK
按钮。在 Action中单击 Object motion选
项，选中 （Rotation XYZ），拖动两
次到 Event map 1 中，分别叠加在

 

 

 

图 48-2 

 

图 48-3 
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（KeyPress_1）和 （KeyPress_2）上面，

出现黑框。单击 RootNode，选中  
（Clock），拖到 Event map 1中，叠加

在两个 （Rotation XYZ）上，出现黑

框。双击 （KeyPress_1）的 （Rotation 

XYZ），弹出对话框，具体设置如图 48-4

所示，选择 Loop方式，单击 Close按钮

完成。双击 （ KeyPress_2）的  
（Rotation XYZ），弹出对话框，具体

设置如图 48-5 所示，选择 Loop 方式，

单击 Close按钮完成。在 Event map 1中

单击 （Keyboard�s key release），拖动
两 次 到 右 面 的 空 白 处 。 双 击

（KeyRelease_1），弹出对话框，在左
边的边框中选中 Arrow Left，单击 Add
按 钮 ， 单 击 OK 按 钮 。 双 击
（KeyRelease_2），弹出对话框，在左
边的边框中选中 Arrow Right，单击 Add
按钮，单击 OK按钮。在 Actions中，选
中 （Stop�），拖动两次到 Event map 
1中，分别叠加在 （KeyRelease_1）和
（KeyRelease_2）上，出现黑框。选
中  （Clock），拖动叠加到两个
（ Stop�）上，出现黑框。双击
（KeyRelease_1）的 （Stop�），出
现对话框如图 48-6 所示。在左边选择
KeyPress_1.Rotation XYZ，单击 ，单
击 Close按钮。双击 （KeyRelease_2）
中的 （Stop�），出现对话框如图 48-7
所示。在左边选择 KeyPress_2.Rotation 
XYZ，单击 ，单击 Close按钮。 

5．制作指针转动的效果。在 Action
中单击 Object motion 选项，选中  
（Rotation XYZ），按住并拖动两次到
Event map 1中，叠加在 （World Start）
上，出现黑框。选中 （Line101）拖动
到 （Rotation XYZ）上，出现黑框。
双击 （Rotation XYZ），在对话框的 Z
轴输入-360，Time输入 60000（毫秒）。

 

图 48-4 

 

图 48-5 

 

 

图 48-6 

 

 

图 48-7 
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选择 Loop方式，单击 OK按钮。选中 
（Line102）拖动到 （Rotation XYZ）

上出现黑框。双击 （Rotation XYZ），

在对话框的 Z 轴输入-360，Time 输入

3600000（毫秒）。选择 Loop方式，单

击 OK按钮。完成效果如图 48-8所示 

6．保存为 Clock.c3p，本例制作完

成。 

 

图 48-8 
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实例 49  书本和书皮 

 

本例制作“书本和书皮”的效果，如

图 49-1所示。 

本例特点：单击鼠标左键，书本会放

入书皮，再单击左键，书本取出。 

本例通过 Translation，Active event

和 Deactive event等知识完成。 

 

图 49-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 book.C3D。选择 File→Add 

Cult3D Designer File命令，在对话框中选

中 book.C3D，如图 49-2所示。 

3．添加 Arcball。在 Event map 1中，

单击 （World start），拖动到右面的空

白处。在 Actions中，单击 Object motion

选项，选中 （Arcball），拖动到 Event map 

1 中，叠加在原来的 （World start）上

面，出现黑框。在 Scene Graph中，单击

RootNode，选中 （BOOK），拖动到

Event map 1中，叠加在 （Arcball）上

面，出现黑框。形成的 Event map 1如图

49-3所示。 

4．制作放入书本的效果。在 Event 

map 1 中，单击 （Left mouse click on 

Object），拖动到右面的空白处。在 Actions

中，单击 Object motion 选项，选中 
（Translation XYZ），拖动到 Event map 1

中，叠加在 （ObjectLClick_1）上，出

现黑框。在 Scene Graph 中，单击

RootNode，单击 （ChamferBox04），

 

 

图 49-2 

 

图 49-3 
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拖动到 （Translation XYZ）上，出现黑

框。单击 （ChamferBox05），拖动到 
（Translation XYZ）上，出现黑框。双击

  Translation XYZ，弹出对话框，具体

设置如图 49-4所示，选择 Repeat count 1

方式，单击 Close按钮完成参数设置。形

成的 Event map 1，如图 49-5所示。 

5．制作放回书本的效果。在 Event 

map 1 中，单击 （Left mouse click on 

Object），拖动到右面的空白处。在 Actions

中，单击 Object motion 选项，选中 
（Translation XYZ），拖动到 Event map 1

中，叠加在 （ObjectLClick_2）上，出

现黑框。选中 Event map 1 中的  
（Chamfer04），拖动到 （Translation 

XYZ），出现黑框。选中 Event map 1中

的 （Chamfer05），拖动到 （Translation 

XYZ），出现黑框。双击  Translation 

XYZ，弹出对话框。在 X 轴中输入�115
（位移），Time 设为 1000（毫秒），并
且选择 Repeat count 1 方式，单击 Close
按钮完成参数设置。形成的 Event map 1，
如图 49-6所示。 

6．确定取出和放回书本的关系。在
Actions中，单击 Event，选中 （Deactivate 
event），拖动到 Event map 1中，叠加在 
（ObjectLClick_1）上，出现黑框。选中 
（Deactivate event），右击选择 parameters
命令，弹出对话框，如图 49-7所示，在左
边框中选中 ObjectLClick_1，单击 Add按
钮，单击 OK按钮。在 Actions中，选中 
（activate event），拖动到 Event map 1中，
叠加在 （ObjectLClick_1）上，出现黑
框。选中 （activate event），右击选择
parameters 命令，弹出对话框，在左边框
中选中 ObjectLClick_2，单击 Add按钮，
单击 OK按钮。形成的 Event map 1，如图
49-8所示。 
在 Actions 中，单击 Event，选中 

 

图 49-4 

 

图 49-5 

 

图 49-6 

 

图 49-7 
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（Deactivate event），拖动到 Event map 1

中，叠加在 （ObjectLClick_2）上，出

现黑框。选中 （Deactivate event），右

击选择 parameters命令，弹出对话框，在

左边框中选中 ObjectLClick_2，单击 Add

按钮，单击 OK 按钮。在 Actions 中，选

中 （activate event），拖动到 Event map 

1中，叠加在 （ObjectLClick_2）上，出

现黑框。选中 （activate event），右击

选择 parameters命令，弹出对话框，在左

边框中选中 ObjectLClick_1，单击 Add按

钮，单击 OK按钮。形成的 Event map 1，

如图 49-9所示。 

7．保存为 book.c3p，本例制作完成。 

 

图 49-8 

 

图 49-9 
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实例 50  桌子和椅子 

 

本例制作“桌子和椅子”的效果，

如图 50-1所示。 

本例特点：用鼠标左击要移动的椅

子，椅子会从桌子底下移出，再次单击，

椅子复位。 

本例通过 Translation，Active event

和 Deactive event等知识完成。 

 

图 50-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 table.C3D。选择 File→Add 

Cult3D Designer File命令，在对话框中

选中 table.C3D，如图 50-2所示。 

3．添加 Arcball。在 Event map 1

中，单击 （World start），拖动到右

面的空白处。在 Actions中，单击 Object 

motion 选项，选中 （Arcball），拖

动到 Event map 1中，叠加在原来的 
（WorldStart_1）上，出现黑框。在 Scene 

Graph 中，单击 RootNode，选中  
（table），拖动到 Event map 1中，叠

加在 （Arcball）上，出现黑框。形

成的 Event map 1如图 50-3所示。 

4．制作椅子移出的效果。在 Event 

map 1中，单击 （Left mouse click on 

Object），拖动到右面的空白处。在

Actions中，单击 Object motion选项，

选中 （Translation XYZ），拖动到 Event 

map 1中，叠加在 （ObjectLClick_1）

上，出现黑框。在 Scene Graph中，单

 

图 50-2 

 

图 50-3 
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击 RootNode，单击 （CADJANT03），

拖动到 （Translation XYZ）上，出现

黑框。在 Event map 1 中单击  
（ CADJANT03 ） ， 拖 动 到  

（ObjectLClick_1）上，出现黑框。双

击  Translation XYZ，弹出对话框，

具体设置如图 50-4 所示，选择 Repeat 

count 1方式，单击 Close按钮。形成的

Event map 1如图 50-5所示。 

5．制作椅子移回的效果。在 Event 

map 1中，单击 （Left mouse click on 

Object），拖动到右面的空白处。在

Actions中，单击 Object motion选项，

选中 （Translation XYZ），拖动到 Event 

map 1中，叠加在 （ObjectLClick_2）

上，出现黑框。选中 Event map 1中的 
（ CADJANT03 ） ， 拖 动 到  
（Translation XYZ），出现黑框。选中

Event map 1中的 （CADJANT03），

拖动到 （ObjectLClick_2），出现黑

框。双击 （Translation XYZ），弹出

对话框。在 Z 轴中输入�1（位移），
Time 设为 1000（毫秒），并且选择
Repeat count 1方式，单击 Close按钮。
形成的 Event map 1如图 50-6所示。 

6．确定移出和移回椅子的关系。
在 Actions 中，单击 Event，选中 
（Deactivate event），拖动到 Event map 
1 中，叠加在 （ObjectLClick_1）上
面，出现黑框。选中  （Deactivate 
event），右击选择 parameters命令，弹
出对话框，如图 50-7 所示，在左边框
中选中ObjectLClick_1，单击Add按钮，
单击 OK按钮。在 Actions中，选中 
（activate event），拖动到 Event map 1
中，叠加在 （ObjectLClick_1）上，
出现黑框。选中 （activate event），
右击选择 parameters 命令，弹出对话
框，在左边框中选中 ObjectLClick_2，

 

图 50-4 

 

图 50-5 

 

图 50-6 

 

图 50-7 
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单击 Add 按钮，单击 OK 按钮。形成

的 Event map 1，如图 50-8所示。 

在 Actions中，单击 Event，选中 
（Deactivate event），拖动到 Event map 

1中，叠加在 （ObjectLClick_2）上，

出现黑框。选中 （Deactivate event），

右击选择 parameters 命令，弹出对话

框，在左边框中选中 ObjectLClick_2，

单击 Add 按钮，单击 OK 按钮。在

Actions中，选中 （activate event），

拖动到 Event map 1 中，叠加在  
（ObjectLClick_2）上，出现黑框。选

中  （ activate event），右击选择

parameters命令，弹出对话框，在左边

框中选中 ObjectLClick_1，单击 Add按

钮，单击OK按钮。形成的 Event map 1，

如图 50-9所示。 

对 于 其 他 三 个 椅 子  
（CADJANT04）、 （CADJANT05）

和 （CADJANT06）用同样的方法制

作如上的效果。最后形成的 Event map 

1如图 50-10所示。 

7．保存为 table.c3p，本例制作完

成。 

 

图 50-8 

 

图 50-9 

 

图 50-10 
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实例 51  旋 转 座 椅 

 

本例制作“旋转座椅”的效果，如

图 51-1所示。 

本例特点：按“1”、“2”、“3”

键座椅还颜色，Arrow Up 和 Arrow 

Down键控制座椅旋转。 

本例通过 Hide Object 和 Unhide 

Object等知识完成。 

 

图 51-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 dental.C3D。执行 File→Add 

Cult3D Designer File命令，在对话框中

选中 dental.C3D，如图 51-2所示。 

3．设定视角和旋转视角的效果。在

Event Map1中单击 （World Start），

拖到右侧的空白处。在 Actions 中单击

Camera，选中 （Select camera），拖

到 Event map 1 中，叠加在 （World 

Start_1）上，出现黑框。在 Scene Graph

窗口中选中 （Right view），拖到 Event 

map 1中，叠加在 （Select camera）上

出现黑框。在 Actions 中单击 Object 

motion选项，选中 （Rotation XYZ），

拖动到 Event map 1中，叠加在 （World 

Start_1）上，出现黑框。在 Scene Graph

中选中  （dental），拖动叠加在  
（Rotation XYZ）上，出现黑框。双击

的 （Rotation XYZ），弹出对话框，

具体设置如图 51-3 所示，选择 Repeat 

count方式，单击 Close按钮完成。Event 

 

 

 

图 51-2 

 

 

图 51-3 
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map 1效果如图 51-4所示。 

4．制作变换座椅色彩的效果。在

Actions 中单击 Render，选中 （Hide 

Object），拖动到 Event map 1中，叠加

在 （World Start_1），出现黑框。双

击 （Hide Object），出现对话框如图

51-5所示，选择 Apply to child，单击 OK

按钮。在 Scene Graph 窗口中，拖动 
（Chair1）和 （Chair2）叠加到 （Hide 

Object）上出现黑框。 

在 Event map 1 中 单 击

（Keyboard�s key press），拖动到右面的
空白处。双击 （KeyPress_1），弹出
对话框，在左边的边框中选中 1，单击
Add 按钮，单击 OK 按钮。在 Actions
中单击 Render，选中 （Hide Object），
拖动到 Event map 1 中，叠加在
（KeyPress_1）上面，出现黑框。双击
（Hide Object），出现对话框，选择 Apply 
to child，单击 OK按钮。在 Scene Graph
窗口中，拖动 （Chair）和 （Chair2）
叠加到 （Hide Object）上出现黑框。
在 Actions 中单击 Render，选中
（Unhide Object），拖动到 Event map 1
中，叠加在 （KeyPress_1），出现黑
框。双击 （Unhide Object），出现对
话框如图 51-5所示，选择Apply to child，
单击 OK 按钮。拖动 （Chair1）叠加
到 （Unhide Object）上出现黑框。Event 
map 1效果如图 51-6所示。 
在 Event map 1 中 单 击
（Keyboard�s key press），拖动到右面的
空白处。双击 （KeyPress_2），弹出
对话框，在左边的边框中选中 2，单击
Add 按钮，单击 OK 按钮。在 Actions
中单击 Render，选中  （Hide Object），
拖动到 Event map 1 中，叠加在
（KeyPress_2）上面，出现黑框。双击
（Hide Object），出现对话框，选择 Apply 

 

图 51-4 

 

 

 

图 51-5 

 

 

图 51-6 
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to child，单击 OK按钮。拖动 （Chair）

和 （Chair1）叠加到 （Hide Object）

上，出现黑框。在Actions中单击 Render，

选中 （Unhide Object），拖动到 Event 

map 1中，叠加在 （KeyPress_2），出

现黑框。双击 （Unhide Object），出

现对话框，选择 Apply to child，单击 OK

按钮。拖动 （Chair2）叠加到 （Unhide 

Object）上，出现黑框。Event map 1效

果如图 51-7所示。 

在 Event map 1 中 单 击

（Keyboard�s key press），拖动到右面的
空白处。双击 （KeyPress_3），弹出
对话框，在左边的边框中选中 3，单击
Add 按钮，单击 OK 按钮。在 Actions
中单击 Render，选中 （Hide Object），
拖动到 Event map 1 中，叠加在
（KeyPress_3）上，出现黑框。双击
（Hide Object），出现对话框，选择 Apply 
to child，单击 OK按钮。拖动 （Chair1）
和 （Chair2）叠加到 （Hide Object）
上，出现黑框。在Actions中单击 Render，
选中 （Unhide Object），拖动到 Event 
map 1中，叠加在 （KeyPress_3）上，
出现黑框。双击 （Unhide Object），
出现对话框，选择 Apply to child，单击
OK 按钮。拖动 （Chair）叠加到
（Unhide Object）上，出现黑框。Event 
map 1效果如图 51-8所示。 

5．制作座椅转动的效果。在 Event 
map 1中单击 （Keyboard�s key press），
拖动两次到右面的空白处。双击

（KeyPress_4），弹出对话框，在左边
的边框中选中 Arrow Down，单击 Add
按 钮 ， 单 击 OK 按 钮 。 双 击
（KeyPress_5），弹出对话框，在左边
的边框中选中Arrow Up，单击Add按钮，
再单击 OK按钮。在 Actions窗口中，单
击 Object motion选项，选中 （Rotation 

 

图 51-7 

 

图 51-8 

 

图 51-9 

 

图 51-10 
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XYZ），拖动两次到 Event map 1中，分

别 叠 加 在 （ KeyPress_4 ） 和

（KeyPress_5）上面，出现黑框。选中 
（Chair）、 （Chair1）和 （Chair2），

分别拖动叠加在两个 （Rotation XYZ）

上面，出现黑框。双击 （KeyPress_4）

的 （Rotation XYZ），弹出对话框，

具体设置如图 51-9 所示，选择 Repeat 

count方式，单击 Close按钮完成。双击

（KeyPress_5）的 （Rotation XYZ），

弹出对话框，具体设置如图 51-10所示，

选择 Repeat count方式，单击 Close按钮

完成。完成效果图如图 51-11所示 

6．保存为 DRLPRESS.c3p，本例制

作完成。 

 

 

图 51-11 
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实例 52  书    桌 

 

本例制作“书桌”的效果，如图 52-1

所示。 

本例的特点是：用鼠标左键单击物

体，被选中的物体会消失，单击右键所

有物体再次显示。 

本例通过Hide Object、Unhide Object

以及 和 等知识完成。 

 

图 52-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 desk.C3D。选择 File→Add 

Cult3D Designer File命令，在出现的对

话框中选中 desk.C3D，如图 52-2所示。 

3．添加 Arcball。在 Event map 1中，

单击 （World start），拖动到右面的空

白处。在 Actions 窗口中，单击 Object 

motion 选项，选中 （Arcball），拖动

到 Event map 1 中，叠加在 （World 

Start_1）上面，出现黑框。在 Scene Graph

中，单击 RootNode选，选中 （desk），

拖动到 Event map 1 中，叠加在  
（Arcball）上面，出现黑框。效果如图

52-3所示。 

4．制作鼠标左键单击效果。在 Event 

map 1中，单击 （Left mouse click on 

Object），拖动到右面的空白处。在

Actions窗口中，单击 Render选项，选中

（Hide Object），如图 52-4所示，拖

动到 Event map 1 中，叠加在  
（ObjectLClick_1）上，出现黑框。在

 

图 52-2 

 

图 52-3 

 

图 52-4 
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Scene Graph中，单击 （Box01），拖

动到 Event map 1 中，分别叠加在 
（ObjectLClick_1）和 （Hide Object）

上，出现黑框。将其他的 （Box02）、

（Box18）和 （Box23），也按上述

方法制作。形成的 Event map 1如图 52-5

所示。 

在此不能用相同方法来制作 。在

Event map 1中，单击 （Left mouse click 

on Object），拖动到右面的空白处。在

Actions窗口中，单击Render选项，选中

（Hide Object）。拖动到 Event map 1中，

叠加在 （ObjectLClick_5）上，出现黑

框。在 Scene Graph中，单击 （skuffe1），

拖动到Event map 1中的 （Hide Object）

上，出现黑框。这里看到 （skuffe1）

是不能叠加到 （ObjectLClick_5）上的。 

单击 （Hide Object），右击选择

Details命令，弹出对话框，如图 52-6所

示，选中 Apply to child 选项。这样

（Hide Object）才会对 （skuffe1）内

包含的子体起作用。用同样的方法制作

 （skuffe2），形成的 Event map 1如图

52-7所示。 

5．制作鼠标右键单击效果。在 Event 

map 1中，单击 （Right mouse click on 

Object），拖动到右面的空白处。在Actions

窗口中，单击Render选项，选中 （Unhide 

Object），叠加在 Evnet map 1 中的  

（ObjectRClick_1）上，出现黑框。在

Scene Graph中，选中 （desk），叠加

到 （Unhide Object）上，出现黑框。

选中 （Hide Object），右击选择 Details

命令，弹出对话框，选中 Apply to child

选项。最后形成的 Event map 1如图 52-8

所示。 

6．保存为 desk.c3p，本例制作完成。 

 

图 52-5 

 

图 52-6 

 

图 52-7 

 

图 52-8 
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实例 53  计  算  机 

 

本例制作“计算机”的效果，如图

53-1所示。 

本例特点：初始时，计算机会转动

180°，用鼠标左键单击计算机，计算

机屏幕上的字体会消失，再次单击，字

体出现。 

本例通过 Hide Object 和 Unhide 

Object等知识完成。 

 

图 53-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 computer.C3D。选择 File

→Add Cult3D Designer File命令，在对

话框中选中 computer.C3D，如图 53-2

所示。 

3．添加 Arcball。在 Event map 1

中，单击 （World start），拖动到右

面的空白处。在 Actions中，单击 Object 

motion 选项，选中 （Arcball），拖

动到 Event map 1中，叠加在原来的 
（WorldStart_1）上面，出现黑框。在

Scene Graph中，单击 RootNode，选中

 （computer），拖动到 Event map 1

中，叠加在 （Arcball）上面，出现

黑框。形成的 Event map 1如图 53-3所

示。 

4．制作开始时计算机旋转 180°

的效果。因为在 3DS MAX输出时，计

算机的背面作为主视图，需要将它转过

来。在 Actions中，单击 Object motion

 

图 53-2 

 

图 53-3 
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选项，选中 （Rotation XYZ），拖动

到 Event map 1 中 ， 叠 加 在  
（WorldStart_1）上面，出现黑框。选

中 Event map 1中的 （computer），

拖动到 （Rotation XYZ）上面，出现

黑框。双击 （Rotation XYZ），弹出

对话框，具体设置如图 53-4 所示，选

择 Repeat count方式，执行 1次，单击

Close按钮完成参数设置。形成的 Event 

map 1，如图 53-5所示。 

5．制作隐藏字体的效果。在 Event 

map 1中，单击 （Left mouse click on 

Object），拖动到右面的空白处。在

Actions中，单击 Render，选中 （Hide 

Object），拖动到 Event map 1中，叠

加在 （ObjectLClick_1）上，出现黑

框。在 Scene Graph中，单击 RootNode，

单击 （www.eskpe.），拖动到 （Hide 

Object），出现黑框。形成的 Event map 

1，如图 53-6所示。 

6．制作显示字体的效果。在 Event 

map 1中，单击 （Left mouse click on 

Object），拖动到右面的空白处。在

Actions 中，单击 Render，选中

（Unhide Object），拖动到 Event map 1

中，叠加在 （ObjectLClick_2）上，

出现黑框。在 Event map 1中，单击 
（www.eskpe.），拖动到 （Unhide 

Object）上面，出现黑框。形成的 Event 

map 1，如图 53-7所示。 

7．确定隐藏和显示字体的关系。

在 Actions 中，单击 Event，选中 
（Deactivate event），拖动到 Event map 

1 中，叠加在 （ObjectLClick_1）上

面，出现黑框。选中  （Deactivate 

event），右击选择 parameters命令，弹

出对话框，如图 53-8 所示，在左边框

中选中ObjectLClick_1，单击Add按钮，

单击 OK按钮。在 Actions中，选中 

 

图 53-4 

 

图 53-5 

 

图 53-6 

 

图 53-7 
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（activate event），拖动到 Event map 1

中，叠加在 （ObjectLClick_1）上，

出现黑框。选中 （activate event），

右击选择 parameters 命令，弹出对话

框，在左边框中选中 ObjectLClick_2，

单击 Add 按钮，单击 OK 按钮。形成

的 Event map 1，如图 53-9所示。 

在 Actions中，单击 Event，选中 
（Deactivate event），拖动到 Event map 

1中，叠加在 （ObjectLClick_2）上，

出现黑框。选中 （Deactivate event），

右击选择 parameters 命令，弹出对话

框，在左边框中选中 ObjectLClick_2，

单击 Add 按钮，单击 OK 按钮。在

Actions中，选中 （activate event），

拖动到 Event map 1 中，叠加在  
（ObjectLClick_2）上，出现黑框。选

中  （ activate event），右击选择

parameters命令，弹出对话框，在左边

框中选中 ObjectLClick_1，单击 Add按

钮，单击OK按钮。形成的 Event map 1，

如图 53-10所示。 

8．保存为 computer.c3p，本例制

作完成。 

 

图 53-8 

 

图 53-9 

 

图 53-10 
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实例 54  键    盘 

 

本例制作“键盘”的效果，如图

54-1所示。 

本例特点：按空格键时，模型上的

空格键会按下，并且 PC喇叭会发声，

释放空格键时，模型上的空格键还原。 

本例通过 System beep，KeyBoard�s 
key press和 KeyBoard�s key release等
知识完成。 

 

图 54-1  效果图 

 

 

1．启动 Cult 3D。 
2．装载 keyboard.C3D。执行 File
→Add Cult3D Designer File命令，在对
话框中选中 keyboard.C3D，如图 54-2
所示。 

3．添加 Arcball。在 Event map 1
中，单击 （World Start），拖动到右
面的空白处。在 Actions中，单击 Object 
motion 选项，选中 （Arcball），拖
动到 Event map 1中，叠加在 （World 
Start_1）上，出现黑框。在 Scene Graph
中，单击RootNode，选中 （keyboard），
拖动到 Event map 1 中，叠加在 
（Arcball）上，出现黑框。效果如图
54-3所示。 

4．制作键盘按下的效果。在 Event 
map 1 中选中 （Keyboard�s key 
Press），拖动到右面的空白处，双击
（KeyPress_1），弹出对话框，在左边
框中选中“Space”，单击 Add按钮，

 

图 54-2 

 

图 54-3 
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添加到右边框，单击 OK按钮。 

在 Actions中，单击 Object motion

选项，选中 （Translation XYZ），拖

动到 Event map 1 中，叠加在

（KeyPress_1）上，出现黑框。选中

Event map 1中的 （Capsule75），拖

动到 （Translation XYZ），出现黑框。

双击 （Translation XYZ），弹出对话

框，具体设置如图 54-4 所示，选择

Repeat count 1方式，单击 Close按钮。

形成的 Event map 1如图 54-5所示。 

在 Event map 1 中，选中

（Keyboard�s key Release），拖动到右
面的空白处，双击 （KeyRelase_1），
弹出对话框，如图 54-6 所示，在左边
框中选中 Space，单击 Add按钮，添加
到右边框，单击 OK按钮完成。 
在 Actions中，单击 Object motion

选项，选中 （Translation XYZ），拖
动到 Event map 1 中，叠加在
（KeyRelase_1）上，出现黑框。选中
Event map 1中的 （Capsule75），拖
动到 （Translation XYZ）上，出现黑
框。双击 （Translation XYZ），弹出
对话框。在 Z轴中输入 4（位移），Time
设为 0（毫秒），选择 Repeat count 1
方式，单击 Close按钮完成参数设置。
形成的 Event map 1如图 54-7所示。 

5．制作按下键时发声的效果。在
Actions中，单击 Sound，选中 （System 
beep），拖动到 Event map 1中，叠加
在 （KeyPress_1）上，出现黑框。最
后形成的 Event map 1如图 54-8所示。 

6．保存为 keyboard.c3p，本例制
作完成。 

 

图 54-4 

 

图 54-5 

 

图 54-6 

 

图 54-7 

 

图 54-8 
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实例 55  算    盘 

 

本例制作“算盘”的效果，如图 55-1

所示。 

本例特点：用鼠标左键单击需要旋转

的数字或者符号，会旋转 60°，换成另

一个数字或者符号显示。 

本例通过 Rotation等知识完成。 

 

图 55-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 abacus.C3D。选择 File→Add 

Cult3D Designer File命令，在对话框中选

中 abacus.C3D，如图 55-2所示。 

3．添加 Arcball。在 Event map 1中

单击 （world start），拖动到右面的空

白处。在 Actions中，单击 Object motion

选项，选中 （Arcball），拖动到 Event 

map 1中，叠加在 （worldStart_1）上，

出现黑框。在 Scene Graph 中，单击

rootnode，选中 （abacus），拖动到 Event 

map 1中，叠加在 （Arcball）上，出现

黑框，形成的 Event map 1，如图 55-3所

示。 

4．建立互相包含的关系。激活 View1

左上角的两个小窗口 Show axes和 Show 

bounding box，这样可以显示所选中物体

的坐标轴和边缘框。将第一个

（Ngon01）上面的 （Text13）、

（Text18）、 （Text27）、 （Text32）、

（Text33）和 （Text38）拖动到

（Ngon01）下，如图 55-5所示。. 

 

图 55-2 

 

图 55-3 

 

图 55-4 
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对于其他的 （Ngon02）、

（Ngon03）、 （Ngon04）和 （Ngon05）

按照上面的方法，同样将表面上的对象拖

动到它的目录下。 

5．制作旋转效果。在 Event map 1

中，单击 （Left mouse click on Object），

拖动到右面的空白处。在 Actions中，单

击 Object motion选项，选中 （Rotation 

XYZ），拖动到 Event map 1中，叠加在

 （ObjectLClick_1）上面，出现黑框。

选中 Scene Graph中的 （Ngon01），拖

动到 （Rotation XYZ），出现黑框。选

中 Event map 1中的 （Ngon01），拖动

到 （ObjectLClick_1）上，出现黑框。

双击 （Rotation XYZ），弹出对话框，

具体设置如图 55-6 所示，选择 Repeat 

count 1 方式，单击 Close 按钮。形成的

Event map 1如图 55-7所示。 

对于其他的 （Ngon02）、

（Ngon03）、 （Ngon04）和 （Ngon05）

按照上面的方法同样制作效果。形成的

Event map 1，如图 55-8所示。 

6．保存为 abacus.c3p，本例制作完

成。 

 

图 55-5 

 

图 55-6 

 

图 55-7 

 

图 55-8 
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实例 56  电    扇 

 

本例制作“电扇”的效果，如图

56-1所示。 

本例的特点：用鼠标单击电扇上左

按钮电扇开启；单击中间按钮，电扇关

闭，单击右按钮电扇摇头。 

本 例 通 过 Rotation XYZ 和

Translation XYZ等知识完成。 

 

图 56-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 ventilator.C3D。执行 File

→Add Cult3D Designer File命令，在对

话框中选中 ventilator.C3D，如图 56-2

所示。 

3．确定包含关系。在 Scene Graph

中，右击 RootNode，单击 New�→
Dummy命令，建立 （Dummy）。右
击 （Dummy），选择 Change name
命令，在弹出对话框的文本框中键入

Group_All，单击 OK按钮。分别选中 
（AbgekZyl01）、 （AbgekZyl02）、

 （AbgekZyl03）、 （Line01）和 
（Group_Head）拖动到 （Dummy）
上，出现黑色框，最后形成的包含关系

如图 56-3所示。 
4．添加 Arcball。在 Event Map1
窗口中单击 （World Start），拖到右
侧的空白处。在 Actions窗口中，单击
Object Motion，选中 （Arcball），拖
到 Event map 1中，叠加在 （World 

 

图 56-2 

 

 

图 56-3 
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Start）上，出现黑框。在 Scene Graph

窗口中，单击 RootNode，选中  
（Group_All），拖到 Event map 1中，

叠加在 （Arcball）上，出现黑框。 

5．制作电扇增速启动的效果。在

Event map 1中单击 （Left mouse click 

on Object），拖动到右面的空白处。在

Actions 窗口中，选中  （Rotation 

XYZ），拖动到 Event map 1中，叠加

在 （ObjectLClick_1）上，出现黑框。

选中 Event map 1中的 （Group_fan），

拖动到 （Rotation XYZ），出现黑框。

双击 （Rotation XYZ），弹出对话框，

单击 Y轴上的 ，选择 ，如图 56-4

所示。单击 Set按钮，出现对话框。在

Waveform type中选择 Sawtooth up方

式。在 Sustain 中和 Global parameters

中进行参数修改，如图 56-5 所示。单

击 Close 按钮。在 Actions窗口中，选

中 （Rotation XYZ），拖动到 Event 

map 1中，叠加在 （ObjectLClick_1）

上，出现黑框。选中 （Group_fan），

拖动到 （Rotation XYZ），出现黑框。

双击 （Rotation XYZ），弹出对话框，

数值设置如图 56-6所示。选择 Loop方

式，单击 Close 按钮完成。选中  
（ObjectLClick_1），右击选择 Edit with 

Time Line View 命令，出现如图 56-7

所示对话框，将下面的  （Rotation 

XYZ）的时间拖动到上面的 （Rotation 

XYZ）后面。选中 Event map 1中的 
（ AbgekZyl01 ） ， 拖 动 到  
（ObjectLClick_1），出现黑框。完成

效果如图 56-8所示。 

6．制作电扇停止的效果。在 Event 

map 1中单击 （Left mouse click on 

Object），拖动到右面的空白处。在

Actions 窗口中，选中  （Rotation 

XYZ），拖动到 Event map 1中，叠加

 

图 56-4 

 

图 56-5 

 

图 56-6 

 

图 56-7 

 

图 56-8 
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在 （ObjectLClick_2）上，出现黑框。

选中  （Group_fan），拖动到  
（Rotation XYZ），出现黑框。双击 
（Rotation XYZ），弹出对话框，数值

修改如图 56-9所示。选择 Loop方式，

单击 Close按钮完成。选中 Event map 1

中的  （AbgekZyl02），拖动到  
（ObjectLClick_2），出现黑框。 

7．制作电扇摇头的效果。在 Event 

map 1中单击 （Left mouse click on 

Object），拖动到右面的空白处。选中

Event map 1中的 （AbgekZyl03），

拖到 （Left mouse click on Object）上，

出现黑框。单击 Object Motion，选中  

（Translation XYZ），拖到 Event map 1

中，叠加在 （ObjectLClick_3）上，

出现黑框。选中 Event map 1 中的 
（Line04），拖到  （Translation XYZ）

上面，出现黑框。双击  （Translation 

XYZ），弹出对话框，数值设置如图

56-10所示，选择 Repeat count方式，

单击 Close按钮完成。在 Actions窗口

中，选中 （Rotation XYZ），拖动到

Event map 1 中 ， 叠 加 在  
（ObjectLClick_3）上，出现黑框。选

中 Event map 1中的 （Group_Head），

拖动到 （Rotation XYZ），出现黑框。

双击 （Rotation XYZ），弹出对话框，

单击 Z轴上的 ，选择 ，如图 56-11

所示，单击 Set，出现对话框。在

Waveform type 中选择 Sine 方式。在

Sustain 和 Global parameters 中修改参

数，如图 56-12所示，选择 Loop方式，

单击 Close 按钮。完成效果如图 56-13

所示。 

8．保存为 ventilator.c3p，本例制

作完成。  

 

图 56-9 

 

图 56-10 

 

图 56-11 

 

图 56-12 

 

图 56-13 
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实例 57  复 印 机 （一） 

 

本例制作“复印机（一）”的效果，

如图 57-1所示。 

本例特点：用键盘上的“←”键和

“→”键控制视角，用鼠标单击相应

物体，来模拟将纸张放入复印机的效

果。 

本 例 通 过 Activate event 和

Deactivate event等知识完成。 

 

图 57-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 Xerox5310.C3D。执行 File

→Add Cult3D Designer File命令，在对

话框中选中 Xerox5310.C3D，如图 57-2

所示。 

3．制作旋转视角的效果。在 Event 

map中单击 （Keyboard�s key press），
拖动到右面的空白处。双击

（KeyPress_1），弹出对话框，选中
Arrow Left单击 Add按钮，添加到右边
框，单击 OK按钮。在 Actions中选中 
（Rotation XYZ），拖动到 Event map 1
中，叠加在 （KeyPress_1）上，出现
黑框。在 Scene Graph 中，单击
RootNode，选中 （Xerox5310），拖
到 Event map 1中，叠加在 （Rotation 
XYZ）上，出现黑框。双击 （Rotation 
XYZ），弹出对话框，具体设置如图
57-3所示，选择 Repeat count方式，单
击 Close按钮。在 Event map中单击

Keyboard�s key press

 

 

 

图 57-2 

 

 

图 57-3 
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（Keyboard�s key press），拖动到右面
的空白处。双击 （KeyPress_2），弹
出对话框，选中左边框中的 Arrow 
Right，单击 Add按钮，单击 OK按钮。
在 Actions中选中 （Rotation XYZ），
拖动到 Event map 1 中，叠加在
（KeyPress_2）上，出现黑框。选中 
（Xerox5310），拖动叠加在 （Rotation 
XYZ）上面，出现黑框。双击 （Rotation 
XYZ），弹出对话框，具体设置如图
57-4所示，选择 Repeat count方式，单
击 Close按钮。效果如图 57-5所示。 

4．添加 Arcball。在 Event Map1
中单击 （World Start），拖到右侧的
空白处。在 Actions 中单击 Object 
Motion，选中 （Arcball），拖到 Event 
map 1中，叠加在 （World Start_1）
上，出现黑框。在 Scene Graph中单击
RootNode，选中 （Xerox5310），拖
到 Event map 1中，叠加在 （Arcball）
上，出现黑框。效果如图 57-6所示。 

5．制作放入纸张的效果。在 Event 
map 中单击 （Left mouse click on 
Object），拖动到右面的空白处。在
Scene Graph窗中选择 （Paper），拖
动叠加到 （ObjectLClick_1）上，出
现黑框。在 Actions中选中 （Rotation 
XYZ），拖动到 Event map 1中，叠加
在 （ObjectLClick_1）上，出现黑框。
选中  （ Paper），拖动叠加在  
（Rotation XYZ）上，出现黑框。双击
 （Rotation XYZ），弹出对话框，具
体设置如图 57-7 所示，选择 Repeat 
count 方式，单击 Close 按钮完成。在
Event map 1中单击 （Left mouse click 
on Object），拖动到右面的空白处。在
Scene Graph中选中 （Paper01），拖
动叠加到 （ObjectLClick_2）上，出
现 黑 框 。 在 Actions 中 选 中  
（Translation XYZ），拖动到 Event map 

 

图 57-4 

 

图 57-5 

 

图 57-6 

 

图 57-7 
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1中，叠加在 （ObjectLClick_2）上，

出现黑框。选中 （Paper01），拖动

叠加在 （Translation XYZ）上，出现

黑框。双击 （Translation XYZ），弹

出对话框，具体设置如图 57-8 所示，

选择 Repeat count方式，单击 Close按

钮完成。在 Event map 1中单击 （Left 

mouse click on Object），拖动到右面的

空白处。选中 （Paper），拖动叠加

到 （ObjectLClick_3）上，出现黑框。

在 Actions中选中 （Rotation XYZ），

拖动到 Event map 1 中，叠加在  
（ObjectLClick_3）上，出现黑框。选

中 （Paper），拖动叠加在 （Rotation 

XYZ）上，出现黑框。双击 （Rotation 

XYZ），弹出对话框，具体设置如图
57-9所示，选择 Repeat count方式，单

击 Close按钮。效果如图 57-10所示。 

6．确定各事件之间的关系。分别

右 击  （ ObjectLClick_2 ） 和  
（ObjectLClick_3），选择不要 Initial 

Activation。单击 Event，选中 （activate 

event），拖动到 Event map 1中，叠加

在 （ObjectLClick_1）上，出现黑框。

将 （ObjectLClick_2）拖动到 （activate 

event）上，出现黑框。单击 Event，选中

 （activate event），拖动到 Event map 1

中，叠加在 （ObjectLClick_2）上，出

现黑框。将 （ObjectLClick_3）拖动到

 （activate event）上，出现黑框。单

击 Event，选中 （Deactivate event），

分别拖动到 Event map 1中，叠加在 
（ObjectLClick_1）、 （ObjectLClick_2）

和  （ObjectLClick_3）上，出现黑框。

将 （ObjectLClick_1）、 （ObjectLClick_2）

和 （ObjectLClick_3）分别拖动到 
（Deactivate event）上，出现黑框。完

成效果如图 57-11所示。 

7．保存为 Xerox5310.c3p，本例

制作完成。 

 

图 57-8 

 

图 57-9 

 

图 57-10 

 

图 57-11 
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实例 58  复 印 机 （二） 

 

本例制作“复印机（二）”的效果，

如图 58-1所示。 

本例的特点：鼠标单击按钮，开始

复印。 

本例通过 Hide Object、Unhide 

Object、Activate event 和 Deactivate 

event等知识完成。 

 

图 58-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 Xerox5310.c3p（源文件）。

执行 File→Load project 命令，在对话

框中选中 Xerox5310.c3p，如图 58-2所

示。 

3．制作进纸效果。在 Event map 1

中单击 （Left mouse click on Object），

拖动到右面的空白处。在 Scene Graph

窗口中，拖动 （Shape15）叠加到 
（ObjectLClick_4）上，出现黑框。在

Actions中选中 （Translation XYZ），

拖动到 Event map 1 中，叠加在  
（ObjectLClick_4）上，出现黑框。在

Scene Graph中，选中 （Paper03），

叠加到 （Translation XYZ）上，出现

黑框。双击 （Translation XYZ），弹

出对话框，具体设置如图 58-3 所示，

选择 Repeat count方式，单击 Close按

钮完成。Event map 1效果如图 58-4所

示。 

4．制作出纸的效果。在 Event map1

 

 

 

图 58-2 

 

图 58-3 
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中单击 （Timer），拖动到右面的空

白处。选中 （Timer_1），右击选择

不 要 Initial Activation 。 双 击

（Timer_1），出现对话框，填入 2000

（ms），单击 OK按钮。单击 Event，

选中 （Deactivate event），拖动到

Event map 1中，叠加在 （Timer_1）

上，出现黑框。选中 （Timer_1），

拖动叠加到 （Deactivate event）上，

出现黑框。在 Actions 中，选中  
（Translation XYZ），拖动到 Event map 

1 中，叠加在 （Timer_1）上，出现

黑框。在 Scene Graph窗口中，选中 
（Paper02），拖动叠加在 （Translation 

XYZ ） 上 ， 出 现 黑 框 。 双 击  
（Translation XYZ），弹出对话框，具

体设置如图 58-5 所示，选择 Repeat 

count 方式，单击 Close 按钮完成。效

果如图 58-6所示。 

5．制作隐藏纸张的效果。在

Actions中单击 Render，选中 （Hide 

Object），拖动到 Event map 1中，叠

加在 （World Start_1），出现黑框。

拖动  （Paper02）叠加到 （Hide 

Object）上出现黑框。在 Actions 中单

击 Render，选中 （Unhide Object），

拖动到 Event map 1 中，叠加在

（Timer_1）上，出现黑框。拖动 
（Paper02）叠加到 （Unhide Object）

上，出现黑框。在 Actions 中单击

Render，选中 （Hide Object），拖动

到 Event map 1 中 ， 叠 加 在  
（ObjectLClick_4）上，出现黑框。拖

动 （Paper03）叠加到 （Hide Object）

上，出现黑框。完成效果如图 58-7 所

示。 

6．确定各事件之间的关系。右击 
（ObjectLClick_4），选择不要 Initial 

Activation。单击 Event，选中 （activate 

 

图 58-4 

 

图 58-5 

 

图 58-6 

 

图 58-7 
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event），拖动到 Event map 1中，叠加

在 （ObjectLClick_3）上，出现黑框。

将  （ ObjectLClick_4）拖动到  
（activate event）上，出现黑框。单击

Event，选中 （activate event），拖动

到 Event map 1 中 ， 叠 加 在  
（ObjectLClick_4）上，出现黑框。将 
（ObjectLClick_3）拖动到 （Timer_1）

上，出现黑框。单击 Event，选中 
（Deactivate event），拖动到 Event map 

1中，叠加在 （ObjectLClick_4）上，

出现黑框。将 （ObjectLClick_4）拖

动到 （Deactivate event）上，出现黑

框。完成效果如图 58-8所示。 

7．设定时间关系。选中  
（ObjectLClick_1）右击，选择 Edit with 

Time Line View命令，出现对话框，将

Activate event 的起始时间拖动到

Rotation XYZ的结束时间处，如图 58-9

所示。选中 （ObjectLClick_2），鼠

标右键单击 （ObjectLClick_2），选

择 Edit with Time Line View，出现对话

框，将 Activate event的起始时间拖动

到 Translation XYZ的结束时间处，如

图58-10所示。选中 （ObjectLClick_3）

右击，选择 Edit with Time Line View命

令，出现对话框，将 Activate event的

起始时间拖动到 Rotation XYZ的结束

时间处，如图 58-11 所示。选中  
（ObjectLClick_4）右击，选择 Edit with 

Time Line View命令，出现对话框，将

Activate event和 Hide Object的起始时

间拖动到 Translation XYZ的结束时间

处，如图 58-12所示。 

8．保存为 Xerox5310-1.c3p，本例

制作完成。 

 

图 58-8 

 

 

图 58-9 

 

 

图 58-10 

 

 

图 58-11 

 

 

图 58-12 
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实例 59  咖  啡  机 

 

本例制作“咖啡机”的效果，如图

59-1所示。 

本例特点：鼠标单击杯盖，盖子合

上，单击杯子，杯子放入咖啡机。咖啡

自动流出，直至充满杯子。 

本例通过 Hide Object 、Unhide 

Object 、 Sequence actions 和 Stop 

Sequence actions等知识完成。 

 

图 59-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 Clock.C3D。执行 File→Add 

Cult3D Designer File命令，在对话框中

选中 Cafemake.C3D，如图 59-2所示。 

3．添加 Arcball。在 Event Map1中

单击 （World Start），拖到右侧的空

白处。在 Actions中，单击 Object Motion，

选中 （Arcball），拖到 Event map 1

中，叠加在 （World Start）上，出现

黑框。在 Scene Graph中，单击 Rootnode，

选中 （Group_All），拖到 Event map 1

中，叠加在 （Arcball）上，出现黑框。

效果如图 59-3所示。 

4．制作关上杯盖的效果。在 Event 

map 中单击  （Left mouse click on 

Object），拖动到右面的空白处。在 Scene 

Graph 窗口中，找到 （couvercle），

拖动到 （ObjectLClick_1）上，出现黑

框。单击 Object motion，选中 （Rotation 

XYZ），拖动到 Event map 1中，叠加在

 

图 59-2 

 

图 59-3 
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  （ObjectLClick_1）上，出现黑框。

拖动  （ couvercle）到  （Rotation 

XYZ），出现黑框。双击 （Rotation 

XYZ），弹出对话框，具体设置如图 59-4

所示，选择 Repeat count方式，单击 Close

按钮完成。 

5．制作放入杯子的效果。在 Event 

map 1 中单击 （Left mouse click on 

Object），拖动到右面的空白处。在 Scene 

Graph中，找到 （caffetiere），拖动到

 （ObjectLClick_2）上，出现黑框。单

击 Object motion 选 项 ， 选 中  
（Translation XYZ），拖动到 Event map 

1中，叠加在  （ObjectLClick_1）上，

出现黑框。拖动  （caffetiere）到  
（Translation XYZ），出现黑框。双击 
（Translation XYZ），弹出对话框，具

体设置如图 59-5所示，选择 Repeat count

方式，单击 Close 按钮完成。效果如图

59-6所示。 

6．制作两者之间的关系。右击 
（ObjectLClick_2），选择不要 Initial 

Activation。在Actions中单击 Event，选中

 （Deactivate event），拖动两次到 Event 

map 1中，叠加在 （ObjectLClick_1）和

 （ObjectLClick_2）上，出现黑框。选

中  （ ObjectLClick_1 ） 和  
（ObjectLClick_2），拖动分别叠加到 
（Deactivate event）上出现黑框。单击

Event，选中 （activate event），拖动到

Event map 1中，叠加在 （ObjectLClick_1）

上，出现黑框。拖动 （ObjectLClick_2）

到 （activate event）上，出现黑框。完

成效果如图 59-7所示。 

7．制作咖啡隐藏的效果。在 Scene 

Graph 中找到  （Cylinder01）至  
（Cylinder08），分别拖动到 （caffetiere）

上，出现黑框。形成关系图如图 59-8所

示。在 Actions 中单击 Render，选中

 

图 59-4 

 

 

图 59-5 

 

图 59-6 
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第四篇  日常用品篇 

 
181 

（Hide Object），拖动到 Event map 1中，

叠加在 （World Start_1）上面，出现

黑框。分别拖动 （Cylinder01）至 
（Cylinder08）到 （Hide Object）上，

出现黑框。 

8．制作咖啡流出的效果。在 Event 

map中单击 （Timer），拖动到右面的

空白处。选中 （Timer_1），右击选择

不 要 Initial Activation 。 双 击

（Timer_1），出现对话框，填入 2000

（ms），单击 OK按钮。单击 Event，选

中 （Deactivate event），拖动到 Event 

map 1中，叠加在 （Timer_1）上，出

现黑框。选中 （Timer_1），拖动叠加

到 （Deactivate event）上出现黑框。

单击 Event，选中 （activate event），

拖动到 Event map 1 中，叠加在  
（ObjectLClick_2）上，出现黑框。将

（Timer_1）拖动到 （activate event）

上出现黑框。在 Actions 中选中

（Sequence actions）拖动到 （Timer_1）

上，出现黑框。单击 Object motion选项，

选中 （Translation XYZ），拖动到 Event 

map 1中，叠加在 （Sequence actions）

上，出现黑框。拖动 （Sphere01）到 
（Translation XYZ），出现黑框。双击 
（Translation XYZ），弹出对话框，具

体设置如图 59-9所示，选择 Repeat count

方式，单击 Close按钮。在 Actions中选

中 （Reset），拖动叠加在 （Sequence 

actions）上，出现黑框。拖动 （Sphere01）

到 （Reset）上出现黑框。完成效果如

图 59-10所示。 

9．制作杯子中咖啡增多的效果。在

Actions中单击 Render，选中 （Unhide 

Object），拖动到 Event map 1中，叠加

在 （Timer_1）上，出现黑框。拖动 
（Cylinder01）叠加到 （Unhide Object）

上，出现黑框。在 Event map中单击

 

图 59-8 

 

图 59-9 
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图 59-11 
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（Timer），拖动到右面的空白处。选中

（Timer_2），单击右键选择不要 Initial 

Activation。双击 （Timer_1），出现

对话框，填入 2000（ms），单击 OK按

钮。单击 Event，选中 （activate event），

拖动到 Event map 1 中，叠加在

（ Timer_1）上，出现黑框。将

（Timer_2）拖动到 （activate event）

上，出现黑框。在Actions中单击 Render，

选中 （Unhide Object），拖动到 Event 

map 1中，叠加在 （Timer_2）上，出

现黑框。拖动 （Cylinder02）叠加到

（Unhide Object）上出现黑框。按同样

的 方 法 为  （ Cylinder03 ） 至  
（Cylinder08）制作 （Timer_3）至

（Timer_8）。完成效果如图 59-11所示。

在 Actions 中选中 （Stop Sequence  

actions），拖动到 （Timer_8）上，出

现黑框，选中 （Sequence actions）拖

动到 （Stop Sequence  actions）上，

出现黑框。完成效果图如图 59-12所示。 

10．保存为 Cafemake.c3p，本例制

作完成。 

 

 

 

 

图 59-12 

 



 

 

本篇介绍如何制作各种家庭音响物品。

本篇继续从人们熟悉的生活用品入手，例如

留声机、收录机、CD播放机等人们耳熟能详的物

体。通过大量丰富的实例，综合 Cult 3D 的各项功

能，制作出各项逼真的 3D效果。通过本篇的学习，

读者可以基本掌握 Cult 3D 基本使用技巧。

音  响  篇 

 

 



Cult 3D产品三维演示时尚创作百例 

 
184 

实例 60  留  声  机（一） 

 

本例制作“留声机（一）”的效果

图，如图 60-1所示。 

本例的特点：用鼠标单击左键开始

播放，单击右键停止播放。 

本例通过 Play sound和 Stop sound

等知识完成。 
 

图 60-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 altai.C3D。执行 File→Add 

Cult3D Designer File命令，在对话框中

选中 altai.C3D，如图 60-2所示。 

3．添加 Arcball。在 Event Map1

中单击 （World Start），拖到右侧的

空白处。在 Actions 中单击 Object 

Motion，选中 （Arcball），拖到 Event 

map 1中，叠加在 （World Start）上面，

出现黑框。在 Scene Graph 中单击
RootNode，选中 （Group_All），拖到
Event map 1中，叠加在 （Arcball）

上，出现黑框。效果如图 60-3所示。 

4．制作播放停止音乐的效果。在
Event map 1中单击 （Left mouse click 

on Object），拖动到右面的空白处。在
Actions 中单击 Sound，选中 （Play 

sound），拖到 Event map 1中，叠加在

 （ObjectLClick_1）上，出现黑框。

选择 View→Sounds 命令，出现如图
60-4 所示对话框，单击 Add 按钮，在

对话框中选中 original_1.wav。关闭此

对话框。在 Scene Graph 中，单击

 

 

 

图 60-2 

 

图 60-3 
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Sounds，选中 （ original_1） ，拖

到 Event map 1 中，叠加在 （Play 

sound）上面，出现黑框。在 Scene Graph

中 ， 依 次 单 击 RootNode 、  
（Group_All）、 （buttons），选中 
（Rectangle01） ，拖到 Event map 1

中，叠加在 （ObjectLClick_1）上，

出现黑框。在 Event map 1 中单击 
（Left mouse click on Object），拖动到

右面的空白处。在 Actions 中单击
Sound，选中 （Stop sound），拖到
Event map 1 中 ， 叠 加 在  
（ObjectLClick_2）上，出现黑框。选

中 （ original_1），拖到 Event map 1

中，叠加在  （Stop sound）上，出

现黑框。在 Scene Graph 中依次单击
RootNode、 （Group_All）、 （buttons），

选中 （Rectangle02），拖到 Event map 

1中，叠加在 （ObjectLClick_2）上，

出现黑框。效果如图 60-5所示。 

5．制作按钮上下运动效果。单击
Object Motion，选中  （Translation 

XYZ），拖到 Event map 1中，叠加在

 （ObjectLClick_1）上，出现黑框。

选 中  （ Rectangle01），拖到   

（Translation XYZ）上，出现黑框。双

击  （Translation XYZ），弹出对话

框，数值设置如图 60-6 所示，选择
Repeat count方式，单击 Close按钮完

成。单击 Object Motion，选中   

（Translation XYZ），拖到 Event map 1

中，叠加在 （ObjectLClick_1）上，

出现黑框。选中 （Rectangle02），拖

到  （Translation XYZ）上，出现黑

框。双击  （Translation XYZ），弹

出对话框，数值设置如图 60-7 所示，

选择 Repeat count方式，单击 Close按

钮完成。单击 Object Motion，选中  

（Translation XYZ），拖到 Event map 1

中，叠加到 （ObjectLClick_2）上，

 

图 60-4 
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出现黑框。选中 （Rectangle02），拖

到 （Translation XYZ）上，出现黑框。

双击 （Translation XYZ），弹出对话

框，数值设置如图 60-8 所示，选择
Repeat count方式，单击 Close按钮完

成。单击 Object Motion，选中   

（Translation XYZ），拖到 Event map 1

中，叠加在 （ObjectLClick_2）上，

出现黑框。选中 （Rectangle01），拖

到  （Translation XYZ）上，出现黑

框。双击 （Translation XYZ），弹出

对话框，数值设置如图 60-9 所示，选

择 Repeat count方式，单击 Close按钮

完成。完成效果图，如图 60-10所示。 

6．设定按钮之间的关系。在
Actions中单击Event，选中 （Deactivate 

event），拖动到 Event map 1中，叠加在

 （ObjectLClick_1）上，出现黑框。

选中 （ObjectLClick_1），拖动叠加

到 （Deactivate event）上，出现黑框。

右击 （ObjectLClick_2），选择不要
Initial Activation。在 Actions 中单击
Event，选中 （Deactivate event），拖

动到 Event map 1 中，叠加在

（ObjectLClick_2）上，出现黑框。选

中 （ObjectLClick_2），拖动叠加到 
（Deactivate event）上，出现黑框。在
Actions中单击 Event，选中 （activate 

event），拖动到 Event map 1中，叠加

在 （ObjectLClick_1）上，出现黑框。

将  （ ObjectLClick_2）拖动到  
（activate event）上，出现黑框。选中 
（activate event），拖动到 Event map 1

中，叠加在  （ObjectLClick_2）上，

出现黑框。将  （ObjectLClick_1）拖

动到 （activate event）上，出现黑框。

完成效果如图 60-11所示。 

7．保存为 altai.c3p，本例制作完

成。 

 

图 60-8 

 

图 60-9 
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实例 61  留  声  机（二） 

 

本例制作“留声机（二）”的效果，

如图 61-1所示。 

本例的特点：用鼠标单击留声机左

键，探针转到唱片上，唱片开始转动，

播放声音；单击留声机右键，探针移开

同时停止播放，最后唱片停止转动。 

本例通过 Rotation XYZ等知识完

成。 

 

 

图 61-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 altai.c3p（源文件）。执

行 File→Load project 命令，在对话框

中选中 altai.c3p，如图 61-2所示。 

3．制作唱片旋转效果。单击 Object 

motion选项，选中 （Rotation XYZ），

拖动到 Event map 1 中，叠加在  
（ObjectLClick_1）上，出现黑框。在

Scene Graph中单击 RootNode，单击 
（ Group_All ） ， 选 中  
（  Cylinder01:1），  拖动叠加到  
（Rotation XYZ），出现黑框。双击 
（Rotation XYZ），弹出对话框，具体

设置如图 61-3所示，选择 Loop方式，

单击 Close 按钮完成。单击 Object 

motion选项，选中 （Rotation XYZ），

拖动到 Event map 1 中，叠加在  
（ObjectLClick_2）上，出现黑框。选

中 （ Cylinder01:1），拖动叠加到 
（Rotation XYZ）上，出现黑框。双击

 

 

 

 

图 61-2 

 

 

图 61-3 
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 （Rotation XYZ），弹出对话框，具

体设置如图 61-4所示，选择Loop方式，

单击 Close 按钮完成。完成效果如图

61-5所示。 

4．调整归属关系。在 Scene Graph

中单击 RootNode 选项，单击  
（Group_All），找到 （Group01），

单 击 RootNode ， 依 次 单 击  
（Group_All）、 （Cone01:1），找到

 （  needlemaster01 ） ， 选 中  
（ Group01 ） ， 拖 动 叠 加 到   

（ needlemaster01）上，出现黑框。完

成后如图 61-6所示。 

5．制作探头水平移动的效果。单

击Object motion选项，选中 （Rotation 

XYZ），拖动到 Event map 1中，叠加

在 （ObjectLClick_1）上，出现黑框。

在 Scene Graph中单击 RootNode，单击

 （Group_All），选中 （Cone01:1）， 

拖动叠加到 （Rotation XYZ）上，出

现黑框。双击 （Rotation XYZ），弹

出对话框，具体设置如图 61-7 所示，

选择 Repeat count方式，单击 Close按

钮完成。单击 Object motion 选项，选

中 （Rotation XYZ），拖动到 Event 

map 1中，叠加在 （ObjectLClick_2）

上，出现黑框。选中 （Cone01:1），

拖动叠加到 （Rotation XYZ），出现

黑框。双击 （Rotation XYZ），弹出

对话框，具体设置如图 61-8 所示，选

择 Repeat count方式，单击 Close按钮

完成。 

6．制作探头竖直移动的效果。在

Actions 中选中 （Rotation XYZ），

拖动到 Event map 1 中，叠加在  
（ObjectLClick_1）上，出现黑框。选中

Event map 1中的 （needlemaster01），

拖动到 （Rotation XYZ）上，出现黑

框。双击 （Rotation XYZ），弹出对
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话框，单击 X轴上的 ，选择 ，图

61-9所示。单击 Set，出现对话框。在

Waveform type 中选择 Sine 方式。在

Sustain 和 Global parameters 中修改参

数，如图 61-10所示。单击 Close按钮。

在 Actions中选中 （Rotation XYZ），

拖动到 Event map 1 中，叠加在  
（ObjectLClick_2）上，出现黑框。选

中 Event map 1中的 needlemaster 01，

拖动到 （Rotation XYZ），出现黑框。

双击 （Rotation XYZ），弹出对话框。

单击 X 轴上的 ，选择 ，单击 Set

出现对话框。参数设置与上面完全一

致，单击 Close按钮。完成效果图如图

61-11所示。 

7．设定时间关系。选中  
（ObjectLClick_1），右击选择 Edit with 

Time Line View命令，出现对话框如图

61-12 所示，将倒数第三个 Rotation 

XYZ（唱片旋转）的起始时间拖动到后

两个 Rotation XYZ（探针移动）的结束

时间上面。将 Play sound的起始时间拖

动到唱片旋转的第一个循环的结束时

间后面。选中 （ObjectLClick_2），

右击选择 Edit with Time Line View命

令，出现对话框如图 61-13所示，将倒

数第三个 Rotation XYZ（唱片停止旋

转）的开始时间拖动到后两个 Rotation 

XYZ（探针移开）的结束时间之后。 

8．保存为 altai 1.c3p，本例制作

完成。 

 

图 61-9 

 

图 61-10 

 

图 61-11 

 

图 61-12 

 

图 61-13 
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实例 62  收  录  机（一） 

 

本例制作“收录机（一）”的效果，

如图 62-1所示。 

本例特点：用鼠标单击黑色按钮控

制播放音乐；单击绿色按钮控制磁带盒

的开合。 

本例通过 Play sound和 Stop sound

等知识完成。 

 

图 62-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 Radio.C3D。执行 File→

Add Cult3D Designer File命令，在对话

框中选中 Radio.C3D，如图 62-2所示。 

3．添加 Arcball、确定视角。在

Event Map1中单击 （World Start），

拖到右侧的空白处。在 Actions中单击

Object Motion，选中 （Arcball），拖

到 Event map 1中，叠加在 （World 

Start_1）上。在 Scene Graph 中，单击

RootNode，选中 （Group_All），拖到

Event map 1中，叠加在 （Arcball）上。

在 Actions 中，单击 Camera，选中

（Select camera），拖到 Event map 1中，

叠加在 （World Start）上，出现黑框。

在 Scene Graph中选中 （Front view），

拖到 Event map 1中，叠加在 （Select 

camera）上。效果如图 62-3所示。 

4．制作磁带盒开合的效果。在
Event map中单击 （Left mouse click 

on Object），拖动到右面的空白处。在

 

图 62-2 

 

图 62-3 

 

图 62-4 
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Scene Graph中，选中 （Box14:1）拖

动叠加到 （ObjectLClick_1）上。在
Actions中，选中 （Rotation XYZ），

拖动到 Event map 1 中，叠加在  
（ObjectLClick_1）上。在 Scene Graph

中 ， 单 击 RootNode ， 选 中  
（Group12:1），拖到 Event map 1中，

叠加在 （Rotation XYZ）上。双击 
（Rotation XYZ），弹出对话框，具体

设置如图 62-4所示，选择 Repeat count

方式，单击 Close按钮，效果如图 62-5

所示。在 Event Map1 窗口中单击

（Right mouse click on Object），拖到

右侧的空白处。拖动 （Box14:1）叠

加到 （ObjectRClick_1）上。在 Actions

中，选中 （Rotation XYZ），拖动到
Event map 1 中 ， 叠 加 在

（ ObjectRClick_1 ） 上 。 选 中  
（Group12:1），拖动叠加在 （Rotation 

XYZ）上。双击 （Rotation XYZ），

弹出对话框，具体设置如图 62-6所示，

选择 Repeat count方式，单击 Close按

钮完成。效果如图 62-7所示。 

5．设置开合关系。右击

（ObjectRClick_1），选择不要 Initial 

Activation。单击 Event，选中 （activate 

event），拖动到 Event map 1中，叠加

在  （ ObjectLClick_1）上。将

（ObjectRClick_1）拖动到 （activate 

event）上。单击 Event，选中  
（Deactivate event），拖动到 Event map 

1中，叠加在 （ObjectLClick_1）上。

将  （ ObjectLClick_1）拖动到  
（Deactivate event）上。单击 Event，

选中 （Deactivate event），拖动到
Event map 1 中 ， 叠 加 在

（ ObjectRClick_1 ） 上 。 将

（ ObjectRClick_1 ） 拖 动 到  
（Deactivate event）上。效果如图 62-8

所示。 

 

图 62-5 

 

图 62-6 

 

图 62-7 

 

图 62-8 
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6．制作播放和停止音乐的效果。

在 Event map 1中单击 （Left mouse 

click on Object），拖动到右面的空白

处。在 Scene Graph中，选中 （Box16）

拖动叠加到 （ObjectLClick_2）上。

在 Actions中单击 Sound，选中 （Play 

sound），拖到 Event map 1中，叠加在

 （ObjectLClick_2）上。执行 View→

Sounds命令，出现对话框如图 62-9所

示。单击 Add 按钮，在对话框中选中

original_1.wav，关闭此对话框。在 Scene 

Graph 中，单击 Sounds，选中

（original_1）拖到 Event map 1中，叠

加在 （Play sound）上。效果如图 62-10

所示。在 Event map 1中单击 （Left 

mouse click on Object），拖动到右面的

空白处。拖动 （Box16）叠加到 
（ObjectLClick_3）上。在 Actions中单

击 Sound，选中  （Stop sound），拖

到 Event map 1 中 ， 叠 加 在  
（ ObjectLClick_3 ） 上 。 选 中

（original_1），拖到 Event map 1中，

叠加在  （Stop sound）上。效果如

图 62-11所示。 

7．设置播放和停止音乐的关系。

右击 （ObjectLClick_3），选择不要
Initial Activation。单击 Event，选中 
（activate event），拖动到 Event map 1

中，叠加在 （ObjectLClick_2）上。

将  （ ObjectLClick_3）拖动到  
（activate event）上。单击 Event，选中

 （Deactivate event），分别拖动到Event 

map 1中，叠加在 （ObjectLClick_2）

和  （ ObjectLClick_3 ）上。将  
（ObjectLClick_2）和 （ObjectLClick_3）

分别拖动到 （Deactivate event）上。

完成效果如图 62-12所示。 

8．保存为 Radio.c3p，本例制作

完成。 

 

图 62-9 

 

图 62-10 

 

图 62-11 

 

图 62-12 
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实例 63  收  录  机（二） 

 

本例制作“收录机（二）”的效果，

如图 63-1所示。 

本例特点：用鼠标单击左侧红色按

钮控制录音，单击左侧黑色按钮（录音

前不可用）可以重放。 

本例通过Timer、Play sound和Stop 

sound等知识完成。 

 

图 63-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 Radio.c3p（源文件）。执

行 File→Load project命令，在对话框中

选中Radio.c3p，如图 63-2所示。 

3．设置播放声音与弹开磁带盒之

间的关系。单击 Event，选中 （activate 

event），拖动到 Event map 1中，叠加

在 （ObjectRClick_1）上，出现黑框。

将  （ ObjectRClick_1）拖动到  
（activate event）上，出现黑框。单击

Event，选中 （activate event），拖动

到 Event map 1 中 ， 叠 加 在

（ObjectRClick_1）上，出现黑框。将 
（ObjectLClick_2）拖动到 （activate 

event）上，出现黑框。单击 Event，选

中 （Deactivate event），拖动到 Event 

map 1中，叠加在 （ObjectLClick_1）

上，出现黑框。将 （ObjectLClick_2）

拖动到 （Deactivate event）上，出现

黑框。效果如图 63-3所示。 

4．制作录音的效果。在 Event map1

 

 

图 63-2 

 

 

图 63-3 
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中单击 （Left mouse click on Object），

拖动到右面的空白处。在 Scene Graph

中，选中 （Box05:1）拖动叠加到 
（ObjectLClick_4）上，出现黑框。在

Actions 中单击 Sound，选中 （Play 

sound），拖到 Event map 1中，叠加在

 （ObjectLClick_4）上，出现黑框。

选中 （original_1），拖动叠加在

（Play sound）上，出现黑框。效果图

如图 63-4所示。在 Event map 1中单击

 （Left mouse click on Object），拖动

到右面的空白处。在 Scene Graph窗口

中，选中 （Box02:1）拖动叠加到 
（ObjectLClick_5）上，出现黑框。在

Actions 窗口中，单击 Sound，选中

（Play sound） ，拖到 Event map 1中，

叠加在 （ObjectLClick_5）上面，出

现黑框。选中 （ original_1），拖动

叠加在 （Play sound）上面，出现黑

框。效果图如图63-5所示。在Event map 

1 中单击 （Timer），拖动到右面的

空白处。选中 （Timer_1），右击选

择不要 Initial Activation。双击

（Timer_1），出现对话框，填入 8000

（ms），单击 OK按钮。单击 Event，

选中 （Deactivate event），拖动到

Event map 1中，叠加在 （Timer_1）

上，出现黑框。选中 （Timer_1），

拖动叠加到 （Deactivate event）上，

出现黑框。在 Actions 中单击 Sound，

选中  （Stop sound） ，拖到Event map 

1 中，叠加在 （Timer_1）上，出现

黑框。选中 （original_1），拖到 Event 

map 1中，叠加在  （Stop sound）上，

出现黑框。完成效果如图 63-6所示。 

5．设置事件间的关系。右击 
（ObjectLClick_5），选择不要 Initial 

Activation。单击 Event，选中 （activate 

event），拖动到 Event map 1中，叠加

 

图 63-4 

 

图 63-5 

 

图 63-6 

 

图 63-7 
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在 （ObjectLClick_5）上，出现黑框。

将 （ObjectLClick_5）拖动到 （activate 

event）上，出现黑框。单击 Event，选中

 （activate event），分别拖动到 Event 

map 1中，叠加在 （ObjectLClick_4）

和 （ObjectLClick_5）上，出现黑框。

将 （Timer_1）分别拖动到 （activate 

event）上，出现黑框，效果如图 63-7

所示。 

6．制作音箱震动的效果。在

Actions 窗口中，选中 （Translation 

XYZ），拖动到 Event map 1中，叠加

在 （ObjectLClick_2）上，出现黑框。

在 Scene Graph 中，分别找到  
（Torus01）和 （Torus05），拖动叠

加在 （Translation XYZ）上，出现黑

框。双击 （Translation XYZ）出现对

话框，单击 Z方向上的 ，选择 ，

如图 63-8所示，单击 Set出现对话框。

在Waveform type中选择 Sine方式。在

Sustain和 global parameters中，修改参

数，如图 63-9所示，单击 Close按钮。

选择 Loop 方式，单击 Close 按钮。在

Actions中，选中 （Translation XYZ），

拖动到 Event map 1 中，叠加在  
（ObjectLClick_2）上，出现黑框。在

Scene Graph 窗口中，分别找到  
（Torus02）和 （Torus06），选中后

拖动叠加在 （Translation XYZ）上，

出现黑框。双击  （Translation XYZ）

出现对话框，单击 Z 方向上的 ，选

择 ，如图 63-10所示，单击 Set出现

对话框。在Waveform type中选择 Sine

方式。在 Sustain 和 global parameters

中，修改参数，如图 63-11所示。单击

Close按钮。选择 Loop方式，单击 Close

按钮。完成效果如图 63-12所示。 

7．保存为 Radio1.c3p，本例制作

完成。 

 

图 63-8 

 

图 63-9 

 

图 63-10 

 

图 63-11 

 

图 63-12 
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实例 64  收  录  机（三） 

 

本例继续制作收录机播放音乐时

音箱的动态效果和播放 CD的效果，如

图 64-1所示。 

本例的效果是：鼠标单击 CD机最

上面按钮，CD盒弹开，单击 CD，CD

放入 CD机并自动播放音乐。 

本例通过 Trigger event 、Timer、

Play sound和 Stop sound等知识完成。 

 

图 64-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 Radio1.c3p（源文件）。

执行 File→Load project 命令，在对话

框中选中 Radio1.c3p，如图 64-2所示。 

3．制作音箱震动停止的效果。在

Actions 中选中 （Stop�），拖动到
Event map 1 中 ， 叠 加 在  
（ObjectLClick_3）上，出现黑框。分
别选中 （Torus01）、 （Torus02） 

 （Torus05）和 （Torus06），拖动
到 （Stop�）上，出现黑框。双击
（Stop�），出现对话框，在左边框中
选择两个 ObjectLClick_2.Translation，
单击 按钮，如图 64-3所示。再单击
下部的复选框（Stop all accumulated 
motions），单击 Close按钮完成。 

4 ． 修改以前的事件。将  
（ObjectLClick_4）和 （ObjectLClick_5）
上的 （Play sound）都删除，将
（Timer_1）上的 （Stop sound）也删
去。在 Action 中单击 Event，选中

 

 

图 64-2 

 

 

图 64-3 
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（Trigger event），分别拖到 Event map 

1 中，叠加在 （ObjectLClick_4）和

的 （ObjectLClick_5）上，出现黑框。

选中的 （ObjectLClick_2），分别拖

动到 （Trigger event）上，出现黑框。

在Action中单击Event，选中 （Trigger 

event），拖到 Event map 1中，叠加在

（Timer_1）上，出现黑框。选中 
（ObjectLClick_3），拖动到 （Trigger 

event）上面，出现黑框。完成效果如

图 64-4所示。 

5．制作打开 CD的效果。在 Event 

map 1中单击 （Left mouse click on 

Object），拖动到右面的空白处。在
Scene Graph 中，拖动 （Ellipse12）

叠加到 （ObjectLClick_6）上，出现

黑框。在 Actions中选中 （Translation 

XYZ），拖动到 Event map 1中，叠加

在 （ObjectLClick_6）上，出现黑框。

在 Scene Graph中找到 （Box30），

拖动叠加在 （Translation XYZ）上，

出现黑框。双击 （Translation XYZ）

出现对话框，具体设置如图 64-5所示，

选择 Repeat count方式，单击 Close按

钮。效果如图 64-6所示。在 Event map 

1 中单击  （ Left mouse click on 

Object），拖动到右面的空白处。在
Scene Graph中找到 （Cylinder01），

拖 动  （ Cylinder01 ） 叠 加 到  
（ObjectLClick_7）上，出现黑框。在
Actions中选中 （Translation XYZ），

拖动到 Event map 1 中，叠加在  
（ObjectLClick_7）上，出现黑框。选

中  （Cylinder01）拖动叠加在  
（Translation XYZ）上，出现黑框。双

击 （Translation XYZ）出现对话框，

具体设置如图 64-7 所示，选择 Repeat 

count 方式，单击 Close 按钮。效果如

图 64-8所示。在 Event map 1中单击

（Timer），拖动到右面的空白处。选

 

图 64-4 

 

图 64-5 

 

图 64-6 

 

图 64-7 
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中 （Timer_2），右击选择不要 Initial 

Activation。双击 （Timer_2），出现

对话框，填入 3000（ms），单击 OK

按钮。单击 Event，选中 （Deactivate 

event），拖动到 Event map 1中，叠加

在 （Timer_2）上，出现黑框。选中

（Timer_2），拖动叠加到 （Deactivate 

event）上，出现黑框。单击 Event，选

中 （activate event），拖动到 Event map 

1中，叠加在 （ObjectLClick_7）上，

出现黑框。将 （Timer_2）拖动到 
（activate event）上，出现黑框。在
Actions中，选中 （Translation XYZ），

拖动到 Event map 1 中，叠加在

（Timer_2）上，出现黑框。选中 
（Box30）拖动叠加在 （Translation 

XYZ ） 上 ， 出 现 黑 框 。 双 击  
（Translation XYZ）出现对话框，具体

设置如图 64-9所示，选择 Repeat count

方式，单击 Close 按钮。在 Actions 窗

口中，选中 （Translation XYZ），拖

动到 Event map 1 中，叠加在

（Timer_2）上，出现黑框。选中 
（ Cylinder01 ） 拖 动 叠 加 在  
（Translation XYZ）上，出现黑框。双

击 （Translation XYZ）出现对话框，

具体设置如图 64-10所示，选择 Repeat 

count方式，单击 Close按钮。在 Action

中单击 Event，选中 （Trigger event），

拖到 Event map 1 中，叠加在

（Timer_2）上，出现黑框。选中  
（ObjectLClick_2），拖动到 （Trigger 

event）上，出现黑框。右击 （Timer_2）

选择 Edit with Time Line View命令。出

现对话框如图 64-11 所示，将 Trigger 

event 的起始时间拖动到 Translation 

XYZ 的结束时间处。关闭对话框。效

果如图 64-12所示。 

6．保存为 Radio2.c3p，本例制作

完成。 

 

图 64-8 

 

图 64-9 

 

图 64-10 

 

图 64-11 

 

图 64-12 
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实例 65  CD 播 放 机（一） 

 

本例制作“CD播放机（一）”，

如图 65-1所示。 

本例特点：用鼠标右击盘片，盘片

弹出，再次右击，盘片弹回。 

本例通过 Translation、Active event

和 Deactive event等知识完成。 

 

图 65-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 cd_disk.C3D。选择 File→

Add Cult3D Designer File命令，在对话

框中选中 cd_disk.C3D，如图 65-2所示。 

3．添加 Arcball。在 Event map 1

中，单击 （World start），拖动到右

面的空白处。在 Actions中，单击 Object 

motion 选项，选中 （Arcball），拖

动到 Event map 1中，叠加在原来的 
（World start）上，出现黑框。在 Scene 

Graph 中，单击 rootnode，选中  
（CD_DISK），拖动到 Event map 1中，

叠加在 （Arcball）上，出现黑框。

形成的 Event map 1如图 65-3所示。 

4．制作取出 CD唱片的效果。在

Event map 1中，单击 （Right mouse 

click on Object），拖动到右面的空白

处。在 Scene Graph中，单击 rootnode，

选中 （CD Dsik），拖动到 Event map 

1中，叠加在 （ObjectRClick_1）上，

出现黑框。在 Scene Graph 中，单击

rootnode，单击 （CD bottom），拖动

 

 

 

图 65-2 

 

 

图 65-3 
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到 Event map 1 中 ， 叠 加 在  
（ObjectRClick_1）上，出现黑框，如

图 65-4所示。在Actions中，单击Object 

motion 选项，选中  （ Translation 

XYZ），拖动到 Event map 1中，叠加

在 （ObjectRClick_1）上，出现黑框。

选中 Event map 1中的 （CD Disk），

拖动到 （Translation XYZ），出现黑

框。双击  Translation XYZ，弹出对

话框。在 X轴中输入 4（位移），Time

设为 1000（毫秒），并且选择 Repeat 

count 1方式，单击 Close按钮完成参数

设置。形成的 Event map 1，如图 65-5

所示。 

5．制作放回 CD唱片的效果。在

Event map 1中，单击 （Right mouse 

click on Object），拖动到右面的空白

处。在 Event map 1中，选中 （CD 

Dsik），叠加在 （ObjectRClick_2）

上，出现黑框。在 Event map 1中，单

击  （ CD bottom），叠加在  

（ObjectRClick_2）上，出现黑框。在

Actions中，单击 Object motion选项，

选中 （Translation XYZ），拖动到

Event map 1 中 ， 叠 加 在   

（ObjectRClick_2）上，出现黑框。选

中 Event map 1中的 （CD Disk），

拖动到 （Translation XYZ）上，出现

黑框。双击 （Translation XYZ），弹

出对话框，具体设置如图 65-6 所示，

选择 Repeat count 1方式，单击 Close

按钮。形成的 Event map 1如图 65-7所

示。 

6．确定弹出和放回 CD唱片的关

系。在 Actions中，单击 Event，选中 
（Deactivate event），拖动到 Event map 

1中，叠加在 （ObjectRClick_1）上，

出现黑框。选中 （Deactivate event），

右击选择 parameters 命令，弹出对话

 

图 65-4 

 

图 65-5 

 

图 65-6 

 

图 65-7 
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框，如图 65-8 所示，在左边框中选中

ObjectRClick_1，单击 Add按钮，单击

OK 按钮。在 Actions 中，选中  
（activate event），拖动到 Event map 1

中，叠加在 （ObjectRClick_1）上，

出现黑框。选中 （activate event），

右击选择 parameters 命令，弹出对话

框，在左边框中选中 ObjectRClick_2，

单击 Add 按钮，单击 OK 按钮。形成

的 Event map 1，如图 65-9所示。 

在 Actions中，单击 Event，选中 
（Deactivate event），拖动到 Event map 

1中，叠加在 （ObjectRClick_2）上，

出现黑框。选中 （Deactivate event），

右击选择 parameters 命令，弹出对话

框，在左边框中选中 ObjectRClick_2，

单击 Add 按钮，单击 OK 按钮。在

Actions中，选中 （activate event），

拖动到 Event map 1 中，叠加在  

（ObjectRClick_2）上，出现黑框。选

中  （ activate event），右击选择

parameters命令，弹出对话框，在左边

框中选中 ObjectRClick_1，单击 Add按

钮，单击OK按钮。形成的 Event map 1，

如图 65-10所示。 

7．保存为 cd_disk1.c3p，本例制

作完成。 

 

图 65-8 

t 

图 65-9 

 

图 65-10 
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实例 66  CD 播 放 机（二） 

 

本例制作“CD播放机（二）”，

如图 66-1所示。 

本例特点：用鼠标左击盒盖，盒盖

盖上，再次左击，盒盖打开。 

本例通过 Rotation、Translation、

Activate event和 Deactivate event等知

识完成。 

 

图 66-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 cd_disk1.c3p。执行 File

→ Load project，在对话框中选中

cd_disk1.c3p，如图 66-2所示。 

3．制作盖上盒盖的效果。在 Event 

map 1中，单击 （Left mouse click on 

Object），拖动到右面的空白处。在

Scene Graph中，单击 rootnode，选中 
（CD cover），拖动到 Event map 1中，

叠加在 （ObjectLClick_1），出现黑

框。在 Actions中，单击 Object motion

选项，选中 （Translation XYZ），拖

动到 Event map 1 中，叠加在   

（ObjectLClick_1）上，出现黑框。选

中 Event map 1中的 （CD cover），

拖动到 （Translation XYZ），出现黑

框。双击 （Translation XYZ），弹出

对话框，具体设置如图 66-3 所示，并

且选择 Repeat count 1方式，单击 Close

按钮完成参数设置。在 Actions中，单

击Object motion选项，选中 （Rotation 

 

 

图 66-2 

 

 

 

图 66-3 
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XYZ），拖动到 Event map 1中，叠加

在  （ObjectLClick_1）上，出现黑框。

选中 Event map 1中的 （CD cover），

拖动到 （Rotation XYZ），出现黑框。

双击 （Rotation XYZ），弹出对话框。

在 Y轴中输入 29（角度），Time设为

1000（毫秒），并且选择 Repeat count 1

方式，单击 Close按钮完成参数设置。

形成的 Event map 1，如图 66-4所示。 

4．制作打开盒盖的效果。在 Event 

map 1中，单击 （Left mouse click on 

Object），拖动到右面的空白处。在

Event map 1中，选中 （CD cover），

叠加在 （ObjectLClick_2），出现黑

框。在 Event map 1中，单击 （CD 

cover），叠加在 （ObjectLClick_2）

上，出现黑框。在 Actions 中，单击

Object motion选项，选中 （Translation 

XYZ），拖动到 Event map 1中，叠加

在  （ObjectLClick_2）上，出现黑框。

选中 Event map 1中的 （CD cover），

拖动到 （Translation XYZ），出现黑

框。双击 （Translation XYZ），弹出

对话框。在 Z轴中输入 1.2（位移），

Time 设为 1000（毫秒），并且选择

Repeat count 1方式，单击 Close按钮完

成参数设置。在 Actions中，单击 Object 

motion选项，选中 （Rotation XYZ），

拖动到 Event map 1 中，叠加在   

（ObjectRClick_2）上，出现黑框。选

中 Event map 1中的 （CD cover），

拖动到 （Rotation XYZ），出现黑框。

双击 （Rotation XYZ），弹出对话框，

具体设置如图 66-5 所示，选择 Repeat 

count 1方式，单击 Close按钮。形成的

Event map 1如图 66-6所示。 

5．确定弹出和放回 CD唱片的关

系。在 Actions中，单击 Event，选中 
（Deactivate event），拖动到 Event map 

 

图 66-4 

 

图 66-5 

 

图 66-6 

 

 

图 66-7 
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1中，叠加在 （ObjectLClick_1）上，

出现黑框。选中 （Deactivate event），

右击选择 parameters 命令，弹出对话

框，如图 66-7 所示，在左边框中选中

ObjectLClick_1，单击 Add按钮，单击

OK 按钮。在 Actions 中，选中  
（Activate event），拖动到 Event map 1

中，叠加在 （ObjectLClick_1）上，

出现黑框。选中 （Activate event），

右击选择 parameters 命令，弹出对话

框，在左边框中选中 ObjectLClick_2，

单击 Add 按钮，单击 OK 按钮。形成

的 Event map 1，如图 66-8所示。 

在 Actions中，单击 Event，选中 
（Deactivate event），拖动到 Event map 

1中，叠加在 （ObjectLClick_2）上，

出现黑框。选中 （Deactivate event），

右击选择 parameters 命令，弹出对话

框，在左边框中选中 ObjectLClick_2，

单击 Add 按钮，单击 OK 按钮。在

Actions中，选中 （Activate event），

拖动到 Event map 1 中，叠加在  
（ObjectLClick_2）上，出现黑框。选

中  （Activate event），右击选择

parameters命令，弹出对话框，如图 66-9

所示。在左边框中选中ObjectLClick_1，

单击 Add 按钮，单击 OK 按钮。形成

的 Event map 1，如图 66-10所示。 

6．保存为 cd_disk2.c3p，本例制

作完成。 

 

图 66-8 

 

图 66-9 

 

图 66-10 
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实例 67  CD 播 放 机（三） 

 

本例制作“CD播放机（三）”的

效果，如图 67-1所示。 

本例特点：用鼠标右击唱片，唱片

弹出，再次右击，唱片放入 CD播放机

内；用鼠标左击盒盖，盒盖盖上并开始

播放音乐，再次左击，盒盖打开并停止

音乐播放。播放音乐时不能取唱片，取

出唱片时不能播放音乐。 

本例通过Toggle event activation ，

Play sound和 Stop sound等知识完成。 

 

 

图 67-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 cd_disk2.c3p。执行 File

→Load project命令，在对话框中选中

cd_disk2.c3p，如图 67-2所示。 

3．将音乐文件导入。在 Scene 

Graph中，单击 （Sounds），右击选

择 New→Sound命令，弹出对话框，如

图 67-3 所示，选中音乐文件明天我要

嫁给你啦.mid（必须为.avi或者.mid格

式）。 

4．制作播放音乐的效果。在

Action中，单击 Sound，选中 （Play 

sound），拖动到 Event map 1中，叠加

在 （ObjectLClick_1）上，出现黑框。

在 Scene Graph中，单击 Sounds，单击

刚添加的音乐 （明天我要嫁给你啦），

如图 67-4所示，拖动到 Event map 1，

叠加在 （Play sound）上，出现黑框。 

 

图 67-2 

 

 

图 67-3 
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5．制作停止播放音乐的效果。在

Action中，单击 Sound，选中 （Stop 

sound），拖动到 Event map 1中，叠加

在  ObjectLClick_2 上，出现黑框。

将 Event map 1中的 （明天我要嫁给

你啦），叠加到 （Stop sound）上。

最后形成的 Event map 1，如图 67-5所

示。 

6．确定音乐参数。选中 （明天

我要嫁给你啦），右击选择 Details 命

令，弹出对话框，单击 Play 按钮，可

以试听 （明天我要嫁给你啦）。选中

（Play sound），右击选择 Details命

令，弹出对话框。调节 Starting position

（ms）和 Ending position（ms），可以

控制播放音乐的起始时间点和终止时

间点。 

7．制作播放音乐时不能取出唱片

的效果。在 Event map 1 中，选中 

（ObjectLClick_2），右击弹出菜单，

如图 67-6 所示。单击 Initial Activion,

去掉前面的打勾的符号。 

在 Action中，单击 Event，选中

（Toggle event activation），拖动到 Event 

map 1中，叠加在 （ObjectLClick_1）

上，出现黑框。选中 （Toggle event 

activation），右击选择 parameters命令，

弹出对话框。在左边框中选中

ObjectRClick_1，单击 Add按钮，单击

OK按钮。 

在 Event map 1中，选中原来激活

 （ObjectLClick_1）的  （activate 

event），右击选择 parameters命令，弹

出对话框，如图 67-7 所示。在左边框

中选中ObjectRClick_1，单击Add按钮，

单击 OK按钮。形成的 Event map 1，

如图 67-8所示。 

8．制作取出唱片的时候不能盖上

盒盖播放音乐的效果。在 Event map 1

 

图 67-4 

 

图 67-5 

 

图 67-6 

 

图 67-7 
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中，选中 （ObjectRClick_2），右击

弹出菜单，如图 67-6所示。单击 Initial 

Activion，去掉前面的打勾的符号。 

在 Action中，单击 Event，选中

（Toggle event activation），拖动到 Event 

map 1中，叠加在 （ObjectRClick_1）

上，出现黑框。选中 （Toggle event 

activation），右击选择 parameters命令，

弹出对话框。在左边框中选中

ObjectLClick_1，单击 Add按钮，单击

OK按钮。 

在 Event map 1中，选中原来激活

 （ObjectRClick_1）的  （activate 

event），右击选择 parameters命令，弹

出 对 话 框 。 在 左 边 框 中 选 中

ObjectLClick_1，单击 Add按钮，单击

OK按钮。形成的 Event map 1，如图

67-9所示。 

9．保存为 cd_disk3.c3p，本例制

作完成。 

 

图 67-8 

 

图 67-9 
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实例 68  播  放  器 

 

本例制作“播放器”的效果，如图

68-1所示。 

本例特点：单击鼠标左键，播放磁

头转动到碟片上，开始播放音乐，再次

单击左键，磁头复位，停止播放音乐。 

本例通过 Rotation、Play sound和

Stop sound等知识完成。 

 

图 68-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 rplayer.C3D。执行 File→

Add Cult3D Designer File命令，在对话

框中选中 rplayer.c3p，如图 68-2所示。 

3．添加 Arcball。在 Event map 1

中，单击 （World start），拖动到右

面的空白处。在 Actions中，单击 Object 

motion 选项，选中 （Arcball），拖

动到 Event map 1中，叠加在原来的 
（World start）上，出现黑框。在 Scene 

Graph 中，单击 rootnode，选中  
（rplayer），拖动到 Event map 1中，

叠加在 （Arcball）上，出现黑框。

形成的 Event map 1如图 68-3所示。 

4．确定需要转动的磁头部件。在

Scene Graph中，单击 RootNode，分别

选中 （nadel01）至 （nadel06）、 
（ nadeldeck）、  （Object）、  
（Object01）至 （Object04）、 （cyl），

依次拖动到 （nadel1）上，最后形成

的包含关系如图 68-4所示。 

 

 

图 68-2 

 

 

图 68-3 
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5．制作磁头旋转的效果。在 Event 

map 1中，单击 （Left mouse click on 

Object），拖动到右面的空白处。在

Scene Graph中，单击 RootNode，选中

 （nadel1），拖动到 Event map 1中，

叠加在 （ObjectLClick_1）上，出现

黑框。 

在 Actions中，单击 Object motion

选项，选中 （Rotation XYZ），拖动

到 Event map 1 中 ， 叠 加 在   

（ObjectLClick_1）上，出现黑框。选

中 Event map 1中的 （nadel1），拖

动到 （Rotation XYZ）上，出现黑框。

双击 （Rotation XYZ），弹出对话框，

具体设置如图 68-5 所示，选择 Repeat 

count 1方式，单击 Close按钮完成参数

设置。形成的 Event map 1，如图 68-6

所示。 

6．制作磁头回转的效果。在 Event 

map 1中，单击 （Left mouse click on 

Object），拖动到右面的空白处。在

Event map 1中，选中 （nadel1），叠

加在 （ObjectLClick_2）上，出现黑

框。在Event map 1中，单击 （nadel1），

叠加在 （ObjectLClick_2）上，出现

黑框。 

在 Actions中，单击 Object motion

选项，选中 （Rotation XYZ），拖动

到 Event map 1 中 ， 叠 加 在   

（ObjectRClick_2）上，出现黑框。选

中 Event map 1中的 （nadel1），拖

动到 （Rotation XYZ）上，出现黑框。

双击 （Rotation XYZ），弹出对话框。

在 Y轴中输入�40（角度），Time设为
2000（毫秒），并且选择 Repeat count 1
方式，单击 Close按钮完成参数设置。
形成的 Event map 1，如图 68-7所示。 

7．确定磁头转动和转回的关系。
在 Actions 中，单击 Event，选中 

 

图 68-4 

 

图 68-5 

 

图 68-6 

 

图 68-7 
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（Deactivate event，拖动到 Event map 1

中，叠加在 （ ObjectLClick_1）上，

出现黑框。选中 （Deactivate event），

右击选择 parameters 命令，弹出对话

框，如图 68-8 所示。在左边框中选中

ObjectLClick_1，单击 Add按钮，单击

OK 按钮。在 Actions 中，选中  
（Activate event），拖动到 Event map 1

中，叠加在 （ObjectLClick_1）上，

出现黑框。选中 （Activate event），

右击选择 parameters 命令，弹出对话

框，在左边框中选中 ObjectLClick_2，

单击 Add 按钮，单击 OK 按钮。形成

的 Event map 1，如图 68-9所示。 

在 Actions中，单击 Event，选中 
（Deactivate event），拖动到 Event map 

1中，叠加在 （ObjectLClick_2）上，

出现黑框。选中 （Deactivate event），

右击选择 parameters 命令，弹出对话

框，在左边框中选中 ObjectLClick_2，

单击 Add 按钮，单击 OK 按钮。在

Actions中，选中 （Activate event），

拖动到 Event map 1 中，叠加在  
（ObjectLClick_2）上，出现黑框。选

中  （Activate event），右击选择

parameters 命令，弹出对话框，如图

68-10 所 示 。 在 左 边 框 中 选 中

ObjectLClick_1，单击 Add按钮，单击

OK按钮。形成的 Event map 1，如图

68-11所示。 

8．将音乐文件导入。在 Scene 

Graph中，单击 （Sounds），右击选

择 New→Sound命令，弹出对话框，选

中音乐文件 AMERPIE1.mid（必须

为.avi或者.mid格式）。 

9．制作播放音乐的效果。在

Action中，单击 Sound，选中 （Play 

sound），拖动到 Event map 1中，叠加

在 （ObjectLClick_1）上，出现黑框。

 

图 68-8 

 

图 68-9 

 

图 68-10 

 

图 68-11 
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在 Scene Graph中，单击 Sounds，单击

刚添加的音乐 （AMERPIE 1），如

图 68-12所示，拖动到 Event map 1中，

叠加在 （Play sound）上，出现黑框。 

10．制作停止播放音乐的效果。

在 Action中，单击 Sound，选中 （Stop 

sound），拖动到 Event map 1中，叠加

在 ObjectLClick_2上，出现黑框。将

Event map 1中的 （明天我要嫁给你

啦），叠加到 （Stop sound）上。最

后形成的 Event map 1，如图 68-13所

示。 

11．确定音乐参数。选中 （明

天我要嫁给你啦），右击选择 Details

命令，弹出对话框，单击 Play 按钮，

可以试听 （明天我要嫁给你啦）。选

中 （Play sound），右击选择 Details

命令，弹出对话框，如图 68-14所示。

调节 Starting position（ms）和 Ending 

position（ms），以控制播放音乐的起

始时间点和终止时间点。 

12．保存为 rplayer.c3p，本例制作

完成。 

 

图 68-12 

 

图 68-13 

 

图 68-14 

 



 

 

本篇介绍如何制作各种工业化的大型产品，

诸如车床、重载卡车等，并且将这些物体的主要

功能通过 Cult 3D 的强大 3D功能体现出来。

如果在网页上用这样丰富生动的 3D 实例来

代替原来枯燥的文字说明和简单的图片展示，必

然会取得更好的效果。

通过本篇的学习，将有助于读者拓宽制作的

思路，将 Cult 3D 的适用范围进一步扩展。

工  业  篇 

 

 



第六篇  工业篇 

 
213 

实例 69  发  动  机 

 

本例制作“发动机”的效果图，如

图 69-1所示。 

本例特点：按键盘上的“↓”键控

制隐藏外壳，按“1”键控制转动引擎。 

本例通过 Hide Object 和 Unhide 

Object等知识完成。 

 

图 69-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载Motor5.C3D。执行 File→
Add Cult3D Designer File命令，在对话

框中选中Motor5.C3D，如图 69-2所示。 

3．添加 Arcball。在 Event map 1

中单击 （world start），拖动到右面

的空白处。在 Actions 中单击 Object 

motion 选项，选中 （Arcball），拖

动到 Event map 1 中，叠加在  
（WorldStart_1）上，出现黑框。在 Scene 

Graph 中单击 rootnode 选项，选中

（Group_ALL），拖动到 Event map 1

中，叠加在的 （Arcball）上，出现

黑框。 

4．修改包含关系。在 Scene Graph

窗口中，单击 RootNode，单击  
（Group_All），找到 （ Kurbelwell），

再 单 击  （ Kurbelwell ） 找 到  
（kolben01）至 （kolben04），分别

拖动到 （Group_All）上，出现黑框，

形成关系图如图 69-3所示。 

5．制作外壳隐藏的效果。在 Event 

map 1 中单击 （Keyboard�s key 

 

图 69-2 

 

图 69-3 

 

图 69-4 
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press），拖动到右面的空白处。双击

（KeyPress_1），出现对话框，在左边

选择 Page Down，单击 Add 按钮，单

击 OK按钮。单击 Render，选中 （Hide 

Object），拖动到 Event map 1中，叠

加在 （KeyPress_1）上面，出现黑框。

双击 （Hide Object），出现对话框如

图 69-4所示，选择 Apply to child，单

击 OK按钮。在 Scene Graph窗口中，

拖动 （Group01）叠加到 （Hide 

Object）上，出现黑框。在 Event map 1

中单击 （Keyboard�s key release），
拖动到右面的空白处。双击

（KeyRelease_1），出现对话框，在左
边选择 Page Down，单击 Add 按钮，
单击 OK 按钮。单击 Render，选中
（Unhide Object），拖动到 Event map 1
中，叠加在 （KeyRelease_1）上，出
现黑框。双击 （Unhide Object），出
现对话框，选择 Apply to child，单击
OK按钮。拖动 （Group01）叠加到
（Unhide Object）上，出现黑框。完成
效果如图 69-5所示。 

6．制作活塞运动的效果。在 Event 
map 1 中单击 （Keyboard�s key 
press），拖动到右面的空白处。双击
（KeyPress_2），出现对话框，在左边
选择 1，单击 Add按钮，单击 OK按钮。
在 Actions 中，选中  （Translation 
XYZ），拖动到 Event map 1中，叠加
在 （KeyPress_2）上，出现黑框。选
中 Event map 1中的 （kolben01）和 
（kolben04），拖动到 （Translation 
XYZ）上，出现黑框。双击 （Translation 
XYZ），弹出对话框，单击 Z 方向上
的 ，选择 ，如图 69-6所示，单击
Set出现对话框。在Waveform type中
选择 Triangle方式。在 Sustain和 global 
parameters中，修改参数，具体设置如

 

图 69-5 

 

图 69-6 

 

图 69-7 

 

图 69-8 
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图 69-7 所示，单击 Close 按钮，选择
Loop方式，单击 Close按钮。 

在 Actions中选中  （Translation 

XYZ），拖动到 Event map 1中，叠加

在 （KeyPress_2）上，出现黑框。选

中 Event map 1中的 （ kolben02）和  

（ kolben03），拖动到  （Translation 

XYZ），出现黑框。双击  （Translation 

XYZ），弹出对话框，单击 Z 方向上

的 ，选择 ，单击 Set出现对话框。

在 Waveform type 中选择 Triangle 方

式。在 Sustain和 global parameters中，

修改参数，具体参数设置如图 69-8 所

示，单击 Close按钮，选择 Loop方式，

单击 Close按钮。效果如图 69-9所示。 

7．制作活塞连杆运动的效果。在
Actions 中选中 （Rotation XYZ），

拖动到 Event map 1 中，叠加在

（KeyPress_2）上，出现黑框。选中
Event map 1 中的  （pleuel）和   

（ pleuel03），拖动到  （Rotation 

XYZ），出现黑框。双击 （Rotation 

XYZ），弹出对话框。单击 Y轴上的 ，

选择 ，单击 Set 出现对话框。在
Waveform type 中选择 Sine 方式。在
Sustain中，修改参数，如图 69-10所示，

单击 Close按钮。选择 Loop 方式，单

击 Close 按钮。在 Actions 中选中 
（Rotation XYZ），拖动到 Event map 1

中，叠加在 （KeyPress_1）上，出现

黑框。选中 Event map 1 中的  
（pleuel01）和 （pleuel02），拖动到

 （Rotation XYZ）上，出现黑框。双

击 （Rotation XYZ），弹出对话框。

单击 Y 轴上的 ，选择 ，单击 Set

出现对话框。在Waveform type中选择
Sine方式。在 Sustain中修改参数，如

图 69-11所示，单击 Close按钮。选择
Loop方式，单击 Close按钮。 

8．制作曲轴转动的效果。在 Actions

 

 

图 69-9 

 

 

图 69-10 

 

 

图 69-11 
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中选中 （Rotation XYZ），拖动到Event 

map 1中，叠加在 （KeyPress_1）上，

出现黑框。双击  （Rotation XYZ），

弹出对话框，在 Y轴输入 360（角度），
Time设为 1000（毫秒）。选择 Loop方

式 ， 单 击 Close 按 钮 。 拖 动   

（Kurbelwell）到 （Rotation XYZ）上，

出现黑框。完成效如图 69-12所示。 

9．保存为Motor5.c3p，本例制作完

成。 
 

图 69-12 
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实例 70  机  床 （一） 

 

本例制作“机床（一）”的效果，

如图 70-1所示。 

本例特点：单击主轴箱右上角按

钮，主轴以低速旋转；单击主轴箱中上

的按钮，主轴以中速旋转；单击主轴箱

左上角按钮，主轴以高速旋转。 

本例通过 Stop和 Rotation XYZ等

知识完成。 

 

图 70-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 Lathe.C3D。执行 File→

Add Cult3D Designer File命令，在对话

框中选中 Lathe.C3D，如图 70-2所示。 

3．添加 Arcball 和确定视角。在

Event Map1 窗口中单击  （World 

Start），拖到右侧的空白处。在 Actions

窗口中，单击 Object Motion，选中 
（Arcball），拖到 Event map 1中，叠

加在 （World Start_1）上，出现黑框。

在 Scene Graph中，单击 RootNode，选

中 （Lathe），拖到 Event map 1中，

叠加在 （Arcball）上，出现黑框。

在 Actions 中，单击 Camera，选中

（Select camera），拖到 Event map 1

中，叠加在 （World Start）上，出现

黑框。在 Scene Graph 中选中

（Camera02），拖到 Event map 1中，

叠加在 （Select camera）上，出现黑

框。效果如图 70-3所示。 

 

 

 

图 70-2 

 

图 70-3 
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4．制作主轴旋转与变速的效果。

在 Scene Graph 窗口中，找到  
（Objec01）、  （Objec02）和   
（Objec03），分别拖动到 （Object14）

上，出现黑框，形成的关系如图 70-4

所示。在 Event map 1中单击 （Left 

mouse click on Object），拖动到右面的

空白处。在 Scene Graph 中，找到 
（Obj06），拖动 （Obj06）叠加到 
（ObjectLClick_1）上，出现黑框。在

Actions中，选中 （Rotation XYZ），

拖动到 Event map 1 中，叠加在  
（ObjectLClick_1）上，出现黑框。在

Scene Graph中，单击 RootNode，选中

 （Object14），拖到 Event map 1中，

叠加在 （Rotation XYZ）上，出现黑

框。双击 （Rotation XYZ），弹出对

话框，具体设置如图 70-5 所示，选择

Loop方式，单击 Close按钮。在 Actions

中，选中 （Stop�），拖动到 Event map 
1中，叠加在 （ObjectLClick_1）上，
出现黑框。选中 （Object14），叠加
到 （Stop�）上，出现黑框。双击
（Stop�），出现对话框如图 70-6所示。
在左边选择 ObjectLClick_2.Rotation 
XYZ和ObjectLClick_3.Rotation XYZ，
单击 加入，单击 Close 按钮。效果
图如图 70-7所示。 
在 Event map 中单击  （Left 

mouse click on Object），拖动到右面的
空白处。在 Scene Graph 中，找到 
（Obj05），叠加到 （ObjectLClick_2）
上，出现黑框。在 Actions中，选中 
（Rotation XYZ），拖动到 Event map 1
中，叠加在 （ObjectLClick_2）上，
出现黑框。选中 （Object14），叠加
在 （Rotation XYZ）上，出现黑框。
双击 （Rotation XYZ），弹出对话框，
具体设置如图 70-8所示，选择 Loop方

 

图 70-4 

 

图 70-5 

 

图 70-6 

 

图 70-7 

 

图 70-8 
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式，单击 Close按钮。在 Actions窗口

中，选中 （Stop�），拖动到 Event map 
1中，叠加在 （ObjectLClick_2）上，
出现黑框。选中 （Object14），叠加
到 （Stop�）上，出现黑框。双击
（Stop�），出现对话框如图 70-9所示。
在左边选择 ObjectLClick_1.Rotation 
XYZ和 ObjectLClick_3.Rotation XYZ，
单击 加入，单击 Close 按钮。完成
效果如图 70-10所示。 
在 Event map 1 中单击 （Left 

mouse click on Object），拖动到右面的
空白处。在 Scene Graph 中，找到 
（Obj04），拖动 （Obj04）叠加到 
（ObjectLClick_3）上，出现黑框。在
Actions 窗口中，选中  （Rotation 
XYZ），拖动到 Event map 1中，叠加
在 （ObjectLClick_3）上，出现黑框。
选中 （Object14），叠加在 （Rotation 
XYZ）上，出现黑框。双击 （Rotation 
XYZ），弹出对话框，具体设置如图
70-11所示，选择 Loop方式，单击 Close
按钮。在 Actions中，选中 （Stop�），
拖动到 Event map 1 中，叠加在  
（ObjectLClick_3）上，出现黑框。选
中 （Object14），叠加到 （Stop�）
上，出现黑框。双击 （Stop�），出
现 对 话 框 ， 在 左 边 选 择 Object 
LClick_1.Rotation XYZ 和 Object 
LClick_2.Rotation XYZ，单击 加入，
单击 Close按钮。效果如图 70-12所示。 

5．保存为 Lathe.c3p，本例制作完
成。 

 

图 70-9 

 

图 70-10 

 

图 70-11 

 

图 70-12 
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实例 71  机  床 （二） 

 

本例制作“机床（二）”的效果，

如图 71-1所示。 

本例特点：鼠标左、右键单击进给

箱右侧手轮，进给箱纵向进给；鼠标左、

右键单击进给箱左侧手轮，进给箱横向

进给。 

本 通 过 Translation XYZ 和

Rotation XYZ等知识完成。 

 

图 71-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 Lathe.c3p（源文件）。执

行 File→Load project 命令，在对话框

中选中 Lathe.c3p，如图 71-2所示。 

3．修改包含关系。在 Scene Graph

窗口中，找到 （Object01）、 （Obj01）

和 （Obj10），分别拖动到 （Obj）

上，出现黑框。再将 （Obj）拖动到 
（Obj16）上，出现黑框。将 （Obj3）、

 （Obj11）~  （Obj16）和 （Obj18）

分别拖动到 （Objec05）上，出现黑

框。形成关系图如图 71-3所示。 

4．制作进给箱纵向进给的效果。

在 Event map 1中单击 （Left mouse 

click on Object），拖动到右面的空白

处。在 Scene Graph中，找到 （Obj15），

拖 动  （ Obj15 ） 叠 加 到  
（ObjectLClick_4）上，出现黑框。在

Actions中，选中 （Rotation XYZ），

拖动到 Event map 1 中，叠加在  

 

图 71-2 

 

 

图 71-3 
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（ObjectLClick_4）上，出现黑框。选

中 （Obj15），叠加在 （Rotation 

XYZ）上，出现黑框。双击 （Rotation 

XYZ），弹出对话框，具体设置如图

71-4所示，选择 Repeat count方式，单

击 Close按钮。在 Actions中，选中 
（Translation XYZ），拖动到 Event map 

1中，叠加在 （ObjectLClick_4）上，

出现黑框。在 Scene Graph中，找到 
（ Objec05 ） ， 选 中 后 叠 加 在  
（Translation XYZ）上面，出现黑框。

双击 （Translation XYZ），出现对话

框，具体设置如图 71-5 所示，选择

Repeat count方式，单击 Close按钮。 

在 Event map 1 中单击 （Right 

mouse click on Object），拖动到右面的

空白处。拖动 （Obj15）叠加到

（ObjectRClick_1）上，出现黑框。在

Actions中，选中 （Rotation XYZ），

拖动到 Event map 1 中，叠加在

（ObjectRClick_1）上，出现黑框。选

中 （Obj15），叠加在 （Rotation 

XYZ）上，出现黑框。双击 （Rotation 

XYZ），弹出对话框，具体设置如图

71-6所示，选择 Repeat count方式，单

击 Close按钮。在 Actions中，选中 
（Translation XYZ），拖动到 Event map 

1中，叠加在 （ObjectRClick_1）上，

出现黑框。选中 （Objec05）叠加在 
（Translation XYZ）上，出现黑框。双

击 （Translation XYZ），出现对话框，

具体设置如图 71-7 所示，选择 Repeat 

count 方式，单击 Close 按钮。完成效

果如图 71-8所示。 

5．制作进给箱横向进给的效果。

在 Event map 1中单击 （Left mouse 

click on Object），拖动到右面的空白

处。在 Scene Graph中，找到 （Obj18），

拖 动  （ Obj18 ） 叠 加 到  

 

图 71-4 

 

图 71-5 

 

图 71-6 

 

图 71-7 

 

图 71-8 
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（ObjectLClick_5）上，出现黑框。在

Actions中，选中 （Rotation XYZ），

拖动到 Event map 1 中，叠加在  
（ObjectLClick_5）上，出现黑框。选

中 （Obj18），叠加在 （Rotation 

XYZ）上，出现黑框。双击 （Rotation 

XYZ），弹出对话框，具体设置如图

71-9所示，选择 Repeat count方式，单

击 Close按钮。在 Actions中，选中 
（Translation XYZ），拖动到 Event map 

1中，叠加在 （ObjectLClick_5）上，

出现黑框。在 Scene Graph中，找到 
（ Obj16 ） ， 选 中 后 叠 加 在  
（Translation XYZ）上，出现黑框。双

击 （Translation XYZ）出现对话框，

具体设置如图 71-10所示，选择 Repeat 

count方式，单击 Close按钮。 

在 Event map 1 中单击 （Right 

mouse click on Object），拖动到右面的

空白处。拖动 （Obj18）叠加到

（ObjectRClick_1）上出现黑框。在

Actions 窗口中，选中  （Rotation 

XYZ），拖动到 Event map 1中，叠加

在 （ObjectRClick_2）上，出现黑框。

选中 （Obj18），叠加在 （Rotation 

XYZ）上面，出现黑框。双击 （Rotation 

XYZ），弹出对话框，具体设置如图

71-11所示，选择 Repeat count方式，

单击 Close按钮。在 Actions中选中 
（Translation XYZ），拖动到 Event map 

1 中，叠加 （ObjectRClick_2）上，

出现黑框。选中 （Obj16）叠加在 
（Translation XYZ）上，出现黑框。双

击 （Translation XYZ）出现对话框，

具体设置如图 71-12所示，选择 Repeat 

count 方式，单击 Close 按钮。完成效

果如图 71-13所示。 

6．保存为 Lathe.c3p，本例制作完

成。 

 

图 71-9 

 

图 71-10 

 

图 71-11 

 

图 71-12 

 

图 71-13 
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实例 72  机  床（三） 

 

本例制作“机床（三）”的效果，

如图 72-1所示。 

本例特点：鼠标左击扳手，机床自

动走刀和推刀；鼠标右击扳手，机床主

轴停止转动。 

本例通过 Translation XYZ 和

Rotation XYZ等知识完成。 

 

图 72-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 Lathe.c3p（源文件）。执

行 File→Load project 命令，在对话框

中选中 Lathe 1.c3p，如图 72-2所示。 

3．制作开关机床主轴的效果。在

Event map 1中单击 （Left mouse click 

on Object），拖动到右面的空白处。在

Scene Graph中，找到 （Obj02），拖

动  （ Obj02 ） 叠 加 到  
（ObjectLClick_6）上，出现黑框。在

Actions中，选中 （Rotation XYZ），

拖动到 Event map 1 中，叠加在  
（ObjectLClick_6）上，出现黑框。选

中 （Obj02），叠加在 （Rotation 

XYZ）上，出现黑框。双击 （Rotation 

XYZ），弹出对话框，具体设置如图

72-3所示，选择 Repeat count方式，单

击 Close按钮。在 Action中单击 Event，

选中 （Trigger event），拖到Event map 

1 中，叠加在 （ObjectLClick_6）上，

出现黑框。选中 （ObjectLClick_6），

 

 

 

图 72-2 

 

 

 

图 72-3 
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拖动到 （Trigger event）上，出现黑

框。形成关系图如图 72-4所示。 

在 Event map 1 中单击 （Right 

mouse click on Object），拖动到右面的

空白处。拖动 （Obj02）叠加到

（ObjectRClick_3）上，出现黑框。在

Actions中，选中 （Rotation XYZ），

拖动到 Event map 1 中，叠加在

（ObjectRClick_3）上，出现黑框。选

中 （Obj02），叠加在 （Rotation 

XYZ）上，出现黑框。双击 （Rotation 

XYZ），弹出对话框，具体设置如图

72-5所示，选择 Repeat count方式，单

击 Close按钮。在 Actions中，选中

（Stop�），拖动到 Event map 1中，
叠加在 （ObjectRClick_3）上出现黑
框。选中 （Object14），叠加到
（Stop�）上，出现黑框。双击
（Stop�），出现对话框。左边选择
ObjectLClick_1.Rotation XYZ 、ObjectL- 
Click_2.Rotation XYZ 和 ObjectL- 
Click_3.Rotation XYZ，单击 加入，
单击 Close按钮如图 72-6所示。 

4．制作一次自动走刀的效果。在
Event map 1中单击 （Timer），拖动
到右面的空白处。右击 （Timer_1）
选择不要 Initial Activation。单击 Event，
选中 （activate event），拖动到 Event 
map 1中，叠加在 （ObjectLClick_6）
上，出现黑框。将 （Timer_1）拖动
到 （activate event）上，出现黑框。
在Action中单击Event，选中 （Trigger 
event），拖到 Event map 1中，叠加在
（Timer_1）上，出现黑框。分别选
中 （ObjectLClick_4）和 （ObjectL- 
Click_5），拖动到 （Trigger event）上，
出现黑框。完成效果如图 72-7所示。 
在 Event map 1中单击 （Timer），
拖动到右面的空白处。选中

 

图 72-4 

 

图 72-5 

 

图 72-6 

 

图 72-7 
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（Timer_2），右击选择不要 Initial 

Activation。双击 （Timer_2），出现

对话框，填入 8000（毫秒），单击 OK

按钮。单击 Event，选中 （activate 

event），拖动到 Event map 1中，叠加

在 （ObjectLClick_6）上，出现黑框。

将 （Timer_2）拖动到  （activate 

event）上，出现黑框。单击 Event，选

中 （Deactivate event），拖动到 Event 

map 1 中，叠加在 （Timer_2）上，

出现黑框。选中 （Timer_2），叠加

到 （Deactivate event）上出现黑框。

再单击 Event，选中  （Deactivate 

event），拖动到 Event map 1中，叠加

在 （Timer_2）上出现黑框。选中

（Timer_1），叠加到  （Deactivate 

event）上，出现黑框。完成效果如图

72-8所示。 

在 Event map 1中单击 （Timer），

拖动两次到右面的空白处。选中

（Timer_3）和 （Timer_4），单击右

键选择不要 Initial Activation。双击

（Timer_4），在出现的对话框中填入

8000（毫秒），单击 OK 按钮。单击

Event，选中 （activate event），拖动

两个到 Event map 1 中，叠加在

（Timer_2）上，出现黑框。完成效果

如图 72-10所示。将 （Timer_3）和

（Timer_4）分别拖动到  （activate 

event）上，出现黑框。在 Action 中单

击 Event，选中 （Trigger event），

拖到 Event map 1 中，叠加在

（Timer_3）上，出现黑框。分别选中

（ ObjectRClick_1 ） 和

（ObjectRClick_2），拖动到 （Trigger 

event）上，出现黑框。单击 Event，选

中 （Deactivate event），拖动到 Event 

map 1 中，叠加在 （Timer_4）上，

出现黑框。选中 （Timer_4），叠加

 

 

图 72-8 

 

 

 

 

 

图 72-9 
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到 （Deactivate event）上，出现黑框。

再单击 Event，选中  （Deactivate 

event），拖动到 Event map 1中，叠加

在 （Timer_4）上，出现黑框。选中

（Timer_3），叠加到  （Deactivate 

event）上，出现黑框。完成效果如图

72-10所示。 

5．保存为 Lathe.c3p，本例制作完

成。 

 

图 72-10 
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实例 73  显  微  镜 

 

本例制作“显微镜”的效果，如图

73-1所示。 

本例特点：单击光圈上的旋钮，控

制背景光亮；单击物镜控制放大倍数；

单击目镜，看到图像。 

本例通过 Scale XYZ、 Select 

camera和 Set background等知识完成。 

 

图 73-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 MICROSCP.C3D。执行

File→Add Cult3D Designer File命令，

在对话框中选中 MICROSCP.C3D，如

图 73-2所示。 

3．确定视角和右击鼠标回到本视

角的效果。在 Event Map1窗口中单击

 （World Start），拖到右侧的空白处。

在 Actions窗口中，单击 Camera，选中

（Select camera），拖到 Event map 1

中，叠加在 （World Start_1）上出现

黑框。在 Scene Graph 窗口中选中

（Camera01），拖到 Event map 1中，

叠加在 （Select camera）上出现黑框。

在 Event Map1 窗口中单击 （Right 

mouse click on Object），拖到右侧的空

白处。在 Actions窗口中，单击 Camera，

选中 （Select camera），拖到 Event 

map 1中，叠加在 （ObjectRClick_1）

上，出现黑框。选中 （Camera01），

叠加在 （Select camera）上出现黑框。

 

 

图 73-2 

 

 

图 73-3 
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效果如图 73-3所示。 

4．制作通过单击目镜看到红细胞

的效果。在 Event map 1中单击 （Left 

mouse click on Object），拖动到右面的

空白处。在 Scene Graph 中，找到 
（eyepce），拖动到 （ObjectLClick_1）

上，出现黑框。在 Actions窗口中，单

击 Camera，选中 （Select camera），

拖到 Event map 1 中，叠加在  
（ObjectLClick_1）上出现黑框。选中

（ Camera02），叠加在 （ Select 

camera）上，出现黑框，效果如图 73-4

所示。 

5．制作调整背景亮度的效果。在

Event map 1中单击 （Left mouse click 

on Object），拖动到右面的空白处。在

Scene Graph窗口中，找到 （diahndl），

叠加到 （ObjectLClick_2）上出现黑

框。在 Action中单击 Render，选中

（Set background），拖动到 Event map 

1 中，叠加在 （ObjectLClick_2）上

面 ， 出 现 黑 框 。 双 击 （ Set 

background），出现对话框。单击中间

的 Color，在出现的对话框中右下角的

自定义颜色里填入：红=255，绿=255，

蓝 =255，单击确定按钮回到 Set 

background action details对话框中，单

击 OK按钮，如图 73-5所示。在 Event 

Map1窗口中单击 （Right mouse click 

on Object），拖到右侧的空白处。拖动

 （ diahndl ） 叠 加 到

（ObjectRClick_2）上出现黑框。在

Action 中单击 Render，选中 （Set 

background），拖动到 Event map 1中，

叠加在 （ObjectLClick_2）上面，出

现黑框。双击 （Set background），

出现对话框。单击中间的 Color，在出

现的对话框中右下角的自定义颜色里

填入：红=109，绿=109，蓝=109，单

 

图 73-4 

 

图 73-5 

 

图 73-6 
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击确定按钮回到 Set background action 

details对话框中，单击 OK按钮，如图

73-6所示。在 Action中单击 Render，

选中 （Set background），拖动到 Event 

map 1中，叠加在 （World Start_1）

上 ， 出 现 黑 框 。 双 击 （ Set 

background），出现对话框。单击中间

的 Color，在出现的对话框中右下角的

自定义颜色里填入：红=192，绿=192，

蓝 =192，单击确定按钮回到 Set 

background action details对话框中，单

击 OK按钮，如图 73-7所示。 

6．制作换物镜放大缩小的效果。

在 Event map 1中单击 （Left mouse 

click on Object），拖动到右面的空白

处。在 Scene Graph 中，找到  
（Objectives），拖动 （Objectives）

叠加到 （ObjectLClick_3）上，出现

黑框。Actions 中选中  （Rotation 

XYZ），拖动到 Event map 1中，叠加

在 （ObjectLClick_3）上，出现黑框。

选中 （Objectives），拖到 （Rotation 

XYZ）上，出现黑框。双击 （Rotation 

XYZ），弹出对话框，具体设置如图

73-8所示，选择 Repeat count方式，单

击 Close按钮。Actions窗口中，选中

（Scale XYZ），拖动到 Event map 1

中，叠加在 （ObjectLClick_3）上，

出现黑框。双击 （Scale XYZ）出现

对话框，具体设置如图 73-9 所示，单

击 OK按钮。在 Event Map1窗口中单

击 （Right mouse click on Object），

拖 到 右 侧 的 空 白 处 。 拖 动  
（ Objectives ） 叠 加 到

（ObjectRClick_3）上，出现黑框。在

Actions 中选中 （Rotation XYZ），

拖动到 Event map 1 中，叠加在  
（ObjectRClick_3）上，出现黑框。选

中 （Objectives），拖到 （Rotation 

 

图 73-7 

 

图 73-8 

 

图 73-9 

 

图 73-10 
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XYZ）上，出现黑框。双击 （Rotation 

XYZ），弹出对话框，具体设置如图

73-10所示，选择 Repeat count方式，

单击 Close按钮。在 Actions中选中

（Scale XYZ），拖动到 Event map 1

中，叠加在 （ObjectLClick_3）上，

出现黑框。双击 （Scale XYZ）出现

对话框，具体设置如图 73-11所示，单

击OK按钮。完成效果如图 73-12所示。 

7．保存为 Bf109G6.c3p，本例制

作完成。 

 

图 73-11 

 

图 73-12 
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实例 74  钻  床 （一） 

 

本例制作“钻床（一）”的效果，

如图 74-1所示。 

本例特点：单击开关，钻头旋转，

再单击停止。按 Arrow Left 和 Arrow 

Right键旋转视角。 

本例通过 Scale XYZ、 Select 

camera和 Set background等知识完成。 

 

图 74-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 DRLPRESS.C3D。执行

File→Add Cult3D Designer File命令，

在对话框中选中 DRLPRESS.C3D，如

图 74-2所示。 

3．确定视角和制作 Arcball。在

Event Map1 窗口中单击  （World 

Start），拖到右侧的空白处。在 Actions

窗口中，单击 Camera，选中 （Select 

camera），拖到 Event map 1中，叠加

在 （World Start_1）上，出现黑框。

在 Scene Graph中选中 （Camera01），

拖到 Event map 1中，叠加在 （Select 

camera）上，出现黑框。在 Actions中，

单击 Object Motion，选中 （Arcball），

拖到 Event map 1中，叠加在 （World 

Start）上，出现黑框。在 Scene Graph

中 ， 单 击 RootNode ， 选 中  
（DRLPRESS），拖到 Event map 1中，

叠加在 （Arcball）上，出现黑框。

效果如图 74-3所示。 

 

 

 

图 74-2 

 

图 74-3 
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4．制作视角转动的效果。在 Event 

map 1 中单击 （Keyboard�s key 
press），拖动两次到右面的空白处。双
击 （KeyPress_1），弹出对话框，在
左边框中选中 Arrow Left，单击 Add
按钮，单击 OK 按钮。双击
（KeyPress_2），弹出对话框，在左边
框中选中 Arrow Right，单击 Add按钮，
单击 OK按钮。在 Action中单击 Object 
motion选项，选中 （Rotation XYZ），
按住并拖动两次到 Event map 1中，分
别叠加在 （ KeyPress_1）和
（KeyPress_2）上面，出现黑框。选中
 （DRLPRESS），叠加在两个  
（Rotation XYZ）上面，出现黑框。双
击 （KeyPress_1）的  （Rotation 
XYZ），弹出对话框，具体设置如图
74-4所示，选择 Loop方式，单击 Close
按钮。双击 （KeyPress_2）的  
（Rotation XYZ），弹出对话框，具体
设置如图 74-5所示，选择 Loop方式，
单击 Close按钮。在 Event map 1中单
击 （Keyboard�s key release），拖动
两次到右面的空白处。双击

（KeyRelease_1），弹出对话框，在左
边框中选中 Arrow Left，单击 Add 按
钮 ， 单 击 OK 按 钮 。 双 击
（KeyRelease_2），弹出对话框，在左
边框中选中 Arrow Right，单击 Add按
钮，单击 OK按钮。在 Actions中，选
中 （Stop�），拖动两次到 Event map 
1中，分别叠加在 （KeyRelease_1）
和 （KeyRelease_2）上，出现黑框。
选中 （DRLPRESS），叠加到两个
（Stop�）上，出现黑框。双击
（KeyRelease_1）的 （Stop�），出
现对话框如图 74-6 所示。在左边选择
KeyPress_1.Rotation XYZ，单击 加
入 ， 单 击 Close 按 钮 。 双 击

 

图 74-4 

 

图 74-5 

 

图 74-6 

 

图 74-7 
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（KeyRelease_2）的 （Stop�），出
现对话框如图 74-7 所示。在左边选择
KeyPress_2.Rotation XYZ，单击 加
入，单击 Close 按钮。效果如图 74-8
所示。 

5．制作开动电动机的效果。在
Event map中单击 （Left mouse click 
on Object），拖动到右面的空白处。在
Scene Graph中，找到 （objec01），
拖动到 （ObjectLClick_1）上出现黑
框。单击 Object motion选项，选中 
（Rotation XYZ），拖动到 Event map 1
中，叠加在 （ObjectLClick_1）上，
出现黑框。双击 （ObjectLClick_1）
的 （Rotation XYZ），弹出对话框，
具体设置如图 74-9所示，选择 Loop方
式，单击 Close 按钮。在 Scene Graph
窗口中，单击 RootNode，选中  
（Object16）拖动到 （Object08）上。
将 （Object08）拖到 Event map 1中，
叠加在 （Rotation XYZ）上，出现黑
框。在 Event map中单击 （Left mouse 
click on Object），拖动到右面的空白
处 。 拖 动  （ objec01 ） 到  
（ObjectLClick_2）上，出现黑框。在
Actions 窗口中，选中 （Stop�），
拖动到 Event map 1 中，叠加在  
（ObjectLClick_2）上，出现黑框。双
击的 （Stop�），出现对话框如图
74-10 所示。在左边选择 ObjectLClick 
_1.Rotation XYZ，单击 加入，单击
Close 按钮，如图 74-11 所示。右键单
击 （ObjectLClick_2），选择不要 Initial 
Activation。在 Actions 窗口中，单击
Event，选中 （Deactivate event），按
住并拖动两次到 Event map 1中，叠
加 在  （ ObjectLClick_1 ） 和  
（ObjectLClick_2）上，出现黑框。选中 
（ObjectLClick_1）和 （ObjectLClick_2），

 

图 74-8 

 

图 74-9 

 

图 74-10 
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分别拖动叠加到 （Deactivate event）

上，出现黑框。单击 Event，选中 
（activate event），拖动两次到 Event 

map 1中，分别叠加在 （ObjectLClick_1）

和 （ObjectLClick_2）上，出现黑框。

拖 动  （ ObjectLClick_1 ） 和  
（ ObjectLClick_2 ） 到 对 方 的  
（activate event）上出现黑框。效果如

图 74-12所示。 

6．保存为 DRLPRESS.c3p，本例

制作完成。 

 

图 74-12 



第六篇  工业篇 

 
235 

实例 75  钻  床 （二） 

 

本例制作“钻床（二）”的效果，

如图 75-1所示。 

本例特点：单击手柄，钻头下降，3

秒后自动返回。 

本 例 通 过 Rotation XYZ 和

Translation XYZ等知识完成。 

 

图 75-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 DRLPRESS.c3p（源文件）。

执行 File→Load project命令，在对话框

中选中 DRLPRESS.c3p，如图 75-2所示。 

3．制作开合机箱盖的效果。在 Event 

map 中单击  （Left mouse click on 

Object），拖动两次到右面的空白处。在

Scene Graph窗口中，找到 （Object20），

分别拖动到 （ObjectLClick_3）和 
（ObjectLClick_4）上，出现黑框。单击

Object motion 选项，选中 （Rotation 

XYZ），按住并拖动两次到 Event map 1

中，叠加在 （ObjectLClick_3）和 
（ObjectLClick_4）上，出现黑框。选中

 （Object20），拖动分别叠加在两个 
（Rotation XYZ）上，出现黑框。双击 
（ ObjectLClick_3 ） 的  （ Rotation 

XYZ），弹出对话框，具体设置如图 75-3

所示，选择 Repeat count方式，单击 Close

按钮。双击 （ObjectLClick_4）的 
（Rotation XYZ），弹出对话框，具体

设置如图 75-4所示，选择 Repeat count

 

图 75-2 

 

图 75-3 

 

图 75-4 
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方式，单击 Close 按钮，效果如图 75-5

所示。右击 （ObjectLClick_4），选择

不要 Initial Activation。在 Actions中，单

击 Event，选中 （Deactivate event），

拖动两次到 Event map 1 中，叠加在 
（ObjectLClick_3）和 （ObjectLClick_4）

上面，出现黑框。选中 （ObjectLClick_3）

和 （ObjectLClick_4），拖动分别叠加

到 （Deactivate event）上，出现黑框。

单击 Event，选中 （activate event），

拖动两次到 Event map 1中，分别叠加在

 （ObjectLClick_3）和 （ObjectLClick_4）

上，出现黑框。拖动 （ObjectLClick_3）

和  （ObjectLClick_4）到对方的  
（activate event）上，出现黑框。效果如

图 75-6所示。 

4．设置开合机箱与开动电动机的关

系。右击 （ObjectLClick_1），选择不要

Initial Activation。在 Actions 中，单击

Event，选中 （Deactivate event），拖动到

Event map 1中，叠加在 （ObjectLClick_4）

上，出现黑框。选中 （ObjectLClick_1）

和 （ObjectLClick_2），分别拖动叠加到

 （Deactivate event）上，出现黑框。单

击 Event，选中 （activate event），拖动

到 Event map 1 中 ， 叠 加 在  
（ObjectLClick_3）上，出现黑框。拖动

 （ObjectLClick_1）和 （ObjectLClick 

_2）到的 （activate event）上，出现黑

框。在 Actions中，选中 （Stop�），
拖动到 Event map 1 中，叠加在  
（ObjectLClick_4）上，出现黑框。选中

 （Object16），叠加到 （Stop�）
上，出现黑框。双击的 （Stop�），
出现对话框如图 75-7 所示。选择
ObjectLClick_1.Rotation XYZ，单击
加入，单击 Close按钮。效果图如图 75-8
所示。 

5．制作钻头下压的效果。在 Event 

 

图 75-5 

 

图 75-6 

 

图 75-7 
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map 1 中单击 （Left mouse click on 

Object），拖动到右面的空白处。找到 
（Object03），拖动到 （ObjectLClick_5）

上，出现黑框。在 Event map 1中单击

（Timer），拖动到右面的空白处。双击

（Timer_1），在弹出的对话框中填

3000（毫秒），单击 OK 按钮。右击

（Timer_1）选择不要 Initial Activation。

单击 Event，选中 （activate event），

拖动到 Event map 1 中，叠加在  
（ObjectLClick_5）上，出现黑框。拖动

（Timer_1）到 （activate event）上，

出现黑框。单击 Event，选中  
（Deactivate event），拖动到 Event map 

1中，叠加在 （Timer_1）上出现黑框。

拖动 （Timer_1）叠加在 （Deactivate 

event）上出现黑框，如图 75-9所示。单

击 Object motion选项，选中 （Rotation 

XYZ），拖动到 Event map 1中，叠加在

 （ObjectLClick_5）和 （Timer_1）

上面，出现黑框。选中 （Object20），

拖动分别叠加在两个 （Rotation XYZ）

上 面 ， 出 现 黑 框 。 双 击 的  
（ ObjectLClick_5 ） 的  （ Rotation 

XYZ），弹出对话框，具体设置如图 75-10

所示，单击 Close 按钮。双击的

（Timer_1）的 （Rotation XYZ），弹

出对话框，在 X轴中输入 60（角度），

Time设为 2000（毫秒），选择默认方式，

单击 Close 按钮。Actions 中，选中 
（Translation XYZ），按住并拖动两次

到 Event map 1 中，分别叠加在  
（ObjectLClick_5）和 （Timer_1）上，

出现黑框。选中 （Object08）后叠加

在 （Translation XYZ）上面，出现黑

框。双击  （ObjectLClick_5）的  
（Translation XYZ），在对话框中的 X

方向上填入 100（位移），Time设为 2000

（毫秒），选择默认方式，单击 Close

 

图 75-8 

 

 

图 75-9 
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按钮。双击 （Timer_1）的 （Translation 

XYZ），在对话框中的X方向上填入�100
（位移），Time设为 2000（毫秒），选
择默认方式，单击 Close 按钮。完成效
果如图 75-11所示。 

6．保存为 DRLPRESS 1.c3p，本例
制作完成。 

 

图 75-11 

 
 
 



 

 

军  事  篇 

本篇介绍如何制作各种国防工业中的军事化

产品，例如激光炮、坦克、军舰等。相信军事爱

好者在这里一定可以找到自己的最爱。

本篇不仅仅满足于模型的展示，而是进一步

制作了强烈视觉效果，如激光炮发射的火焰等。

读者在本篇中也可以体会一下操纵各类武器，充

当指挥员的感受。通过本篇的学习，读者可以充

分感受到 Cult 3D 的巨大功能。
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实例 76  激 光 炮（一） 

 

本例制作“激光炮（一）”的效果，

如图 76-1所示。 

本例特点：单击鼠标左键，激光炮

打开，按下键盘“1”、“2”键上下瞄准。 

本例通过 Deactive event、Rotation 

XYZ和 Translation XYZ等知识完成。 

 

图 76-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 Gun.C3D。执行 File→Add 

Cult3D Designer File命令，在对话框中

选中 Gun.C3D，如图 76-2所示。 

3．添加 Arcball。在 Event Map1

窗口中单击 （World Start），拖到右

侧的空白处。在 Actions中，单击 Object 

Motion，选中 （Arcball），拖到 Event 

map 1中，叠加在 （World Start）上，

出现黑框。在 Scene Graph 中，单击

Rootnode，选中 （Group_All），拖

到 Event map 1中，叠加在 （Arcball）

上，出现黑框。效果如图 76-3所示。 

4．制作舱门打开的效果。在 Event 

map 1中单击 （Left mouse click on 

Object），拖动到右面的空白处。单击

Object motion选项，选中 （Rotation 

XYZ），拖动到 Event map 1中，叠加

在  （ObjectLClick_1）上，出现黑框。

选中 Scene Graph中的 （Group12）,

拖动到 （Rotation XYZ）上，出现黑

框。双击 （Rotation XYZ），弹出对

 

 

图 76-2 

 

 

图 76-3 
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话框，在 Y轴中输入 120（角度），Time

设为 2000（毫秒），选择 Repeat count

方式，单击 Close按钮。 

5．制作激光炮旋转上升的效果。

在 Actions窗口中，单击 Object motion

选项，选中 （Translation XYZ），拖

动到 Event map 1 中，叠加在   

（ObjectLClick_1）上，出现黑框。单

击Object motion选项，选中 （Rotation 

XYZ），拖动到 Event map 1中，叠加

在  （ObjectLClick_1）上，出现黑框。

选中 Scene Graph中的 （Group07），

拖动到 （Translation XYZ）上，出现

黑框。将  （Group_All）拖动到  
（Rotation XYZ）上，出现黑框。双击

  （Translation XYZ），弹出对话框，

具体设置如图 76-4 所示，选择 Repeat 

count 方式，单击 Close 按钮。双击 
（Rotation XYZ），弹出对话框，具体

设置如图 76-5所示，选择 Repeat count

方 式 ， 单 击 Close 按 钮 。 在   

（ObjectLClick_1）上右击选择 Edit 

with Time Line View命令，弹出对话框

如图 76-6所示，将 Translation XYZ和

后一个 Rotation XYZ的时间拖动到第

一个 Rotation XYZ以后，关闭对话框。 

6．制作激光炮打开的效果。单击
Object motion选项，选中 （Rotation 

XYZ），拖动到 Event map 1中，叠加

在 （ObjectLClick_1）上，出现黑框。

选中 Event map 1中的 （Group11），

拖动到 （Rotation XYZ）上，出现黑

框。双击 （Rotation XYZ），弹出对

话框。在 Y轴中输入 90（角度），Time

设为 2000（毫秒），选择 Repeat count

方 式 ， 单 击 Close 按 钮 。 在   

（ObjectLClick_1）上右击选择 Edit 

with Time Line View命令，弹出对话框

如图 76-7 所示，将最后一个 Rotation 

XYZ 拖动到其他 Actions 的最后。在

 

图 76-4 
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Actions 窗口中，单击 Event，选中 
（Deactivate event），拖动到 Event map 

1中，叠加在 （ObjectLClick_1）上，

出现黑框。选中 （Deactivate event），

右击选择 parameters 命令，弹出对话

框，如图 76-8 所示，在左边框中选中
ObjectLClick_1，单击 Add按钮，单击
OK按钮。形成的Event map 1如图 76-9

所示。 

7．制作激光炮瞄准的效果。在
Event map 中单击 （Keyboard�s key 
press），拖动到右面的空白处。单击
Object motion选项，选中 （Rotation 
XYZ），拖动到 Event map 1中，叠加
在  （KeyPress_1）上，出现黑框。,
拖动  （Group11）到  （Rotation 
XYZ），出现黑框。双击 （Rotation 
XYZ），弹出对话框，在 Y轴中输入 5
（角度），Time 设为 500（毫秒），
选择 Loop 方式，单击 Close 按钮。在
Event map 中单击 （Keyboard�s key 
press），拖动到右面的空白处。单击
Object motion选项，选中 （Rotation 
XYZ），拖动到 Event map 1中，叠加
在  （KeyPress_2）上，出现黑框。,
拖动 （Group11）到 （Rotation XYZ）
上，出现黑框。双击 （Rotation XYZ），
弹出对话框，在 Y轴中输入�5（角度），
Time设为 500（毫秒），选择 Loop方
式 ， 单 击 Close 按 钮 。 双 击
（KeyPress_1），弹出对话框如图 76-10
所示，在左边框中选中 1，单击 Add按
钮 ， 单 击 OK 按 钮 。 双 击
（KeyPress_2），弹出对话框，在左边
框中选中 2，单击 Add按钮，单击 OK
按钮。形成的 Event map 1如图 76-11
所示。 

8．保存为 Gun.c3p，本例制作完
成。 

 

图 76-9 

 

图 76-10 

 

图 76-11 
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实例 77  激 光 炮（二） 

 

本例制作“激光炮（二）”的效果，

如图 77-1所示。 

本例特点：用鼠标右键单击，激光

炮关闭，打开、关闭和瞄准相互关联。 

本例通过 Activate event、Deactive 

event、Rotation XYZ、Translation XYZ

和 Reset等知识完成。 

 

图 77-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 Gun.c3p（源文件）。执

行 File→Load project 命令，在对话框

中选中 Gun.c3p，如图 77-2所示。 

3．制作激光炮关闭的效果。在

Event Map1 窗口中单击 （Right 

mouse click on Object），拖到右侧的空

白处。在 Actions 中，单击 Object 

Motion，选中 （Reset），拖到 Event 

map 1中，叠加在 （ObjectRClick_1）

上，出现黑框。选中 （Group11），

拖到 （Reset）上，出现黑框。单击

Object Motion，选中  （ Rotation 

XYZ），拖到 Event map 1中，叠加在

（ObjectRClick_1）上，出现黑框。

选中 （Group_All），拖到 （Rotation 

XYZ）上，出现黑框。双击 （Rotation 

XYZ），弹出对话框，具体设置如图

77-3所示，选择 Repeat count方式，单

击 Close 按钮。选中  （Translation 

XYZ），拖到 Event map 1中，叠加在

 

 

图 77-2 

 

 

 

图 77-3 
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（ObjectRClick_1）上，出现黑框。

选 中  （ Group07 ） ， 拖 到   

（Translation XYZ）上，出现黑框。双

击  （Translation XYZ），弹出对话

框，具体设置如图 77-4 所示，选择

Repeat count方式，单击 Close按钮。

单击 Object Motion，选中 （Rotation 

XYZ），拖到 Event map 1中，叠加在

（ObjectRClick_1）上，出现黑框。

选中 （Group12），拖到 （Rotation 

XYZ）上，出现黑框。双击 （Rotation 

XYZ），弹出对话框，具体设置如图

77-5所示，选择 Repeat count方式，单

击 Close按钮。在 （ObjectRClick_1）

上右击选择 Edit with Time Line View，

弹出对话框如图 77-6 所示，将

Translation XYZ 和后一个 Rotation 

XYZ 的时间拖动到第一个 Rotation 

XYZ以后，关闭对话框。效果如图 77-7

所示。 

4．建立打开和关闭之间的关系。

用鼠标右键单击 （ObjectRClick_1），

选择不要 Initial Activation。在 Actions

窗口中，单击 Event，选中 （Deactivate 

event），拖动到 Event map 1中，叠加

在 （ObjectRClick_1）上，出现黑框。

选中 （Deactivate event），右击选择

parameters命令，弹出对话框，在左边

框中选中 ObjectRClick_1，单击 Add按

钮，单击 OK按钮。在 Actions窗口中，

单击 Event，选中 （activate event），

拖动到 Event map 1 中，叠加在

（ObjectRClick_1）上，出现黑框。将 
（ObjectLClick_1）拖动到 （activate 

event）上，出现黑框。选中 （activate 

event），拖动到 Event map 1中，叠加

在  （ObjectLClick_1）上，出现黑框。

将 （ ObjectRClick_1）拖动到  
（activate event）上，出现黑框。完成

 

图 77-4 

 

 

图 77-5 

 

 

图 77-6 

 

 

图 77-7 
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效果如图 77-8所示。 

5．建立打开和瞄准之间的关系。

用鼠标右键单击 （KeyPress_1），选

择不要 Initial Activation。在 Actions窗

口中，单击 Event，选中 （activate 

event），拖动到 Event map 1中，叠加

在  （ObjectLClick_1）上，出现黑框。

选中 （activate event），右击选择

parameters命令，弹出对话框，如图 77-9

所示，在左边框中选中 KeyPress_1，单

击 Add 按钮，单击 OK 按钮。右击

（ KeyPress_2），选择不要 Initial 

Activation。在 Actions中，单击 Event，

选中 （activate event），拖动到 Event 

map 1中，叠加在  （ObjectLClick_1）

上，出现黑框。选中 （activate event），

右击选择 parameters 命令，弹出对话

框，在左边框中选中 KeyPress_2，单击

Add按钮，单击 OK按钮。完成效果如

图 77-10所示。 

6．建立打开和瞄准之间的关系。

在 Actions窗口中，单击 Event，选中 
（Deactivate event），拖动到 Event map 

1中，叠加在 （ObjectRClick_1）上，

出现黑框。选中 （Deactivate event），

右击选择 parameters 命令，弹出对话

框，在左边框中选中 KeyPress_1，单击

Add 按钮，单击 OK 按钮。在 Actions

窗口中，单击 Event，选中 （Deactivate 

event），拖动到 Event map 1中，叠加

在 （ObjectRClick_1）上，出现黑框。

选中 （Deactivate event），右击选择

parameters命令，弹出对话框，在左边

框中选中 KeyPress_2，单击 Add按钮，

单击OK按钮。完成效如图 77-11所示。 

7．保存为 Gun 1.c3p，本例制作

完成。 

 

图 77-8 

 

图 77-9 

 

图 77-10 

 

图 77-11 
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实例 78  M1A1 坦 克（一） 

 

本例制作“M1A1坦克（一）”的

效果，如图 78-1所示。 

本例特点：按方向键控制车体行

动，按 A、D键控制炮塔转动，按W、

S键控制火炮俯仰，车体旋转时火炮始

终指着目标。 

本 例 通 过 Rotation XYZ 和

Translation XYZ等知识完成。 

 

图 78-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 M1a1.C3D。执行 File→

Add Cult3D Designer File命令，在对话

框中选中M1a1.C3D，如图 78-2所示。 

3．确定包含关系。在 Scene Graph

中，单击RootNode，单击 （Sespention），

拖动到 （Hull）上，出现黑色。 

4．添加 Arcball。在 Event Map1

窗口中单击 （World Start），拖到右

侧的空白处。在 Actions窗口中，单击
Object Motion，选中 （Arcball），拖

到 Event map 1中，叠加在 （World 

Start）上，出现黑框。在 Scene Graph

窗口中，单击RootNode，选中 （Hull），

拖到 Event map 1 中，叠加在  
（Arcball）上，出现黑框。效果如图
78-3所示。 

5．制作车体前进转弯的效果。在
Event map 1中单击 （Keyboard�s key 
press），拖动到右面的空白处。单击
Object motion选项，选中 （Translation 

 

 

图 78-2 

 

图 78-3 
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XYZ），拖动到 Event map 1中，叠加

在 （KeyPress_1）上，出现黑框。拖

动 （Hull）到 （Translation XYZ）

上，出现黑框。双击  （Translation 

XYZ），弹出对话框，具体设置如图
78-4所示，选择 Loop方式，单击 Close

按钮。双击 （KeyPress_1），弹出对

话框如图 78-5 所示，在左边框中选中
Arrow Up，单击 Add 按钮，单击 OK

按钮。在 Event map 1 中单击

（Keyboard�s key press），拖动到右面
的空白处。单击 Object motion 选项，
选中 （Translation XYZ），拖动到
Event map 1中，叠加在 （KeyPress_2）
上，出现黑框。拖动 （Hull）到 
（Translation XYZ），出现黑框。双击
 （Translation XYZ），弹出对话框，
具体设置如图 78-6所示，选择 Loop方
式 ， 单 击 Close 按 钮 。 双 击
（KeyPress_2），弹出对话框，在左边
框中选中Arrow Down，单击Add按钮，
单击OK按钮。在Event map 1中单击
（Keyboard�s key press），拖动到右面
的空白处。单击 Object motion 选项，
选中 （Rotation XYZ），拖动到 Event 
map 1中，叠加在 （KeyPress_3）上，
出现黑框。拖动 （Hull）到 （Rotation 
XYZ），出现黑框。双击 （Rotation 
XYZ），弹出对话框，具体设置如图
78-7所示，选择 Repeat count方式，单
击 Close按钮。双击 （KeyPress_3），
弹出对话框，在左边框中选中 Arrow 
Left，单击 Add按钮，单击 OK按钮。
在 Event map 1中单击 （Keyboard�s 
key press），拖动到右面的空白处。单
击Object motion选项，选中 （Rotation 
XYZ），拖动到 Event map 1中，叠加
在 （KeyPress_4）上，出现黑框。拖
动 （Hull）到 （Rotation XYZ），
出现黑框。双击 （Rotation XYZ），

 

图 78-4 

 

图 78-5 

 

图 78-6 

 

图 78-7 

 

图 78-8 
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弹出对话框，具体设置如图 78-8，选择
Repeat count方式，单击 Close按钮。

双击 （KeyPress_4），弹出对话框，

在左边框中选中Arrow Right，单击Add

按钮，单击 OK 按钮。完成效果如图
78-9所示。 

6．制作炮塔旋转的效果。在 Event 

map 1 中单击 （Keyboard�s key 
press），拖动到右面的空白处。单击
Object motion选项，选中 （Rotation 
XYZ），拖动到 Event map 1中，叠加
在 （KeyPress_5）上，出现黑框。单
击 RootNode，单击 （Hull），选中 
（Turret），拖到 Event map 1中，叠加
在 （Rotation XYZ）上，出现黑框。
双击 （Rotation XYZ），弹出对话框，
具体设置如图 78-10，选择 Repeat count
方式，单击 Close 按钮。双击
（KeyPress_5），弹出对话框，在左边
框中选中 a，单击 Add按钮，单击 OK
按钮。在 Event map 1 中单击
（Keyboard�s key press），拖动到右面
的空白处。单击 Object motion 选项，
选中 （Rotation XYZ），拖动到 Event 
map 1中，叠加在 （KeyPress_6）上，
出现黑框。选中 （Turret），叠加在 
（Rotation XYZ）上，出现黑框。双击
 （Rotation XYZ），弹出对话框，具
体设置如图 78-11，选择 Repeat count
方式，单击 Close 按钮。双击
（KeyPress_6），弹出对话框，在左边
框中选中 d，单击 Add按钮，单击 OK
按钮。完成效果如图 78-12所示。 

7．制作火炮俯仰的效果。在 Event 
map 1 中单击 （Keyboard�s key 
press），拖动到右面的空白处。单击
Object motion选项，选中 （Rotation 
XYZ），拖动到 Event map 1中，叠加
在 （KeyPress_7）上，出现黑框。单
击 RootNode，单击 （Hull），再单

 

图 78-9 

 

图 78-10 

 

图 78-11 

 

图 78-12 
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击 （Turret），选中 （Barrel），

拖到 Event map 1 中，叠加在  
（Rotation XYZ）上，出现黑框。双击

 （Rotation XYZ），弹出对话框，具

体设置如图 78-13，选择 Repeat count

方式，单击 Close 按钮。双击

（KeyPress_7），弹出对话框，在左边

框中选中 w，单击 Add按钮，单击 OK

按钮。在 Event map 1 中单击

（Keyboard�s key press），拖动到右面
的空白处。单击 Object motion 选项，
选中 （Rotation XYZ），拖动到 Event 
map 1中，叠加在 （KeyPress_6）上，
出现黑框。选中 （Barrel），叠加在 
（Rotation XYZ）上，出现黑框。双击
 （Rotation XYZ），弹出对话框，具
体设置如图 78-14，选择 Repeat count
方式，单击 Close 按钮。双击
（KeyPress_8），弹出对话框，在左边
框中选中 s，单击 Add按钮，单击 OK
按钮。 

8．制作炮塔和车体旋转的关系。
单击 Object motion 选项，选中  
（Rotation XYZ），拖动到 Event map 1
中，叠加在 （KeyPress_3）上，出现
黑框。选中 （Turret），叠加在 
（Rotation XYZ）上，出现黑框。双击
 （Rotation XYZ），弹出对话框，具
体设置如图 78-15 所示，选择 Repeat 
count 方式，单击 Close 按钮。单击
Object motion选项，选中 （Rotation 
XYZ），拖动到 Event map 1中，叠加
在 （KeyPress_4）上，出现黑框。选
中 （ Turret），叠加在 （Rotation 
XYZ）上，出现黑框。双击 （Rotation 
XYZ），弹出对话框，具体设置如图
78-16，选择 Repeat count 方式，单击
Close按钮。完成效果如图 78-17所示。 

9．保存为M1a1.c3p，本例制作完
成。 

 

图 78-13 

 

图 78-14 

 

图 78-15 

 

图 78-16 

 

图 78-17 
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实例 79  M1A1 坦 克（二） 

 

本例制作“M1A1坦克（二）”的

效果，如图 79-1所示。 

本例特点：按 Enter键控制开炮的

效果，车体前进、后退或转弯时主动轮

相应转动，按空格键改变背景颜色。 

本 例 通 过  Rotation XYZ 、

Translation XYZ、Start particle emission

和 Stop particle emission等知识完成。 

 

图 79-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载M1a1.c3p（源文件）。执

行 File→Load project 命令，在对话框

中选中M1a1.c3p，如图 79-2所示。 

3．制作改变背景色彩的效果。在

Event map 1中单击 （Keyboard�s key 
press），拖动到右面的空白处。在 Action
中 单 击 Render ， 选 中 （ Set 
background），拖动到 Event map 1中，
叠加在 （KeyPress_9）上，出现黑框。
双击 （Set background），出现对话
框如图 79-3所示。单击中间的 Color，
再出现的对话框中选择黑色，单击 OK
按钮。双击 （KeyPress_9），弹出对
话框，在左边框中选中 Space，单击
Add按钮，单击 OK按钮。 

4．制作进退时主动轮旋转的效果。
单击 Object motion 选项，选中  
（Rotation XYZ），拖动到 Event map 1
中，叠加在 （KeyPress_1）上，出现

 

图 79-2 

 

图 79-3 
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黑框。单击 RootNode，单击 （Hull），

选中 （Drive L），拖到 Event map 1

中，叠加在 （Rotation XYZ）上，出

现黑框。双击 （Rotation XYZ），弹

出对话框，具体设置如图 79-4 所示，

选择 Loop 方式，单击 Close 按钮。单

击Object motion选项，选中 （Rotation 

XYZ），拖动到 Event map 1中，叠加

在 （KeyPress_1）上，出现黑框。单

击 RootNode，单击 （Hull），选中 
（Drive R），拖到 Event map 1中，叠

加在 （Rotation XYZ）上，出现黑框。

双击 （Rotation XYZ），弹出对话框，

具体设置如图 79-5所示，选择 Loop方

式，单击Close按钮。单击Object motion

选项，选中 （Rotation XYZ），拖动

到 Event map 1 中 ， 叠 加 在

（KeyPress_2）上，出现黑框。选中 
（Drive L），拖到 Event map 1中，叠

加在 （Rotation XYZ）上，出现黑框。

双击 （Rotation XYZ），弹出对话框，

具体设置如图 79-6所示，选择 Loop方

式，单击Close按钮。单击Object motion

选项，选中 （Rotation XYZ），拖动

到 Event map 1 中 ， 叠 加 在

（KeyPress_2）上，出现黑框。选中 
（Drive R），拖到 Event map 1中，叠

加在 （Rotation XYZ）上，出现黑框。

双击 （Rotation XYZ），弹出对话框，

具体设置如图 79-7所示，选择 Loop方

式，单击Close按钮。完成效果如图 79-8

所示。 

5．制作转弯时主动轮旋转的效果。

单击 Object motion 选项，选中  
（Rotation XYZ），拖动到 Event map 1

中，叠加在 （KeyPress_3）上，出现

黑框。选中 （Drive L），拖到 Event 

map 1中，叠加在 （Rotation XYZ）

上，出现黑框。双击 （Rotation XYZ），

 

图 79-4 

 

图 79-5 

 

图 79-6 

 

图 79-7 

 

图 79-8 
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弹出对话框，具体设置如图 79-9所示，

选择 Repeat count方式，单击 Close按

钮。单击 Object motion选项，选中 
（Rotation XYZ），拖动到 Event map 1

中，叠加在 （KeyPress_3）上，出现

黑框。选中 （Drive R），拖到 Event 

map 1中，叠加在 （Rotation XYZ）

上，出现黑框。双击 （Rotation XYZ），

弹出对话框，具体设置如图79-10所示，

选择 Repeat count方式，单击 Close按

钮。单击 Object motion选项，选中 
（Rotation XYZ），拖动到 Event map 1

中，叠加在 （KeyPress_4）上，出现

黑框。选中 （Drive L），拖到 Event 

map 1中，叠加在 （Rotation XYZ）

上，出现黑框。双击 （Rotation XYZ），

弹出对话框，具体设置如图79-11所示，

选择 Repeat count方式，单击 Close按

钮。单击 Object motion选项，选中 
（Rotation XYZ），拖动到 Event map 1

中，叠加在 （KeyPress_4）上，出现

黑框。选中 （Drive R），拖到 Event 

map 1中，叠加在 （Rotation XYZ）

上，出现黑框。双击 （Rotation XYZ），

弹出对话框，具体设置如图79-12所示，

选择 Repeat count方式，单击 Close按

钮。完成效果如图 79-13所示。 

6．制作开炮的效果。在 Scene 

Graph 中单击 RootNode，单击  
（Hull），再单击 （Turret），选中 
（Barrel）。右击 （Barrel），选择

New...→Particle system 命令，如图

79-14所示。双击 （Particle_1），出

现对话框，在对话框的上部 Color 

settings 中按从左向右的顺序依次选中

5个三角形进行颜色设置，下面分别给

出它们的 RGB值：Red=0，Green=0，

Blue=0 ； Red=255 ， Green=255 ，

Blue=255； Red=255， Green=255，

 

图 79-9 

 

图 79-10 
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图 79-13 



第七篇  军事篇 

 
253 

Blue=128；Red=255，Green=0，Blue=0；

Red=0，Green=0，Blue=0。在 Particle 

settings 中修改默认值，具体设置如图

79-15所示，单击 Close按钮。在 Event 

map 1 中单击 （Keyboard�s key 
press），拖动到右面的空白处。在 Action
中单击 Particle systems，选中 （Start 
particle emission），拖动到 Event map 1
中，叠加在 （KeyPress_10）上，出
现黑框。单击RootNode，单击 （Hull）、

 （Turret）、 （Barrel），选中
（Particle_1），拖到 Event map 1中，
叠加在 （Start particle emission）上，
出现黑框。在 Event map 1 中单击
（Timer），拖动到右面的空白处。选
中 （Timer_1），右击选择不要 Initial 
Activation。在 Action 中单击 Particle 
systems ， 选 中 （ Stop particle 
emission），拖动到 Event map 1中，
叠加在 （Timer_1）上，出现黑框。
选中 （Particle_1），拖到 Event map 
1中，叠加在 （Stop particle emission）
上，出现黑框。在 Action中单击 Event，
选中 （activate event），拖动到 Event 
map 1中，叠加在 （KeyPress_10）上，
出现黑框。选中 （Timer_1），叠加
在 （activate event）上，出现黑框。
完成效果如图 79-16所示。 

7．保存为M1a1.c3p，本例制作完
成。 

 

图 79-14 

 

图 79-15 

 

图 79-16 
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实例 80  T80 坦 克（一） 

 

本例制作“T80坦克（一）”的效

果，如图 80-1所示。 

本例特点：按“1”键控制视角转

动，按“A”、“D”键控制炮塔转动，

按“2”键控制烟雾效果。 

本例通过 Stop particle emission、

Stop�和 Start particle emission等知识
完成。 

 

 

图 80-1  效果图 

 

 

1．启动 Cult 3D。 
2．装载 T80.C3D。执行 File→Add 

Cult3D Designer File命令，在对话框中
选中 T80.C3D，如图 80-2所示。 

3．确定包含关系。在 Scene Graph
中 ， 单 击 RootNode ， 找 到  
（t80/tykki7）、 （t80/runko）和 
（Object01）。选中 （t80/tykki7） 和

 （Object01）拖动到 （t80/runko）
上。形成关系图如图 80-3所示。 

4．制作旋转视角的效果。在 Event 
map 1 中单击 （Keyboard�s key 
press），拖动到右面的空白处。双击
（KeyPress_1），出现对话框，在左边
选择 1，单击 Add按钮，单击 OK按钮。
在 Actions中，选中 （Rotation XYZ），
拖动到 Event map 1 中，叠加在
（KeyPress_1）上。选中 （t80/runko），
拖动到 （Rotation XYZ）上。双击 
（Rotation XYZ），弹出对话框，具体

 

图 80-2 

 

图 80-3 

 

图 80-4 
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设置如图 80-4所示，选择 Loop方式，

单击 Close按钮。在 Event map 1中单

击 （Keyboard�s key release），拖动
到 右 面 的 空 白 处 。 双 击

（KeyRelease_1），出现对话框，在左
边框选择 1，单击 Add按钮，单击 OK
按钮。在 Actions中选中 （Stop�），
拖动到 Event map 1 中，叠加在
（KeyRelease_1）上。选中  （t80/runko），
拖动到 （ Stop�）上。双击
（Stop�），出现对话框如图 80-5 所
示。在左边选择 KeyPress_1.Rotation 
XYZ，单击 加入，单击 Close按钮。
完成效果如图 80-6所示。 

5．制作炮塔旋转的效果。在 Event 
map中单击 （Keyboard�s key press），
拖动到右面的空白处。单击 Object 
motion选项，选中 （Rotation XYZ），
拖动到 Event map 1 中，叠加在
（KeyPress_2）上。单击 RootNode，
选中 （t80/luukks），拖到 Event map 
1中，叠加在 （Rotation XYZ）上。
双击 （Rotation XYZ），弹出对话框，
具体设置如图 80-7，选择 Loop方式，
单击 Close按钮。双击 （KeyPress_2），
弹出对话框，在左边框中选中 a，单击
Add按钮，单击OK按钮。在Event map1
中单击 （Keyboard�s key press），拖
动到右面的空白处。单击 Object motion
选项，选中 （Rotation XYZ），拖动
到 Event map 1 中 ， 叠 加 在
（KeyPress_3）上。选中 （t80/luukks），
叠加在 （Rotation XYZ）上。双击 
（Rotation XYZ），弹出对话框，具体
设置如图 80-8，选择 Loop方式，单击
Close 按钮。双击 （KeyPress_3），
弹出对话框，在左边框中选中 d，单击
Add按钮，单击 OK按钮。完成效果如
图 80-9所示。 

 

图 80-5 

 

图 80-6 

 

图 80-7 

 

图 80-8 
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6．制作发出烟雾的效果。在 Event 

map 1 中单击 （Keyboard�s key 
press），拖动到右面的空白处。双击
（KeyPress_4），弹出对话框，在左边
框中选中 2，单击 Add按钮，单击 OK
按钮。在 Scene Graph 中找到  
（t80/pullo）。右击 （t80/pullo），
选择 New...→Particle system命令。双
击 （Particle），出现对话框，在 Color 
settings 中分别选中 5 个三角形，按从
左至右的顺序在右侧的框中设置它们

的 RGB 值，具体设置为 Red=0，
Green=0 ， Blue=0 ； Red=128 ，
Green=128， Blue=128； Red=192，
Green=192， Blue=192； Red=128，
Green=128 ， Blue=128 ； Red=0 ，
Green=0，Blue=0。修改默认值，具体
设置如图 80-11所示。单击 Close按钮。
在 Action中单击 Particle systems，选中
（Start particle emission），拖动到

Event map 1中，叠加在 （KeyPress_4）
上。选中 （Particle），拖到 Event map 
1中，叠加在 （Start particle emission）
上。在Event map 1中单击 （Keyboard�s 
key release），拖动到右面的空白处。
双击 （KeyRelease_2），出现对话框，
在左边选择 2，单击 Add 按钮，单击
OK 按钮。在 Action 中单击 Particle 
systems ， 选 中 （ Stop particle 
emission），拖动到 Event map 1中，
叠加在 （KeyRelease_2）上。选中
（Particle），拖到 Event map 1中，叠
加在 （Stop particle emission）上，出
现黑框。完成效果如图 80-12所示。 

7．保存为 T80.c3p，本例制作完
成。 

 

图 80-9 

 

图 80-11 

 

图 80-12 
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实例 81  T80 坦 克（二） 

 

本例制作“T80坦克（二）”的效

果，如图 81-1所示。 

本例特点：按 s键开炮，四秒钟后

炮塔发生爆炸。 

本例通过 Stop particle emission和

Start particle emission等知识完成。 

 

图 81-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 T80.c3p（源文件）。执行
File→Load project命令，在对话框中选

中 T80.c3p，如图 81-2所示。 

3．制作火炮发射的效果。在 Event 

map中单击 （Keyboard�s key press），
拖动到右面的空白处。双击

（KeyPress_1），出现对话框，在左边
选择 s，单击 Add按钮，单击 OK按钮。
在 Scene Graph中找到 （tuliputk01）。
右击 （tuliputk01），选择 New...→
Particle system 命 令 。 双 击
（Particle_1），出现对话框，如图 81-3，
在 Color settings 中分别设定五个三角
形为 Red=0，Green=0，Blue=0；Red=0，
Green=0，Blue=0；Red=255，Green=0，
Blue=0；Red=0，Green=0，Blue=0 和
Red=0，Green=0，Blue=0。修改默认
值，具体设置如图 81-4所示。单击Close
按钮。在Action中单击Particle systems，
选中 （Start particle emission），拖动
到 Event map 1 中 ， 叠 加 在
（KeyPress_5）上出现黑框。选中

 

图 81-2 

 

图 81-3 
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（Particle_1），拖到 Event map 1中，

叠加在 （Start particle emission）上出

现黑框。在 Event map 1 中单击

（Keyboard�s key release），拖动到右
面的空白处。双击 （KeyRelease_3），
出现对话框，在左边选择 s，单击 Add
按钮，单击 OK 按钮。在 Action 中单
击 Particle systems，选中 （ Stop 
particle emission），拖动到 Event map 1
中，叠加在 （KeyRelease_3）上。选
中 （Particle_1），拖到 Event map 1
中，叠加在 （Stop particle emission）
上。完成效果如图 81-5所示。 

4．制作炮塔中弹爆炸的效果。在
Event map 1中单击 （Timer），拖动
到右面的空白处。选中 （Timer_1），
右击选择不要 Initial Activation。双击
（Timer_1），出现对话框，填入 4000
（ms），单击 OK按钮。单击 Event，
选中 （Deactivate event），拖动到 Event 
map 1中，叠加在 （Timer_1）上。选
中 （Timer_1），叠加到 （Deactivate 
event）上。单击 Event，选中 （activate 
event），拖动到 Event map 1中，叠加
在 （KeyRelease_3）上。将 （Timer_1）
拖动到 （activate event）上。效果如
图 81-6所示。在 Event map 1中单击
（Timer），拖动到右面的空白处。选
中 （Timer_2），右击选择不要 Initial 
Activation。双击 （Timer_2），出现
对话框，填入 1000（ms），单击OK按
钮。单击 Event，选中 （Deactivate 
event），拖动到 Event map 1中，叠加
在 （Timer_2）上。选中 （Timer_2），
叠加到 （Deactivate event）上。单击
Event，选中 （activate event），拖动
到 Event map 1中，叠加在 （Timer_1）
上。将 （Timer_2）拖动到 （activate 
event）上。效果如图 81-7所示。在 Scene 
Graph中找到 （t80/luukks）。右击 

图 81-4 

 

图 81-5 

 

图 81-6 

 

图 81-7 
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（t80/luukks），选择 New...→Particle 

system命令。双击 （Particle_2），出

现对话框如图 81-8，在 Color settings中
5 个三角形分别设定为 Red=0，
Green=0，Blue=0；Red=255，Green=255，
Blue=128；Red=255，Green=0，Blue=0；
Red=0，Green=0，Blue=0；Red=0，
Green=0，Blue=0。修改默认值，具体

设置如图 81-9所示。单击 Close按钮。

在Action中单击 Particle systems，选中

（Start particle emission），拖动到
Event map 1中，叠加在 （Timer_1）

上。选中 （Particle_2），拖到 Event map 

1中，叠加在 （Start particle emission）

上。在Action中单击 Particle systems，

选中 （Stop particle emission），拖动

到 Event map 1中，叠加在 （Timer_2）

上。选中 （Particle_2），拖到 Event map 

1中，叠加在 （Stop particle emission）

上。单击 Object motion 选项，选中 
（Rotation XYZ），拖动到 Event map 1

中，叠加在 （Timer_1）上。双击 
（Rotation XYZ），弹出对话框，具体

设置如图 81-10所示，选择 Repeat count

方式，单击 Close 按钮。单击 Object 

Motion，选中  （Translation XYZ），

拖到 Event map 1中，叠加在（Timer_1）

上。双击  （Translation XYZ）出现对

话框，单击 Z 方向上的 ，选择 ，

单击 Set出现对话框。在Waveform type

中选择 Sine方式。在 Sustain中，设定
Time=1000，Amplitude=1000，Global 

parameters 中保留默认值。单击 Close

按钮。选择Repeat count方式，单击Close

按钮。选中 （t80/luukks），分别拖到

  （Translation XYZ）和 （Rotation 

XYZ）上。完成效果图如图 81-11所示。 

5．保存为 T80 1.c3p，本例制作完

成。 

图 81-8 

 

图 81-9 

 

图 81-10 

 

图 81-11 
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实例 82  装 甲 车（一） 

 

本例制作“装甲车（一）”的效果，

如图 82-1所示。 

本例特点：按 A、D键控制炮塔转

动，按 Delete键控制轮胎爆炸。 

本例通过 Stop particle emission、

Select camera和 Start particle emission

等知识完成。 

 

图 82-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 pln_stuk.C3D。执行 File

→Add Cult3D Designer File命令，在对

话框中选中 pln_stuk.C3D，如图 82-2

所示。 

3．确定包含关系。在 Scene Graph

中，找到  （ FWRTYRE）和  
（ FWLTYRE ） ， 将 它们 拖 到  
（FWRINGS）上。找到 （TURMGS），

将它们拖到 （TURRET0）上。形成

关系图如图 82-3所示。 

4．制作旋转视角的效果。在 Event 

Map1窗口中单击 （World Start），

拖到右侧的空白处。在 Actions窗口中，

单击 Camera，选中 （Select camera），

拖到 Event map 1中，叠加在 （World 

Start）上。在 Scene Graph 中单击

RootNode，选中 （Front view），拖

到 Event map 1中，叠加在 （Select 

camera）上。在 Actions 中选中  
（Rotation XYZ），拖动到 Event map 1

 

 

 

图 82-2 

 

 

 

图 82-3 
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中，叠加在 （World Start）上。在 Scene 

Graph 中，单击 RootNode，选中  
（dtruck），拖到 Event map 1中，叠

加在 （Rotation XYZ）上。双击 
（Rotation XYZ），弹出对话框，具体

设置如图 82-4所示，选择 Loop方式，

单击 Close按钮。效果如图 82-5所示。 

5．制作炮塔旋转的效果。在 Event 

map 1 中单击 （Keyboard�s key 
press），拖动到右面的空白处。单击
Object motion选项，选中 （Rotation 
XYZ），拖动到 Event map 1中，叠加
在 （KeyPress_1）上。单击 RootNode，
选中 （TURRET0），拖到 Event map 
1中，叠加在 （Rotation XYZ）上。
双击 （Rotation XYZ），弹出对话框，
具体设置如图 82-6，选择 Repeat count
方式，单击 Close 按钮。双击
（KeyPress_1），弹出对话框，在左边
框中选中 a，单击 Add按钮，单击 OK
按钮。在 Event map 1 中单击
（Keyboard�s key press），拖动到右面
的空白处。单击 Object motion 选项，
选中 （Rotation XYZ），拖动到 Event 
map 1中，叠加在 （KeyPress_2）上。
选中  （ TURRET0），叠加在  
（Rotation XYZ）上。双击 （Rotation 
XYZ），弹出对话框，具体设置如图
82-7所示，选择 Repeat count方式，单
击 Close按钮。双击 （KeyPress_2），
弹出对话框，在左边框中选中 d，单击
Add按钮，单击 OK按钮。完成效果如
图 82-8所示。 

6．制作轮胎爆炸的效果。在 Event 
map 1 中单击 （Keyboard�s key 
press），拖动到右面的空白处。双击
（KeyPress_3），弹出对话框，在左边
框中选中 Delete，单击 Add按钮，单击
OK 按钮。在 Scene Graph 中找到 

 

图 82-4 

 

图 82-5 

 

图 82-6 

 

图 82-7 

 

图 82-8 



Cult 3D产品三维演示时尚创作百例 

 
262 

（FWRTYRE）。右击 （FWRTYRE），

选择 New...→Particle system命令。双

击 （Particle），出现对话框，如图

82-10所示。在 Color settings中选中 5

个三角形由左至右依次设置为：

Red=0，Green=0，Blue=0；Red=255，

Green=255， Blue=128； Red=255，

Green=0，Blue=0；Red=0，Green=0，

Blue=0；Red=0，Green=0，Blue=0。修

改默认值，具体设置如图 82-10所示。

单击 Close 按钮。在 Action 中单击

Particle systems，选中 （Start particle 

emission），拖动到 Event map 1中，

叠加在 （KeyPress_3）上。选中

（Particle），拖到 Event map 1中，叠

加在 （Start particle emission）上。在

Event map 1中单击 （Timer），拖动

到右面的空白处。选中 （Timer_1），

右击选择不要 Initial Activation。双击

（Timer_1），出现对话框，填入 1000

（ms），单击 OK按钮。单击 Event，

选中 （Deactivate event），拖动到

Event map 1中，叠加在 （Timer_1）

上。选中 （Timer_1），叠加到 
（Deactivate event）上。单击 Event，

选中 （activate event），拖动到 Event 

map 1中，叠加在 （KeyPress_3）上。

将 （Timer_1）拖动到  （activate 

event）上。在 Action 中单击 Particle 

systems ， 选 中 （ Stop particle 

emission），拖动到 Event map 1中，

叠加在 （KeyPress_3）上。选中

（Particle），拖到 Event map 1中，叠

加在 （Stop particle emission）上。完

成效果如图 82-11所示。 

7．保存为 pln_stuk.c3p，本例制

作完成。 

 

图 82-9 

 

图 82-10 

 

图 82-11 
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实例 83  装 甲 车（二） 

 

本例制作“装甲车（二）”的效果，

如图 83-1所示。 

本例特点：按“A”、“D”键控

制炮塔转动，按 Delete 键控制轮胎爆

炸。 

本例通过 Stop particle emission、

Select camera和 Start particle emission

等知识完成。 

 

图 83-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 pln_stuk.c3p（源文件）。

执行 File→Load project 命令，在对话

框中选中 pln_stuk.c3p，如图 83-2所示。 

3．制作装甲车翻倒的效果。在

Actions中选中 （Rotation XYZ），拖

动到 Event map 1 中，叠加在

（KeyPress_3）上。选中 （Group_All），

叠加在 （Rotation XYZ）上。双击 
（Rotation XYZ），弹出对话框，具体

设置如图 83-3所示，选择 Repeat count

方式，单击 Close按钮。在 Actions中，

选中 （Rotation XYZ），拖动到 Event 

map 1中，叠加在 （KeyPress_3）上。

选中  （Group_All），叠加在  
（Rotation XYZ）上。双击 （Rotation 

XYZ），弹出对话框，具体设置如图

83-4所示，选择 Repeat count方式，单

击 Close 按钮。在 Actions 中选中

（Stop�），拖动到 Event map 1中，

 

图 83-2 

 

图 83-3 

 

图 83-4 



Cult 3D产品三维演示时尚创作百例 

 
264 

叠加在 （KeyPress_3）上。选中 
（Group_All），拖动到 （Stop�）上。
双击 （Stop�），出现对话框如图 83-5
所示。在左边选择WorldStart_1.Rotation 
XYZ，单击 加入，单击 Close按钮。
效果如图 83-6所示。 

4．制作轮胎炸飞的效果。在
Actions中，单击 Render，选中 （Hide 
Object），拖动到 Event map 1中，叠
加在 （KeyPress_3）上。在 Scene 
Graph中找到 （FWRTYRE），拖动 
（FWRTYRE）叠加到 （Hide Object）
上。 

5．制作修复的效果。在 Event map1
中单击 （Left mouse click on Object），
拖动到右面的空白处。在 Scene Graph
中找到 （STYRE），拖动 （STYRE）
叠加到  （ObjectLClick_1）上。在
Actions中，单击 Render，选中 （Hide 
Object），拖动到 Event map 1中，叠
加在 （ObjectLClick_1）上。在 Scene 
Graph中，拖动 （ STYRE）叠加到
（Hide Object）上。单击 Render，选中
（Unhide Object）， 按住拖动到 Event 

map 1中，叠加在 （ObjectLClick_1）
上。拖动 （FWRTYRE）叠加到
（Unhide Object）上。效果如图 83-7
所示。 

6．制作恢复车身姿态的效果。在
Action中单击 Event，选中 （Trigger 
event），拖到 Event map 1中，叠加在
 （ObjectLClick_1）上。选中 （World 
Start），拖动到 （Trigger event）上。
在 Actions中选中 （Rotation XYZ），
拖动到 Event map 1 中，叠加在  
（ ObjectLClick_1 ） 上 。 选 中  
（Group_All），叠加在  （Rotation 
XYZ）上。双击 （Rotation XYZ），
弹出对话框，具体设置如图 83-8所示，

 

图 83-5 

 

图 83-6 

 

图 83-7 

 

图 83-8 

 

图 83-9 
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选择 Repeat count方式，单击 Close按

钮。在 Actions 中选中  （Rotation 

XYZ），拖动到 Event map 1中，叠加

在 （ObjectLClick_1）上，出现黑框。

选中  （Group_All），叠加在  
（Rotation XYZ）上，出现黑框。双击

 （Rotation XYZ），弹出对话框，具

体设置如图 83-9 所示，选择 Repeat 

count 方式，单击 Close 按钮。完成效

果如图 83-10所示。 

7．设定各事件之间的相互关系。

单击 Event，选中 （Deactivate event），

拖动到 Event map 1 中，叠加在

（KeyPress_3）上。右击 （Deactivate 

event）选择 Parameters�，出现对话框
如 图 83-11 所 示 ， 在 左 边 选 择
KeyPress_3，单击 OK 按钮。选中 
（ObjectLClick_1），右击选择不要
Initial Activation。单击 Event，选中 
（activate event），拖动到 Event map 1
中，叠加在 （KeyPress_3）上。将 
（ObjectLClick_1）拖动到 （activate 
event）上。单击 Event，选中  
（Deactivate event），拖动到 Event map 
1中，叠加在 （ObjectLClick_1）上。
右 击  （ Deactivate event ） 选 择
Parameters�，出现对话框如图 83-12
所示，在左边选择 ObjectLClick_1，单
击OK按钮。完成效果如图 83-13所示。 

8．保存为 pln_stuk 1.c3p，本例制
作完成。 

 

图 83-10 

 

图 83-11 

 

图 83-12 

 

图 83-13 
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实例 84  军  舰 （一） 

 

本例制作“军舰（一）”的效果，

如图 84-1所示。 

本例特点：按“1”键控制雷达的

停止；按住方向键，军舰转弯，松开键

转弯停止。 

本 例 通 过 Rotation XYZ 和

Translation XYZ等知识完成。 

 

图 84-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 N2.C3D。执行 File→Add 

Cult3D Designer File命令，在对话框中

选中 N2.C3D，如图 84-2所示。 

3．添加 Arcball。在 Event Map1

窗口中单击 （World Start），拖到右

侧的空白处。在 Actions窗口中，单击

Object Motion，选中 （Arcball），拖

到 Event map 1中，叠加在 （World 

Start）上，出现黑框。在 Scene Graph

窗口中，单击 RootNode，选中  
（Group_All），拖到 Event map 1中，

叠加在 （Arcball）上，出现黑框。 

4．制作船体随波浪俯仰的效果的

效果。在 Action中单击 Object motion

选项，选中 （Rotation XYZ），拖到

Event map 1 中，叠加在  （World 

Start_1）上，出现黑框。双击 （Rotation 

XYZ）出现对话框，单击 Y 方向上的

，选择 ，如图 84-4 所示，单击

Set 出现对话框，在 Sustain 和 Global 

 

 

图 84-2 

 

图 84-3 
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parameters中修改参数，具体设置如图

84-5 所示。单击 Close 按钮。选中 
（Group_All），叠加在  （Rotation 

XYZ）上，出现黑框。在 Action 中单

击Object motion选项，选中 （Rotation 

XYZ），拖到 Event map 1中，叠加在

 （World Start_1）上，出现黑框。双

击 （Rotation XYZ）出现对话框，单

击 X 方向上的 ，选择 ，单击 Set

出现。修改参数，在 Sustain 中设定

Time=2500，Amplitude=3。在 Global 

parameters 中设定 Period=2500，Final 

period=2500。单击 Close按钮。选中 
（Group_All），叠加在  （Rotation 

XYZ）上，出现黑框。完成效果如图

84-6所示。 

5．制作船体进退和转弯的效果。

在 Event map 1中单击 （Keyboard�s 
key press），拖动到右面的空白处。单
击 Object motion 选 项 ， 选 中  
（Translation XYZ），拖动到 Event map 
1中，叠加在 （KeyPress_1）上，出
现黑框。拖动  （Group_All）到  
（Translation XYZ），出现黑框。双击
 （Translation XYZ），弹出对话框，
具体设置如图 84-7所示，选择 Loop方
式 ， 单 击 Close 按 钮 。 双 击
（KeyPress_1），弹出对话框，在左边
框中选中 Arrow Up，单击 Add按钮，
单击OK按钮。在Event map 1中单击
（Keyboard�s key press），拖动到右面
的空白处。单击 Object motion 选项，
选中 （Translation XYZ），拖动到
Event map 1中，叠加在 （KeyPress_2）
上，出现黑框，拖动 （Group_All）
到 （Translation XYZ），出现黑框。
双击 （Translation XYZ），弹出对话
框，具体设置如图 84-8所示，选择 Loop
方式，单击 Close 按钮。双击
（KeyPress_2），弹出对话框，在左边

 

图 84-4 

 

图 84-5 

 

图 84-6 

 

图 84-7 

 

图 84-8 
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框中选中Arrow Down，单击Add按钮，

单击OK按钮。在Event map 1中单击

（Keyboard�s key press），拖动到右面
的空白处。单击 Object motion 选项，
选中 （Rotation XYZ），拖动到 Event 
map 1中，叠加在 （KeyPress_3）上，
出现黑框。,拖动 （Group_All）到 
（Rotation XYZ），出现黑框。双击 
（Rotation XYZ），弹出对话框，具体
设置如图 84-9所示，选择 Loop方式，
单击 Close按钮。双击 （KeyPress_3），
弹出对话框，在左边框中选中 Arrow 
Left，单击 Add按钮，单击 OK按钮。
在 Event map 1中单击 （Keyboard�s 
key press），拖动到右面的空白处。单
击Object motion选项，选中 （Rotation 
XYZ），拖动到 Event map 1中，叠加
在 （KeyPress_4）上，出现黑框。拖
动  （Group_All）到  （ Rotation 
XYZ），出现黑框。双击 （Rotation 
XYZ），弹出对话框，具体设置如图
84-10所示，选择 Loop方式，单击 Close
按钮。双击 （KeyPress_4），弹出对
话框，在左边框中选中 Arrow Right，
单击 Add 按钮，单击 OK 按钮。完成
效果如图 84-11所示。 

6．制作停止转弯的效果。在 Event 
map 1 中单击 （Keyboard�s key 
release），拖动到右面的空白处。单击
Object motion选项，选中 （Rotation 
XYZ），拖动到 Event map 1中，叠加
在 （KeyRelease_1）上，出现黑框。
拖动 （Group_All）到 （Rotation 
XYZ），出现黑框。双击 （Rotation 
XYZ），弹出对话框，具体设置如图
84-12所示，选择 Loop方式，单击 Close
按钮。双击 （KeyRelease_1），弹出
对话框，在左边框中选中 Arrow Left，
单击Add按钮，单击OK按钮。在 Event 
map 1 中单击 （Keyboard�s key 

 

图 84-9 

 

图 84-10 

 

图 84-11 

 

图 84-12 

 

图 84-13 
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release），拖动到右面的空白处。单击

Object motion选项，选中 （Rotation 

XYZ），拖动到 Event map 1中，叠加

在 （KeyRelease_2）上，出现黑框。

拖动 （Group_All）到 （Rotation 

XYZ），出现黑框。双击 （Rotation 

XYZ），弹出对话框，具体设置如图

84-13所示，选择 Loop方式，单击 Close

按钮。双击 （KeyPress_4），弹出对

话框，在左边框中选中 Arrow Right，

单击 Add 按钮，单击 OK 按钮。完成

效果如图 84-14所示。 

7．制作雷达天线转动和停止的效

果。单击 Object motion选项，选中 
（Rotation XYZ），拖动到 Event map 1

中，叠加在 （KeyRelease_1）上，出

现黑框。在 Scene Graph窗口中，单击

RootNode，单击 （Group_All），再

单击  （Structure），分别选中  
（SQ-HEAD）、 （POP-GROUP）和 

 （MUFF-COBB），拖到 Event map 1

中，叠加在 （Rotation XYZ）上，出

现黑框。双击 （Rotation XYZ），弹

出对话框，具体设置如图 84-15所示，

选择 Loop 方式，单击 Close 按钮。在

Event map 1中单击 （Keyboard�s key 
press），拖动到右面的空白处。单击
Object motion选项，选中 （Rotation 
XYZ），拖动到 Event map 1中，叠加
在 （KeyPress_5）上，出现黑框。分
别拖动  （ POP-GROUP）和   
（MUFF-COBB）到 （Rotation XYZ），
出现黑框。双击 （Rotation XYZ），
弹出对话框，具体设置如图84-16所示，
选择 Loop 方式，单击 Close 按钮。双
击 （KeyPress_5），弹出对话框，在
左边框中选中 1，单击 Add按钮，单击
OK按钮。完成效果如图 84-17所示。 

8．保存为 N2.c3p，本例制作完成。 

 

图 84-14 

 

图 84-15 

 

图 84-16 

 

图 84-17 
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实例 85  军  舰 （二） 

 

本例制作“军舰（二）”的效果，

如图 85-1所示。 

本例特点：按“1”键控制进入瞄

准，按“a”和“d”键控制导弹旋转；

按“2”键控制导弹发射。 

本 例 通 过 Rotation XYZ 、

Translation XYZ、Start particle emission

和 Deactivate event等知识完成。 

 

图 85-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 N2.c3p（源文件）。执行

File→Load project命令，在对话框中选

中 N2.c3p，如图 85-2所示。 

3．制作进入发射的效果。在 Action

中单击 Event，选中  （Deactivate 

event），拖动到 Event map 1中，叠加

在 （KeyPress_5）上，出现黑框。选

中 （Deactivate event），右击选择

parameters命令，弹出对话框，在左边

框中选中 KeyPress_5，单击 Add按钮，

单击OK按钮。在Actions中单击Object 

Motion，选中 （Reset），拖到 Event 

map 1中，叠加在 （KeyPress_5）上，

出现黑框。选中 （KeyPress_5），拖

到 （Reset）上，出现黑框。完成的

效果，如图 85-3所示。 

4．雷达跟随导弹瞄准的效果。在

Event map 1中单击 （Keyboard�s key 
press），拖动到右面的空白处。双击

 

图 85-2 

 

图 85-3 
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（KeyPress_6），出现对话框，在左边

选择 a，单击 Add按钮，单击 OK按钮。

单击 Object motion 选项，选中  
（Rotation XYZ），拖动到 Event map 1

中，叠加在 （KeyPress_6）上，出现

黑框。拖动  （POP-GROUP）到 
（Rotation XYZ），出现黑框。在 Scene 

Graph窗口中，单击 RootNode，单击 
（Group_All），在单击 （Structure），

选中 （aamiss），拖到 Event map 1

中，叠加在 （Rotation XYZ）上，出

现黑框。双击 （Rotation XYZ），弹

出对话框，具体设置如图 85-4 所示，

选择 Repeat count方式，单击 Close按

钮。在 Event map1中单击 （Keyboard�s 
key press），拖动到右面的空白处。双
击 （KeyPress_7），出现对话框，在
左边选择 d，单击 Add按钮，单击 OK
按钮。单击 Object motion选项，选中 
（Rotation XYZ），拖动到 Event map 1
中，叠加在 （KeyPress_7）上，出现
黑框。分别拖动 （POP-GROUP）和
 （aamiss），到原来的 （Rotation 
XYZ）上，出现黑框。双击 （Rotation 
XYZ），弹出对话框，具体设置如图
85-5所示，选择 Repeat count方式，单
击 Close 按钮。完成效果，如图 85-6
所示。 

5．制作导弹焰火的效果。在 Scene 
Graph 中单击 RootNode，单击  
（ Group_All ） ， 再 依 次 单 击  
（Structure）和 （aamiss），选中 
（SA-N-4GK）。右击 （SA-N-4GK），
选择 New...→Particle system命令。双
击 （Particle），出现对话框，在对
话框的上部 Color settings 中分别从左
至右选中 5个三角形，在右侧的框中分
别填写的 RGB 值如为：Red=0，
Green=0 ， Blue=0 ； Red=255 ，

 

图 85-4 

 

图 85-5 

 

图 85-6 

 

图 85-7 
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Green=255， Blue=128； Red=255，

Green=0，Blue=0；Red=0，Green=0，

Blue=0；Red=0，Green=0，Blue=0，在

Particle settings中修改默认值，具体如

图 85-7所示，单击 Close按钮。 

6．制作导弹发射的效果。在 Event 

map中单击 （Keyboard�s key press），
拖动到右面的空白处。双击

（KeyPress_8），出现对话框，在左边
选择 2，单击 Add按钮，单击 OK按钮。
在 Action中单击 Particle systems，选中
（Start particle emission），拖到 Event 

map 1中，叠加在 （KeyPress_8）上，
出现黑框。在 Scene Graph中选中刚才
所建立的 （Particle），拖到 Event map 
1中，叠加在 （Start particle emission）
上，出现黑框。在 Action中单击 Object 
motion 选项，选中  （ Translation 
XYZ），拖到 Event map 1中，叠加在
（KeyPress_8）上，出现黑框。双击

  （Translation XYZ）出现对话框，
具体设置如图 85-8 所示，选择 Repeat 
count 方式，单击 Close 按钮。选中 
（SA-N-4GK），拖动到  （Translation 
XYZ）上，出现黑框。在 Action 中单
击 Event，选中 （Deactivate event），
拖动到 Event map 1 中，叠加在
（KeyPress_8）上，出现黑框。选中 
（ Deactivate event ） ， 右 击 选 择
parameters命令，弹出对话框，在左边
框中选中 KeyPress_8，单击 Add按钮，
单击 OK 按钮。完成效果如图 85-9 所
示。 

7．保存为 N2-1.c3p，本例制作完
成。 

 

图 85-8 

 

 

 

 

图 85-9 
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实例 86  战 斗 机（一） 

 

本例制作“战斗机（一）”的效果，

如图 86-1所示。 

本例特点：用键盘上的“↑”和“↓”

键控制飞机的俯仰。 

本例通过 Stop�、activate event和
Deactivate event等知识完成。 

 

图 86-1  效果图 

 

 

1．启动 Cult 3D。 
2．装载 Bf109G6.C3D。执行 File
→Add Cult3D Designer File命令，在对
话框中选中 Bf109G6.C3D，如图 86-2
所示。 

3．确定视角和制作视角旋转的效
果。在 Event Map1 中单击 （World 
Start），拖到右侧的空白处。在 Actions
窗口中，单击 Camera，选中 （Select 
camera），拖到 Event map 1中，叠加
在 （World Start_1）上。在 Scene Graph
窗口中选中 （Right view），拖到 Event 
map 1中，叠加在 （Select camera）
上。在 Actions 中选中  （Rotation 
XYZ），拖动到 Event map 1中，叠加
在 （World Start_1）上。在 Scene Graph
中找到 （Bf109G6），拖到 Event map 
1中，叠加在 （Rotation XYZ）上。
双击 （Rotation XYZ），弹出对话框，
具体设置如图 86-3所示，选择 Loop方
式，单击 Close 按钮。效果如图 86-4
所示。 

 

图 86-2 

 

图 86-3 

 

图 86-4 
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所示。 

4．制作战斗机俯仰的效果。在

Event map 1中单击 （Keyboard�s key 
press），拖动两次到右面的空白处。双
击 （KeyPress_1），弹出对话框，在
左边框中选中 Arrow Up，单击 Add按
钮 ， 单 击 OK 按 钮 。 双 击
（KeyPress_2），弹出对话框，在左边
框中选中Arrow Down，单击Add按钮，
单击 OK按钮。在 Action中单击 Object 
motion选项，选中 （Rotation XYZ），
按住拖动两次到 Event map 1中，分别
叠 加 在 （ KeyPress_1 ） 和
（KeyPress_2）上。单击 RootNode，
选中 （Bf109G6），拖到 Event map 1
中，叠加在两个 （Rotation XYZ）上。
双击 （KeyPress_1）的 （Rotation 
XYZ），弹出对话框，具体设置如图
86-5所示，选择 Loop方式，单击 Close
按钮。双击 （KeyPress_2）的  
（Rotation XYZ），弹出对话框，具体
设置如图 86-6所示，选择 Loop方式，
单击 Close按钮。在 Event map 1中单
击 （Keyboard�s key release），拖动
两次到右面的空白处。双击

（KeyRelease_1），弹出对话框，在左
边框中选中 Arrow Up，单击 Add按钮，
单击OK按钮。双击 （KeyRelease_2），
弹出对话框，在左边框中选中 Arrow 
Down，单击 Add按钮，单击 OK按钮。
在 Actions窗口中，选中 （Stop�），
拖动两次到 Event map 1中，分别叠加
在 （KeyRelease_1）和 （KeyRelease_2）
上。选中 （Bf109G6），叠加到两个
（Stop�）上。双击 （KeyRelease_1）
的 （Stop�），出现对话框如图 86-8
所示。在左边选择 KeyPress_1.Rotation 
XYZ，单击 加入，单击 Close按钮。
双击 （KeyRelease_2）的 （Stop�），

 

图 86-5 

 

图 86-6 

 

图 86-7 

 

图 86-8 
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出现对话框如图 86-9 所示。在左边选

择 KeyPress_2.Rotation XYZ，单击

加入，单击 Close按钮。效果如图 86-10

所示。 

5．制作水平尾翼配合运动的效果。

在 Event map 1中单击 （Timer），拖

动两次到右面的空白处。双击

（Timer_1）和 （Timer_2），在弹出

的对话框中填 0（ms），单击 OK按钮。

右键单击 （Timer_1）和 （Timer_2）

选择不要 Initial Activation。单击 Event，

选中 （activate event），拖动四次到

Event map 1 中，分别叠加在

（KeyPress_1）、 （KeyPress_2）、

（KeyRelease_1）和 （KeyRelease_2）

上。将 （ Timer_1）拖动到

（KeyPress_1）和 （KeyRelease_2）

的  （ activate event）上。将

（Timer_2）拖动到 （KeyPress_2）

和 （KeyRelease_1）的 （activate 

event）上。单击 Event，选中  
（Deactivate event），拖动两次到 Event 

map 1 中，分别叠加在 （Timer_1）

和 （Timer_2）上。选中 （Timer_1）

和 （Timer_2），拖动分别叠加到各

自的 （Deactivate event）上。效果如

图 86-11所示。 

在 Action中单击 Object motion选

项，选中 （Rotation XYZ），按住拖

动两次到 Event map 1 中，叠加在

（Timer_1）和 （Timer_2）上。在

Scene Graph 中 ， 找 到  
（NoName_4_1）、  （NoName_4_2），

分别叠加在两个 （Rotation XYZ）上。

双击 （Timer_1）的  （Rotation 

XYZ），弹出对话框，在 Y 轴中输入

30（角度），Time设为 500（毫秒），

选择 Repeat count方式，单击 Close按

钮。双击 （Timer_2）的 （Rotation 

 

图 86-9 

 

 

 

图 86-10 

 

 

 

图 86-11 
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XYZ），弹出对话框，在 Y轴中输入�30
（角度），Time 设为 500（毫秒），
选择 Repeat count方式，单击 Close按
钮。效果图如图 86-12所示。 

6．保存为 Bf109G6.c3p，本例制
作完成。 

 

 

图 86-12 
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实例 87  战 斗 机（二） 

 

本例制作“战斗机（二）”的效果，

如图 87-1所示。 

本例特点：按 Arrow Left和 Arrow 

Right键控制飞机的俯仰。 

本例通过 Stop�、activate event和
Deactivate event等知识完成。 

 

图 87-1  效果图 

 

 

1．启动 Cult 3D。 
2．装载 Bf109G6.c3p。执行 File
→Load project命令，在对话框中选中
Bf109G6.c3p，如图 87-2所示。 

3．制作战斗机滚翻的效果。在
Event map 1中单击 （Keyboard�s key 
press），拖动两次到右面的空白处。双
击 （KeyPress_3），弹出对话框，在
左边框中选中 Arrow Right，单击 Add
按钮，单击 OK 按钮。双击
（KeyPress_4），弹出对话框，在左边
框中选中 Arrow Left，单击 Add按钮，
单击 OK按钮。在 Action中单击 Object 
motion选项，选中 （Rotation XYZ），
按住拖动两次到 Event map 1中，分别
叠 加 在 （ KeyPress_3 ） 和
（KeyPress_4上。选中 （Bf109G6），
叠加在两个 （Rotation XYZ）上。双
击 （KeyPress_3）的  （Rotation 
XYZ），弹出对话框，具体设置如图
87-3所示，选择 Loop方式，单击 Close

 

图 87-2 

 

图 87-3 

 

图 87-4 
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按钮。双击 （KeyPress_4）的  
（Rotation XYZ），弹出对话框，具体

设置如图 87-4所示，选择 Loop方式，

单击 Close按钮。在 Event map 1中单

击 （Keyboard�s key release），拖动
两次到右面的空白处。双击

（KeyRelease_3），弹出对话框，在左
边框中选中 Arrow Right，单击 Add按
钮 ， 单 击 OK 按 钮 。 双 击
（KeyRelease_4），弹出对话框，在左
边框中选中 Arrow Left，单击 Add 按
钮，单击 OK按钮。在 Actions中，选
中 （Stop�），拖动两次到 Event map 
1中，分别叠加在 （KeyRelease_3）
和 （KeyRelease_4）上。选中  
（Bf109G6），叠加到两个 （Stop�）
上。双击 （KeyRelease_3）的
（Stop�），出现对话框如图 87-5 所
示。在左边选择 KeyPress_3.Rotation 
XYZ，单击 加入，单击 Close按钮。
双击 （KeyRelease_4）的 （Stop�），
出现对话框如图 87-6 所示。在左边选
择 KeyPress_4.Rotation XYZ，单击
加入，单击 Close按钮。效果如图 87-7
所示。 

4．制作副翼配合运动的效果。在
Event map 1中单击 （Timer），拖动
两次到右面的空白处。双击

（Timer_3）和 （Timer_4），在弹出
的对话框中填 0（ms），单击 OK按钮。
右键单击 （Timer_3）和 （Timer_4）
选择不要 Initial Activation。单击 Event，
选中 （activate event），拖动四次到
Event map 1 中，分别叠加在
（KeyPress_3）、 （KeyPress_4）、
（ KeyRelease_3 ） 和 （ Key 

Release_4）上。将 （Timer_3）拖动
到 （ KeyPress_3 ） 和 （ Key 
Release_4）的 （activate event）上。

 

图 87-5 

 

图 87-6 

 

图 87-7 

 

图 87-8 
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将 （Timer_4）拖动到 （KeyPress_4）

和 （KeyRelease_3）的 （activate 

event）上。单击 Event，选中  
（Deactivate event），拖动两次到 Event 

map 1 中，分别叠加在 （Timer_3）

和 （Timer_4）上。选中 （Timer_3）

和 （Timer_4），分别拖动叠加到各

自的 （Deactivate event）上。效果如

图 87-8所示。 

在 Action中单击 Object motion选

项，选中 （Rotation XYZ），按住拖

动四次到 Event map 1 中，叠加在

（Timer_3）和 （Timer_4）上。在

Scene Graph中，找到 （NoName_4_0）

和 （NoName_05），分别叠加在四

个  （Rotation XYZ）上。双击

（Timer_3）上连接 （NoName_4_0）

的 （Rotation XYZ），弹出对话框，

具体设置如图 87-9 所示，选择 Repeat 

count 方式，单击 Close 按钮。双击

（Timer_3）上连接 （NoName_05）

的 （Rotation XYZ），弹出对话框，

具体设置如图 87-10所示，选择 Repeat 

count 方式，单击 Close 按钮。双击

（Timer_4）上连接 （NoName_4_0）

的 （Rotation XYZ），弹出对话框，

具体设置如图 87-11所示，选择 Repeat 

count 方式，单击 Close 按钮。双击

（Timer_4）上连接 （NoName_05）

的 （Rotation XYZ），弹出对话框，

具体设置如图 87-12所示，选择 Repeat 

count 方式，单击 Close 按钮。效果如

图 87-13所示。 

5．保存为 Bf109G6-1.c3p，本例

制作完成。 

 

图 87-9 

 

图 87-10 

 

图 87-11 

 

图 87-12 

 

图 87-13 
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实例 88  战 斗 机（三） 

 

本例制作“战斗机（三）”的效果，

如图 88-1所示。 

本例特点：按 Enter键控制飞机的

开火，6秒钟后飞机着火坠落。 

本例通过 Start particle emission和

Stop particle emission等知识完成。 

 

图 88-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 Bf109G6-1.c3p（源文件）。

执行 File→Load project 命令，在对话

框中选中 Bf109G6-1.c3p，如图 88-2所

示。 

3．制作战斗机开火的效果。在

Scene Graph中，找到 （NoName_4_3）

右击，选择 New...→Particle system命

令。双击 （Particle），出现对话框，

如图 88-3所示。在对话框的上部 Color 

settings 中选中 5 个三角形，按从左至

右的顺序，分别在右侧的框中设置为：

Red=0，Green=0，Blue=0；Red=255，

Green=255， Blue=128； Red=255，

Green=0，Blue=0；Red=0，Green=0，

Blue=0；Red=0，Green=0，Blue=0。修

改默认值，具体设置如图 88-4 所示，

单击 Close按钮。在 Event map 1中单

击 （Keyboard�s key press），拖动到
右面的空白处。双击 （KeyPress_5），
出现对话框，在左边选择 Enter，单击
Add 按钮，单击 OK 按钮。在 Action

 

 

 

图 88-2 

 

 

 

图 88-3 
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中单击 Particle systems，选中 （Start 

particle emission），拖动到 Event map 1

中，叠加在 （KeyPress_5）上。选中

（Particle），拖到 Event map 1中，

叠加在 （Start particle emission）上。 

在Actions中单击Object motion选

项，选中 （Rotation XYZ），拖动到

Event map 1中，叠加在 （KeyPress_5）

上。选中 （Bf109G6），叠加在 
（Rotation XYZ）上。双击 （Rotation 

XYZ），弹出对话框，在 Z 轴中输入

157（角度），Time设为 6000（毫秒），

选择 Repeat count方式，单击 Close按

钮。效果如图 88-5所示。 

右击 （KeyPress_5），选择 Edit 

with Time Line View，在出现对话框中

将 Start particle emission的起始时间拖

动到 Rotation XYZ的结束时间处。效

果如图 88-6所示。 

4．制作飞机被击中的效果。在

Scene Graph中，找到 （Form55_01）

右击，选择 New...→Particle system命

令。双击 （Particle_1），出现对话

框，在对话框的上部 Color settings中设

置的参数和前面一样。修改默认值，具

体设置如图 88-7 所示。单击 Close 按

钮。在 Event map 1中单击 （Timer），

拖动到右面的空白处。双击

（Timer_5），在弹出的对话框中填

12000（ms），单击 OK按钮。右键单

击 （ Timer_5）选择不要 Initial 

Activation。单击 Event，选中 （activate 

event），拖动到 Event map 1中，叠加

在 （KeyPress_5）上。将 （Timer_5）

拖动到 （activate event）上。单击

Event，选中 （Deactivate event），拖

动到 Event map 1 中，叠加在

（Timer_5）上。选中 （Timer_5），

叠加到 （Deactivate event）上。在

 

图 88-4 

 

图 88-5 

 

图 88-6 
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Action中单击 Particle systems，选中

（Start particle emission），拖动到 Event 

map 1 中，叠加在 （Timer_5）上。

选中 （Particle_1），拖到 Event map 

1中，叠加在 （Start particle emission）

上。在 Action中单击 Particle systems，

选中 （Stop particle emission），拖动

到 Event map 1中，叠加在 （Timer_5）

上。选中 （Particle），叠加在 （Start 

particle emission）上。效果如图 88-8

所示。 

在Actions中单击Object motion选

项，选中 （Rotation XYZ），拖动到

Event map 1中，叠加在 （Timer_5）

上。选中 （Bf109G6），叠加在 
（Rotation XYZ）上。双击 （Rotation 

XYZ），弹出对话框，具体设置如图

88-9所示，选择 Repeat count方式，单

击 Close 按钮。Actions 中选中  
（Translation XYZ），拖动到 Event map 

1中，叠加在 （Timer_5）上。选中 
（Bf109G6）后叠加在 （Translation 

XYZ）上。双击 （Translation XYZ）

出现对话框，具体设置如图88-10所示，

选择 Repeat count方式，单击 Close按

钮。完成效果如图 88-11所示 

5．保存为 Bf109G6-2.c3p，本例

制作完成。 

图 88-7 

 

图 88-8 

 

图 88-9 

 

图 88-10 

 

图 88-11 
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实例 89  变形战斗机（一） 

 

本例制作“变形战斗机”的效果，

如图 89-1所示。 

本例特点：按“1”键旋转，按“2”

键做直线运动和机翼后掠角变化。 

本例通过 Stop�、Select camera和
Set background等知识完成。 

 

图 89-1  效果图 

 

 

1．启动 Cult 3D。 
2．装载MESHES.C3D。执行 File
→Add Cult3D Designer File命令，在对
话框中选中 MESHES.C3D，如图 89-2
所示。 

3．添加 Arcball 和设置背景与视
角。在 Event Map1 窗口中单击  
（World Start），拖到右侧的空白处。
单击 Object Motion，选中 （Arcball），
拖到 Event map 1中，叠加在 （World 
Start）上。在 Scene Graph 中选中 
（Group_All），拖到 Event map 1中，
叠加在 （Arcball）上。在 Actions中，
单击 Camera，选中 （Select camera），
拖到 Event map 1中，叠加在 （World 
Start）上。在 Scene Graph 中选中
（Camera01），拖到 Event map 1中，
叠加在 （Select camera）上。在 Action
中 单 击 Render ， 选 中 （ Set 
background），拖动到 Event map 1中，
叠加在 （World Start）上。双击 （Set 
background），出现对话框。在 Type

 

 

 

图 89-2 

 

 

图 89-3 
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中选择Linear Gradient，如图89-3所示，

选择 Angel为 270，单击 OK按钮。完

成效果如图 89-4所示。 

4．制作飞机旋转的效果。在 Event 

map 1 中单击 （Keyboard�s key 
press），拖动到右面的空白处。双击
（KeyPress_1），出现对话框，在左边
选择 1，单击 Add按钮，单击 OK按钮。
在Actions中，选中 （Rotation XYZ），
拖动到 Event map 1 中，叠加在
（KeyPress_1）上。选中 （Group_All），
拖动到 （Rotation XYZ）上。双击 
（Rotation XYZ），弹出对话框，具体
设置如图 89-5所示，选择 Loop方式，
单击 Close按钮。在 Event map 1中单击
（Keyboard�s key release），拖动到
右面的空白处。双击 （KeyRelease_1），
出现对话框，在左边选择 1，单击 Add
按钮，单击 OK 按钮。在 Actions 窗口
中，选中 （Stop�），拖动到 Event map 
1 中，叠加在 （KeyRelease_1）上。
选中  （Group_All），拖动到
（Stop�）上。双击 （Stop�），出
现对话框如图 89-6 所示。在左边选择
KeyPress_1.Rotation XYZ，单击 加
入，单击Close按钮。完成效果如图 89-7
所示。 

5．制作尾喷管的火焰效果。在
Event map 1中单击 （Keyboard�s key 
press），拖动到右面的空白处。双击
（KeyPress_2），出现对话框，在左边
选择 2，单击 Add按钮，单击 OK按钮。
在 Scene Graph中找到 （r flame）。
右击 （ r flame），选择 New...→
Particle system命令。双击 （Particle），
出现对话框，将 Name改为 Particle_r ，
在 Color settings 中按从左至右的顺序
选中 5个三角形，分别设置它们的RGB
值，具体为：Red=0，Green=0，Blue=0；

 

图 89-4 

 

图 89-5 

 

图 89-6 

 

图 89-7 



第七篇  军事篇 

 
285 

Red=255， Green=255， Blue=255；
Red=255， Green=255， Blue=128；
Red=255，Green=0，Blue=0；Red=0，
Green=0，Blue=0。修改默认值，Emit 

speed=10， End angle=360， Particle 

size=50，Spreed size=20。单击 Close

按钮。找到 （l flame），用同样的方

法制作 （Particle_l）。在 Action 中

单击 Particle systems，选中 （Start 

particle emission），拖动到 Event map 1

中，叠加在 （KeyPress_2）上。选中

（Particle_r）和 （Particle_l），拖

到 Event map 1 中，叠加在 （Start 

particle emission）上。完成效果如图
89-9所示。 

6．制作飞机加速和机翼转动的效

果。在 Actions 中选中  （Rotation 

XYZ），拖动到 Event map 1中，叠加

在 （KeyPress_2）上。选中 （left 

wing），叠加在 （Rotation XYZ）上。

双击 （Rotation XYZ），弹出对话框，

具体设置如图 89-10所示，选择 Repeat 

count方式，单击 Close按钮。在 Actions

中选中 （Rotation XYZ），拖动到
Event map 1中，叠加在 （KeyPress_2）

上。选中 （right wing），叠加在 
（Rotation XYZ）上。双击 （Rotation 

XYZ），弹出对话框，具体设置如图
89-11所示，选择 Repeat count方式，

单击 Close按钮。单击 Object Motion，

选中  （Translation XYZ），拖到 Event 

map 1中，叠加在 （KeyPress_2）上。

拖动 （Group_All）到  （Translation 

XYZ）上。双击  （Translation XYZ），

弹出对话框。在 Y方向上输入-100（位

移），Time 设为 200（毫秒），选择
Loop 方式，单击 Close 按钮。完成效

果如图 89-12所示。 

7．保存为 Meshes.c3p，本例制作

完成。 

 

图 89-9 

 

图 89-10 

 

图 89-11 

 

图 89-12 
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实例 90  变形战斗机（二） 

 

本例制作“变形战斗机（二）”的

效果，如图 90-1所示。 

本例特点：按 3键控制飞机变形和

减速。 

本例通过 Start particle emission和

Stop particle emission等知识完成。 

 

图 90-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载MESHES.c3p（源文件）。

执行 File→Load project 命令，在对话

框中选中 MESHES.c3p，如图 90-2 所

示。 

3．改变归属关系。在 Scene Graph

窗口中，单击 RootNode，单击  
（Group_All），找到 （r-engfin-l）、

 （r-engfin-u） 和 （r flame），拖

动 （r-engfin-u） 和 （r flame）到 
（r-engfin-l）上，形成关系图如图 90-3

所示。用同样的方法拖动 （l-engfin-u） 

和 （l flame）到 （l-engfin-l）上。 

4．制作飞机变形的效果。在 Event 

map中单击 （Keyboard�s key press），
拖动到右面的空白处。双击

（KeyPress_1），出现对话框，在左边
选择 3，单击 Add按钮，单击 OK按钮。
在 Actions中选中 （Rotation XYZ），
拖动到 Event map 1 中，叠加在
（KeyPress_3）上，选中 （l-lowr leg）
和 （r-lowr leg），叠加在 （Rotation 
XYZ）上。双击 （Rotation XYZ），
弹出对话框，具体设置如图 90-4所示，

 

 

图 90-2 

 

图 90-3 

 

图 90-4 
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选择 Repeat count方式，单击 Close按

钮。Actions中选中 （Rotation XYZ），

拖动到 Event map 1 中，叠加在

（KeyPress_3）上。选中 （r-engfin-l）

和 （r-engfin-l），叠加在 （Rotation 

XYZ）上。双击 （Rotation XYZ），

弹出对话框，具体设置如图 90-5所示，

选择 Repeat count方式，单击 Close按

钮。选中 （KeyPress_3），右击选择
Edit with Time Line View命令，出现对

话框如图 90-6所示，将后一个 Rotation 

XYZ 的起始时间拖到前一个 Rotation 

XYZ 的终止时间处。完成效果如图
90-7所示。 

5．制作飞机停止前进的效果。在
Action中单击 Particle systems，选中

（Stop particle emission），拖动到 Event 

map 1中，叠加在 （KeyPress_3）上。

选中 （Particle_l）和 （Particle_r），

拖到 Event map 1中，叠加在 （Stop 

particle emission）上。在 Actions中，

选中 （Stop�），拖动到 Event map 1
中，叠加在 （KeyPress_3）上。选中
 （Group_All），拖动到 （Stop�）
上。双击 （Stop�），出现对话框如
图 90-8 所 示 。 在 左 边 框 选 择
KeyPress_2. Translation XYZ，单击
加入，单击 Close 按钮。选中
（KeyPress_3），右击选择 Edit with 
Time Line View命令，出现对话框如图
90-9 所示，将最后的 Stop�的开始时
间拖动到刻度线 6 处，完成效果如图
90-10所示。 

6．制作飞机悬停的效果。在 Action
中单击 Particle systems，选中 （Start 
particle emission），拖动到 Event map 1
中，叠加在 （KeyPress_3）上。选中
（Particle_r）和 （Particle_l），拖
到 Event map 1 中，叠加在 （Start 
particle emission）上。单击 Object 

 

图 90-5 

 

图 90-6 

 

图 90-7 

 

图 90-8 

 

图 90-9 

 

图 90-10 
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Motion，选中  （Translation XYZ），

拖到 Event map 1 中，叠加在

（KeyPress_3）上。双击  （Translation 

XYZ）出现对话框，单击 Y 方向上的

，选择 ，如图 90-11 所示，单击
Set出现对话框。在Waveform type中

选择 Sine 方式。在 Sustain 和 Global 

parameters中，修改参数，具体设置如

图 90-12所示，单击 Close按钮。选择
Loop 方式，单击 Close 按钮。选中 
（Group_All），叠加在  （Translation 

XYZ）上。选中 （KeyPress_3），右

击选择 Edit with Time Line View命令，

出现对话框，如图 90-13 所示，将最后

的 Start particle emission 和 Translation 

XYZ的起始时间拖动到Stop�的起始时
间处。Actions窗口中，选中 （Rotation 
XYZ），拖动到 Event map 1中，叠加在
（ KeyPress_3 ） 上 。 选 中  
（L-Lowr-Leg），叠加在 （Rotation 
XYZ）上。双击 （Rotation XYZ），
弹出对话框，具体设置如图 90-14所示，
选择Repeat count方式，单击Close按钮。
Actions中选中 （Rotation XYZ），拖
动到 Event map 1 中，叠加在
（ KeyPress_3 ） 上 。 选 中  
（L-Lowr-Leg），叠加在 （Rotation 
XYZ）上。双击 （Rotation XYZ），
弹出对话框，在 X轴输入 30（角度），
Time设为 4000（毫秒），选择 Repeat 
count方式，单击 Close按钮。在 Actions
中单击 Event，选中  （Deactivate 
event），分别拖动到 Event map 1中，
叠 加 在 （ KeyPress_2 ） 和
（ KeyPress_3） 上。分别 选中
（KeyPress_2）和 （KeyPress_3），
叠加到各自的 （Deactivate event）上
出现黑框。完成效果如图 90-15所示。 

7．保存为Motor5.c3p，本例制作完
成。 

 

图 90-11 

 

图 90-12 

 

图 90-13 

 

图 90-14 

 

图 90-15 
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实例 91  爆炸的战斗机 

 

本例制作“爆炸的战斗机”效果，

如图 91-1所示。 

本例的特点是：单击左键，火箭从

原地升空时，火箭底部喷射火焰的情

景。 

本例通过 Start particle emissioin和

Stop particle emission等知识来完成。 

 

图 91-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 plane.C3D。执行 File→Add 

Cult3D Designer File命令，在出现的对

话框中选中 plane.C3D，如图 91-2所示。 

3．添加 Arcball。在 Event Map 1

窗口中单击 （World Start），拖到右

侧的空白处。在 Actions窗口中，单击

Object Motion，选中 （Arcball），拖

到 Event map 1 中，叠加在原来的 
（World Start）上面，出现黑框。在

Scene Graph窗口中，单击 rootnode选

项，选中 （plane），拖到 Event map 

1中，叠加在原来的 （Arcball）上面，

出现黑框。效果如图 91-3所示。 

4．制作爆炸时飞溅的效果。在

Event map 1中单击 （Left mouse click 

on Object），拖动到右侧的空白处，在

Actions窗口中，单击 Object motion选

项，选中 （Translation XYZ），按住

拖动到 Event map 1 中，叠加在  
（ObjectLClick_1）上面，出现黑框。

 

 

图 91-2 

 

 

图 91-3 
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在 Actions窗口中，单击 Object motion

选项，选中 （Rotation XYZ），拖动

到 Event map 1 中 ， 叠 加 在  
（ObjectLClick_1）上面，出现黑框。

在 Scene Graph窗口中，单击 rootnode

选项，选中的  （01），按住拖动到 
（Translation XYZ），出现黑框。双击

 （Translation XYZ），弹出对话框，

如图 91-4所示。在 Y轴中输入 20（位

移），Time设为 10000（毫秒），在 Z

轴中输入-100（位移），Time设为 10000

（毫秒），选择 Repeat count  1方式，

单击 Close 按钮完成参数设置。选中

Event map 1中的  （01），拖动到 
（Rotation XYZ），出现黑框。双击 
（Rotation XYZ），弹出对话框，如图

91-5所示。在 X轴中输入 360（角度），

Time设为 5000（毫秒），在 Y轴中输

入 360（角度），Time 设为 5000（毫

秒），在 Z轴中输入 360（角度），Time

设为 5000（毫秒），选择 Repeat count  

1方式，单击 Close按钮完成参数设置。 

5．其他的物体从  （02）到  

（07）的飞溅路径，参照  （01）的

设置方法，但是要注意到参数的设置，

要有所不同，这样飞溅的效果较好，具

体过程这里不再重复叙述，最后形成的

Event map 1关系如图 91-6所示。 

6．制作爆炸时的火花效果。在

Scene Graph窗口中，单击 rootnode选

项，选中 （plane），右击选择 New

→Particle System 命令，单击在 Scene 

Graph窗口中出现的 （particle），拖

动到 Event map 1中。在 Actions窗口

中，单击 Object motion选项，选中

（Start particle emission），拖动到 Event 

map 1中，叠加在 （ObjectLClick_1）

上面，出现黑框。选中 Event map 1中

的 （particle），叠加在 （Start particle 

 

图 91-4 

 

图 91-5 

 

图 91-6 

 

图 91-7 
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emission）上面，出现黑框。选中

（particle），右击选择 Details 命令，

弹出对话框。在 Color settings中，单击

左面的颜色方框可以选取不同的颜色，

将第一段颜色设为红色，第二段颜色设

为黄色，其他的颜色设为白色，如图

91-7所示。设置 Particle settings中的参

数，如图 91-8所示，在 Emit speed（m/s）

中输入 80，在 Speed range（%）中输

入 0.5，在 Brith rate（particle）中输入

25，在 Life length（ms）中输入 1，在

Start angle（deg）中输入 0，在 End angle

（deg）中输入 1，在 Particle size（m）

中输入 10，在 Gravity（m/（s*s））中

输入 0.5，在 Friction中输入 1，在 Speed 

size 中输入 0.1，在 wiggle（deg/s）中

输入 72，在 wiggle amplitude 中输入

0.3，在 Opacity中输入 1，在 Time scales

（s/s）中输入 2。单击 Close按钮完成

设置。 

7．制作爆炸停止时火花停止的效

果和战斗机复位的效果。在 Event map 

1中选中 （Keyboard�s key Press），
按住拖动到右面的空白处，双击

（KeyPress_1），弹出对话框，如图 91-9
所示，在左边框中选中“Enter”，单
击 Add按钮，添加到右边框，单击 OK
按钮完成。在 Actions 窗口中，单击
Particle systems，选中  （Stop particle 
emission），按住拖动到 Event map 1
中，并且叠加在 （KeyPress_1）上面，
出现黑框。选中 Event map 1 中的
（particle），拖动到  （Stop particle 
emission）上面，出现黑框。在 Actions
窗口中，单击 Object motion选项 s，选
中 （Reset），拖到 Event map 1中，
叠加在 （KeyPress_1）上面，出现黑
框。选中 Event map 中原来的  
（plane），把它叠加在 （Reset）上

 

图 91-8 

 

 

图 91-9 

 

 

图 91-10 
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面，出现黑框。最后形成 Event map 1

中的关系，如图 91-10所示。 

8．保存为 cycle.c3p，按动鼠标上

的左键，战斗机会爆炸，如图 91-11所

示。按动键盘上的 Enter键恢复的原来

的状态。 

 

图 91-11 
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实例 92  卫星姿态控制 

 

本例制作“卫星姿态控制”的效果，

如图 92-1所示。 

本例的特点是：用键盘上的“1”、

“2”、“3”、“4”、“5”、“6”

键来控制卫星在三个坐标自由度的调

整，“1”、“2”围绕 X轴方向旋转，

“3”、“4”围绕 Y轴方向旋转，“5”、

“6”围绕 Z轴方向旋转，按空格键复

位。 

本例通过 Keyboard�s key press等
知识完成。 

 

图 92-1  效果图 

 

 

1．启动 Cult 3D。 
2．装载 galileo.C3D。执行 File→

Add Cult3D Designer File命令，在出现
的对话框中选中 galileo.C3D，如图 92-2
所示。 

3．添加 Arcball。在 Event map 1
中单击 （world start）选项，拖动到
右面的空白处。在 Actions窗口中，单
击 Object motion 选项，选中  
（Arcball），拖动到 Event map 1中，
叠加在 （WorldStart_1）上面，出现
黑框。在 Scene Graph中，单击 rootnode
选项，选中 （GALILEO），拖动到
Event map 1中，叠加在 （Arcball）
上面，出现黑框。形成的 Event map 1
如图 92-3所示。 

4．制作卫星沿 X轴旋转的效果。
在 Event map 1中，单击 （Keyboard�s 

 

图 92-2 

 

图 92-3 
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在 Event map 1中，单击 （Keyboard�s 
key Press），拖动到右面的空白处，双
击 （KeyPress_1），弹出对话框，如
图 92-4所示，在左边框中选中“1”，
单击 Add按钮添加到右边框，单击 OK
按钮完成。在 Actions 窗口中，单击
Object motion选项，选中 （Rotation 
XYZ），拖动到 Event map 1中，叠加
在 （KeyPress_1），出现黑框。选中
Event map 1中的 （GALILEO），拖
动到 （Rotation XYZ），出现黑框。
双击 （Rotation XYZ），弹出对话框，
如图 92-5 所示。在 X 轴中输入 2（角
度），Time设为 0（毫秒），选择 Repeat 
count 1方式，单击 Close按钮完成参数
设置。 
在 Event map 1 中，单击

（Keyboard�s key Press），拖动到右面
的空白处，双击 （KeyPress_2），弹
出对话框，在左边框中选中“2”，单
击 Add 按钮添加到右边框，单击 OK
按钮完成。在 Actions 窗口中，单击
Object motion选项，选中 （Rotation 
XYZ），拖动到 Event map 1中，叠加
在 （KeyPress_2）上，出现黑框。选
中 Event map 1中的 （GALILEO），
拖动到 （Rotation XYZ），出现黑框。
双击 （Rotation XYZ），弹出对话框。
在 X轴中输入�2（角度），Time设为
0（毫秒），选择 Repeat count 1方式，
单击 Close按钮完成参数设置。形成的
Event Map 1关系，如图 92-6所示。 

5．制作卫星沿 Y轴旋转的效果。
在 Event map 1中，选中 （Keyboard�s 
key Press），拖动到右面的空白处，双
击 （KeyPress_3），弹出对话框，在
左边框中选中“3”，单击 Add按钮添
加到右边框，单击 OK 按钮完成。在
Actions窗口中，单击 Object motion选

 

图 92-4 

 

 

图 92-5 

 

 

图 92-6 

 

 

图 92-7 
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项，选中 （Rotation XYZ），拖动到

Event map 1中，叠加在 （KeyPress_3）

上，出现黑框。选中 Event map 1中的

（GALILEO），拖动到  （Rotation 

XYZ）上，出现黑框。双击 （Rotation 

XYZ），弹出对话框。在 Y轴中输入 2

（角度），Time 设为 0（毫秒），选

择Repeat count 1方式，如图 92-7所示，

单击 Close按钮完成参数设置。形成的

Event map 1如图 92-8所示。 

在 Event map 1 中，选中

（Keyboard�s key Press），拖动到右面
的空白处，双击 （KeyPress_4），弹
出对话框，在左边框中选中“4”，单
击 Add 按钮添加到右边框，单击 OK
按钮完成。 
在 Actions 窗口中，单击 Object 

motion选项，选中 （Rotation XYZ），
拖动到 Event map1 中，叠加在
（KeyPress_4）上，出现黑框。选中
Event map 1中的 （GALILEO），按
住拖动到 （Rotation XYZ），出现黑
框。双击 （Rotation XYZ），弹出对
话框。在 Y轴中输入�2（角度），Time
设为 0（毫秒），并且选择 Repeat count 
1方式，单击 Close按钮完成参数设置。
形成的 Event Map 1 关系，如图 92-9
所示。 

6．制作卫星沿 Z轴旋转的效果。
在 Event map 1中，选中 （Keyboard�s 
key Press），拖动到右面的空白处，双
击 （KeyPress_5），弹出对话框，在
左边框中选中“5”，单击 Add按钮添
加到右边框，单击 OK 按钮完成。在
Actions窗口中，单击 Object motion选
项，选中 （Rotation XYZ），拖动到
Event map 1中，叠加在 （KeyPress_5）
上，出现黑框。选中 Event map 1中的
（GALILEO），按住拖动到 （Rotation 

 

图 92-8 

 

 

图 92-9 

 

 

图 92-10 
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XYZ），出现黑框。双击 （Rotation 

XYZ），弹出对话框。在 Z轴中输入 2

（角度），Time 设为 0（毫秒），并

且选择 Repeat count 1方式，单击 Close

按钮完成参数设置。形成的 Event map 

1如图 92-10所示。 

在 Event map 1 中，选中

（Keyboard�s key Press），拖动到右面
的空白处，双击 （KeyPress_6），弹
出对话框。在左边框中选中“6”，单
击 Add 按钮添加到右边框，单击 OK
按钮完成。在 Actions 窗口中，单击
Object motion选项，选中 （Rotation 
XYZ），拖动到 Event map 1中，叠加
在 （KeyPress_6）上，出现黑框。选
中 Event map 1中的 （GALILEO），
拖动到 （Rotation XYZ），出现黑框。
双击 （Rotation XYZ），弹出对话框。
在 Z轴中输入�2（角度），Time设为
0（毫秒），选择 Repeat count 1方式，
单击 Close按钮完成参数设置。形成的
Event Map关系，如图 92-11所示。 

7．制作卫星复位的效果。在 Event 
map 1 中，选中 （Keyboard�s key 
Press），拖动到右面的空白处，双击
（KeyPress_7），弹出对话框，在左边
框中选中“7”，单击 Add按钮添加到
右边框，单击 OK按钮完成。 
在 Actions 窗口中，单击 Object 

motion 选项，选中 （Reset），拖动
到 Event map 1 中 ， 叠 加 在
（KeyPress_7）上，出现黑框。选中
Event map 1中的 （GALILEO），拖
动到 （Reset），出现黑框。最后形
成的 Event Map 1关系图，如图 92-12
所示。 

8．保存为 galileo.c3p，本实例制
作完成。 

 

图 92-11 

 

 

 

 

图 92-12 
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实例 93  雷    达 

 

本例制作“雷达”的效果，如图

93-1所示。 

本例特点：按方向键分别控制雷达

的旋转和俯仰。 

本例通过 Stop和 Rotation XYZ等

知识完成。 

 

图 93-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 antenna.C3D。执行 File→

Add Cult3D Designer File命令，在对话

框中选中 antenna.C3D，如图 93-2所示。 

3．设置背景颜色和确定视角。在

Scene Graph窗口中，找到 Textures，

单击右键，选择 New�→Texture，在
弹出的对话框中选择灯火.jpg文件，单
击打开。在 Event Map1 中单击  
（World Start），拖到右侧的空白处。
在 Actions窗口中，单击 Render，选中
（Set background），拖动到 Event map 

1中，叠加在 （World Start_1）上。
双击 （Set background），出现对话
框如图 93-3 所示。在 Type 中选择
Texture，点开下方的组合框，选择
Texture_1，可以在下方预览图片。单
击 OK 按钮。在 Actions 中，单击
Camera，选中 （Select camera），拖
到 Event map 1中，叠加在 （World 
Start）上。在 Scene Graph窗口中选中
（Camera01），拖到 Event map 1中，

 

 

图 93-2 

 

图 93-3 
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叠加在 （Select camera）上。 

4．制作雷达左右转动的效果。在

Event map 1中单击 （Keyboard�s key 
press），拖动到右面的空白处。双击
（KeyPress_1），弹出对话框，在左边
框中选中 Arrow Left，单击 Add按钮，
单击 OK按钮。在 Action中单击 Object 
motion选项，选中 （Rotation XYZ），
拖动到 Event map 1 中，叠加在
（KeyPress_1）上，出现黑框。单击
RootNode，选中 （Group01），拖到
Event map 1 中，叠加在 （Rotation 
XYZ）上，出现黑框。双击 （Rotation 
XYZ），弹出对话框，具体设置如图
93-4所示，选择 Loop方式，单击 Close
按钮。在 Event map 1 中单击
（Keyboard�s key release），拖动到右
面的空白处。双击 （KeyRelease_1），
弹出对话框，在左边框中选中 Arrow 
Left，单击 Add按钮，单击 OK按钮。
在 Actions中，选中 （Stop�），拖
动到 Event map 1 中，叠加在
（KeyRelease_1）上。选中 （Group01），
叠加到 （ Stop�）上。双击
（Stop�），出现对话框如图 93-5所示。
在左边选择 KeyPress_1.Rotation XYZ，
单击 加入，单击 Close 按钮。效果
如图 93-6所示。在 Event map 1中单击
（Keyboard�s key press），拖动到右
面的空白处。双击 （KeyPress_2），
弹出对话框，在左边框中选中 Arrow 
Right，单击 Add按钮，单击 OK按钮。
在 Action中单击 Object motion选项，
选中 （Rotation XYZ），拖动到 Event 
map 1中，叠加在 （KeyPress_2）上。
选中 （Group01），叠加在 （Rotation 
XYZ）上。双击 （Rotation XYZ），
弹出对话框，具体设置如图 93-7所示，
选择 Loop 方式，单击 Close 按钮。在

 

图 93-4 

 

 

图 93-5 

 

 

图 93-6 

 

 

图 93-7 
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Event map 中单击 （Keyboard�s key 
release），拖动到右面的空白处。双击
（KeyRelease_2），弹出对话框，在
左边框中选中 Arrow Right，单击 Add
按钮，单击 OK按钮。在 Actions中选
中 （Stop�），拖动到 Event map 1
中，叠加在 （KeyRelease_1）上。选
中 （Group01），叠加到 （Stop�）
上。双击 （Stop�），出现对话框如
图 93-8所示。在左边选择 KeyPress_2. 
Rotation XYZ，单击 加入，单击
Close按钮。效果如图 93-9所示。 

5．制作雷达俯仰的效果。在 Event 
map中单击 （Keyboard�s key press），
拖动到右面的空白处。双击

（KeyPress_3），弹出对话框，在左边
框中选中Arrow Down，单击Add按钮，
单击 OK按钮。在 Action中单击 Object 
motion选项，选中 （Rotation XYZ），
拖动到 Event map 1 中，叠加在
（KeyPress_3）上。选中 （dish），
叠加在 （Rotation XYZ）上。双击 
（Rotation XYZ），弹出对话框，具体
设置如图 93-10所示，选择Repeat count
方式，单击 Close按钮。在 Event map
中单击 （Keyboard�s key press），拖
动 到 右 面 的 空 白 处 。 双 击

（KeyPress_4），弹出对话框，在左边
框中选中 Arrow Up，单击 Add按钮，
单击 OK按钮。在 Action中单击 Object 
motion选项，选中 （Rotation XYZ），
拖动到 Event map 1 中，叠加在
（KeyPress_4）上。选中 （dish），
叠加在 （Rotation XYZ）上，出现黑
框。双击 （Rotation XYZ），弹出对
话框，具体设置如图 93-11所示，选择
Repeat count方式，单击 Close按钮。
效果如图 93-12所示。 

6．保存为 antenna.c3p，本例制作
完成。 

 

图 93-8 

 

图 93-9 

 

图 93-10 

 

图 93-11 

 

图 93-12 
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实例 94  导弹发射车 

 

本例制作“导弹发射车”的效果，

如图 94-1所示。 

本例特点：按“1”键控制打开发

射架，按“2”键控制发射。 

本例通过 Timer 和 Start particle 

emission等知识完成。 
 

图 94-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 scudh.C3D。执行 File→

Add Cult3D Designer File命令，在对话

框中选中 scudh.C3D，如图 94-2所示。 

3．添加 Arcball。在 Event Map1

窗口中单击 （World Start），拖到右

侧的空白处。在 Actions中，单击 Object 

Motion，选中 （Arcball），拖到 Event 

map 1中，叠加在 （World Start）上，

出现黑框。在 Scene Graph窗口中，单

击 RootNode，选中 （Group_All），

拖到 Event map 1 中，叠加在  
（Arcball）上，出现黑框。效果如图

94-3所示。 

4．制作发射架打开的效果。在

Event map1中单击 （Keyboard�s key 
press），拖动到右面的空白处。双击
（KeyPress_1），出现对话框，在左边
选择 1，单击 Add按钮，单击 OK按钮。
单 击 Object Motion ， 选 中   
（Translation XYZ），拖到 Event map 1
中，叠加在 （KeyPress_1）上，出现

 

 

 

图 94-2 

 

图 94-3 
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黑框。双击  （Translation XYZ），

出现对话框，具体设置如图 94-4所示，

选择 Repeat count方式，单击 Close按

钮。在 Scene Graph中，单击 RootNode，

选中 （leg1），拖到 Event map 1中，

叠加在  （Translation XYZ）上，出

现黑框。在Actions窗口中，单击 Event，

选中 （Deactivate event），拖动到

Event map 1中，叠加在 （KeyPress_1）

上，出现黑框。选中 （KeyPress_1，

叠加到 （Deactivate event）上出现黑

框。完成效果如图 94-5所示。在 Event 

map1中单击 （Timer），拖动到右面

的空白处。选中 （Timer_1），右击

选择不要 Initial Activation。双击

（Timer_1），出现对话框，填入 1000

（ms），单击 OK按钮。在 Actions窗

口中，选中 （Rotation XYZ），拖动

到 Event map 1中，叠加在 （Timer_1）

上，出现黑框。选中 Event map 1中的 
（Group01），拖动到 （Rotation XYZ）

上，出现黑框。双击 （Rotation XYZ），

弹出对话框，具体设置如图 94-6所示，

选择 Repeat count方式，单击 Close按

钮。在 Actions中，单击 Event，选中 
（Deactivate event），拖动到 Event map 

1 中，叠加在 （Timer_1）上，出现

黑框。选中 （Timer_1），叠加到 
（Deactivate event）上，出现黑框。在

Actions 窗口中，单击 Event，选中 
（activate event），拖动到 Event map 1

中，叠加在 （KeyPress_1）上，出现

黑框。将 （Timer_1）拖动到  
（activate event）上，出现黑框。完成

效果如图 94-7所示。 

5．制作导弹发射的效果。在 Scene 

Graph 窗口中，找到 （ scud），把

它拖动到 （Group01）上出现黑框。

右击 （ scud），选择 New...→Particle 

system 命令。双击 （Particle），出

 

图 94-4 

 

图 94-5 

 

图 94-6 

 

图 94-7 
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现对话框，在对话框的上部 Color 

settings 中分别选中 5 个三角，按从左

至左的顺序分别设置它们的 RGB值，

具体数值设置为 Red=0，Green=0，

Blue=0 ； Red=255 ， Green=255 ，

Blue=128；Red=255，Green=0，Blue=0；

Red=0，Green=0，Blue=0；Red=0，

Green=0，Blue=0。修改默认值，具体

设置如图 94-8所示，单击 Close按钮。

在 Event map 1中单击 （Keyboard�s 
key press），拖动到右面的空白处。双
击 （KeyPress_2），出现对话框，在
左边选择 2，单击 Add按钮，单击 OK
按钮。在Action中单击Particle systems，
选中 （Start particle emission），拖动
到 Event map 1 中 ， 叠 加 在
（KeyPress_2）上。选中 （Particle），
拖到 Event map 1中，叠加在 （Start 
particle emission）上。在 Actions中，
选中  （Translation XYZ），拖动到
Event map 1中，叠加在 （KeyPress_2）
上。选中  （  scud），拖动到   
（ Translation XYZ）上。双击   
（Translation XYZ），弹出对话框，单
击 Y方向上的 ，选择 ，如图 94-9
所示。单击 Set，在Waveform type中
选择 Swtooth up 方式。在 Sustain 和
Global parameters中修改参数，具体设
置如图 94-10所示，单击 Close按钮。
选择 Repeat count方式，单击 Close按
钮。选中 （KeyPress_2），右击选择
不要 Initial Activation。在 Actions中，
单击 Event，选中 （activate event），
拖动到 Event map 1 中，叠加在
（Timer_1）上。将 （KeyPress_2）
拖动到 （activate event）上，出现黑
框。完成效果如图 94-11所示。 

6．保存为Motor5.c3p，本例制作
完成。 

 

图 94-8 

 

图 94-9 

 

图 94-10 

 

图 94-11 
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实例 95  火  箭 （一） 

 

本例制作“火箭（一）”的效果，

如图 95-1所示。 

本例特点：按 Enter键单击以后火

箭发动，4秒钟后火箭发射。 

本例通过 Stop�、Stop particle 
emission、 Start particle emission 和
Select camera等知识完成的。 

 

图 95-1  效果图 

 

 

1．启动 Cult 3D。 
2．装载 Ariane.C3D。执行 File→

Add Cult3D Designer File命令，在对话
框中选中 Ariane.C3D，如图 95-2所示。 

3．确定视角和制作视角旋转的效
果。在 Event Map1 中单击 （World 
Start），拖到右侧的空白处。在 Actions
窗口中，单击 Camera，选中 （Select 
camera），拖到 Event map 1中，叠加
在 （World Start_1）上。在 Scene Graph
窗口中选中 （Camera01），拖到 Event 
map 1中，叠加在 （Select camera）
上。在 Actions 中选中  （Rotation 
XYZ），拖动到 Event map 1中，叠加
在 （World Start_1）上。在 Scene Graph
窗口中，找到 （Ariane），拖到 Event 
map 1中，叠加在 （Rotation XYZ）
上，出现黑框。双击 （Rotation XYZ），
弹出对话框，具体设置如图 95-3所示，
选择 Loop 方式，单击 Close 按钮。效
果如图 95-4所示。 

 

图 95-2 

 

图 95-3 

 

图 95-4 
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4．制作发动机点火的效果。在

Scene Graph中，找到 （Group01），

右击  （Group01），选择 New...→

Particle system命令。双击 （Particle），

出现对话框，如图 95-5 所示。在对话

框的上部Color settings中选中5个三角

形，按由左向右的顺序在右侧的框中分

别填写 RGB值，为 Red=0，Green=0，

Blue=0 ； Red=255 ， Green=255 ，

Blue=128；Red=255，Green=0，Blue=0；

Red=0，Green=0，Blue=0；Red=0，

Green=0，Blue=0。修改 Particle settings

的默认值，具体设置如图 95-6 所示，

单击 Close按钮。用同样的方法和参数

分别为 （Group02）和 （Group03）

制作 （Particle_1）和 （Particle_2）。 

在 Event map 1 中 单 击

（Keyboard�s key press），拖动到右面
的空白处。双击 （KeyPress_1），出
现对话框，在左边选择 Enter，单击 Add
按钮，单击 OK 按钮。在 Action 中单
击 Particle systems，选中 （ Start 
particle emission），拖动到 Event map 1
中，叠加在 （KeyPress_1）上。选中
（Particle）、 （Particle_1）和
（Particle_2），分别拖到 Event map 1
中，叠加在 （Start particle emission）
上。在 Actions中，选中 （Stop�），
拖动到 Event map 1 中，叠加在
（KeyPress_1）上。选中 （Ariane），
叠加到 （ Stop�）上。双击
（Stop�），出现对话框如图 95-7 所
示。左边选择 WorldStart_1.Rotation 
XYZ，单击 加入，单击 Close按钮。
效果如图 95-8所示。 

5．制作发动机启动的效果。左击 
（Group01），选择 New...→Particle 
system 命令。双击 （Particle_3），
出现对话框，在对话框的上部 Color 

 

图 95-5 

 

图 95-6 

 

图 95-7 

 

图 95-8 
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settings 中设定与前面相同。修改默认

值，具体设置如图 95-9所示，单击Close

按钮。用同样的方法和参数分别为 
（Group02）和 （Group03）制作

（Particle_4）和 （Particle_5）。 

在 Event map 1中单击 （Timer），

拖动到右面的空白处。双击

（Timer_1），在弹出的对话框中填 300

（ms），单击 OK 按钮。右键单击

（Timer_1）选择不要 Initial Activation。

单击 Event，选中 （activate event），

拖动到 Event map 1 中，叠加在

（KeyPress_1）上。将 （Timer_1）

拖动到 （activate event）上。单击

Event，选中 （Deactivate event），拖

动到 Event map 1 中，叠加在

（Timer_1）上。选中 （Timer_1），

叠加到 （Deactivate event）上。效果

如图 95-10 所示。在 Action 中单击

Particle systems，选中 （Start particle 

emission），拖动到 Event map 1中，

叠加在 （Timer_1）上。选中

（Particle_3）、 （Particle_4）和

（Particle_5），分别拖到 Event map 1

中，叠加在 （Start particle emission）

上。在 Action中单击 Particle systems，

选中 （Stop particle emission），拖动

到 Event map 1中，叠加在 （Timer_1）

上。选中 （Particle）、 （Particle_1）

和 （Particle_2），分别叠加在 （Stop 

particle emission）上。完成效果如图

95-11所示。 

6．保存为 Ariane.c3p，本例制作

完成。 

 

图 95-9 

 

 

图 95-10 

 

图 95-11 
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实例 96  火  箭 （二） 

 

本例制作“火箭（二）”的效果，

如图 96-1所示。 

本例特点：火箭发射后助推器脱

离，火箭加速前进。 

本例通过 Stop particle emission和

Trigger event等知识完成。 

 

图 96-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 Ariane.c3p（源文件）。

执行 File→Load project 命令，在对话

框中选中 Ariane.c3p，如图 96-2所示。 

3．制作火箭先上升视角在跟随的

效果。在Actions中，选中 （Translation 

XYZ），拖动到 Event map 1中，叠加

在 （Timer_1）上。选中 （Ariane）

后叠加在 （Translation XYZ）上。双

击 （Translation XYZ）出现对话框，

单击 Z方向上的 ，选择 ，如图 96-3

所示，单击 Set 出现对话框，在

Waveform type 中选择 Sine 方式。在

Sustain和 Global parameters中，修改参

数，具体设置如图 96-4所示。单击Close

按钮。选择 Repeat count 方式，单击

Close按钮。 

4．制作助推器脱离的效果。在

Event map 1中单击 （Timer），拖动

到右面的空白处。双击 （Timer_2），

在弹出的对话框中填 160000（ms），

单击 OK按钮。右键单击 （Timer_2）

选择不要 Initial Activation。单击 Event，

 

图 96-2 

 

图 96-3 

 

图 96-4 
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选择不要 Initial Activation。单击 Event，

选中 （activate event），拖动到 Event 

map 1 中，叠加在 （Timer_1）上。

将 （Timer_2）拖动到  （activate 

event）上。单击 Event，选中  
（Deactivate event），拖动到 Event map 

1中，叠加在 （Timer_2）上。选中

（Timer_2），叠加到  （Deactivate 

event）上。在 Actions 中单击 Object 

motion选项，选中 （Rotation XYZ），

拖动到 Event map 1 中，叠加在

（Timer_2）上。双击  （Rotation 

XYZ），弹出对话框，具体设置如图

96-5所示，选择 Repeat count方式，单

击 Close 按钮。在 Actions窗口中，选

中 （Translation XYZ），拖动到 Event 

map 1 中，叠加在 （Timer_2）上。

在 Scene Graph中，找到 （Group01），

选中后叠加在 （Translation XYZ）和

 （ Rotation XYZ）上。双击  
（Translation XYZ），出现对话框如图

96-6所示，选择 Repeat count方式，单

击 Close 按钮。完成效果如图 96-7 所

示。在 Actions中单击 Object motion选

项，选中 （Rotation XYZ），拖动到

Event map 1中，叠加在 （Timer_2）

上。双击 （Rotation XYZ），弹出对

话框，具体设置如图 96-8 所示，选择

Repeat count方式，单击 Close按钮。

在 Actions 中选中  （ Translation 

XYZ），拖动到 Event map 1中，叠加

在 （Timer_2）上。在 Scene Graph

窗口中，找到 （Group02），选中后

叠加在  （Translation XYZ）和  
（ Rotation XYZ ） 上 。 双 击  
（Translation XYZ）出现对话框，具体

设置如图 96-8所示，选择 Repeat count

方式，单击 Close 按钮。在 Actions 中

单 击 Object Motion ， 选 中   

 

图 96-5 

 

图 96-6 

 

图 96-7 

 

图 96-8 

 

图 96-9 
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（Translation XYZ），拖到 Event map 1

中，叠加在 （Timer_2）上。选中 
（Group02）叠加在  （Translation 

XYZ）上。双击  （Translation XYZ）

出现对话框，单击 Z 方向上的 ，选

择 ，单击 Set 出现对话框，在

Waveform type 中选择 sine 方式。在

Sustain和 Global parameters中，修改参

数，具体设置如图 96-10 所示。单击

Close按钮。选择 Repeat count方式，

单击 Close按钮。 

5．制作助推器发动机关闭的效果。

在 Action中单击 Particle systems，选中

（Stop particle emission），拖动到

Event map 1中，叠加在 （Timer_2）

上 。 选 中 （ Particle_3 ） 和

（Particle_4），分别叠加在 （Start 

particle emission）上。 

6．制作恢复视角旋转和加速前进

的效果。在 Action中单击 Event，选中

（Trigger event），拖到 Event map 1

中，叠加在 （Timer_2）上。选中 
（World Start_1），拖动到 （Trigger 

event）上。在 Actions 中，选中  
（Translation XYZ），拖动到 Event map 

1中，叠加在 （Timer_2）上。在 Scene 

Graph 中，找到 （Group03），选中

后叠加在 （Translation XYZ）上。双

击 （Translation XYZ）出现对话框，

具体设置如图 96-11所示，选择 Repeat 

count 方式，单击 Close 按钮。完成效

果如图 96-12所示。 

7．保存为 Ariane.c3p，本例制作

完成。 

 

 

图 96-10 

 

 

 

图 96-11 

 

 

 

图 96-12 
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实例 97  火  箭 （三） 

 

本例制作“火箭（三）”的效果，如图

97-1所示。 

本例的特点是：单击鼠标左键火箭发

射，并且在上升函数中编辑为加速度上升。 

本例通过对象的包含关系和加速度等

知识完成。 

 

图 97-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 spacepad.C3D。执行 File→Add 

Cult3D Designer File，在出现的对话框中选

中 spacepad.C3D，如图 97-2所示。 

3．添加 Arcball。在 Event map 1中单击

 （world start），拖动到右面的空白处。在

Actions窗口中，单击 Object motion选项，

选中 （Arcball），拖动到 Event map 1中，

叠加在 （WorldStart_1） 上面，出现黑框。

在 Scene Graph中，单击 rootnode选项，选

中 （SPACEPAD），拖动到 Event map 1

中，叠加在 （Arcball）上面，出现黑框。

形成的 Event map 1如图 97-3所示。 

4．制作将火箭的部件合为一体。在

Scene Graph窗口中可以看到，所有的 都是

包含在 （SPACEPAD）下的，但是各个

是相互独立的，这里来制作各个 之间的相

互包含关系。单击 View 4窗口中的 和 ，

将这两个置为亮色，如图 97-4所示。选中这

两个选项后，单击 Scene Graph 中

（SPACEPAD）下的各个 ，可以看到对应

的物体在 View 4窗口会显示出边框和坐标。 

 

图 97-2 

 

图 97-3 

 

图 97-4 
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当单击部件的时候可以看到火箭的各

个部件是独立的，由于制作火箭升空的效果

时，火箭的所有部件必须同时运动，为避免

出现不和谐，需要将所有火箭的部件合为一

个部件，以减少工作量。编辑前的效果如图

97-5所示。 

在 Scene Graph 中 ， 单 击

（SPACEPAD），分别选中 （HIDDEN01）、

（SFNOZZELO01）、（TANKHARN01）、

（MAINTANK01）、 （CORTANK01）、

（VEHICLE01）依次拖动到 （01）下。

观察执行以上步骤后的 Scene Graph，可以看

到部件的关系有所改变，如图 97-6所示。  

5．制作火箭加速度上升的效果。在

Event map 1中，选中 （Left mouse click on 

Object），拖动到右面的空白处。 

在 Actions窗口中，单击 Object motion

选项，选中 （Translation XYZ），拖动到

Event map 1中，叠加在 （ObjectLClick_1）

上面，出现黑框。选中 Scene Graph中的

（01），拖动到 （Translation XYZ）上，

出现黑框。双击 （Translation XYZ），弹

出对话框，单击 Z轴右面的 按钮，在弹出

的下拉菜单中选择 按钮，如图 97-7所示。 

单击该按钮右面的 Set按钮，弹出对话

框，如图 97-8所示。在Waveform type的下

拉菜单中，选中 Squre选项。在Decay下 Time

中，输入 10000（ms），Amptitude 中输入

2000（位移），在右下角的 Period中同样输

入 10000（ms），Final Period也输入 10000

（ms）。最后在 Grobal Parameter 中调整

Offset和 Phase使函数的起点大概是在零点。

其中 Offset 的值为：22（位移），Phase 的

值为：�180（角度）。选中 lock选项，单击
Close 按钮完成函数设置。最后得到函数波
形如图 97-9所示。 

6．制作火箭复位的效果。在 Event map 
1中选中 （Right mouse click on Object），
拖动到右面的空白处。在 Actions 窗口中，

 

图 97-5 

 

图 97-6 

 

图 97-7 

 

图 97-8 
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单击 Object motion选项，选中 （Reset），

拖动 到 Event map 1 中，叠加 在  
（ObjectRclick_1）上面，出现黑框。选中

Event map 1中的  （SPACEPAD），拖动

到 （Reset）上面，出现黑框，最后形成的

Event Map关系图如图 97-10所示。 

7．保存为 huojian.c3p，本实例制作完

成。 

 

图 97-9 

 

图 97-10 
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实例 98  火  箭 （四） 

 

本例制作“火箭（四）”的效果，

如图 98-1所示。 

本例的特点是：单击鼠标左键，火

箭从原地升空时，火箭底部喷射火焰的

情景。 

本例通过 Start particle emissioin和

Stop particle emission等知识完成。 

 

图 98-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 huojian.c3p。执行 File→

Load project命令，在出现的对话框中

选中 huojian.c3p，如图 98-2所示。 

3．制作火箭升空时的火焰喷射的

效果。在 Scene Graph 窗口中，单击

rootnode 选 项 ， 选 中  
（SFNOZZEL01），右击选择 New→

Particle System 命令。在 Scene Graph

窗口中，会出现一个  （Particle），

如图 98-3 所示。单击 （Particle），

拖动到 Event map 1中。在 Actions窗

口中，单击 Object motion选项，选中

（Start particle emission），拖动到 Event 

map 1中，叠加在 （ObjectLClick_1）

上面，出现黑框。选中 Event map 1中

的 （Particle），叠加在 （Start particle 

emission）上面，出现黑框。选中

（Particle），右击选择 Details 命令，

弹出对话框。在 Color settings中，单击

左面的颜色方框可以选取不同的颜色，

 

 

 

图 98-2 

 

图 98-3 
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将第一段颜色设为红色，第二段颜色设

为黄色，第三段颜色设为黄色，第四段

颜色设为红色，最后一段的颜色设为黄

色，如图 98-4 所示，拖到颜色框下的

三角形按钮，可以控制每一段不同颜色

持续的时间长短。设置 Particle settings

中的参数，如图 98-5 所示，在 Emit 

speed（m/s）中输入 4.5，在 Speed range

（%）中输入 3.6，在 Brith rate（particle）

中输入 250，在 Life length（ms）中输

入 1.1，在 Start angle（deg）中输入 0，

在 End angle（deg）中输入 15，在 Particle 

size（m）中输入 30，在 Gravity（m/

（s*s））中输入 1，在 Friction中输入

1，在 Speed size中输入 0.07，在 wiggle

（deg/s）中输入 72，在 wiggle amplitude

中输入 0.03，在 Opacity中输入 0，在

Time scales（s/s）中输入 1。单击 Close

按钮完成设置。形成的 Event map 1如

图 98-6所示。 

4．制作火箭复位时火焰停止的效

果。在 Actions 窗口中，单击 Particle 

systems ， 选 中  （ Stop particle 

emission），按住拖动到 Event map 1

中，并且叠加在 （ObjectRClick_1）

上面，出现黑框。选中 Event map 1中

的 （particle），拖动到  （Stop 

particle emission）上面，出现黑框。最

后形成 Event map 1如图 98-7所示。 

5．保存为 huojian1.c3p，本例制作

完成。 

 

图 98-4 

 

图 98-5 

 

图 98-6 

 

图 98-7 
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实例 99  阿波罗 13号（一） 

 

本例制作“阿波罗 13号（一）”

的效果，如图 99-1所示。 

本例特点：按“1”键点火脱离，

按“2”键控制转移轨道。 

本例通过 Start particle emission、

Stop particle emission和 Trigger event

等知识完成。 

 

图 99-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 Apollo.C3D。执行 File→

Add Cult3D Designer File命令，在对话

框中选中 Apollo.C3D，如图 99-2所示。 

3．添加 Arcball和设置背景色。在

Event Map1 窗口中单击  （World 

Start），拖到右侧的空白处。在 Actions

窗口中，单击 Object Motion，选中 
（Arcball），拖到 Event map 1中，叠

加在 （World Start）上，出现黑框。

在 Scene Graph 窗 口 中 ， 单 击

RootNode，选中 （Group_All），拖

到 Event map 1中，叠加在 （Arcball）

上，出现黑框。在Action中单击Render，

选中 （Set background），拖动到 Event 

map 1中，叠加在 （World Start_1）

上 ， 出 现 黑 框 。 双 击 （ Set 

background），出现对话框如图 99-3

所示。单击中间的 Color，在出现的对

话框中选择黑色，单击 OK按钮。完成

效果如图 99-4所示。 

 

 

 

图 99-2 

 

图 99-3 
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4．制作飞船点火脱离的效果。在

Scene Graph中单击 RootNode，单击 
（Group_All），再单击 （13），选

中 （thruster01）。右击 （thruster01），

选择 New...→Particle system命令。右

击 （Particle），选择 Change name

命令，在出现的对话框的文本框中输入

Particle_1，单击 OK 按钮。双击

（Particle_1），出现对话框，在对话框

的上部 Color settings 中选中五个三角

形最左面的一个，在右侧的框中填写，

如图 99-5 所示。下面给出其余 4 个三

角形的 RGB 值，顺序为从左至右。

Red=255， Green=255， Blue=255；

Red=255， Green=255， Blue=128；

Red=255，Green=0，Blue=0；Red=0，

Green=0，Blue=0。修改 Particle settings

的数值，具体设置如图 99-6 所示，单

击 Close按钮。使用与上面完全相同的

方法，分别为 （thruster02）、  
（thruster03） 和 （thruster04）创建

（Particle_2）、 （Particle_3）和

（Particle_4）。在 Event map 1中单击

（Keyboard�s key press），拖动到右
面的空白处。在 Action 中单击 Object 
motion 选项，选中   （Translation 
XYZ），拖到 Event map 1中，叠加在
（KeyPress_1）上，出现黑框。选中

 （13），拖到  （Translation XYZ）
上，出现黑框。双击  （Translation 
XYZ），弹出对话框，具体设置如图
99-7所示。选择 Repeat count方式，单
击 Close 按钮。完成效果如图 99-8 所
示。在 Action中单击 Particle systems，
选中 （Start particle emission），拖动
到 Event map 1 中 ， 叠 加 在
（KeyPress_1）上，出现黑框。单击
RootNode，单击 （Group_All），再
单击 （13）和 （thruster01）选中

 

图 99-4 

 

图 99-5 

 

图 99-6 

 

图 99-7 
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（Particle_1），拖到 Event map 1中，

叠加在 （Start particle emission）上，

出现黑框。在 Action 中单击 Particle 

systems ， 选 中 （ Start particle 

emission），拖动到 Event map 1中，

叠加在 （KeyPress_1）上，出现黑框。

单击 RootNode，单击 （Group_All），

再单击 （13）和 （thruster02）选

中 （Particle_2），拖到 Event map 1

中，叠加在 （Start particle emission）

上，出现黑框。在 Action中单击 Particle 

systems ， 选 中 （ Start particle 

emission），拖动到 Event map 1中，

叠加在 （KeyPress_1）上，出现黑框。

单击 RootNode，单击 （Group_All），

再单击 （13）和 （thruster03）选

中 （Particle_3），拖到 Event map 1

中，叠加在 （Start particle emission）

上，出现黑框。在 Action中单击 Particle 

systems ， 选 中 （ Start particle 

emission），拖动到 Event map 1中，

叠加在 （KeyPress_1）上，出现黑框。

单击 RootNode，单击 （Group_All），

再单击 （13）和 （thruster04）选

中 （Particle_4），拖到 Event map 1

中，叠加在 （Start particle emission）

上，出现黑框。完成效果如图 99-9 所

示。在 Event map 1中单击 （Timer），

拖动到右面的空白处。选中

（Timer_1），右击选择不要 Initial 

Activation。在 Action 中单击 Particle 

systems ， 选 中 （ Stop particle 

emission），拖动到 Event map 1中，

叠加在 （Timer_1）上，出现黑框。

分 别 选 中 （ Particle_1 ） 、

（Particle_2）、 （Particle_3）和

（Particle_4），拖到 Event map 1中，

叠加在 （Stop particle emission）上，

出现黑框。在 Action中单击 Event，选

 

图 99-8 

 

图 99-9 

 

图 99-10 

 

图 99-11 
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中 （activate event），拖动到 Event map 

1中，叠加在 （KeyPress_1）上，出

现黑框。右击 （activate event）出现

对话框如图 99-10 所示，在左边选择

Timer_1，单击 Add按钮，单击 OK按

钮。双击 （Timer_1），出现对话框

如图 99-11所示，在文本框中填入 4000

（ms），单击 OK 按钮。完成效果如

图 99-12所示。 

5．制作飞船调整姿态的效果。在

Event map 1中单击 （Keyboard�s key 
press），拖动到右面的空白处。在 Action
中单击 Object motion 选项，选中  
（Translation XYZ），拖到 Event map 1
中，叠加在 （KeyPress_2）上，出现
黑框。双击  （Translation XYZ）出
现对话框，具体设置如图 99-13所示，
选择 Repeat count方式，单击 Close按
钮。在 Action中单击 Object motion选
项，选中 （Rotation XYZ），拖到
Event map 1中，叠加在 （KeyPress_2）
上，出现黑框。双击 （Rotation XYZ）
出现对话框，具体设置如图99-14所示，
选择 Repeat count方式，单击 Close按
钮。在 Action中单击 Object motion选
项，选中 （Rotation XYZ），拖到
Event map 1中，叠加在 （KeyPress_2）
上，出现黑框。双击 （Rotation XYZ）
出现对话框，如图 99-15 所示，选择
Repeat count方式，单击 Close按钮。
在Action中单击Event，选中 （Trigger 
event），拖到 Event map 1中，叠加在
（KeyPress_2）上，出现黑框。选中
（KeyPress_1），拖动到 （Trigger 

event）上，出现黑框。完成效果如图
99-16所示。 

6．保存为 Apollo.c3p，本例制作
完成。 

 

图 99-12 

 

图 99-13 

 

图 99-14 

 

图 99-15 

 

图 99-16 
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实例 100  阿波罗 13号（二） 

 

本例制作“阿波罗 13号（二）”

的效果，如图 100-1所示。 

本例特点：按“3”键控制飞船离

开，并在一定的时间以后登月舱开始转

移轨道。 

本例通过 Start particle emission、

Stop particle emission、Deactivate event

和 activate event等知识完成。 

 

图 100-1  效果图 

 

 

1．启动 Cult 3D。 

2．装载 Apollo.C3P（源文件）。

执行 File→Load project命令，在对话框

中选中Apollo.C3P，如图 100-2所示。 

3．制作主发动机火焰的效果。在

Scene Graph中单击 RootNode，单击 
（Group_All），再单击 （13），选中

 （13-thrust）。右击 （13-thrust），

选择New...→Particle system命令。双击

（Particle），出现对话框，在对话框

的上部Color settings中选中 5个三角形

最左面的一个，在右侧的框中填写，如

图 100-3所示。下面给出其余 4个三角

形的 RGB 值（顺序由左至右）：

Red=255 ， Green=255 ， Blue=255 ；

Red=255 ， Green=255 ， Blue=128 ；

Red=255，Green=0，Blue=0；Red=0，

Green=0，Blue=0。修改 Particle setting

的数值，具体设置如图 100-4 所示，单

击Close按钮。 

 

 

 

 

 

图 100-2 

 

图 100-3 
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4．制作飞船加速离开的效果。在

Event map 1中单击 （Keyboard�s key 
press），拖动到右面的空白处。双击
（KeyPress_3），出现对话框，在左边
选择 3，单击 Add按钮，单击 OK按钮。
在 Action中单击 Particle systems，选中
（Start particle emission），拖到 Event 

map 1中，叠加在 （KeyPress_3）上，
出现黑框。在 Scene Graph中选中刚才
所建立的 （Particle），拖到 Event map 
1中，叠加在 （Start particle emission）
上，出现黑框。在 Action中单击 Object 
motion 选项，选中   （Translation 
XYZ），拖到 Event map 1中，叠加在
（KeyPress_3）上，出现黑框。双击

  （Translation XYZ）出现对话框，
单击 Y 方向上的 ，选择 ，如图
100-5 所示，单击 Set 出现对话框，在
Sustain和 parameters中修改参数，具体
设置如图 100-6所示，单击 Close按钮。
选中 （13）叠加在  （Translation 
XYZ）上，出现黑框。在 Event map 1
中单击 （Timer），拖动到右面的空
白处。双击 （Timer_2），出现对话
框，在文本框中填 20000，如图 100-7
所示，单击 OK 按钮。选中
（Timer_2），右击选择不要 Initial 
Activation。在 Action 中单击 Particle 
systems ， 选 中 （ Stop particle 
emission），拖动到 Event map 1中，
叠加在 （Timer_2）上，出现黑框。
选中 （Particle），拖到 Event map 1
中，叠加在 （Stop particle emission）
上，出现黑框。在 Action中单击 Event，
选中 （activate event），拖动到 Event 
map 1中，叠加在 （KeyPress_3）上，
出现黑框。选中 （Timer_2），按住
叠加在 （activate event）上，出现黑
框。完成效果如图 100-8所示。 

 

图 100-4 

 

图 100-5 

 

图 100-6 

 

图 100-7 



Cult 3D产品三维演示时尚创作百例 

 
320 

5．制作登月舱调整姿态的效果。

在 Event map 1中单击 （Timer），拖

动到右面的空白处。双击 （Timer_3），

出现对话框，在文本框中填 10000，单

击 OK 按钮。选中 （Timer_3），右

击选择不要 Initial Activation。在 Action

中单击 Event，选中 （activate event），

拖动到 Event map 1 中，叠加在

（KeyPress_3）上，出现黑框。选中

（Timer_3），按住叠加在 （activate 

event）上，出现黑框。在 Action 中单

击 Event，选中 （Deactivate event），

拖动到 Event map 1 中，叠加在

（Timer_3）上，出现黑框。选中

（Timer_3），叠加在  （Deactivate 

event）上，出现黑框。单击 Object 

Motion，选中 （Rotation XYZ），拖

到 Event map 1中，叠加在 （Timer_3）

上，出现黑框。在 Scene Graph中单击

RootNode，单击 （Group_All），选

中 （lam），拖到 （Rotation XYZ）

上，出现黑框。双击 （Rotation XYZ），

弹出对话框，具体设置如图100-9所示，

选择 Repeat count方式，单击 Close按

钮。单击 Object Motion，选中   

（Translation XYZ），拖到 Event map 1

中，叠加在 （Timer_3）上，出现黑

框。选中 （lam），拖到  （Translation 

XYZ ） 上 ， 出 现 黑 框 。 双 击   

（Translation XYZ），弹出对话框，具

体设置如图 100-10所示，选择 Loop方

式，单击Close按钮。选中 （Timer_3），

右击选择 Edit with Time Line View，出

现对话框如图 100-11 所示，将   

（Translation XYZ）的时间拖动到 
（Rotation XYZ）后面。最后完成的效

果如图 100-12所示。 

6．保存为 Apollo1.c3p，本例制作

完成。 

 

图 100-8 

 

图 100-9 

 

图 100-10 

 

图 100-11 

 

图 100-12 
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